


Babylon 5:
I Have Found Her
IFH (I Have Found Her) is the
computer game project main-
tained by Space Dream Facto-
ry. It’s a space combat
simulator based on the popu-
lar Sci-Fi TV show Babylon 5.

Eternal: A free, open
source first person shooter
engine derived from Bungie’s
Marathon 2. The story is a
direct, unofficial sequel to
Marathon Infinity, the last
installment of the original
Marathon trilogy.

Halo Zero Full Game
A free fan-made 2D action
game based on Bungie and
Microsoft Game Studio’s
Halo Franchise.

Prince of Persia 4D
Prince of Persia 4D is an
unofficial release of the orig-
inal Prince of Persia, with
harder levels and more chal-
lenging gameplay. The origi-
nal Prince of Persia was
released in 1990 and became
extremely popular over the
years. With its Arabian
theme and realistic, unex-

pected surprises and puz-
zles, some think this is one of
the best games ever made!

Microsoft Monster
Truck Madness 2
There's a whole new mud
bath waiting for you! The
question is... ARE YOU
READY TO RUMBLE?!!
Monster Truck Madness 2
combines outrageous atti-
tude, unrestrained racing
and real monster trucks to
provide a fun and exhilarat-
ing offroad driving experi-
ence across rugged terrain.

Dressed To Kill (1946)

Dressed to Kill
puts Sherlock
Holmes and
the devoted
but bumbling
Dr Watson on
the trail of a
ruthless gang
intent on sec-
uring—by hook, crook or
thrown dagger—three seem-
ingly innocuous music
boxes.

The Kid
The Kid was
Charlie Chap-
lin's first full-
length movie.
It, more than
anything else
to that date,
made Chaplin
a living leg-
end. It took over a year to
produce, and was an incred-
ible success for Chaplin.

The Last Man on
Earth

Based on the
chilling Richard
Matheson sci-
ence fiction clas-
sic I am Legend
and later remade
as The Omega
Man starring
Charlton Hes-
ton, this classic features Vin-
cent Price as scientist Robert
Morgan in a post-apocalyptic
nightmare world.

Superman:
Mechanical Monsters
An inventor has built power-
ful giant robots that can fly
like planes and open
banks like cans. Of
course, Lois Lane
gets into trouble
with a robot; can
Superman res-
cue her from the
inventor's hideout?

Come join the Digit 5th 

Anniversary Bash!

Cube
An open source multiplayer
and single-player first per-
son shooter game built on
an entirely new and very
unconventional engine.
Cube is a landscape-style
engine that pretends to be
an indoor FPS engine.

TORCS
TORCS, The Open
Racing Car Simulator,
is a highly portable
multi-platform car
racing simulation.

It is used as an ordinary
car racing game, an AI
racing game and as a
research platform.

D2X-XL
An OpenGL mod

for the classic 3D
game Descent 2.

Now you don’t need to
go to the theatres!

Special Report

Celebrating its fifth anniversary, India’s
No. 1 technology magazine Digit treats its
readers to a special issue that doffs its hat

to the most amazing things about technology
yet. Featuring:

5 Tech Shopping-Carts
Fancy a laptop with a 20-hour
battery? What about a bathtub
that immerses you in movies
while you immerse yourself
in water? A round-up of the
coolest tech products that will
affect you now and in the
future. Divided neatly into five
little piles. 

5 Decades of Technology
While the hippies played in the fields and the
rockers rocked in the parks, new and wonder-
ful things were happening in technology. Digit
takes a heady nostalgic trip through the past
five decades. On our way, we will witness the
birth of BASIC, the first LAN, and the coming
of the Internet—among many other things.
And what lies in store for us in the remainder
of this decade? A look into the Great Big Plan.

5 Technologies That Fell Flat

Ever wondered
where Virtual
Reality went? And
whatever hap-
pened to flying
cars? Welcome to
our guided tour of
the great tech-nological graveyard. Today’s
attractions: great ideas that fell flat on their
faces, and ideas that flopped because they were
idiotic to begin with. Please, no pushing!

5 of Digit’s Tech Desires
Do Digit employ-
ees dream of bina-
ry sheep? We
reveal five of the
least embarrassing
things on our tech-
nology wish-lists.
Actually, they’re not so crazy after all! How
long will we need to wait? 

5 Experts on Tech
We roped in industry biggies to tell us what
they think the future in their
respective areas of expertise
is going to hold. Read about
five facets that are going to
refresh the way we see the
technological world today.

The Great Cell
Phone Shootout

5 years n 60 issues n10,000+ pages n Nearly 200 GB of data n 6,00,000+ readers

10 All Time Classic Movies on DVD

Mobility is in now, and mobile devices are becoming
increasingly convergent. We put the cells and smartphones of
today under our microscope and bring you the low-down on

the best and the rest!

Digit Unleashes the
Power of Five

Penguin Passionates
can Play too!

LINUX GAMES

Business Planning Software & Motocross Madness 2 Free with this issue

Gamers’ Delight: 30+ Games—Believe It!

Mobility is in now, and mobile devices are becoming
increasingly convergent. We put the cells and smartphones of
today under our microscope and bring you the low-down on

the best and the rest!



Some people ask, why this devotion to
technology? It’s not an idle question, and I shall
attempt to answer it. First, India is a developing
country, but when it comes to IT, we have a
global presence. We’re a force in the global arena,
respected for our prowess, and other countries
are suddenly trying to emulate us. Within the
country, as open source percolates, as the digital
divide is bridged, with people taking to
computing in regional languages, with IT
awareness spreading to the remotest corners of
the country, with prices coming down sharply—

who knows what the IT landscape will be five
years hence? Sure, we are yet to improve the
infrastructure in our cities, but when the world
talks about India, it’s now about our growth as
an IT force, about our place in the sun.

Second, technology is what is propelling us
into the future, a point I do not need to belabour.
Tech brands are competing with traditional ones
in terms of popularity. Tech products and
developments top peoples’ wish-lists. “Progress”
almost means “technological progress.”

Finally, it’s technology that connects us to the
world. We may be a developing country, but
when someone reads a blog post of yours, your
national economic situation does not show. What
shows is how much we’re in step with the rest of
the world. We’re an integral part of the global
community—and I must stress that this was not
the case earlier—the Internet, that great leveller,
has enabled this transition. And we adapted.

And so, as much as we’re celebrating the five
years that have gone by, we’re eagerly
anticipating what coming years will bring. We
don’t need to make a New Year resolution, as it
were: we’ll continue doing what we’ve been
doing. I believe we’ve been doing it well.

Enjoy this, our Five-Star issue—and stay tuned
for much more to come!

t’s clear enough from the packaging of what you
just bought, but let me state it formally: Digit this
month celebrates its Fifth Anniversary. It’s been
five exciting years of keeping you, our readers, in
touch with how the technology saga has been
progressing; Five great years of infotainment and
innovation; Five fabulous years of focusing on the
present and looking fondly to the future.

What’s special about Five? Man has always
given the number Five special treatment: think of
the five-pointed star, or the pentagram, which
wards off evil. Or of the five elements. Or of the
five virtues. Coming down to earth, five translates
to half a decade, so we can now speak about
ourselves in terms of decades rather than merely
months and years. Half a decade is a lot in
Internet time, as you’re all too aware! Then there’s
the power of your hand with its five fingers: from
what I can see, the trend has been towards
putting everything in your hands. Whether it’s
figuratively—as in control and ease of use—or
literally, as in mobile devices. I’ve been fascinated
by how everything is shrinking.

When we started off in 2001, we knew we’d be
do well. Becoming India’s Number One
Technology magazine by far has validated our
confidence. We think we’ve been ably doing our
bit to promote interest in information technology
in India. Sure, we talk a lot about technology in
the personal sphere, but that’s where it begins: as
an interest, as a hobby, as an obsession—and then
comes the drive to, for example, base a career
around it. Yes, we believe we’ve been changing
lives over the past five years. Letters from you, our
readers, are testimony to this.

Publisher’s
Note

The Power Of Five
Maulik Jasubhai Publisher
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FIRST, PARDON ME for coming back to the topic of
blogs, something about which I wrote in this space
last month. But have you wondered why blogging,
podcasting or even vlogging is such a rage today? All
of a sudden, so many of us have the opportunity to
be broadcasters or publishers, and have discovered
the requisite talent in ourselves— resulting in an out-
pouring of thoughts. A new breed of blogaholics is
writing five to ten times a day in their corners on
the Web, while others have made such activity their
sole profession.

Some well-known blogs are now being published
as novels, and aim to be bestsellers in the USA. Jes-
sica Cutler, a former Capitol Hill intern, traded
inside secrets of her workplace on her blog Wash-
ingtonienne, and now it’s a sought-after novel.

To me, this trend seems to be a reflection of a
certain shift—from where the inherently introverted
are expected to be submissive, to where anyone can
afford to be individualistic, vocal and expressive. Pri-
vate diaries in the days of ink-pens were shrouded in
secrecy and a sense of privacy revolved around them,
but blogs today carry an invitation to be read and
criticised. So what has changed?

The Internet is the great leveller, as our publisher
has said in his note. “Why not me?” seems to be the
general idea. You’re as much a blogger as the next
Blogspot or TypePad member. Not so in “real” life: in
that other world, he or she is better-looking, more
sociable, more chatty, more extroverted. His or her
views are taken more seriously just because, for
example, he or she is more articulate. We’re wit-
nessing the great levelling act— where it does not
matter whether you’re pretty or ugly, introverted or
not. This reminds me of marriages that begin as
online relationships: the focus is hardly on looks, as
it is in the case of the traditional matrimonial pro-
ceedings. When the couple finally meet offline,
looks take a backseat.

Second, everyone has this need to be rated, to be
appreciated, to be appraised. Witness such sites as
ratepeople.com, where people put up their photo-
graphs and wait to be rated on a scale of five, osten-
sibly by members of the opposite sex. Now with
blogs, you can be sized up—from behind the com-
fort, in most cases, of a nickname. There’s also the
need for acceptance by society: the Net is the new

society, and blogs are the platform where one gauges
how worthy one is. The introverts amongst us now
have a level playing field, so to speak. It had to
happen: way before blogs, the socially maladjusted
had taken to the Net.

Most interesting, perhaps, is the need and capa-
bility to be a part of it all. To have an established voice
on the Net is a matter of pride, not least because it can
be accessed from anywhere at any time.

Virtual reality—as in the comical goggles— might
have failed to deliver, as we speak about in this issue,
but even apart from MMORPGs, the Net is virtual.
It’s a reflection of every aspect of our brick-and-
mortar lives, a more ideal expression; a new play-
ground where it’s easier to arrive. The traditional
shackles have been shed.

deepak_ajwani@thinkdigit.com

Virtually Vocal

Editorial

“With blogs, you can be sized up—
from behind the comfort, in most

cases, of a nickname”

Deepak Ajwani Associate Editor
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VJ Sophia and
her mobile
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got it wrong all
this while? Do
the masses
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more than they
do PCs? 
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Digital Tools

138 Tips & Tricks 
Another edition of registry tweaks to speed up (or
kill) your PC, how to use RAW with your digicam,
and what lenses you can add on

126 30 Days With The Creative I-Trigue 3400
A reviewer used these decidedly beautiful speakers,
and figured what they were really made of

122 Take A Crack
Win a book on Computer Security—but you have to
tickle your brain with our task first!

98 Mobile Madness
47 cell phones ranging from the unbelievably
cheap to the super-indulgent! Start talking!

5 Decades Of Technology
A trip back in tech time.

A nostalgic glance at when games 
were loaded off cassette tapes

5 Tech Shopping-Carts
Wish for a gadget that does more? 

Grab your shopping basket! 

5 Technologies That Fell Flat
These brave runners started their

electronic marathons on a shining hope.
Then they tripped over their shoelaces

5 Of Digit’s Tech Desires
Our fondest dreams for our tech 

futures. The ones we wouldn’t get 
laughed at for, anyway

5 Experts On Tech
What is the future of the open source

Movement? How will Web 2.0 affect the 
way we use the Internet? Five experts
comment on the areas dearest to them

132 New &
Notable 
The NVIDIA
7900GTX came
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starring an ultra-
thin Sony laptop and the
Vantech AVOX-100 Jukebox, and
an expensive but very desirable 
USB drive
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134 Agent 001
Quick. Where can you get a licensed copy of
Microsoft Office? Stumped? Agent 001 hunts down
the paid software you’ll need
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Babylon 5: I Have Found Her
BIFH (I've Found Her) is the computer game
project maintained by Space Dream Factory. It
is a space combat simulator based on the
popular Sci-Fi TV show Babylon 5

Eternal 
Its story is a direct, unofficial sequel to
Marathon Infinity, the last installment of the
original Marathon trilogy 

S.W.I.N.E
S.W.I.N.E. is a real-time tactical
strategy game in which you
must carry out extremely
varied missions while taking
advantage of the terrain and
your units’ special abilities

SMALL GAMES

Gruntz
This puzzle game from Monolith begins as the
Gruntz are whisked off to
another realm. These Gruntz
must venture through this
new world to gather
missing pieces of the Warp
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■ Yahoo! Widgets

WALLPAPERS
More than 280 MB of Wallpapers

FREE MOVIES

The Kid
The Kid was Charlie
Chaplin's first full-length
movie. It, more than
anything else to that
date, made Chaplin a
living legend. It took over
a year to produce, and
was an incredible
success for Chaplin

Dressed To Kill
Dressed to Kill puts Sherlock
Holmes and the devoted but
bumbling Dr. Watson on the
trail of a ruthless gang
intent on securing - by
hook, crook or thrown
dagger - three
seemingly innocuous
music boxes 

■ Little Lulu: Bored of
Education (1946)

■ Popeye the Sailor
Meets Ali Baba's
Forty Thieves (1937)

■ Sherlock Holmes
and the Secret Weapon (1943)
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■ Superman: Mechanical Monsters
■ The Last Man on Earth (1964)
■ The Man Who Knew Too Much (1934)

SHORT FILMS
■ Core Wars
■ Quake done Quick With a Vengeance

(2000)
■ The Matrix (Halo Remix)
■ Star Wars TV Trailer
■ Nostalgia

FREE Ebooks

■ Asynchronous JavaScript Technology and
XML (AJAX) With Java 2 Platform,
Enterprise Edition

■ Introduction to the Java EE 5 Platform
■ The Basics of GlassFish
■ Project Gutenberg August 2003 CD

TOOLS

Sox
Sox is a program for
converting sound files
between several formats
such as CD audio, .au, .voc
and .wav. It can also apply sound effects to
the audio fill

■ DivX Video 5.0.5
■ KDE Multimedia 3.1.4
■ Mp3blaster
■ PyKaraoke 0.4.1
■ RipperX
■ Sing-Along Disk Player
■ Xine Lib: 1 - rc3a
■ Xmms 1.2.8

LINUX GAMES

TORCS

TORCS, The Open Racing Car
Simulator, is a highly
portable multi platform car
racing simulation. It is used
as ordinary car racing game, as AI racing
game and as research platform

■ HCube
■ D2X-XL
■ glTron
■ Racer

Neverball
In the grand
tradition of
Marble Madness
and Super
Monkey Ball,
Neverball has
you guide a rolling ball through dangerous
territory. Balance on narrow bridges,
navigate mazes, ride moving platforms, and
dodge pushers and shovers to get to the goal

A/V EDITORS

Mixxx 1.4.2
Mixxx is designed for DJ'ing for both
professional and semi-professional users.
Mixxx was started in early 2001 as one of the
first digital DJ systems 

Music Magic Mixer 1.5c
The MusicMagic Mixer is the ultimate music
library power tool-digital signal processing
is used to automatically perform acoustic
analysis of the sounds in your music collection

■ Aestesis All Starz 2.0
■ Audiograbber 1.83
■ EXPStudio Audio Editor Free 3.95
■ Free CD to MP3 Converter 1.8 build

20051129
■ Free iPod Video Converter 1.32 build 852
■ Id3ToFolder 2.2
■ MadTracker 2.6.1
■ MP3 Recorder
■ Switch 1.05
■ Vjamm Blueprint 1.0.2
■ VP7 Personal Edition 7.0
■ WavePad Audio Editor 2.10
■ Zortam Mp3 Media Studio 6.05

MEDIA PLAYERS
■ Ace Player 1.28
■ AdvancedDVDPlayer 1.37
■ All-in-One DVD Player 2.4.8
■ Artisan DVD/DivX Player 3.1
■ Ashampoo Media Player 2.03 build 2
■ Avant DVD/DivX Player 2.03
■ AVI Movie Player 5
■ Flash Movie Player 1.4
■ FLV Player 1.3.3
■ Google Video Player 1.0.1.0
■ automatically.
■ Got All Media 5.0.2
■ jetAudio 6.2.6 Basic
■ Manny's Simple Music Machine 1.02
■ Media Player Classic 6.4.9
■ Music Manager
■ MusicCubeOne 1.31.6
■ musikCube 1 RC2
■ Pulse MP 1.2
■ QuickTime 7.0.2 + iTunes
■ Quintessential Player 4.51
■ RealPlayer 10
■ Winamp 5.21
■ Windows Media Player 10
■ Zoom Player Standard 4.03

LINUX TOOLSEYE CANDY AUDIO VISUAL

6
LINUX GAMES

FREE E-BOOKS

CLASSIC MOVIES10
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WebPlus 6
Explore the endless possibilities of
designing eye-catching web pages with
WebPlus 6

F-Prot Antivirus
F-Prot Antivirus for Linux Workstations is
designed for workstations running the
Linux operating system

Parallels Workstation for Linux 2.0
Parallels Workstation is the
most powerful, easiest-to-
use, cost-effective desktop
virtualization solution
available today

DEVELOPER TOOLS
■ DB Explorer 1.0.1
■ DrJava
■ Gel  version 1.0 RC39
■ Plugins for Gel
■ Gentee Studio 2.1
■ Hyper Care 1.01
■ Java Code Export 1
■ Menu Creator 0.5.0
■ SmallSQL Database 0.13
■ SourceMonitor 2.1.8.9

■ Database Browser 2.0.2
■ SQL Dumper 1.1.3
■ Very Simple Database Inspector 1.84
■ Vide
■ Xotics 4.1.23

LINUX
■ Advanced Power Management
■ Daemon 3.0.2
■ Guarddog
■ Kdevelop 3.2.0
■ KTranslator 0.1

■ LabPlot 1.5.0
■ MZL & Novatech Traffic Statistics
■ Linux Server 1.2.0.0
■ unRAR 2.71
■ SynchronEX File Sync/FTP/DAV for Linux 3.0.7.1
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ThinkFree Office 3
ThinkFree Office is a simple but powerful application
suite that includes word processing, spreadsheet and
presentation graphics programs

PDF995 7.7s
Create PDF files from any application by simply selecting
the print command

Yeah Write
Yeah Write has an unusual
approach to creating
documents: it sports a fill-in-
the-blanks interface, saves files automatically without
users having to know the file names of the files, etc

PRODUCTIVITY TOOLS 
■ CrawlTrack 1.3.1
■ Jarte Word Processor
■ NeedForTrade Studio Lite 1
■ Paper Label Maker 1.06
■ SimpleOCR 3
■ TopSales Basic 5
■ NetWorx
■ SoftPerfect Network

Protocol Analyzer 2.3
■ Universal Document Converter 4.1

MOBILE APPS
■ FMA 2.0
■ Nokia PC Suite 6.8 release 21
■ Wapalize! WAP Development kit 0.75
■ Database Viewer 3.1
■ Magicbyte DVD Ripper Deluxe 
■ Mobile Media Master 1.5
■ Psiloc Mini GPS

SMALL GAMES

Alphattack
Can you save the planet from the
alpha bombs? Defeat the threat
before our cities are destroyed!

Clash N Slash
Protect your home planet from the endless onslaught of
enemy weaponry! 

Sub Commander
Guide your submarine through
the treacherous waters - avoiding
the obstacles

Reel Gold
Clear each level of gold before the
time runs out to move onto the
next valley! You can only pickup
highlighted gold nuggets

Hostile Skies
You're a fighter ace, complete a
series of dangerous missions then
challenge the evil 'Red Baron' for
supremacy of the skies!

King of the Hill
Use your castles weapons to protect yourself from the
enemy, and become King of the Hill

VIDEOS
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DrawPlus 4
DrawPlus 4 is the user-friendly drawing
program that opens up a whole new
creative world

Ulead Photo Explorer 8.5
It's the all-in-one solution for owners of
digital cameras, camcorders, scanners or anyone who
wants to make it easier to keep track of their media

MULTIMEDIA
■ Audacity 1.2.4b
■ Audio Files GDS Indexer 1.0
■ AudioShell 1.2
■ Inkscape 0.43
■ Photo Manager
■ PhotoPlus 6
■ Tag Support Plugin for Media Player 1 
■ Cool Edit Pro 2.1
■ DVD and CD Cover Print 3.4.2
■ FlashDigger Plus 3.7.1.94
■ Photo Pos Pro image editor 1.27
■ Virtual DJ 3.4

INTERNET

■ Abtrusion Protector Personal Edition 1.1
■ Antispam Scanner 1.1
■ GhostWall v1.150
■ Google SketchUp
■ Internet Explorer 7 Beta 2
■ Messenger Plus! 3.63
■ PSST
■ SoftPerfect Personal Firewall
■ SpywareGuard 2.2
■ X-IM
■ ewido anti-malware

SYSTEM
■ AntiVir Personal Edition
■ BitDefender AntiVirus
■ Contig
■ Dasher Stable Release (4.0)
■ Font Viewer 1.2
■ Notepad2
■ PageDefrag
■ Touch Typing
■ Quick File Rename
■ Recover My Email 
■ R-Word Demo
■ Zip Repair

ESSENTIALS 
■ .NET Framework 1.1
■ FoxIt Reader
■ Avast Home Edition 4.7
■ Digit Software Archive 2006 Beta
■ Irfan View 3.98
■ K-Lite Mega Codec Pack 1.53
■ Opera 8.54
■ Spybot Search & Destroy 1.4
■ VLC Media Player 0.8.4 ■ X-Men: The Last Stand■ Poseidon (2006)

■ Keeping Up With The Steins



By Demand
You get to choose what goes on Digit
Interactive. This month, you chose:

Ulead Photo Explorer 8.5
Size: 23 MB

WebPlus 6
Size: 26 MB

Subscribe
No more snail-mail! No need to visit post
offices! All you have to do is log on to
www.thinkdigit.com/subscribe and use
your Credit Card to make sure you never
miss another issue of your favourite
magazine!

Online

taste technology at www.thinkdigit.com

Online Survey
We’re conducting an
online survey to help better
your experience with our
online publications.
Please visit http://www.
thinkdigit.com/forum/
to take the survey.

Total: 4,258Last Month’s Question

This Month’s Question

< 7 KBps

8 to 16 KBps

17 to 32 KBps

33 to 64 KBps

above 64 KBps

To vote Log on to www.thinkdigit.com

What is the actual Broadband speeed you get?

Digit Reader Poll

Digit Patrons
It really does

pay to be loyal!

Find out more

on www.
thinkdigit.com

THERE’S SOMETHING FOR
EVERYONE ON THE DIGIT FORUM
News, reviews, troubleshooting, open source
fanatics, hardcore gamers, tips and tricks,
tutorials, funny anecdotes and more... all
this and more awaits you. All you have to do
is log on to wwwwww..tthhiinnkkddiiggiitt..ccoomm//ffoorruumm  and
become a part of India’s largest technology
community online. 

We’ve just upgraded the forum to offer
the best user experience possible. 10,000+
members and counting...
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VJ Sophia
(Sophia Chaudhry)
Singer/VJ

Sophia has had our
attention as a VJ and

singer for some time now.
An alumnus of the London

School of Economics,
she is fluent in

French and
Italian, and also
sings in Arabic
and Spanish. She
sang the backing

vocals for Alisha
Chinai’s Made in

India and recently acted in
the movie Shaadi No. 1.

What does technology mean
to you?
I would be understating facts if
I called technology “simply
amazing.” It is so much more
than that. The leaps and
bounds we have made with
technology aiding us is
testimony to its usefulness.

Which of your gadgets are
you inseparable from?
I carry my Panasonic portable
DVD everywhere with me and,
of course, my iPod mini is my
constant companion too.  

Any instance where
technology has come to your
rescue?
As a single working girl in a
city, the cell phone is a definite
advantage when I have to keep
my family informed about my
safety, as I discovered during
the floods in Mumbai last year.
It similarly must have helped
reduce panic for others a little.

What would you say are the
limitations of technology?
With technology comes power
but not many use it properly.
Camera phones, although a
breakthrough invention, can
sometimes be a nuisance. The
brilliance of technology is
marred by its misuse.

Java To Go Open Source
Java will be going open source, Sun’s new vice president of
Software, Rich Green, announced at the 2006 JavaOne
Conference in San Francisco. “It is not a question of
whether,” he said, “but a question of how.” As for “when”,
Green could only say, “as soon as possible.”

Word To Have Blogging Support 
The forthcoming version of Microsoft Word will allow users to
publish blog postings directly from the application. Bloggers
who currently use Word to draft their posts experience
trouble when they paste the text into online blog publishing
tools because Word uses non-standard HTML tags.

There’s a race on to
provide cheap PCs to the

world’s poor, but something
seems to be going wrong.
Mid-May, a group of
technology leaders from
developing countries—
delegates at the World
Congress on Information
Technology (WCIT) in
Austin, Texas—criticised
AMD, Intel and MIT for not
co-operating in their efforts
to create low-cost
computers. They also added
that they’d prefer to see the
likes of Nokia and Motorola
bringing in cell phones to
their countries before PCs.
At WCIT, AMD, Intel and MIT
all made pitches about why
their low-cost computers
would get the job done
better than the others’.

AMD gave each WCIT
attendee a PIC (Personal
Internet Communicator).
This Internet enabler has a
no-frills version of Windows,
and a thick plastic casing for
protection. Intel’s CEO Paul
Otellini unveiled the
Eduwise laptop: the chip
giant believes the cheap
computers should have
full OSes as well as most
of the cutting-edge
technology found on
more expensive
computers. The
Eduwise costs
more than

AMD’s PIC, but it’s faster.
MIT’s Nicholas Negroponte
made an appearance before
the WCIT crowd to make his
pitch for the now-famous
hand-cranked $100 laptop,
pictured below.

“When I listen to the
multiple presentations here,
I wonder... are they talking to
each other in terms of how
they can collaborate,” said
Theogene Rudasingwa, a
technology expert from
Rwanda. “It occurred to me
that probably they are not...
We need to do a little more
in seeing how we can
collaborate… How can we put
all these things together into
some kind of sustainable
effort that begins to have an
impact on people in the
developing world.”

“We are also worried
whether AMD, Intel and the
MIT professor are talking to
each other,” said Ibrahim
Kaliisa, special advisor on
technology to the president
of Uganda. “It can be about
moral obligation here, but it

also must make business
sense for these companies.
Maybe that is why they are
not talking to each other.”

Co-operation seems
unlikely given that AMD and
Intel don’t see their low-cost
PC efforts as charity
projects, but as seeding
potential growth markets
with their brands.

But are PCs what the
developing world wants?

“I think we need to raise
the first question, which is,
should we have a PC-
oriented view on
communications,” said C K
Prahalad, a business
professor and author at the
University of Michigan.
Prahalad backed the idea
that there will be more
growth and interest around
cell phones in the coming
years in developing nations.
Companies, according to
Prahalad, should
concentrate on creating
affordable service plans, as
well as devices that provide
PC-like tools.

Teresa Peters, a senior
program officer at the Bill
and Melinda Gates
Foundation, said in
reference to the cheap PCs:

“At the individual level, the
people on the ground

aren’t clamouring for
these kinds of
devices.” In contrast,
they want cell
phones, she said.
Even if it is a PC the

people want, the price point
is a topic of much debate—
$400, say, is too expensive,
and no-one wants a barely-
usable $100 device. Will the

Enter

THE RACE IS GOING AWRY

Do The Poor Want PCs Or Phones?



whole “provide-the-world’s-
poor-with-cheap-laptops”
thing flop after all? Is there
any research being done on
what exactly the poor in
developing countries want?
There is much debate and
much talk over the issue.
Some ask why a kid in, say,
rural Rwanda, would even
want a laptop. Others talk of
distributing PCs as a sure-
shot way of bridging the
digital divide. With three
major players now in the
fray, it’s getting interesting.

WILL IT BE GOOD ENOUGH?

Vista To Have
Inbuilt
Security 

According to a recent
analyst report,
Windows Vista will

include security
features that will
make it
unnecessary to
install third-
party anti-
spyware and
firewall software.
This means
Windows will be
more secure, but
it will significantly
impact the $3.6
billion (Rs 17,000
crore) market for
Windows security
products.

The anti-virus
market, though,
will not be
affected: Vista will
not ship with anti-
virus software.

Microsoft has plans to sell
its own anti-virus
software—Windows Live
OneCare—separately.
OneCare will be available
starting this month.

The impact on the anti-
spyware and software
firewall market will depend
on how good these features
in Vista are. As of now, in
Windows XP, many believe
the inbuilt firewall isn’t
quite good enough—and
third-party firewalls are
often recommended.
However, sources say that
the new Windows Firewall,
as well as Windows
Defender—the anti-spyware
in Vista—will be good
enough for most users.

The enhanced features
in Vista will mean better
security, but according to
Andrew Jaquith, a Yankee
Group analyst, the security
features mean upgrading

won’t be easy. “Vista

will dramatically improve
the security for Windows
users, but they have some
execution and usability
challenges,” Jaquith said. “It

is clear as day that Vista is
going to really annoy
users.” This is because of
features such as User
Account Control,
which will be enabled
by default, and which
will let users run the
OS with fewer
privileges. The intent
here is to prevent
malware from taking
over PCs, but Jaquith
says, “Although the new
security system shows
promise, it is far too
chatty and annoying.”

That apart, does the
report spell doom for
security product
vendors (excluding anti-

virus makers)? Perhaps
not. According to Jaquith,

Divyakshi Motwani, Mumbai 
Urvi Desai, Mumbai

Google
A poll
conducted in the UK of
nearly 3,000 consumers has
put Google as the most-loved
brand. The poll included a
wide range of consumer
brands such as Coke and
Pepsi, as well as
supermarket chains.

eBay
OK, this might be UK-centric,
but eBay stood at fourth
position in the same poll,
having also been beaten by
Tesco and Nokia.

The British happen to be
less likely than Americans to
shop online.

“Sending teachers to the moon!”  
“Producing movies.”

“The cold-drink business.” 

Rahul Khatri, Mumbai
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Security Watch

Vulnerabilities In Word

The Problem
Security Experts have warned
that a vulnerability in Microsoft
Word XP and 2003 is actively
being exploited, in a targeted
“zero-day” attack using a
combination of a Trojan and a
Backdoor. (A zero-day exploit is
one that takes advantage of a
vulnerability on the same day
that the vulnerability becomes
generally known.)

Trojan Dropper.MSWord.
1Table.bd spreads via targeted
e-mails identified to be sent
from China and Taiwan. Once
you try to download and try to
open the infected file, it shows
an error message. If you click
Retry, the malicious file is
immediately replaced by a clean
one. By that time, Trojan-
Dropper would have already
slipped into your computer. It
then goes ahead and downloads
Backdoor.Win32.Gusi. This
Backdoor can open a direct
channel that connects to the
remote attacker suspected to be
in China, to receive and execute
commands. With its rootkit
capability, this Backdoor can
smartly hide itself.

Well-known security firm
Secunia has issued a rare
“Extremely Critical” advisory for
this vulnerability.

The Solution
At the time of writing, Microsoft
was aware of the problem, but
had not released a patch yet. By
the time you read this, a patch
might have been released; visit
www.microsoft.com/athome/se
curity/update/bulletins/default.
mspx. If there’s no patch
available yet, do not open
untrusted Office documents.

“Dentistry!”
“Making pillows…”
Vijayendra Bhoiv, Mumbai

“What Business Should Microsoft Be Doing Besides IT?”One Silly Question

27

Illustrations Harsho Mohan Chattoraj

Rujutha  Deshpande, Mumbai



Pulse

28 DIGIT JUNE 2006

Online Access

TThhiinnkkffrreeee
This site offers you 1 GB of free storage!
It’s a boon for those who don’t have
office packages and yet need to work
on documents. The site also allows you
to work on such files online using your
browser—you can create and edit
Microsoft Office-compatible word
processing, spreadsheet and
presentation files.

LLooggMMeeIInn
Log in to a PC remotely via this site! If
you’re at home and need to access your
office PC, you can—using LogMeIn! The
site allows you access to systems behind
firewalls and proxies. LogMeIn also
provides 128- to 256-bit encryption
protection for data and passwords.
Remote-control everything! Open files,
check e-mail, run programs—all on a
faraway computer!

BBooxx
You get a GB of free space here to store
your files online. The site allows you to
synchronise or back up folders. The most
exciting feature here is that it allows you
to share files—you can specify the
privileges for each folder so only certain
users who have also signed up can access
them. Several sites offer free storage, but
not with so much functionality.

www.logmein.com

www.box.net

http://thinkfree.com

“Windows security issues
will continue to be a
permanent fact of life for
Microsoft, which means that
third parties will always
have a rich and robust
aftermarket available to
them to serve.”

Things aren’t clear, but
Symantec CEO John
Thompson said his firm
would produce better
security products than
Microsoft. “We know more
about security than they
ever will,” Thompson said.
The Microsoft brand “is
synonymous with a lot of
things. Security is not one of
them.” Which we know all
too well!

PATENT, WAIT, SUE

Creative
Sues Apple
Sues
Creative 

May 15, Creative Labs
filed complaints

against Apple Computer in
the US Federal court and
with the US International

Trade Commission, saying
Apple’s iPods impinge on a
Creative Labs’ patent for
how the iPods “access and
display music.” The patent
Creative is referring to are
what Creative’s Nomad
Jukebox and Zen digital
music player are based on.
Specifically, the patent
covers the user interface for
how “songs or pictures are
organised, accessed and
displayed” on the screen.

That patent is the so-
called “Zen Patent,” which
Creative applied for in 2001
and was awarded in August
2005. The company says it
engineered and
demonstrated the interface
that its own players as well
as competing players use—
well before the first iPods
began shipping.

In the filing with the US
International Trade
Commission, Creative
claimed that the two
companies had a licensing
agreement by which Apple
would have access to
Creative’s source code for its
Nomad Jukebox, and that
Apple’s 2001 edition of the
iTunes software on updated
2001 Macintosh computers

A Round-up Of Technology News From Across The GlobeThe Digital World

Three Incredibly Useful Sites

UNITED STATES

CANADA

AUSTRALIA

SOUTH KOREA

Telephone giant AT&T has
plans to offer IPTV service in
as many as 20 US markets
by year’s end. The company
is spending $4.6 billion to
make the service available
to 19 million homes by the
end of 2008

In an indication of the
menace that the
Internet represents to
the printed press,
CanWest, one of the
largest media
companies in Canada,
ceased print
production of Dose
Magazine on 17 May. It
will be continued on
the Internet and on
cell phones

The laying of
Bangladesh’s first
submarine fibre-optic
cable has recently been
completed. It will
provide a link with a
capacity of 10 Gbps,
compared to the current
150 Mbps Internet
service providers use

A recent survey found that more
people are using the Net to find a
partner because it is more
convenient than traditional
methods. It found that most online
romantics are middle-aged and very
pressed for time

A South Korean lawmaker is
seeking to draw up a bill to
prevent kids from spending too
much time playing games
online. If the bill is passed,
parents of minors will be able
to require online game
publishers to limit the daily
game time of their children
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Photograph Sonu Sharma

Last Month’s Winner!
Bhavesh N Momaya
Chalisgaon, Dist. Jalgaon
“The Window-modded PC cabinet”

E-mail your caption with the
subject “Beat That”, and your
postal address, to
beatthat@thinkdigit.com
and win 

SCJP Sun Certified
Programmer for Java 5
by Kathy Sierra & 
Bert Bates

Each month, Digit will carry a caption for a photo. Come up with something funnier, 

and beat the Digit team at their own game! Entries accepted by the 15th of this month.

Digit Caption

“E-Tea!”
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could integrate with
Creative’s digital media
players. Creative alleges that
after the agreement,
executives from the two
companies—including Apple
CEO Steve Jobs—had
discussions to “explore ways
in which the companies
could work together.
Creative showed Apple
several prototype portable
digital media players that
showed the patented
interface”—meaning that
Apple just stole the idea.

Creative asked for no less
than the US International
Trade Commission to bar
Apple from importing iPods,
iPod nanos, and iPod Minis
from its manufacturing
operations in China. The
company is also asking for
monetary damages
amounting to triple what
the court might find as the
damage that Creative has
suffered as a result of the
patent impingement. (As of
April 1, 2006, Apple had sold
50 million iPods.)

Apple reacted by counter-
suing Creative in a
Wisconsin District Court,
alleging that Creative
infringes four patents it

holds for digital music
players. Apparently, two can
play at this game!

But it was Creative who
started it, and was that a
case of a company patenting
something rather general
only to sue later? Think
about it: it’s an interface
we’re talking about. There’s
nothing special about it: it’s
a simple, intuitive way to
navigate through data. How
would Apple let users sort
through their MP3s without
using the kind of menu it
does? And the question
everyone is asking is, what
took Creative so long to
complain? 

NET PORN COMPANIES HAPPY

ICANN:
No .XXX

ICANN, the body that
oversees how Internet

names are awarded, has once
and for all turned down the
proposal to create the .xxx
domain for porn sites. The
proposal has existed for a
long time, and has faced
opposition from conservative

groups as well as Net porn
companies. 

The company
that was most
pushing for the
.xxx domain is
the ICM Registry.
According to
ICM—and some
people—a porn-
specific domain
would result in a
virtual red-light
area, clearly
identifiable,
making it easier
to prevent
children from
accessing
porn. On the
surface of it, it
sounds good—
there would be
no need for porn
filters: just block .xxx URLs!
But actually, it’s much more
complicated.

Mukul Krishna, an
analyst with Frost &
Sullivan, said the porn
industry doesn’t want a
special domain, and that
governments don’t want it
either. “ICANN doesn’t want
it because it doesn’t have the
resources,” he said, adding
that the issue would

probably fade into
the background.

ICANN initially decided
in favour of adding .xxx to
the list of top level domains
in June of 2005, but
pressure from conservatives
and the Bush government
led to ICANN revoking its
decision. The US
Government argues that the
creation of a specific porn
domain would allow for
more porn on the Net.

Published by
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To analyse it a little,
would a .xxx domain
actually help reduce porn
from proliferating? It
probably wouldn’t make a
difference. Porn site
operators will not relinquish
their .com and .net domains
in exchange for a .xxx
domain; for them, having
only a .xxx domain would
mean easy censorship. They

would probably keep their
old domain names and also
register the new domains—
meaning more money!

As regards the argument
that .xxx would help
authorities filter lewd
material and help parents
protect their children, it
might be unfounded.
Pornographic Web sites are
everywhere, operated by

people in different
countries. What worldwide
law would force adult site
operators to relegate
themselves to a specialised
domain? It seems a near-
impossible task.

BEYOND SEARCH

Google
Unveils New
Tools

Google on 17 May
unveiled new products

that could turn search into
more of a group activity.
One of these is Google Co-
Op Beta (google.com/coop),
where users can save links
or label Web pages and
make their choices
available to others. As an
example of how Co-Op
might be used, a researcher
could tag certain Web pages
related to, say,
nanotechnology. Anyone
who subscribes to that list
would be shown the
researcher’s selections at
the top of their search
under, say, “developments,”
whenever they enter a
search term such as
“nanotubes.”

Google has already
arranged with partners to
create pre-selected content,
such as health and city
guides, and restaurant and
movie information. “Going
forward, the broader online
community will begin
building out new topic
areas,” Google said in a
statement.

Then there’s Google
Notebook (www.google.com/
notebook)—a program that
lets users keep text, links, or
images from search results

on a scratch pad. The
Notebook can be accessed
from any computer, and,
if the user wants, it can
be shared.

Google Trends
(www.google.com/trends)
lets users see how popular a
specific search term is for a
given period of time, as a
trend line measures billions
of searches.

Google also showed off
Google Desktop 4 Beta
(desktop.google.com), an
upgrade to Google Desktop
Search, which permits
Google Gadgets—little
programs—to be more
easily downloaded and
installed. The Gadgets can
show weather reports
without users having to
open a browser, and can
provide games, music, and
news. Desktop 4 Beta also
can track your searches if
you want it to, and then
create a personalised home
page related to those
searches.

Google has said it has
“hundreds” of Gadgets ready
for download. Developers
will be able to create and
share Gadgets of their own.

Some observers see
Google’s new releases as
part of the trend towards
social networking and user-
created material on the
Web. “Google is making it
easier to create user-
generated content,” said
Jennifer Simpson, a
research associate at the
Yankee Group. “Yahoo,
Microsoft, and AOL are also
all beginning to release
user-generated applications
or services that have a social
context, in search and
elsewhere. For search, it’s
part of a big thrust to
increase the value of results
to consumers.”

The much-anticipated Nintendo Wii gaming
console will soon be hitting the market. Word is

that it will be priced “under $200.” What’s special
about it? Well, if you’re playing tennis, you use the
controller as a racquet! The main controller acts
like a gamepad when turned on its side. The
distance between the controller and console can
be ten metres. Four controllers can be used

simultaneously, meaning four players can be part
of a game! Two sensors help the console pinpoint
the position, orientation and acceleration, in 3D, of
the Wii remote. The controller has a speaker and a
rumble motor! An expansion slot on the remote
allows you to plug in add-ons such as the much-
vaunted Nunchuk controller—a classic controller
for games that require gamepad functionality.

Nintendo Wii

GENDER 

BENDERS

We took an image of our Desktop, complete with icons and all—and placed it as
the background, and then hid the actual icons. Clicking on the “icons” therefore
did not open any files or folders! Prakhar turned to us, a little confused. Upon a
hint, he changed the desktop background, and realisation dawned: the icons had
been hidden! Prakhar searched for how to get them back in Display Properties >
Desktop > Customize Desktop. Not finding it there, he again right-clicked on the
Desktop and checked the menu. He located “Arrange icons by” right at the top,
and clicked “Show desktop icons”—there they were, all the icons, safe and sound!

Ashwini vs. Prakhar

What’s Up With The Icons?

Ashwini quickly realised we’d set up a trick task, and was a little unclear
about what she was supposed to do. When clicking on the icons did not
change anything on the screen, she immediately changed the desktop
background. She came to a stall at this point: even when she did right-click
on the screen and a menu popped up, she couldn’t immediately discern the
correct thing to do to bring the icons back. After some thought, she chose
the “Arrange icons by” path and finished the task by clicking “Show desktop
icons.” Well done, Ashwini—for time and for not needing a hint!

00:02:14:71

00:01:22:75
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FLASH IN HARD DRIVES

Faster
Bootups,
Longer
Battery Life

Microsoft and Samsung
first demonstrated a

hard drive with Flash
memory about a year ago.
This month, they will
showcase the technology
again in a form they claim
will be ready to come to
market. The system will be
demonstrated at the
WinHEC (Windows
Hardware Engineering
Conference), which started
24 May. However, the OS
code that supports the Flash
package will only ship with
Windows Vista.

The unit that
Samsung showed off
last year had 128 MB
of Flash, which was
used to cache
startup data and
other frequently-
accessed
information, both to
make the loading of
the data into RAM
faster and to boost
laptop battery life.

When Vista arrives,
Intel will be promoting
its own, related
technique, which
incorporates the Flash
on an add-in card
rather than putting it
in the hard drive. This
approach allows the
Flash to be replaced
easily and will keep hard
drive prices down, but will
raise the system price. In
fact, Intel, Hynix, Micron,
Sony and other companies
have founded the Open
NAND Flash Interface (ONFI)
working group, which will
develop a specification that
might make it easier to
incorporate Flash memory
in laptops.

Intel had actually
announced the formation of
ONFI at its Developer Forum
in March. It showed off an
add-in card codenamed
“Robson” designed to be

fitted into a notebook to
accelerate the boot process
and the loading of
applications. ONFI will
define a standardised
interface by which the Flash
chips mounted on the card
communicate with the
card’s controller chip. The
initial specification is
expected to be completed in
the second half of this year.

IBM’S BLUEGENE

Nanotech
Gets A Boost

IBM is to back a research
centre being developed at

Rensselaer Polytechnic
Institute (RPI). The $100
million Computational
Center for Nanotechnology
Innovations (CCNI), based

at Rensselaer Technology
Park in Troy, New York, will
further research into
shrinking electronic devices
including computer chips.
An IBM BlueGene
supercomputer, yet to be
built, will power the effort.
It will be able to perform 70
trillion calculations per
second (70 teraflops).

Herb Schultz, marketing
manager for BlueGene at
IBM, explained, “To do
simulations on how
molecules react, which is
the essence of

nanotechnology, researchers
need the computing power
that BlueGene delivers.”
Underlining the growing
importance of nanotech,
Schultz went on, “There are
so many applications for
this that will be emerging
in the next decade.” He also
hinted that using BlueGene
to work on computational
problems such as ways to
extend Moore’s Law could
open new opportunities for
a range of industries.

Among the technologies
that might benefit from the
centre are super-fast
nanocapacitors and
nanoscale memory cells.
These would have
applications in Flash-
like memory.

Chip manufacturers have
sustained Moore’s Law for a
long time now: current

circuit components
are about 65
nm wide.
Experts say
this needs to
shrink to 45
nm by 2009

and 22 nm by
2015. “Current

semi-conductor
technology is
rapidly
approaching its
practical limits,”
says John E Kelly III,
IBM’s senior vice
president of
technology and

intellectual
property. “New,
nanotechnology-
based

technologies will
be needed to

sustain the growth
that the IT industry

provides to the world
economy.”

Indeed, it is today
generally believed that to
keep Moore’s Law going—
and possibly even redefine
it—the field of
nanotechnology will have to
deliver. Recall Move Over
Silicon, Digit, May 2006:
transistors may soon use
carbon nanotubes instead of
silicon. The dedication of a
research centre with a 70-
teraflop supercomputer
specially for such research
seems a defining moment. 

MAID

What is MAID?
MAID stands for Massive
Array of Idle Disks. This is a
technology that promises to
provide massive scaleable
storage at a very low cost.

Where will it be used?
MAID will be used where
there is a need to archive or
back up data amounting to
terabytes. It will also be used
in places where large amount
of archived data needs to be
accessed quickly.

Who is selling MAID
solutions?
Though the concept has been
around some time now, only
one company—Copan
Systems—offers the solution. 

What was the alternative to
this technology? 
The older alternative to MAID
is archiving using a tape
drive. There are many
drawbacks to tape, the main
one being slow access speeds.
Also, when a large amount of
data in image form has to be
stored on a tape drive that
has less storage capacity than
the image, the image has to
be split—which is
cumbersome and also takes a
lot of time. Sometimes it
takes days to access the
archived data stored in tapes,
discouraging active usage.

How scalable is MAID?
MAID is an array of hard
drives combined to work as a
single point of storage.
Scalability is therefore not an
issue. The smallest of Copan’s
systems is 28 terabytes, and
the largest is 200 terabytes.
The space used for the
largest-capacity array Copan
produces is just one square
metre, making for space-
saving.

Why MAID?
MAID consumes less power
and produces less heat, since
when the data is not accessed
on the hard disks, the disks
go into idle mode—making it
energy-efficient. MAID allows
one to store data in both
structured (SQL, MS Access)
and unstructured data
formats (Word, PowerPoint).
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being able to use their computers
for business as well as pleasure,
and wherever there were comput-
ers—mostly labs—Spacewar was
being played.

You might or might not believe
how simple Spacewar! was. It was a
two-player game, and each player
controlled a spaceship, meaning a
little white blotch on the screen.
There was a star that pulled you
towards it—and you had to avoid
the star. The players shot at each
other: the bullets were little dots.
Take a look for yourself—you can
play a Java version of the original
game at http://lcs.www.media.mit.
edu/ groups/el/projects/spacewar/

Actually, the first video game
wasn’t Spacewar! either. Spacewar!
was the first game “intended for
computer use,” according to some
sources. The first “graphical
computer game” is “widely
believed” to have been Tic-Tac-Toe
(or “Noughts and Crosses,” depend-
ing on your source) by A S  Douglas
in 1952. According to pong-
story.com, “the game was played
against the machine. Once the
game started, the player specified
where he wanted to place his
nought or cross using a mechanical
telephone dialler.” (!) Not much of a
game—and we think we can safely
say Spacewar! was “the first
computer game.”

It might come as a surprise
that robotics predates computers
(the way we think of them, at
least). In 1961 was marketed the

Ram Mohan Rao

“History is bunk,” flatly
and famously stated
Henry Ford in 1916. We

don’t quite agree. Sure, we can let
bygones be bygones, but if what
was done a fifty or a hundred years
ago endures, if it has changed the
way we live, if it has enriched our
lives—we’re interested. What was
computing like when there were
no mice and—the horror of it!—no
colour displays? A passion for tech-
nology is not limited to checking
out the latest graphics cards. We
want to know how it all happened:
how we got married to the
phenomenon called technology.

This is not a history lesson. It’s
a celebration of five decades of
tech, and not to forget, a tribute to
the men who made it all happen.

So, while the hippies were
lying on the grass and getting
stoned, not everyone was
convinced that that was where the
good life was. Researchers in
corporate and university labs were,
for the ultimate good of mankind,
engaged in serious work (yes, there
was a lot of that in the ’60s, too).
And they weren’t working on their
laptops from the comfort of their
homes: they got down to the dirty,
as in actual hands-on work with
primitive components. A few
dreamers here and there wrote
seminal papers. And companies—
some small, some large—intro-

duced devices, some that fizzled
out, some that endured.

The audio cassette, invented in
this decade, endured. It started off
the whole portable music thing. Of
course, it was the Walkman,
brought out much later, that actu-
ally put cassettes to good use.

Laser mice and multi-button
mice are all fine, but how about a
word of thanks to Doug Engelbart,
who invented the device in the
’60s? It was a “primitive” device—
carved from (ugh) wood—but it did
the job. (Actually, wooden mice
seem to us a cool retro idea—we
found a couple on eBay!) While on
the subject of inventions, Xerox
came out with the Telecopier—the
first successful fax machine. And
if you can think of a programming
language as an invention, BASIC -
as in VB, only a lot less capable—
was invented this decade. Ah, the
simple joys of life! LET x=10; LET
y=20; LET a = x + y; PRINT a! That
was probably the first program
many of us at Digit ever wrote… 

…because BASIC really was
pretty basic, and became popular
with folks learning to program.
We were surprised when our in-
house programmer told us it’s
been around since the ’60s!

If you can imagine a world
with no computer games, you
don’t need to think beyond the
’60s—that was when the first video
game came out: Spacewar!. It
generated no little excitement—
people liked the idea of actually

It’s clichéd to say we live in a technologically advanced world, but just five decades
ago, a mouse was only something a cat chased. It’s all zoomed by us—almost too fast

Imaging Shrikrishna Patkar

When Mice Were Wooden
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first industrial robot. And in 1969
was invented the Stanford Arm,
the first electrically-powered,
computer-controlled robot arm.
Talking about robotics, where was
AI? Well, it was there, and the
research being done back then
doesn’t seem primitive compared
to what’s being done today. OK, a
lot has been done since then, but
think about how much we’ve done
and how far we need to go. They
were developing chat-bots and
neural networks back then, and
we’re developing chat-bots and
neural networks now as well.

Still, the point is that a lot of
work done back then was seminal.
AI was in vogue. Frank Rosenblatt
built, in 1960, the Perceptron—a
sort of computer that could actu-
ally learn by trial and error. It
employed a neural network.
(Neural networks themselves were
already in existence.) And then in
1966 happened Eliza, probably the
most famous chat-bot of all time.
Joseph Weizenbaum developed
Eliza at MIT: “she” was a psychia-
trist, and would chat with people
primarily in consulting mode.
“Tell me more about your mother.”
“Does that make you feel
depressed?” You can find a Web
version of the original Eliza at
www-ai.ijs.si/eliza/eliza .html.

Why was Eliza important?
Mostly because it proved that
something like a chat-bot could be
built; people were fascinated by
the fact that a computer seemed to
be exhibiting intelligence.

More in AI: a team at Stanford
led by Ed Feigenbaum created
DENDRAL, the first expert system.
In an expert system, one feeds in
as much knowledge in a certain
domain as one can into the system,
and it analyses the situation and
provides answers comparable in
quality to what a human expert
would propose. What DENDRAL

did is not very interesting, but
expert systems had come into
being. They’re used today in many
domains, but medicine is one field
that has particularly benefited.

Come to think of it, a lot
happened in the ’60s. Did you
think the CD was invented by
Philips in the ’80s? Not really: the
man behind the CD (and there-
fore, optical storage) was a less-
known-today inventor called
James Russell. Actually, he
invented a complete optical digi-
tal recording system, not just the
storage medium. In an interview,
asked what prompted him to
explore the concept of optical
recording, Russell’s answer was
that he developed the technology
because he “wanted a better hi-fi
system”! Talk about necessity
being the mother of…

We won’t bore you with
details of what research papers
were written around this time.
But so much tech that we take for
granted started off as single
research papers! At Rand Corpo-
ration, Paul Baran developed, in
1960, the packet-switching princi-
ple. This was followed, in 1961, by
the first paper on packet-switch-
ing theory, by Leonard Kleinrock
at MIT: it was called “Information
Flow in Large Communication
Nets.” What talk of the Internet
without packet switching?

Coming to the Internet, the
first plans for ARPANET were laid
out by Larry Roberts, also of MIT,
in a 1966 paper called “Towards a
Co-operative Network of Time-
Shared Computers.” ARPANET, as
you might know, was what even-
tually “became the Internet.” We’ll
be talking more, as we should,
about ARPANET—it’s not as simple
as “it was the first Internet.” In
fact, some of the foundations of
the Internet were laid in the 60s:
way back in 1960, J C R Licklider

published a seminal paper called
“Man-Computer Symbiosis.” It
included these excerpts:

“It seems reasonable to envi-
sion, for a time 10 or 15 years
hence, a ‘thinking center’ that will
incorporate the functions of pres-
ent-day libraries together with
anticipated advances in informa-
tion storage and retrieval.

“The picture readily enlarges
itself into a network of such
centers, connected to one another
by wide-band communication
lines and to individual users by
leased-wire services…”

Sound sufficiently enough
like something we’re familiar
with today?

To avoid hate-mail for having
missed out on this point, we must
mention that Unix was developed
by Ken Thompson and Dennis
Ritchie in 1969 at Bell Labs, the
same year Linus Torvalds was born.
We don’t need to tell you how
important that development was.

Yes, much was done in the
1960s, but we think the seventies
were even more exciting—and
something we can relate to better!
Turn the page! 
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There are many, many firsts in the world of personal
computing; the DEC PDP-1 is just one of those firsts, but it
sounds suspiciously like our PCs. It’s been described as the
“first commercial computer with a monitor and keyboard
input,” as the “world’s first small, interactive computer,”
and so on. Essentially, this was the first thing that felt—if
not looked—something like what we all have on our desks
today. It was an 18-bit machine with a keyboard and a light
pen for input. It was small—about the size of a couple of
fridges. One of its biggest pluses was that it didn’t require
specialised air conditioning, and that it could run on
standard (US) 110-volt power. Some PDP-1s had CRT
graphics display systems, which happened to be the first
commercially-available computer graphics terminals.

A PDP-1 at MIT became the first computer on which a
game was played: Spacewar!, which became a DEC
standard diagnostic program for the rest of the decade.

DEC’s PDP-1

FIFTH ANNIVERSARY
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wasn’t the first hard disk, though:
the 5 MB IBM 350 RAMAC of 1956
was the first commercial hard disk.
And to clear the air a bit, the first
hard disk is widely considered to be
the IBM 350 Disk File of 1955.

AI wasn’t as much in vogue as
in the ’60s. In fact, some felt
they’d been wasting their time on
the whole thing. Still, some things
were happening: a robot called
Shakey was the first to use AI for
navigation. PROLOG—an impor-
tant language for AI program-
ming, more in vogue in Europe
than in the US—was developed. In
1974, the first computer chess
tournament was held in Stock-
holm. And in 1979, backgammon
player Luigi Villa—then the world
champion—officially became the
first champion of a board game to
be beaten by a computer.

Back to networks: Ray Tomlin-
son, the man who decided upon
the “@” sign for e-mail addresses,
sent the first network e-mail in
1971. As Tomlinson puts it,
“‘Network’ should be included
because there were many earlier
instances of e-mail within a
single machine.” We can’t figure
why, though! A year later, the first
computer-to-computer chat took
place over ARPANET. It was
between two AI programs,
“Parry” and “Doctor.” Parry was
psychotic, and Doctor was, well,
a Doctor—we have no details on
whether Parry was restored to
good health.

We promised this wouldn’t
be a history lesson—and it
won’t be. So we won’t talk

about the development of
ARPANET and other experimental
networks such as ALOHAnet—we’ll
make do by saying that most of the
major foundations for the Internet
were laid down in this decade:
proposals, papers, protocols, and
what not. It all developed at a
mind-boggling pace—ARPANET was
commissioned by the Department
of Defense in 1969 to further
research into networks, and in
1984, the Domain Name System
was already in place! That’s about
15 years from “ancient” to
“modern”—and in another 15
years, the Internet was pretty
much what it is now.

Networks, disks, processors,
printers, programming, phones—
you name it—it all happened in this
decade! Naturally, with the compo-
nents being developed, the
personal computer—essentially a
convergence of all these—had to
emerge. So what enabled the quick
transition from computers such as
the PDP-1 to the PC as we know it?
Microprocessors and disks come to
mind first.

1971 saw the development of
Intel’s 4-bit 4004, which was
quaintly dubbed “a computer on a
chip” at the time. Different sources
state different things about what
was the first this and the first that,
and you’ll all too often come across
the phrase “widely considered”!

And so, well, The Intel 4004 is
widely considered the world’s first
“commercial single-chip micro-
processor.” It was designed to be
just a component of a calculator,
but people figured it could be
used for many other things. For
example, it could replace certain
logic chips. As more and more
uses were found for the 4004,
people realised that the micro-
processor had tremendous poten-
tial. A trend began—that of
developing more and more
sophisticated microprocessors;
there we see the beginnings of
today’s zillion-dollar micro-
processor industry. However, it
wasn’t the 4004 that started the
microcomputer revolution: the
distinction is “widely considered”
to belong to the 8080.

Also at the beginning of the
decade, IBM introduced a floppy
disk drive called the 23FD. It used
a read-only 8-inch plastic disk,
which held 0.816 MB. It was the
first flexible disk drive—no, not
“widely considered”: it really was!
The 5¼” flexible disk drive and
diskette were introduced later, in
1976. You can imagine the impact
of portable disks at a time when
there were no LANs, and in 1973
came the Winchester hard disk,
also by IBM.

Most hard disks today are
basically Winchester disks: the
Winchester was the first disk to
use a “sealed head/disk assembly,”
which is what we use today. This

So much happened in the ’70s that if we had to choose a “winner decade” from
amongst the five we’re talking about, this would have to be it

The Plot Thickens
FIVE                              DECADES OF TECHNOLOGY ■ FIVE DECADES OF TECHNOLOGY ■ FIVE DECADES OF TECHNOLOGY ■

FIFTH ANNIVERSARY

Imaging Shrikrishna Patkar



Then, of course, there’s Ether-
net. In 1973, Robert Metcalfe’s PhD
thesis at Harvard outlined the idea.
The same year, after he joined
Xerox’s PARC as a researcher, he
was required to build a networking
system for the Center’s computers.
The company wanted the network
because they were building the
first laser printer, and wanted to be
able to share the printer amongst
all PARC computers. Necessity is
the mother of… Metcalfe, there-
fore, had two things to achieve: a
fast enough network to drive the
fast printer, and a connectivity
system that could scale up to
hundreds of computers.

It is “generally considered” that
Ethernet was invented in May of
1973, but Metcalfe claims Ethernet
was invented gradually over several
years. We don’t need to tell you
how much this landmark inven-
tion meant: in three words, it revo-
lutionised networking.

Coming to processors, Intel’s
8008, in 1972, was the first 8-bit
microprocessor. It was soon
replaced by the 8080, in 1974,
which was the beginning of a revo-
lution. Michael Kanellos of CNET
News.com sums it up: “The break-
through moment for micropro-
cessing came in 1974, according to
many, with the 8080 processor. Not
only did the chip feature a more
complex instruction set, it came in
a package with 40 pins, two inno-
vations that greatly expanded its
capabilities.” The transition to 16-
bit happened in 1978: Intel’s 8086
saw the light that year.

From processors to personal
computers: the story is long and
complex, and is chock-full of
“generally believed”—you’d do well
to visit www.blinkenlights.com/
pc.shtml for a lowdown on which
“The First Personal Computer” was.
But here, we should mention the
French Micral, arguably the first

commercial, non-kit, personal
computer based on a microproces-
sor, the Intel 8008. Now that’s a lot
of qualifications, but you’ll notice
that it is a first of sorts. Then in
1975 came the Altair 8800, as a kit.
Some call it the first personal
computer; some call it the first
microcomputer. Some say it’s
neither. Whatever the case, it was a
first of some sort! Specs: 2 MHz
Intel 8080, 256 bytes RAM.

Enter Apple. The two Steves—
Jobs and Wozniak—designed and
built the Apple I in 1976. It wasn’t
easy. Jobs first had to persuade a
computer store to buy his creation,
and the store ended up ordering 50
units at $500 each. He then went
about obtaining the components.
This must not have been fun: he
had to sell some of his stuff to buy
them. And after the parts were
procured, Wozniak and a friend
called Ronald Wayne assembled
the Apple I. It was the first personal
computer with a keyboard and
which ran on a microprocessor,
while also having a connection to a
monitor. Too many qualifications,
and a better reason for mentioning
it is probably that the Apple I was
the first personal computer sold in
fully-assembled form.

Succeeding the Apple I was—no
prizes—the Apple II: it was a hit,
partly because it was capable of
being hooked up to a colour TV set.
Colour and high-res graphics were
a first, as were its sound capabili-
ties. Some say (and some don’t) that
the Apple II was “the beginning of
the personal computer revolution.”
Which, actually, many things
were—take your pick!

Other highlights of the decade
included the development of the
inkjet as well as the laser printer.
By HP, right? In fact, that’s what
even President G H W Bush
believed: in a certain speech, he
congratulated HP engineers for

having invented the laser printer.
HP actually came up with the
LaserJet in 1984. It’s Xerox that
invented the laser printer. (Perhaps
we should qualify that with a
“generally considered.”) 

People discovered home enter-
tainment—and theatres lost their
monopoly on movie lovers—when
the VCR was invented in 1970. In
1972, Seymour Cray founded Cray
Research and introduced the first
successful commercial supercom-
puter, and megalomaniacally
named it the Cray I. And in 1977,
Bell Labs built a prototype cell
phone system in Chicago, and
tested the system the next year. The
year after that, the first commer-
cial cell phone system was started
in Tokyo. Last but not least—can we
leave out mention of Microsoft,
founded in 1977 by Bill Gates and
Paul Allen?

As we move on to the 80s, we
note that much of what we’re
familiar with today had been devel-
oped by 1979, at least in rudimen-
tary form. There was colour
graphics, there was 16-bit proces-
sors, there was the hard disk. The
stage was set for everyman’s PC. 
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Formally, ARPANET was the first wide-area packet-
switching network. Much of its development happened in
the 70s, and we think no-one will dispute the notion that
nothing more significant than this happened in the
decade—processors and PCs notwithstanding: no other
single development contributed as much to the computing
experience as we know it today.

ARPANET was to serve as a test-bed for networking
technologies. The plan required the network to be
composed of computers known as Interface Message
Processors (IMPs). The IMPs at each node performed
packet-switching functions, and used modems connected
to leased lines (the initial speed was 50 kbps). ARPANET
initially ran on the NCP-Network Control Program, or
Network Control Protocol. In 1983, TCP/IP replaced NCP.

To read up on the history of ARPANET, a particularly
good site is www2.dei.isep.ipp.pt/docs/arpa.html.

ARPANET
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QDOS and PC-DOS, MS licensed
QDOS to IBM, which became PC-
DOS 1.0 on the PC.)

Too much happened in the first
half of the decade, really. The PC,
the Mac, the Osborne 1, and the
Walkman. “The Osborne 1” proba-
bly didn’t ring a bell there: it was
the first laptop. Actually, it wasn’t
a laptop: it was about the size of a
briefcase. But it was portable. So
well, the Osborne 1 by Adam
Osborne weighed about 11 kg,
shipped with a lot of software, and
cost $1,795 (which means several
lakhs in today’s terms). But then
there was the software, and some
of the specs were attractive: 64 KB
RAM, two floppy drives (5 ¼ inch)
and also a modem. It, however, had
only a 5-inch display. Mind you, it
didn’t start off the portable
computing revolution—Compaq
and others came out with more
workable models.

Going a level above “personal
computing,” think of “personal
technology”: it was that that the
Walkman brought to the streets—
literally. It was (obviously) still
considered funny if you walked
down a street with wires dangling
from your ears: the Walkman over-
came that little hurdle to popular-
ity, and went on to become
probably the most-celebrated
single gadget of all time, in the
strictest sense of the word.

The Apple Macintosh in 1984
was, formally, the first commer-
cially-successful GUI-and-mouse

There’s a pattern to the devel-
opment of technology: in the
early days are written all the

seminal papers, and are made all
the breakthrough inventions and
innovations; later on come things
that build upon these old founda-
tions. Compared to decades such as
the ’40s, when the transistor was
invented, little was actually
invented in the ’80s. But a lot was
built upon, and computing
reached critical mass—it was no
longer something for the geeks.

The ’80s were the decade of
personal computing more than
anything else—not just in terms of
technology, but in general terms.
This is reflected in Time Maga-
zine’s choosing of the PC as the
“Man” of the Year in 1982. We wish
we had a copy. (We’re sure there’s
one for sale on eBay.)

1984 may have been when the
Mac came out, but August 1981 saw
the launch of the IBM PC. And
that’s the date the non-Macaholics
amongst us celebrate: the dark ages
of computing were over. We’d
reached what has merely evolved
and tided us through thus far.

Apple innovated and Microsoft
followed, but IBM chose DOS for its
PCs. That’s what’s important to
folks like us who write stuff like
this on a Wintel. The original
arrangement, in 1981, between IBM
and Microsoft as regards the
machine and the OS, stated that
MS would provide the base OS, and
that both IBM and Microsoft would

then work on developing different
parts of it in order to build a more
powerful system. The companies
were to then share the code they
had arrived at.

Just to be accurate, PC-DOS was
what was chosen as the IBM OS; it
wasn’t very different from MS-DOS,
which was reserved by Microsoft
for non-IBM PCs. We should
mention here that MS-DOS was
reverse-engineered from the CP/M-
86 OS, which was written by Digital
Research!

Why DOS? There are rumours
and theories aplenty, but here’s
what we found as plausible expla-
nations on reference.com:

“CP/M was by far the most
popular OS in use at the time…
there are at least two rumours
about why IBM ended up licensing
QDOS instead… One story is that
Gary Kildall, creator of CP/M,
simply refused to answer the door
when representatives from IBM
rang his doorbell. However, the
most prevalent story… is that when
IBM approached Kildall for a
license, Kildall kept the IBM execu-
tives waiting for hours while he
went flying in his airplane... IBM
then turned to Microsoft to provide
an operating system.”

The article, unfortunately, goes
on to state—you guessed it—that
neither story is “generally
accepted” as true. We figure, there-
fore, that the story is much
longer—do write in if you know!

(To clear the confusion between

The PC—as in “personal computer”—is what technology is first associated with. The
’80s was when “PC” began to mean “IBM PC”

Think PC
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based personal computer. Running
on an MC68000 CPU by Motorola at
8 MHz, it had 128 KB of RAM—
decent for those days, but not too
much. The OS was, of course, Mac
OS 1.0. While the Mac popularised
the GUI, it didn’t do too much for
games: the non-console gaming
honours for the decade go to the
little monitor-less, floppy-less
microcomputers of the time—
notably the Commodore 64, BBC
Micro, and ZX Spectrum. In retro-
spect, it’s absolutely amazing how
much game developers packed into
48 K and 64 K those days! In fact,
these computers, while running
BASIC compilers and all, were
primarily used as gaming devices,
being hooked up to a TV set. Games
were loaded via tape—it took about
five minutes for one game to load—
and some folks bought drives such
as the ZX Microdrive, which loaded
games via cartridges much faster.
(But those of us who were there
remember that tape was the best
way to go because they could be
easily replicated!)

The beginning of the decade
also witnessed the optical storage
revolution: the Philips-Sony-CD
story. In 1979, Sony and Philips set
up a joint engineering task force
with the mandate of designing a
standardised digital audio disc out
of the ashes of earlier efforts at
promoting the optical disc. (If you
remember, the first CD had already
been invented in the ’60s by James
Russell.) This task force soon came
up with the “Red Book”—the CD
standard. The disc based on that
standard soon reached the
market—in 1982 in Asia.

There’s an apocryphal story
about the maximum length of the
audio CD being set at 74 minutes
so it could hold a recording of
Beethoven’s Ninth Symphony.
Some sources say the reason was
because it was Sony president

Norio Ohga’s favourite piece of
music. Honestly, we can’t vouch for
the veracity of this story—or of any
others. Anyway, Billy Joel’s 52nd
Street was the first CD released
commercially, not a recording of
the Ninth Symphony.

By 1984, CDs were household
things (at least in developed coun-
tries). In 1985, evolved out of the
music CD, the CD-ROM drive
stepped out to the market.

The first IBM PC clone came out
in 1982. It was by a company with
the sedate name of Columbia Data
Products; Compaq soon came out
with their own version. The x86
revolution essentially happened in
the ’80s: 1984 saw IBM releasing
the PC Jr. and the PC-AT. The former
flopped, the latter didn’t: it was
based around Intel’s 80286 proces-
sor, and became popular. Later on,
Compaq released the obviously-
named Deskpro 386, the first PC to
use the 80386 processor from Intel.

The 386 was 32-bit, and
computers based on the 386 were
as powerful as some mainframes of
yore. The 486 debuted in 1989, but
it wasn’t as much of a landmark—
with the 386, “modern” desktop
computing was already in place.

Windows, too, actually has its
origins in the ’80s (and not in the
’90s), with Windows 1.0 having
been developed in 1985. Was it just
a front-end for DOS? Many believe
so, but there are differences:
Windows EXEs had a file format
called “new executable,” which
only Windows could process. There
was also Windows’ own memory
management system, which imple-
mented a virtual memory scheme.
Still, Windows 1.0 didn’t become
hugely popular. Version 2.0 enjoyed
more success, and from then on,
it’s a history lesson.

Meanwhile, the decade saw the
introduction of commercial e-mail.
But the most important develop-

ment here was inarguably TCP/IP:
in 1982, DCA (the Defense Commu-
nications Agency) and ARPA estab-
lished TCP/IP as the protocol suite
for ARPANET. The definition of the
word “internet” was set: “an inter-
net” was now defined as a
connected set of networks running
on TCP/IP, and “The Internet” was
defined as the set of connected TCP/IP
internets. And so, the Internet had
arrived: the first name server was
developed at the University of
Wisconsin, and the DNS system
was introduced by 1984. And in
1986, the first domain name was
registered. Symbolics.com. Inter-
estingly, Symbolics.com is today a
plain HTML page!

With personal technology—
including personal computing—
and TCP/IP in place, the ’90s had it
easy. The x86 architecture simply
had to improve upon itself in
accordance with Moore’s Law of
1965, Windows would have to
become Windows 95, and the
Internet would have to grow a
million-fold—but that was just a
matter of hooking up computers
to the phone system. On to a world
we’re familiar with… 
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The star of the ’80s was obviously the personal computer,
but Apple or PC? Motorola or x86? It’s a tough choice and a
touchy subject. Many reasons are cited for why the Mac is
not our PC today: it was underpowered for the GUI it
sported, and DOS was faster. Macs were more expensive
than PCs. And perhaps most important is the fact that
Apple didn’t allow a Mac clone industry (except for a brief
time, and to disastrous effect, to be historically accurate)—
the world might well have been different if IBM patented
the PC architecture and kept it proprietary.

Yes, the IBM PC is the best thing the 1980s gave us.
x86 is a phenomenon in itself: IBM’s decision to use the
architecture was criticised, and the Motorola 68000 was
considered a much better alternative. But due to certain
accidents of history, x86 it was.

And then there was the rise of Windows. Apple had
already become niche by the early ’90s.

IBM PC, x86, Windows
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Celeron was out in 1998, and the
Pentium III in ’99. Our PCs might
have been boring, with no trace of
fruity colours, but the numbers I,
II and III were important: they set
the benchmarks for desktop
processing power.

As for RAM, hard disks and
such, well, so much happened
then, we can’t talk about it in this
space! We’ll just say that around
1995 onwards, components just
kept getting faster and larger: the
MHz/GHz/GB/whatever race had
already begun. And since you’re a
Digit reader, you’re well familiar
with that. But for those who were
too young to remember, we should
mention that in 1995, a 1 GB hard
disk was the envy of every kid on
the block, and the corresponding
figure for RAM was a whopping 32
MB! By 1999, these had become 30
or 40 GB and 256 MB respectively.

But what was a computer with-
out the Internet to connect it to?
All of a sudden—from a bird’s-eye
view of history, that is—this
connection was as important as the
computer. From the de-commis-
sioning of ARPANET in 1990 to the
WWW to broadband connections,
all it took was one decade. The
figures, while boring now, say it all.
Here is the approximate number of
hosts on the Internet by year:

1989: 1 lakh; 1990: 3 lakh; 1992:
10 lakh; 1996: 1 crore; 1998: 4 crore

Boring enough, but they’re
indicative of the growth of
mankind’s greatest creation! An

The WWW. Dial-up. Broad-
band. Netscape. The browser
wars. Windows. Linux. The

Pentium. The DVD. Napster.
Google. PDAs. Cell phones. That
about sums up the 1990s, except it
doesn’t describe how our PCs tran-
sitioned from a luxury item to a
staple, and it sidelines AMD.

As we said earlier, Apple’s prod-
ucts were niche offerings by 1990.
During this decade, the company
defined that niche better, coming
up with innovative, colourful prod-
ucts—literally and figuratively. 1991
saw the Macintosh PowerBook
series, Apple’s first truly portable
computers. They came with a 16-bit
Motorola CPU, 2 MB of RAM, a hard
disk ranging from 20 to 40 MB, and
a 640 x 400 black and white screen.
As an aside, 20 MB was quite the
size for hard disks back then: 30 or
40 MB was considered large.

The fruity-coloured iMacs were
launched only in 1998, with their
hockey-puck mice. Specs: 233 MHz
PowerPC 750, a 4 GB hard disk, and
32 MB of RAM. The monitor was
translucent, and these machines
ran deadly quiet. Some say that
even this addition of colour was
imitated by the Wintel alliance,
with cabinets now coming in
black, silver, and grey! In 1999
came the equally colourful iBooks,
as well as the PowerMac G4.

Yes, the ’90s were good times
for Mac lovers (already there was a
cult of Mac lovers, or fans, or
addicts, or advocates). “Think

different”, they were told—and
that’s what they did. While Apple
was being innovative in the
features as well as the design
departments, the company unfor-
tunately, didn’t revolutionise
anything. The world was already
sold on Windows—not so much
sold on Windows 3.1 in 1992, but
very, very much sold on Windows
95 in 1995. Reports at the time said
people waited in long queues
outside US stores August 24th,
waiting to get the Windows 95
retail pack.

We can’t sideline the impor-
tance of Windows 95: it wasn’t
merely an improvement over 3.x, it
was the first “real” Windows.
Crash-prone as hell, Apple fans
might snigger, but for those of us
who used it back then, it did the
job. If you bought a new computer
at the time, people would ask you
if you’d managed to load Windows
95 on it—and lose interest in you if
it turned out you were still using
3.x or even DOS. Windows 98,
again, wasn’t quite as revolution-
ary as the 95 version—it even had
the same splash screen! But we all
upgraded anyway, of course.

The operating systems were
getting more demanding, but the
hardware was keeping pace: March
22, 1993, the Intel Pentium micro-
processor with its 3.1 million tran-
sistors saw the light, and (cutting a
long story short) on May 7 1997
happened the Pentium II, with 7.5
million transistors. The low-cost

Those of us born around 1980 are fortunate: we witnessed the prime time of tech 
in the prime of our youth
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important difference between the
Net as it was in the ’90s and as it is
now is how US-dominated it was
earlier: the Internet pretty much
was America back then.

Commercial dial-up access to
the Internet began way back in
1990, with The World
(world.std.com) coming into the
nascent market. The same year, Sir
Tim Berners-Lee wrote the first
browser for the WWW. The browser
itself was called WorldWideWeb,
and the first version was finished
on Christmas day. URLs, HTML, and
HTTP were all his creations, and he
used these in his model of the
WWW—an information-sharing
model built on top of the Internet. 

It comes as a surprise to most
of us that the WWW was not
invented by an American, and not
in America: the WWW project was
at CERN (the European Laboratory
for Particle Physics; “CERN” is how
it comes out in French.)

By 1991, the WWW was put in
place by CERN. Two years later,
Mosaic—the first graphics-based
Web browser—was received rather
enthusiastically by the growing
population of Netizens, as you
might imagine. Netscape Commu-
nications Corp. was formed in
1994, by Marc Andreessen and Jim
Clark. Their first browser was out
the same year, as Netscape Naviga-
tor 1.0, and “Web browsing”
became a standard term.
Andreessen was on the cover of
Time Magazine in 1996, under an
article called “The Golden Geeks.”
Right on the cover of Time Maga-
zine, Andreessen sported a near-
comical, sneering grin. Netscape
ruled: the browser wars had begun,
and Netscape was much better
than IE at the time. We remember
installing Netscape on our
Windows 95 machines, even
though IE was there by default.

Well, Microsoft wasn’t stupid,

and kept improving IE; by 1998, the
war was over, Microsoft won, and
Netscape released the source code
for Navigator to the public domain.

What use is a browser without
a search engine? Back in 1997, we
remember, most folks’ default start
page was Yahoo!. It had a human-
edited directory—and then came
the major searchbots. The notables
at the time were HotBot and
AltaVista. Then in 1998, Google
happened. It was initially a
competitor to AltaVista and a
couple of other search engines. You
know the rest.

The killer app of the Web back
then was, obviously, Web-based e-
mail (“Access your e-mail anytime,
anyplace!”). Hotmail, the first Web
mail service, was launched July 4,
1996. It was a killer idea, and once
it was out, a million companies
followed. Yahoo!, Hotmail, and
Google were the WWW staples
towards the end of the ’90s.

1999 saw the emergence of
Napster, and the P2P revolution, for
lack of a less clichéd word. Napster
was a file-sharing service for music,
and people “shared” music like it
was the ’60s, what with free love
and all. Everyone was happy, except
the music companies. Come to
think of it, “revolution” is a good
fit there: Time Magazine’s October
2000 cover featured Shawn
Fanning, Napster’s sole creator, in
an article called “How Shawn
Fanning, 19, upended music... and
a lot more.”

And what’s P2P without broad-
band? It was in 1998 that broad-
band began to be aggressively
advertised: “Get 50 times the speed
of your dial-up modem.” By 1999, 1
Mbps and 2 Mbps DSL connections
were routine. (Yes, India is a devel-
oping country.) DSL had a competi-
tor in the form cable TV operators
who provided broadband connec-
tions at the same price.

We’ve sidelined so many things
talking about the Net experience,
and indeed, the rest wasn’t much
in the news. OK, some of it was: in
1996, IBM’s Deep Blue defeated
world chess champion Gary
Kasparov. Sony’s robotic dog, the
Aibo, came out in 1999. DVD
became popular in ’98, and did for
movies what the CD had done for
music: towards the end of the
decade, a computer was considered
incomplete without a DVD drive.

The Palm Pilot improved PDA
capabilities in 1996, and again
towards the end the decade, every-
one wanted “a Palm.”

Cell phones in India were for
the rich folk circa 1996, but soon
trickled down. On the other side of
the planet, there were 90 million
cell phone connections in 2000.

Yes, it all happened in the ’90s,
for sure. The Nintendo 64. The Sony
PlayStation. Java. Bluetooth. The
finalisation of the initial standard
for wireless LANs, IEEE 802.11. And
last but definitely not least, Linux!

There’s a lot we’ve glossed over
here, but anyway, by 2000, the
world was networked—and that’s
what matters. 
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What we absolutely must declare as the defining technology
event of the 1990s is the development and expansion of the
World Wide Web. We’re sure you’ll agree.

Some background about Berners-Lee: in 1980, he
was an independent contractor at CERN, and felt the need
to build a system to aid in sharing information amongst
the researchers there. Sir Tim thought about hypertext
for this purpose, and along with another researcher, built
a prototype system called Enquire. As you can guess, it
was something like a wiki. It wasn’t published, but it
served the purpose, and remained a private thing. Much
later, in 1989, Berners-Lee thought about using the same
ideas as in Enquire to create a global network. It was
conceptually simple, and as he put it, “I just had to take
the hypertext idea and connect it to the TCP and DNS
ideas and—ta-da!—the World Wide Web.” CERN liked the
idea. Later on, we all did.

The WWW
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about broadband: people are clam-
ouring for more. More speed, more
content, more services. They want
all their data to come in through
one pipe, too. That’s why IPTV and
VoIP are taking off: one line, many
services—WWW, TV, phone,
movies. And all high-definition,
high-fidelity.

(Pause for breath.) Think about
how much broadband has prolif-
erated: in fact, in the developed
world, everyone has it, so it almost
makes no sense to call it by a
special name. From 2 to 5 to 10
Mbps—to 50 and even 100 Mbps in
some countries. (Off the top of our
heads; there might even be 1 Gbps
in some places!)

Not only do we want more, we
want it along, wherever we go. Yes,
the mobile revolution: it all
happened so fast, the timeline is a
series of months rather than years.
Sometime between 1995 and 2000,
it happened in India: by 2003 or so,
everybody had a cell phone. In the
developed world, kids as young as
8 and 10 years old have cell phones.
(Younger kids are tending to get
RFID-tagged in countries such as
Japan.) And once you’ve got a
gadget, why not pack more into it?
Naturally, we don’t need to tell you
about when cell phones became
phones cum PDAs cum MP3 play-
ers and radio tuners and what not.

It doesn’t seem to make sense
to call it a “phone” anymore; it’s
just “the Gadget.” These Gadgets
have processing power, and they’re

It’s not hard to sum up this, the
current decade, in two words:
“Smaller, faster!” The ’00s is the

decade of miniaturisation and
speed. The century, of course,
belongs to nanotechnology.

Already by 2000, we’d lost our
innocence. No more the tinkering
around with toys and making
inventions of them. We’ve been
going aggressively ahead, looking
at the basic laws of physics and
asking, “Why not?”

“Miniaturisation” is not
restricted to gadgets: we’re also
getting to the nanoscale. A great
example is the DVD to blue-laser
transition: we packed more onto a
DVD than we could on a CD, so
find new materials! Invent better
microscopes! Dig out more of
nature’s secrets! Do whatever, and
figure out just how densely those bits
can be packed! It was in this spirit of
scientific aggressiveness that HD-
DVD and Blu-ray were born—as
with almost everything else that’s
happening in tech today: proces-
sors, RAM, and all the rest.

Early this decade was born the
Pentium 4. AMD came into its own
this decade, and became a true
competitor after long years of
lagging behind. The gigahertz
races had begun. (An aside: AMD
reached the 1 GHz finish line first
with its 1 GHz Athlon, just days
before Intel released the 1 GHz
Pentium III.) Then someone got the
not-so-original idea that if one
processor could do this much

work, why not employ two or
more—and thus came in dual-core
and multi-core: the future of desk-
top computing.

Meanwhile, the graphics
processor was becoming less
specialised in its capabilities and
more flexible in its nature. Thus
was born the idea of the Graphics
Processing Unit, or the GPU. The
first GPU was the NVIDIA GeForce
256, launched in August of 1999.

If the GPU primarily enhanced
the gaming experience, what was
needed was better sound—and
starting off from the simple
SoundBlaster sound cards of yore,
we’re moving on to immersive
sound experiences. The x.x speaker
thing is for the most part a
phenomenon of this decade: 4.1,
5.1, now 7.1 and even 9.1. (Maybe
there’s a 11.1 set—only we don’t
know!) Similarly with displays:
with so many visual bytes ready to
be delivered, we needed better
things to display them. So CRTs
became better, LCD technology
went mainstream, and OLED and
plasma displays came in. Sure,
LCDs are still weak when it comes
to games, but do you really believe
they won’t be on par by, say, 2012?

Games have thus far been driv-
ing much of the PC consumer
industry. We now have physics
processors for games. The PS3 uses
the Cell processor, dubbed a super-
computer in its own right.

While the Internet in the ’90s
was all about expansion, it’s now

The current decade is seeing technology driving us rather than the other way
round—and we’re happy slaves
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growing hard disks and all—so why
not store and/or watch movies and
TV on them? That’s where 3G and
4G and all come in; they enable
everything on the gadget, just like
the Internet connection will (and
in some places, does) enable every-
thing on the PC. The Gadget is
surpassing the laptop.

But human nature is never
content. (A silly truism, because
human nature means “never
content.”) So, well, who wants to
watch stuff on a teeny-weeny 3-
inch screen? Enter the holographic
display. The technology could soon
be mainstream: the Gadget might
well project movies into the air
over a large area. And as for the
input, who wants to type or write
onto a 3-inch pad? The answer is
the projection keyboard, which
“projects” keys onto any surface
you place the Gadget on. And hey,
if you can do all this on the
Gadget, can real 3D games on a 3D
surface be far behind?

Getting back to the Internet,
what we’ve been seeing is
expanded use. Blogging comes to
mind first: as the world increas-
ingly deals with information in
byte-sized chunks, people
increasingly turned towards bite-
sized write-ups called blog posts
instead of long, boring Web
pages to navigate through. Then
there’s MMORPGs: that’s real
virtual reality. People in coun-
tries where the bandwidth lies
live, sleep, work, play, and even
mate online. They can’t eat
online—yet; although at least one
MMORPG allows you to order
pizza through its interface.
When will that promised food-
pill arrive? No, we’re beyond
kidding now: nanotech might
well produce that staple of
science fiction.

While on the subject of the
Internet, we must talk about the

real problem of our age—the
clichéd “information overload.”
There are two problems here: stor-
ing it all, and retrieving it all. As
for the retrieval, trust all the
search companies out there—and,
going a level beyond, the data
mining companies. Yes, data
mining and text mining will
become more important. We want
only what we need: data mining
will provide precisely that,
patterns gleaned from heaps of
information. Text mining will
enable us to read summaries of
articles, the main points of a news
item, and so on. Like we said, we
like everything in bite-sized
chunks these days.

Coming to the storage, just
make the hard disks larger! Did we
say “hard disks”? No, no, it won’t
be hard disks. There’s already Flash
memory replacing it—initially for
faster bootups—and then there
will be holographic storage (due
out commercially this year, by the
way), and ultimately carbon
nanotube storage. A pinhead of
nanotubes will hold terabytes. 

Everything else is moving on,
but when it comes to the interfac-
ing with our Gadgets and our PCs,
we’re stuck with mouse, keyboard,
and stylus. Will AI please come to
the rescue? How soon will we able
to just tell our display device to
play a certain movie?

And when you talk about inter-
action, think of pervasive comput-
ing: already, researchers are
talking about it. Check out
www.pervasive.dk: “Pervasive
computing is the next generation
computing environments with
information and communication
technology everywhere, for every-
one, at all times. Information and
communication technology will
be an integrated part of our envi-
ronments: from toys, milk cartons
and desktops to cars, factories and

whole city areas—with integrated
processors, sensors, and actuators
connected via high-speed
networks, and combined with new
visualisation devices—ranging
from projections directly into the
eye to large panorama displays.”

“Projections directly into the
eye”? Now that’s an idea, come to
think of it!

The decade so far has been, and
the years to come will be, not so
much about new technologies such
as perpendicular recording for
hard disks. It’s more about people
generally having come to believe—
perhaps rightly so— that technol-
ogy can give us whatever we want.

On-the-fly. Instant. Anyplace.
Anytime. More. Even more. We
want. It’s moving fast. It’s getting
faster. It’s getting smaller. Into
our palms. Under our skin. Every-
where around us. Possibly inside
us. God is now well and truly the
Great Geek in the Sky—and what
we want, as of this decade and in
the decades to come, is for all our
material desires to be fulfillable
anytime, anyplace, right next to
us, on demand. 

ram_mohan@thinkdigit.com
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Will AI
please
come to the
rescue?
How soon
will we able
to just tell
our display
device to
play a
certain
movie?
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It’s the definitive development of this decade thus far: the
portable Gadget. It was a cell phone at first, and at some
point, when both cell phones and PDAs were being used, it
became obvious that they could be combined. Some called
the new gadget the smartphone. Then the big idea: if
everyone’s got this in their pockets, why not make it more
capable? They added a digital music player. They added FM
radio. They added faster processors and more memory.
They Web-enabled it. They added a camera, so you could
click snaps and instantly send them off to someone via e-
mail. (“Look! Here’s where I am!”) And the cameras are
piling on megapixels, the network is gaining in speed, the
processors are getting better, and all the rest of it.

The Gadget, as we’re calling it, represents convergence.
But it’s not just about convergence, or even about

convenience. It goes beyond: we want to break free of the
shackles of time and space, as it were.

The Gadget
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Our homes are becoming
more digitised—which will
be obvious after you’re
done counting the
number of gadgets in
your house. But that’s not
the end of it—you proba-

bly already wish you had
newer models of most of
them! That’s the lifestyle
we’re getting used to today,
and will continue to do so.
This willingness to spend
has raised the bar for
manufacturers, and with
technology surging ahead

and convergence blur-
ring the lines

between product
categories, it’s no

surprise that every
device you go out to buy

has a spec sheet over two
pages long!

Manufacturers are falling
over themselves in the race to
your home, offering gadgets in
almost every form. However, the
most significant category, which
is also the most hotly contested,
is the personal entertainment
segment. Let’s skip past the air
conditioners that can be
switched on remotely, and the
fridge that has an inbuilt 12-inch
TVs, and look at some products
that do nothing but entertain.

TVs
Traditionally, the idiot box has
been a staple of everyone’s fun
diet, and still is. Only, now the
boxes are a lot smarter, and

come in huge sizes, with as
many features as there are

competing brands.
The television was

given a huge boost in
popularity—not that it

needed one—with the coming of
cable TV in India over a decade
ago. Now, with more channels
than we care to remember, and a
more informed target audience,
TVs really need to keep up with
ever-changing technologies.
Since this is the era of high defi-
nition (HD) video, the TV
segment is leading the way, and
almost every manufacturer has
already released products that
are decently future-proofed in
terms of technology.

It’s the age of plasma and
LCD TVs, and almost every manu-
facturer is offering various
models of these. What’s really
cool right now are wireless TVs
that do away with the clutter of
cables—be it the cable that comes
in through the window, those
that emanate from your DVD
player, and so on. So when you’re
thinking about where to place
your TV, all you need to keep an
eye open for is a power outlet. Of
course, if you want to, you can
have a portable TV for yourself,
which doesn’t even need a power
outlet—for a few hours of viewing
at least!

Sharp AQUOS LC-15L1U-S
Sharp’s wireless AQUOS LC-
15L1U-S is an LCD television that
offers 15 inches of screen space
(4:3 aspect ratio) and is less than
3 inches deep. It has a recharge-
able battery, a 500:1 contrast
ratio and a great viewing angle
of 170 degrees. It can be carried
up to 50 feet from the base sta-
tion, and why would you want
any more than that? With just 2
x 2.1 watt speakers, it’s not
something you’ll enjoy watch-
ing a rock concert on, but hey,
catching up with the news while
you’re in the loo should be cool
enough to want one!
Approximately Rs 50,000 is what

…that’s what comes to us first when we look at
technology for leisure. Let’s take a look at some

products out there that will guarantee a smile for
you and the family

I Want To Be
Entertained…
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you’ll have to cough up to own
one of these.

Portable Media Players
Here, without a doubt, the iPod
rules, whether it’s video or
audio that you’re looking to
play! Apple sure has taken the
market by storm with its stan-
dard and Video iPod models,
but that doesn’t mean there
aren’t other options—especially
if you want additional features
and would like to try something
different!

It’s really hard to mention
just one product in this segment,
because each and every big
manufacturer is offering so
many models with features you
never knew existed. That said,
the personal favourite of this
writer is the Archos AV 700.
Here’s why:

7-inch, 16:9 wide screen—480
x 234 pixel resolution
40 or 100 GB hard drive capac-
ity
Video recording capability—
MPEG-4, up to 640 x 480 @ 
30 fps

Directly record from TV
Music recording
MP3 and WMA support
Photo viewer (JPG / BMP)
USB 2.0 port + USB host
port to connect directly
to a digital camera
A/V out, earphone out
Claimed 4 hour battery
life with video, 30
hours* with audio

Less than 600 grams
…and best of all

The ability to play games
using the Mophun gaming
engine (visit www.mophun
.com for a list of supported
games)

Other devices such as the
Creative Zen Vision and the Nokia
770 Internet Tablet are also good
options for people with different
needs. If you’re looking for some-
thing smaller, the Zen Vision’s 30
GB might be sufficient for you, and
at only 240 grams, it’s a lot lighter
than the Archos. The Nokia Inter-
net Tablet is for those who prima-
rily want to surf and view
multimedia content online, rather
than saved content.

Gaming Consoles
There’s a whole new market
now for gaming consoles. Apart
from first person shooter
games, everything else is as fun
and easy to play on consoles as
on the PC. When you consider
that the average console is
cheaper than the latest top-of-
the-line graphics card, forget
about the rest of a PC—it all
starts to make sense!

The Xbox 360 has been out for
some time now, and it’s by far
the best console yet. However, it’s
in for some stiff competition
from the Sony PS 3, which is
scheduled to be released (finally)
at the end of this year. Let’s take

a look at some of the cool
features the PS 3 promises:

A Cell processor, running at
3.2 GHz
256 MB XDR RAM
256 MB GDDR3 RAM
High definition output capable 
A gigabit Ethernet port, four
USB 2.0 ports
Bluetooth
BD-ROM (Blu-ray disc ROM)
drive
Memory card readers (Secure
Digital/CompactFlash/ Memo-
ryStick)
20 or 60 GB SATA hard drive
5.1 Dolby audio output

The PlayStation 3 will be the
most powerful gaming console
when it is released, and it’s no
wonder that fans are impatiently
awaiting its already-delayed
launch. We’ll have to do a head-
to-head shootout of the Xbox 360
and PS 3, when we get our hands
on both sometime in early 2007,
to be able to tell you if the PS 3
really is as good as it sounds.

If you just cannot wait, go out
and buy an Xbox 360 now—it’s a
magnificent console!

Buy, Buy, Buy
So whether it’s gaming, movies,
music, or television that is your
poison, entertainment is guar-
anteed! With all the cool prod-
ucts vying for our attention, it’s
no wonder that the current gen-
eration is spending so much
money. For those with nagging,
frugal relatives, you can always
use the popular excuse, “My
bank balance may be nil, but at
least I’m doing my bit to help
the economy by spending!” 

Just keep telling yourself that
and buy, buy, buy! After all, you
only live once! 

robert_smith@thinkdigit.com
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From it's none too humble
days as a 40 kg car add-on to
its current barely-there

form, the cellular phone has
become as much as a part of our
lives as a pair of shoes. Twelve
years ago, cellular networks were
set up in the four metros, and
you'd pay Rs 8 per minute for
your calls, and Rs 16 during peak
hours. You'd make these calls on
handsets that we now so affec-
tionately call the "pencil-box"
phones. Ah, good times.

Today, the cell phone has
become the ultimate conver-
gence device. Play games, listen
to music, take photos, record
movies, view documents, surf the
Net and make phone calls too! 

Into the Arcade
If you remember Snake, raise your
hands. It was (and still is to some)
one of the best things you could
do with your phone, and sent the
concept of mobile gaming on a
wild toboggan ride that's still
going. Newer phones came with
support for Java and colour
screens, enabling wilder, richer
games right there in your pocket. 

The Sony Ericsson W550i
While it came out as another
one in Sony Ericsson's line of
Walkman phones, no phone has
been as conducive to gaming -
not even the pioneer, the Nokia

N-Gage QD - as the SE
W550i. Turn it horizon-
tally and you have a
clear, crisp TFT screen in

landscape mode and a but-
ton arrangement almost

like a dedicated game con-
troller. Its fast processor lets
you play 3D games with ease,

and the bundled Worms Forts
game is extremely addictive,
especially with the ability to

throw stuff like refrigerators
and banana bombs at your
opponent.

Getting Down To Business
The days of the PDA are num-
bered. With smart phones get-
ting ever smarter, we now have
cell phones that are veritable
powerhouses for the business-
man on the go. They have all the
necessary features of the PDA -
powerful organisers, synchronis-
ing contacts and data with your
home PC, and all the abilities of
a phone on top of that! With a
GPRS or EDGE connection, you
can now connect your PDA-
Phone to the Internet; the world
is your office!

The Sony Ericsson P990i
Pick up your jaws; the Sony
Ericsson P990i takes mixing
business with pleasure to new
levels. Running on the Symbian
9.1 operating system and UIQ 3
platform, the phone comes
packed with a host of business
and entertainment applications.
It's capable of holding up to 4 GB
of data (or music, or video, if
you'd like), and also features
Word and Excel editors, and
viewers for PowerPoint presenta-
tions and PDF files. The flip-lid
sports a standard phone keypad
on one side; open it, and you
reveal a full-f ledgedQWERTY
keyboard on the underside. 

Another nifty feature is that
its 2 Megapixel camera also
moonlights as a business card
scanner, using character recog-
nition to convert the scanned
card into text! It's even Wi-Fi
enabled so you can connect to
the Internet the way you choose
- WLAN or GPRS. 

Freedom with VoIP
There has been much talk about
VoIP (Voice over IP) for a long
time. When the concept first hit

The stuff that keeps us going on and on and on

Keep
Talking
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our ears, we were still on our old
dial-up connections putting on
pots of coffee every time we wait-
ed for a Web site to load, so it sat
in the background for a while. 

The coming of software such
as Skype and Google Talk
brought VoIP back into our
dictionaries again, and with a
bang, too. VoIP has become an
important part of businesses and
homes, and soon, there came the
Skype handsets that could
connect you to anyone on the
Skype network without even
having to turn on your PC.

The iMate PDA2k
Practically a PDA with the inci-
dental ability to make phone
calls, the iMate PDA2k will be
one of the first cell phones which
will feature Skype - you will be
able to make phone calls via
Skype using its Wi-Fi connection.
Imagine the ability to make
international calls from your cell
phone absolutely free of cost!

The PDA2k runs on Windows
Mobile 2003 Pocket PC edition,
has 128 MB of RAM and a sizable
3.5 inch touchscreen. There’s
also a full QWERTY keyboard
for text input, just in case
handwriting recognition isn’t
your cup of tea. 

IM Fone
Want to convert your cellular
phone into a VoIP phone right
away? It's simple with this little
USB device called the IM Fone.
Currently compatible with
Skype and Imtel, all you need to
do is plug the device into your
USB port; it uses Bluetooth to
connect to your cell phone and
you can now move around with-
in 50 metres around your PC.
One of its neatest features is 
the fact that your cell phone
number will be displayed in 
the caller ID of the person 
you're calling. 

The Big Click
The introduction of cameras in
cellular phones has spawned off
a whole new community of ama-
teur photographers (and amateur
pornographers, as we all know so
well by now). Social issues aside,
the camera phone has become
incredibly popular, and manufac-
turers are always on a quest to
make a better phone. 

At CeBIT 2006, Samsung
unveiled its B600, a phone that
takes pictures at a massive 10
Megapixels. To put that into
perspective, even professional
photographers still swear by
their 8 Megapixel digital SLR
cameras! Of course, this still
won’t match up to a 10 Megapixel
digital camera due to the charac-
teristics of its lens, but it’ll no
doubt make your current
phone’s camera feel pretty silly. 

More Power!
One of the biggest annoyances
that we face with cell phones
today is battery life. Activities
like playing music, recording
video and general tinkering take
a lot of juice out of your hand-
set, which is why mobile phone
manufacturers are looking into
new ways to power up the
devices. The most promising
idea is the fuel cell. 

Fuel cells work much like
batteries—Hydrogen and Oxygen
combine in an electrochemical
reaction to create water and
energy. Hydrogen fuel cells are
favoured more by car manufac-
turers—our gadgets will see the
Direct Methanol Fuel Cell (DMFC).
It works by mixing methanol with
air and water to produce electri-
cal power. The biggest advantage
is that one can get an instant
recharge by just plugging in a fuel

cell recharger. It's been pitched
as the alternative to the stan-
dard battery for a long time
now; the only argument against
them now is that they're too big
and bulky. 

Right now, fuel cells are start-
ing to find their place as charg-
ers on the go. Just plug them into
your current cell phone for a
hearty power boost. NTT DoCoMo,
Japan's biggest mobile service
provider, has showcased a proto-
type charger that should be
commercially available by 2007.
Around a year after that, we shall
see fuel cells replacing the cell
phone battery altogether. They'll
last at least 10 times longer than
current batteries, and to recharge
would be to just replace the water
in the cell! 

nimish_chandiramani@thinkdigit.com
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The willing slave, the work-
horse, the friend(?); we all
have a strange and unde-

fined relationship with our boxes.
Most of all, we’re all tired of their
dry, boring classic forms. ’Tis the
age of cool, and all PCs have started
queuing up for a makeover more
suited to these crazy times of
indulgence. 

Listen And Obey 
We’ve been tied to the same old
keyboard and mouse for nearly
two decades—and rightly so.
There have been several alterna-
tive input devices for the PC—
from strange claws to incompre-
hensible foot-pedals, but in the
end, we all return to the warm
fuzzy safety of our keyboards.
QWERTY is our religion and
WASD its gaming sect! 

Create your own keyboard
True, we love our keyboards, but
that still doesn’t mean we should
remain content with the layout.
The DX1 input system lets you
create your own personalised
keyboard layout for that perfect
key-punching experience. What
starts out as a blank pad becomes
your own personalised keyboard
as you attach keys on it. Hardcore
gamer or just plain keyboard
warrior, this one’s for you—just
slap on a key where you want it,
assign a combination of keys or a
macro and be done with it. It
even lets you add new keys in the
heat of a game, so you can add
new action as soon as you
discover you need it!
URL: www.ergodex.com

The Hand—the next input
device?
Ever wanted to grab a window and
throw it into a corner à la Minority
Report? Researchers are working on
a device that will enable you to do
just that: the DataGlove, originally
developed by VPL research. Sensors
in the glove detect your hand

movements, completely immers-
ing you into the world of file and
window handling.

For more information on the
original DataGlove and similar
devices, head to the site below. It’s
not clear where one can be bought,
but prices of such devices are
reportedly falling rapidly.
URL: www.cse.unsw.edu.au/~walee
d/thesis/node33.html

Tagalong
Falling laptop prices have almost
made it a realistic substitute for
the desktop PC, especially with
most of them getting faster than
your entry-level machine. To the
average geek, a computer is only
about how much juice it has, and
to the geek on the go, it’s about
how much juice you can carry
around with you. 

The Dell Inspiron XPS M1710
This runs on an Intel Core Duo
processor, has 2 GB of system RAM,
a 100 GB SATA hard disk, a killer
GeForce Go 7900 GTX with 512 MB
of RAM, and will cause the people
surrounding you to spontaneously
combust in uncontrollable jeal-
ousy. With a setup like that, you’d
probably expect the battery to
fizzle out in the first five minutes
of gaming, but you’d be wrong. The
9-cell battery can take an hour and
five minutes of continuous
gaming, which, given the nature of
its extreme use, is very impressive,
and a goodish bit beyond what
other gaming laptops would give
you. Moreover, the fact that it’s a
laptop just makes it easier to take
to a LAN party and brag.
URL: www.dell.com

No more tears
A nagging “feature” of laptops is
their incredible penchant for
going pfft after a couple of hours
of continuous use—and this just
with regular PC use. Try playing a
game and you’d barely make it
past level one! To counter this
tragic occurrence, companies are
in a mad race to create the next
fuel-cell battery for the laptop. At

Goodies that make your personal computing
experience more… personal

Gadgetise!
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CES 2006, Panasonic showed off a
fuel-cell powered laptop that had
enough juice to last nearly 20
hours at a size that was just
slightly bigger than current
battery packs. Throw that into an
XPS and international flights
won’t be so long and boring any
more, will they? 

Stuff It
Most of us here at Digit have
invested in 250 GB hard disks for
our homes—they’re so affordable
now! Of course, figuring out what
to put into that much space does
take some thinking. Storage is
becoming cheaper by the day, and
huge hard disks will have lost
their ooh value quite soon.

In May 2005, Hitachi
announced its Deskstar 7K500,
which holds a respectable 500 GB
of data using the standard record-
ing technique that all hard disks
use. But this is probably the limit
for hard disk recording—no more
data can be stuffed into those disks
without overhauling the way data
is recorded. So they overhauled it. 

The Hitachi Travelstar 5K160
With their revolutionary new
Perpendicular Storage technolo-
gy, Hitachi have managed to
squeeze more bits onto hard disk
platters, opening the doors to a
world where hard disks get small-
er in physical size while remain-
ing bloated enough to hoard your
data ten times over. While bits
today “lie down” on hard disk
platters, occupying more space,
the perpendicular technique
stands them up, allowing for
more data to fit into the same
area of the hard disk. 

The Travelstar 5K160 is
Hitachi’s first 2.5 inch drive with a
capacity of 160 GB—60 GB more
than the current longitudinal stor-
age disk—and comes with new
“travel head” technology that will
double the drive’s reliability. They

will now turn their attention
to the smaller 1.8 inch to
see how much they can get

onto those—will we see 100
GB drives on our cell phones

soon? 
The 5K160 will launch later

this year, and will cost around
$269 (Rs 11,500). 
URL: www.hitachigst.com

The Swiss Army Drive
Standard USB drive not doing
enough for you? Get your hands
on this Swiss Army knife that

packs in all the goodies essential
for survival in the wild: a red LED
light for night-time jaunts, a ball-
point pen to, well, write stuff, a
knife, a pair of scissors, a file with
a screwdriver, a key-ring, and a
USB flash drive! You can choose
from 256 MB, 512 MB and 1 GB,
and the drive’s detachable if you
want to be boring as well.  
Order it from: www.thinkgeek.com/
gadgets/tools/6b3b/

Mine, All Mine!
When you’re on the road
with your laptop, you
need to (a) keep other
people’s noses out of
your business, and 
(b) ensure that your busi-
ness stays well clear of
others’ noses. These two
USB devices will make
sure that the things hap-
pening around your lap-
top will stay in the vicin-
ity of your laptop. 

The USB Flex Light
Want to work on your

laptop on a night-time journey
without bothering your fellow
passengers? Just stick this flexible
light into your laptop’s USB port
to illuminate the keyboard or any
surrounding area. Its flexible
neck lets you change its position
to best suit you. It drains very lit-
tle power from the battery, so is
ideal for the  road warrior who
cares.
URL: www.iogear.com

The FlyFan USB Fan
This one is the ultimate tool to
make your fellow travellers burn—
both in jealousy and in the heat.
Perfect for unforgiving summer
travel, connect this fan to your
laptop’s USB port to sit back and
enjoy a steady stream of cooling
air and a view of the others wip-
ing the sweat off their foreheads. 
URL: www.kensington.com

nimish_chandiramani@thinkdigit.com
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The gob-smacking success of
Nick Park’s Wallace and
Gromit movies is probably the

strongest argument for anyone to
try their hand at their own home-
made creation at least once, espe-
cially now that you have
technology on your side. Have you
ever watched a movie and
thought, “Ooh I want to do that!”

Recent advances in technol-
ogy, and more importantly the
increasing affordability thereof
have given us a gaggle of options
to showcase our creativity. Fancy
yourself as the next big movie
director or special effects artist?
Grab that shopping basket!

Starry, Starry Eyes
In the beginning, there was the
VHS camera. It sat upon the
shoulders of the strong, weaken-
ing them, and the shoulders of
the weak, near-killing them.
Then Sony said, “Let there be the
HandyCam!” And there was still
the VHS camera, but at least
now you could hold it in one
hand without crippling yourself.
And thus began the age of the
Home Movie. Suddenly
dwellings went from being just
house to art house, and every-
one loved the camera, even if it
hated them.

As all things analogue were
doomed to, video went digital too.
The big DV (that’s Digital Video)
has invaded our lives in a bigger
way than VHS could ever have
hoped. For one thing, you can store
movies from your DV camcorder
onto your PC, and thanks to
Windows XP, you can even turn to
small-time movie editing using

Windows Movie Maker which
comes free with XP.

The Sony HDR - HC1 
No video enthusiast can
resist the temptations of
High Definition (HD)

video. The size, the crispness,
the capability to kill entry-level
PCs, mmm…

Sony’s HDR-HC1 is the world’s
smallest and lightest HD
camcorder, and as with all Sony
camcorders, this one is very
drool-worthy. Weighing in at just
a tad heavier than their lightest
camcorders, it captures video in
all its vivid glory. Of course, if
you’re going to edit the movies
this one creates, you’d better
juice up your PC—editing HD will
take a big bite out of your
system’s resources. 
Price: $1,999 (Rs 85,000)

Shutterbug
While nearly all camcorders
come with the ability to take
still images as well, they still
pose no threats to our much
loved digital cameras. When dig-
ital photography was first intro-
duced, it tried hopelessly to
match up to the quality of the
traditional film camera, and no
real photographer would admit
to even touching one. All that’s
changed now—with 8-megapixel
cameras littered all over the
markets, digital photography
has finally given film something
to worry about, to say the least.

High end photography is find-
ing its way into our mobile
phones, too. Samsung has been
quite aggressive in this area—
they showed off a 7-megapixel
phone when 1.3 megapixels were
a big deal, and at CeBIT 2006,
they unveiled the SCH-B600—a
10-megapixel camera-phone!

The Cybershot DSC-R1
Sony’s DSC-R1 is the perfect
meeting ground between the
digital SLR and the point-and-
shoot camera. It gives you a real-
time preview of the shot you’re
taking, unlike other digital
SLRs, and sports a 10.3-megapix-
el CMOS sensor. A 2-inch LCD
lets you frame your shots nicely,
and its considerable weight will

Gear for that tough journey

From Wannabe
To Legend

CREATION
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ensure that your arm muscles
are always finely toned. 
Price: $999 (Rs 43,000)

Playing God
For a long time, the idea of being
able to create movie-style 3D
graphics and imagery was quite
preposterous. The average home
PC couldn’t take the load, and
there weren’t even that many
commercially available tools for
those who itched to bring their
fantasies to life. The statement
was clear—this was the domain
of big studios who worked on
expensive and powerful Silicon
Graphics workstations. 

Then came tools like 3D
Studio Max, which ran on most
respectable PC configurations
and were so easy to use that one
could become something of an
expert just sitting at home!
Specialised tools such as MetaCre-
ations’ (then Corel’s and now DAZ

Studios’) Bryce let
you imitate nature
and create ultra-
realistic landscapes
or bizarre fantasy
worlds in minutes—
even if you didn’t
know the first
thing about 3D

modelling.

The Big Gun: 
Autodesk Maya 7
The leader in creating

special effects for movies
(Spider-Man 2, for example),

Maya is to 3D graphics what EA is
to gaming. Designers cower in
humility before it and even say a
little prayer of thanks every time
they work with it. Its powers are
truly awe-inspiring, if not down-
right frightening. Capable of
creating uncannily realistic
images, Maya has all the features
you could possibly need to get
started with your own creation. To
get a true sense of its power, take
the “Fake or Foto” test:
www.autodesk.com/ eng/etc/
fake_or_foto.

There was considerable para-
noia when Autodesk, the makers
of 3ds max, a close competitor to
Maya, took over Alias|Wavefront—
the developers of Maya; loyal
users wondered if this rang the
final bell for their favourite
design tool. Thankfully, Autodesk
seem committed to taking Maya
further, so it will carry on as the
industry’s darling. 

Price: Rs 3 lakh, but you can
start learning Maya by download-
ing the Maya 7 Personal Learning

Edition free from www.autodesk.
com. Maya isn’t easy, though—
you’ll require plenty of patience.

Home building comes home
Google has brought 3D graphics
even closer to the home user with
their new Google SketchUp, which
makes designing houses and other
buildings as easy as puffing your
cheeks. Build your dream home or
remodel your current one—thanks
to its clean, intuitive interface and
ridiculous ease of use, it’ll be just
minutes before you’ve mastered
the art. More importantly, it’s free,
and you’ll find it on this month’s
Digit CD!

Rock On
Peoples’ fascination with creating
their own music has led to many
popular games such as  Guitar

Hero for the PS2, Nintendo’s
Donkey Kong and Namco’s Taiko
Drum Master. There are also plenty
of tools that let you mix and
create your own compositions—
you can read about them in this
month’s Fast Track.

Fear My Virtual Axe
Want to be a rock god but can’t
handle a guitar to save your life?
Students at the Helsinki
Institute of Technology have
developed Virtual Air Guitar,
which translates those silly air
guitar moves into actual sound!
It uses a Web cam to watch your
hand movements and throws
out sound accordingly.

They’re also working on a
version that can work with our
everyday Web cams, so now you
don’t need to jump on your bed
looking like a nincompoop—you
can sound like one too! 

nimish_chandiramani@thinkdigit.com
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Robert Sovereign-Smith

Atrue geek shows off his
geekdom (and fat salary as
well) by talking about every

gadget in his house, not just his
PC and cell phone. For them,
there’s an increasing market for
cool consumer electronics.

If you were born before the
‘80s, you will remember the days
when even owning a microwave
was considered posh. Today, in the
age of iPods, everyone seems to
have one of everything. What sets
you apart from the crowd is which
one you have. This applies to every-
thing from microwaves to refrig-
erators, televisions to air

conditioners, and much more.

Odds ‘n’ Ends 
There’s always been the devices
that have no real purpose, or
features that have no business
being in a device, and the people
who can afford them lap them up
with relish! Since we couldn’t
come up with a name that did
this category justice, we decided
to call this the Odds ‘n’ Ends cate-
gory. Let’s take a look at the top
three products that we came
across, and took a fancy to for
some reason or the other.

Multimedia Chair
Let’s face it—all of us are couch
potatoes at heart! We’d like noth-
ing better than to kick back after
a hard day’s work (or play) and
relax to some serious gaming
console action! Or perhaps we’d
like to watch a movie, or just
chill to our favourite TV series.

Well, now you should be able
to do it with style, and loads
of comfort to boot. If there’s

one thing that will get your
buddies all green, it’s the
Hammacher Multimedia Chair.

Yes, as the name suggests, it’s
a chair meant to laze about and

enjoy any type of multimedia
content. It has two 50-watt
speakers built into the headrest,
and promises to envelop you in
rich, life-like sound. Whether it’s
Mozart, a movie, or F.E.A.R.,
you’re sure to love the experi-
ence this chair has to offer—not
just because it has speakers in
the headrest, but because it
boasts of a “tactile sound trans-
ducer” that actually vibrates the
chair realistically according to
the woofer’s output.

The technology is not new,
however, and was first seen in
USAF flight simulators and also
later in some theme parks and
movie theatres.  

The good thing is that even at
lower volumes, because of the
chair’s transducer, you will still
feel every bump in the road in a
racing game, and have a richer
movie-watching experience. It
will also add a full body experi-
ence for those who use game
consoles—instead of just tactile
feedback for your hands from
joysticks, your entire body will
feel the recoil of that sniper rifle!

Of course you can control the
volume of the 300-watt amplifier
as well as the chair’s vibrations
from a hidden side panel that’s
within easy reach for the truly
lazy. There’s a headphone jack
for when the family is asleep,
and the comfort levels are said to
be exquisite—thanks to the
suede micro-fibre upholstery,
high-density foam and hard-
wood frame.
Price:  $800 (Rs 36,000)
Coolness Factor:  7/10
URL: www.hammacher.com

PC Desk
So your friend just bought the
latest gaming rig. And everyone
is trying to outdo everyone else
with their configurations. RAM
sizes are soaring into the GBs,
hard disks are approaching the

Every geek’s dream house has not just a top-of-the-line
PC, but also all the gaming consoles and cool gadgets…

Coolness
Quotients
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TB mark, and everyone has a 64-
bit 3+ GHz processor with at
least two graphics cards…

Yes, life’s a competition for
most of us geeks, and in our quest
to get the best and outdo the rest,
we often forget that it’s not what
you have, but how you flaunt it!

Now here’s a product that
will make the dual AMD X2
4800+ system your friend just
bought look like the biggest joke.
Forget funky cooling solutions
and silly lighting, forget about
modding your PC cabinet. Just
get a Powerdesk!

We gave this product a cool-
ness factor of 9/10, not because of
the configuration of the PC it
contains, but because this is liter-
ally a PC Desk. It’s not just a desk
that you put your PC on top of, it
is the PC!

For those who didn’t get it,
Powerdesk has integrated the PC
and the desk to form one unit
that hides all clutter, all wires
and makes your home or office so
neat-looking that your friends
will have to hang their heads in
abject shame!

You also have the added
flaunt value of showcasing a PC
that almost no one without a
crane can steal! Plus it can be
adjusted for any height—a seated
child or a standing adult. Of
course, if you have the money,
and really want to rub your
friends’ faces in the dirt, you can
completely customise the hard-
ware configuration, and get
those four 7800s in quad-SLI
mode on a dual-core, dual-CPU
setup! It’s also easily upgradeable,
and you can do it yourself. 

Pay a visit to www.powerdesk
.com, sell a kidney and buy one of
these. The dark side commands
you to!
Price:  Starting at £1,550 (Rs
1,32,000)
Coolness Factor: 9/10
URL: www.powerdesk.com

Coast Spas Extreme XLT
TV Bath Tub
If every part of your house is out-
fitted to display your geekdom,
make sure the bathroom isn’t
left out!

Now we all have fancy bath
fittings and weird little gadgets
for soap dispensers and the like,
but how many of us have heard of
a home theatre bathtub?

It’s not one of those tiny little
one-person affairs either: this is a
tub you will be showing off with,

and you’ll want your friends to
join you in a nice Jacuzzi-cum-
movie experience—so it’s got
enough place to fit eight adults,
and measures 96 x 96 x 40 inches.
96 inches is eight feet!

This is obviously not the tub
for any of our apartments, and
you better own a nice big bunga-
low before you buy this baby. Of
course, at a price that’s reported
to be over Rs 14,50,000 (yes, that’s
14 lakh 50 thousand), you’ll prob-
ably own a bungalow or two
anyway! You might need to sell
one of them to buy this extrava-
gantly ridiculous tub and its
accessories though.

With 80 water jets, waterfalls,
lights, a 17-inch LCD screen, DVD
player, Extreme Sound
subwoofers, a refrigerator, and
even a water-proof, floating
remote, the tub actually seems
worth the 15 lakh investment!

Perhaps you can fake your death
and collect the insurance money
to get one of these!

Price:  Over Rs 14.5 lakh
Coolness Factor: 10/10 (Kill for
money, buy this, and you’ll proba-
bly be the talk of the country!)
URL: www.coastspa.com

And More…
Here are a few more products that
were too wacky not to mention!

The “On Target” Urinal
By Marcel Neundörfer
This one is for men who don’t
pay too much attention to aim
when going. It actually has an
LCD screen in the urinal, with a
target that gets smaller as time
progresses, as well as sound and
visual effects!
URL: www.apartment10.net

Computer Bug Zapper
You know how we see bugs get-
ting zapped in restaurants?
Here’s one that is hung above
your computer and runs on bat-
teries. It’s completely pointless,
but your friends should get a
laugh out of the explanation you

concoct for it! This is the perfect
gift for software testers, who can
claim they’re destroying a bug
every time this thing goes off!

It’s available from www.
thinkgeek.com/homeoffice/gear/
80c9/?cpg=cj

Speaker-Sneakers—Code
M From Dada Footwear
Now here’s a new way to listen to
music while you jog—instead of
an MP3 player, you can have
speakers in your sneakers! Well,
the speakers aren’t that great, so
they added a wireless headset
with a range of 30 metres. This is
because you might want to take
off your shoes but continue listen-
ing to music, or perhaps you’re
over 30 metres tall! The shoes are
rechargeable via a USB port, can
store up to 100 songs, and offers
six hours of playback on a single
charge! Plans are underway to
integrate cell phone technology
with the shoes so that you never
lose your cell phone or find it
stolen—unless you get mugged for
your shoes, that is! 
URL: www.dadafootwear.com

robert_smith@thinkdigit.com
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Artificial Intelligence

Ideas that suffered Fate’s wrath. Or were just
plain asinine

Broadband

The Paperless Office

Virtual Reality

Voice Recognation
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people are looking to adaptive soft-
ware and natural language under-
standing, with logical decision-
making in their AI software. This is
good, but we’re still far from any
breakthroughs, and Asimov’s
Positronic Brain, alas, is just fiction
as yet.

A lot of areas of research are
proclaiming and promising results
soon. However, soon is widely
believed to be over a decade or two,
and the broken promises of the
past cause us to take AI timelines
with a rather large pinch of salt. 

Ai Research (www.a-i.com), for
instance, is working on starting off
a software as a child, and gradually
teaching it and making it smarter.
In their words:

“Founded to create true artifi-
cial intelligence—making it possi-
ble for humans and computers to
speak to each other in everyday
language—Ai is an international
project with a research center near
Tel Aviv, Israel.

“The Ai team consists of scien-
tists, researchers, engineers, and
language specialists. All work
together to nurture Ai’s child
machine, and to ensure that it will
successfully pass the Turing Test
within the next 10 years.”

(“Turing Test” refers to the idea
that if a man and a machine can be
confused for each other, the
machine has passed the Turing
Test.)

Artificial Idiots
If we’re only talking about the
Turing Test, there might be a few
projects that will come close in
the next decade. However, making
machines as smart as a teenager,
even, might take a lot, lot longer.

Right now, we’re stuck playing
games against moronic AI that is
stuck debugging a simple program
where you’ve put an OR instead of
an AND! You’re also going to be irri-
tated by the same software bugs,
again and again, until human
research brings about true artifi-
cially sentient software, which
learns, adapts, and can hold its
own against human brains! For
now, AI is a huge disappointment,
and has been relegated to the stack
of technologies that didn’t keep
their promises. 

robert_smith@thinkdigit.com

The promise
of AI has
been broken
too many
times. Will
we ever get
smart
computers?
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Artificial Idiots
Robert Sovereign-Smith

If you’ve heard of Isaac Asimov,
the Positronic Brain and the
Three Laws of Robotics, you’re

probably as disappointed as we are
with the current state of Artificial
Intelligence (AI). Sure, computers
have evolved from machines the
size of buildings to chips the size
of your thumb! We’re not saying
that computers haven’t become
smarter; we’re just asking, by how
much?

An AI pioneer called Herbert
Simon said in 1965 that machines
would, by 1985, be capable of doing
any work a man can do. It’s 2006
now, and far from “doing any work
a man can do,” machines can’t
even use a broom to sweep a room!
OK, there are robotic vacuum
cleaners, but those just avoid colli-
sions and go around the room—can
you even imagine a robot asking
you, in English, “Should I sweep out
that corner  as well?” (Because it
can see that the corner isn’t all that
dirty, and that more energy might
unnecessarily be expended doing
it—since it knows from experience
that you don’t demand that every
nook and cranny be perfectly clean,
because you’d rather get the job
done quicker?)

We want to see AI put to prac-
tical use. Unfortunately, there’s
hardly any of that happening in
the fields we’d like to see it happen
in. Sure, there are “expert systems”
in the field of medicine and others,
and robots that use AI to navigate,
but we want to see it in our every-
day lives!

But Everyone Claims To Have A
Solution and that’s one of the prob-

lems plaguing AI. There are so
many brilliant minds involved in
so much varied research, and no-
one seems to be able to arrive at a
consensus about what’s needed. A
robot here is coded to navigate a
maze, a chat-bot there is coded to
behave like a doctor!

They’re all specialised! What we
need—or rather, what we want—is
a generalised artificial intelligence,
something that behaves the way we
do: employing common sense, real-
ising when something is repeating,
and so on. In fact, common sense
and pattern matching—two of the
biggest AI problems—just haven’t
been solved in all these decades!
And no, hard-coding common
sense by using world knowledge
just doesn’t cut it.

Imitating human intelligence
is another issue: brain modelling
apart, there’s too much of that
going on—when will researchers
get to developing an entirely new
kind of intelligence? Why does
intelligence have to be human?

Thinking Machines
We’ve seen supercomputers beat
grandmasters in chess games, but
even those instances were riddled
with controversy—with the
humans claiming that the com-
puter was specifically pro-
grammed to beat him! We still
haven’t seen a computer win a
chess tournament, beating many
different grandmasters.

But that’s just chess! After all,
it is a game of logic and mathe-
matics, which come naturally to
computers. What we really want to
see is a computer that can answer
such questions as “Three of us need
to enter a room; how many doors
are needed?” If a computer or robot
can answer these questions using
common sense—without specifi-
cally being coded to do so—then we
will have achieved true artificial
intelligence, the I, Robot type.

The Current Scene
As of now, there’s really nothing
new that one would want to write
home about. Like we said at the
outset, computers and software
have become more knowledgeable,
but not more intelligent.

We need more AI programs to
understand better. More and more
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Are rulers
different in
different
places? No?
Then why is
broad band
so narrow
in India

Agent 001

With availability of tech
jobs rising, airfares
dropping and salaries

being hiked, life for the urban
Indian never seemed better. We’ve
all gotten used to the pollution,
pothole-riddled roads and endless
traffic jams (especially in my
home city of Mumbai), and we’ve
learnt to take it in our stride.
Slowly but surely, our civic ameni-
ties are improving, and people are
now demanding more from the
government authorities and
private companies that control
public amenities. Various tabloids
and newspapers across the coun-
try take up fights for citizens’
rights to better lives, making the
bigwigs of the aforementioned
government and private sector
companies tremble in their boots.
Yes, life as an urban Indian is
getting better by the day—or is it?

Though I’m all for the better-
ment of public transport, safety,
and the construction of flyovers
and highways, I’d much rather see
a reduction of potholes and speed-
bumps in the most important
highway of all—the information
superhighway! I’m talking about
something basic here, access to the
Internet. If you think about it,
you’ll realise that the Internet is to
geeks what the universe is to astro-
nauts! Alas, much like the Indian

astronauts, we resident Indian
geeks cannot do much exploring
because of the lack of a proper
space programme!

A Pain In The A**
You know what those two *s spell
out, and frankly, when I hear
about “increasing Internet pene-
tration in India,” that’s the part
of my anatomy that begins to
hurt, because I know we’re all
getting painfully screwed by our
ISPs. This is 2006, and yet the
majority of India is browsing the
Internet at blazing speeds of
between 16 and 48 kbps! 

A few years ago, the govern-
ment was kind enough to force ISPs
to stop using the term “broadband”
so freely: it stated that “broadband
is an always-on Internet connec-
tion of at least 256 kbps speeds.” So,
although we don’t have 64 kbps
connections being called broad-
band, we now have every ISP conve-
niently overlooking the words “at
least” in the government directive,
and offering “broadband” connec-
tions that have “speeds of up to 256
kbps” for always-on, unlimited
usage connections! 

Limited MBs 
Here’s where all the bandwidth
lies! Of my two connections, it’s
the limited MB connection that I
use the most. Why? Because I have
actually got download speeds of
64 kBps i.e 512 kbsps (8 bits = 1
Byte) on it, while my “unlimited
connection” never gives me any-
thing above 32 kBps i.e 256 kbps—
actually, it’s more like an average
of 25 kBps! And that’s me—others
in Mumbai report even lower.

Though this would still sound
like a dream to many across smaller
cities in India, my friends abroad
naturally laugh at my plight—the
average American can get a 2 Mbps
connection for anywhere between
Rs 1,000 and 2,000 a month, while
people in Scandinavian countries
have national bandwidth averages
of hundreds of Mbps to 1 Gbps per
person! Here, I’m paying over Rs

4,000 for two connections on
which I barely download a

few GB per month! 
And I’m consid-

ered one of the
“lucky few”?

ISPs
The majority of non-dial-up con-
nected Indians pay between Rs 300
to Rs 3,000 for either limited MB
connections or unlimited connec-
tions that offer speeds below 256
Kbps. Yet, all of those same people
think they have “broadband”!

ISPs claim to have brought
down prices, but the fact is that
they were overcharging us before,
and are still doing so now. They
claim that the infrastructure costs
demand such high prices, and also
that they “buy” bandwidth at high
prices. The simple truth is that all
of us millions of bandwidth con-
sumers have just sat back and
accepted our fates. Either that, or
we’ve been too busy fighting for
better roads and services to care
about Internet access. It’s time we
changed that!

The Bandwidth Revolution
Let’s start one! Even if it’s as simple
a task as calling up your ISP hotline
and asking for the price of a 512
kbps, unlimited, always-on connec-
tion, and then gasping at the price
and hanging up. You could even
suggest that they offer you a 512
kbps unlimited connection at a
lower price and make up the loss in
revenue in terms of advertising—I
know I’d gladly watch a few ads on
the top (bottom, left, right, or any-
where!) of my screen, and even
click on a few of them, just to have
a 512 kbps, unlimited Net pipe! 

Perhaps someday you actually
might be able to watch or listen to
streaming video or audio, instead
of going to a site with such content
and having to select your connec-
tion speed as “dial-up” rather than
“broadband”!

If we all do our bits, perhaps
Indian ISPs will wake up to the fact
that they will lose out their
customers to the first ISP that actu-
ally offers affordable broadband. All
that’s required is one national ISP
to make a policy change, and I
know I’ll switch immediately

However, as of now, with all
the “limited MB plans” available
out there, I have no option but to
hand “broadband” and the ISPs
that fail to provide it the dubious
title of “technology that failed 
to deliver!” 

agent001@thinkdigit.com
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Reality Bites...
Robert Sovereign-Smith

Remember those 3D comic
books that came with glasses
with one blue and one red

lens? There were movies that used
the same principle…

The idea was simple: make
movies or comics, which were all
so boringly two-dimensional, into
something that appeared three-
dimensional, and thus more real!
These were perhaps the first
attempts at Virtual Reality (VR),
and they failed miserably!

Move along forward in history
and we come to the basic displays
of today, which are basically 2D,
but offer the depth and immer-
siveness of looking through an
actual window at all the action
happening on screen! Games,
movies, basic television, that
India vs. Pakistan cricket match…
they all look absolutely surreal on
our televisions or computer
monitors today. However, they
have no interactivity!

Think about it. If you were
standing at your window, looking
out at the world (perhaps at the
street below), you would be expe-
riencing a real-life scenario, right?
Now, put a camera into the same
window, and sit in a closed room
and watch the same scene play
out on your TV or monitor… get
the picture?

The Next Step In
Entertainment…
VR was supposed to be the next
big thing in terms of entertain-
ment. It seemed that everyone
with a science degree was working
on VR in some way or the other. A
lot of weird gadgets were devel-
oped, and none of them delivered
what they had promised. 

Many fans of VR and developers
in the VR field will aver that it was
the general public that expected
too much, too soon, while many
others place the blame of failure
squarely on the researchers, saying
that they got carried away by the
initial progress and made ridicu-
lous claims...the debate continues,
but the truth is, VR bombed big
time!

The problem was simple: in
order to be even called virtual real-
ity, a device or technology had to
immerse the user in a world that
was indistinguishable from the
real one. Though the field of graph-
ics was moving forward by leaps
and bounds—which is best under-
stood by watching the evolution of
special effects scenes in  science-
fiction and fantasy movies —every-
thing else remained where it was.
The problem was that we were
approaching visual reality, not
virtual reality!

Visual Reality
Have you played any of the latest
games? For they are beginning to
look incredibly real. It’s doubly
real when you look at the latest
movies and the special effects—if
anything, we’ve achieved visual
surreality! But forget the movies,
because we still haven’t figured
out a way to make them interac-
tive, even if directors let you
choose your own endings on DVD
versions of major blockbusters.
The fact is, games are the most
immersive of all forms of enter-
tainment, because you’re actually
the proponent in one, instead of
being a bystander!

Gaming Goofs
Now games come with their own
share of problems. Visually, every-
thing in today’s games can look as
good (and real) as you want it to. If
you spend enough to buy the lat-
est hardware, you can run games

such as F.E.A.R. at the highest set-
tings and enjoy the near-real expe-
riences on offer! However, all this
is just visual, and just seeing isn’t
believing! 

A few of the problematic areas
in games are the physics and AI
factors. When you see someone
standing on thin air, or getting
stuck in a corner just because your
team-mate refuses to move out of
your way, it’s a rude awakening!

Other Interests
Another very important but
embarrassing implementation of
VR was in the pornography indus-
try. The concept was simple,
instead of sitting back and watch-
ing, you would much rather par-
ticipate in your fantasies. At least
that was the initial idea. Thanks to
the same drawbacks that have
plagued games, this, too, turned
out to be just another un-achiev-
able idea.

Useless?
Not at all! VR did not keep the
promises that its supporters made
in terms of entertainment, and
that’s the reason it finds its way
into Digit’s demerit list. However,
mass consumption aside, VR is
very, very helpful in a lot of fields.
Take flight simulators, for
instance. Here, VR is the perfect
pilot training tool, because it
allows people to learn to fly with-
out actually endangering a plane
or themselves if they make a mis-
take. Then there are its applica-
tions in the field of medicine, and
so many doctors are now training
on computer-controlled dummies,
robots and even software—practis-
ing operations that will save so
many lives.
VR is also used to train soldiers,
and can be used to construct the
surface of Mars for instance, by
collating data from all the probes
we’ve sent there.

The bottomline is that though
VR holds much promise, it’s being
held back by the lack of develop-
ment in areas such as AI. It’s turn-
ing out to be just another
audio-visual experience, it’s
nowhere near what’s needed in
terms of entertainment computer
generated  realities!

robert_smith@thinkdigit.com
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Or how I
learned to
stop
worrying
and love the
Document

Papierlove
sifting through paper. Add to that
the fact that paper costs ate up
about one to three per cent of
revenue, and paper-hatred makes
perfect sense.

The Promise
The intervention of technology
would automate most tasks—no
more filling out forms in tripli-
cate, no more running around
offices to get paperwork
processed. Information would be
easily stored in the electronic for-
mat, available almost instantly to
those who needed it via a fully-
indexed search function.

As the years trundled on, the
possibility of a paperless office
seemed to come closer to reality.
From tools such as Adobe Acrobat
to full-fledged collaborative solu-
tions for company intranets—
everything promised to ease us
into the nirvana of clean desks.
And so much did companies
believe in it that many of them
even instated a “Clean Desk”
policy, where employees were
encouraged to leave their desks
free of any paperwork, or suffer
their unannounced disposal. 

Indeed, paper has been elimi-
nated to a massive extent thanks
to the wonders of technology.
Paperwork is increasingly being
taken online. Collaborative tech-
nologies like the wiki have made
knowledge-sharing and manage-
ment much easier than a shelf of
reference books and assorted
documents. And yet, we always
seem to be one step away from the
paperless office.

The Reality
The great irony of the paperless
office is that while technology
can help eliminate paper, its
development has actually
increased its proliferation. We’ve
never had access to as much infor-
mation as we do today, and what
do we do when we find an inter-
esting article on the Internet?
Why, print it, of course! And with
the cost of printing a page lower
than that of your average cough
lozenge, hardly a grey cell is
expended in thinking about hit-
ting that Print button.

The fact is, much though we

Nimish Chandiramani

Getting under top manage-
ment’s skin, Method #32435:
Generously apply layers (to

taste) of important/important-look-
ing paper on desk.

Nothing frustrates managers
like inefficiency or the perception
thereof. And the sight of mounds
of paper on one’s desk creates that
perception quite well. Depending
on paper to get your work done is
quite ineffective, they would say.
It could easily get lost, torn, burnt,
be the victim of a coffee spill, or
just simply become old and illegi-
ble. There must be a better way,
and technology must provide. 

As early as 1975, corporate
bigwigs fantasised about an office
without paper—a streamlined,
seamlessly integrated workplace
where one doesn’t have to make
endless trips to the printer, and
lost documents are a little joke
that colleagues share at the water-
cooler. And not without reason—
red tape was rampant even for the
smallest of tasks, and the mount-
ing volumes of paper all but

clogged the lines of efficiency in
the workplace. It was esti-

mated that people
spent at least ten

hours a week just

hate paper, we love it. It’s an incred-
ible medium for information shar-
ing. It’s high-resolution, supports
both colour and black-and-white
display, it’s ultra-compact, ultra-
portable, ultra-cheap, requires no
expertise to use, and even smells
good when old. People still love
paper for its tactile, tangible feel,
and that doesn’t look likely to
change in the coming years. The
debacle of gadgets like dedicated e-
book readers proved just that. 

And then there’s the question
of whether technology is really the
great enabler. What’s easier,
fumbling around with a computer
program to take notes, or scrib-
bling them down on a notepad?
Until technology achieves the
incredible ease-of-use of paper, it’s
going to remain a preferred
medium to jot down thoughts and
ideas quickly. Sure, there won’t be
a full-text search available, but
people don’t seem to mind that.
Moreover, handing in documents
in paper has the psychological
effect of assuring one that the task
has indeed been completed.

There’s so much that could go
wrong with computers—a corrupt
hard disk could be the death of an
organisation that chooses not to
have anything to do with paper. A
system crash or an incorrect
command could undo hours of
work. With so much that could go
wrong, can you really blame your-
self for wanting a hard copy of your
work? And we still haven’t talked
about legal documents that
require physical copies with real
signatures—the idea of a digital
signature is still indigestible. 

The role of technology in the
office is to minimise the use of
paper to save on costs and produc-
tivity. Even now, documents go
through all their review cycles in
the electronic format, to be
printed out only when final. Tech-
nologies like fax over IP and print-
ers that print on both sides of the
paper also play their own little
role in the big picture of the
paper-efficient office. But when it
comes to the actual meaning of
the phrase, the paperless office is
an urban myth—so hang on to
your notebooks. 

nimish_ chandiramani@thinkdigit.com
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(You Can’t) Read My Lips
Robert Sovereign-Smith

We don’t mean to malign
any particular company,
but here’s part of a Web

ad for a certain dictation software:
“Send e-mails and instant

messages, surf the web, chat and
create documents—all by speaking.
With (name of software), you’ll be
faster than ever before—and have
more fun with your PC.”

Sure it’s fun. Speak, and watch
the words appear in, say, MS Word.
It’s fun in the beginning, then you
realise you need to train the soft-
ware if you want to get any work
done. OK, so you train the software
a little, by reading out the pages of
text it presents you (so it can get
used to the nuances of your voice).
Then you try it again, and it’s a
little better—but it’s already less
fun. The software urges you to
train it some more, and you go
ahead. After a lot of training, you
think, “I can finally speak to my
computer!”—and happily sit down
to compose an e-mail by speaking.

Only to find you need to reach
out to the keyboard approximately
once every 10 seconds for the
mistakes it makes. Mic to keyboard
and back to mic. It’s no fun any
more. It doesn’t work. You repack-
age the software—without making
a copy of it, of course—and sell it
on eBay. End of story.

Why?
Think about it: the sheer conven-
ience of being able to yack away
and have it all appear in an appli-
cation. If these products were
that good, why doesn’t everybody
use it? Have you personally seen
anyone using it on a regular
basis? Probably not. So, well, why
doesn’t it work? If that’s too
harsh a question, let’s put it this
way: why hasn’t voice (or speech)
recognition software become as
popular as it should have, given
its potential?

The answer is, very simply, that
speech recognition is very difficult
to achieve.

Unnaturally Speaking
While speaking into your mic
using dictation software, you
must not cough—it’ll show up as a
word. You can’t say “umm…” or
“errr…” because it’ll either show
up as a word, or modify the word
just before that. You can’t speak
too fast. You can’t speak too slow.
You need to first find a sweet spot
for your pace—which is difficult—
and then stick to it, which is even
more difficult. You can’t use the
software if your spoken English
varies too much from what is con-
sidered standard English. Then
there’s ambiguity: trivial exam-
ples like “I scream” and “ice-
cream” apart, did you say “eye” or
“I”? “Right” or “write”? Then, you
can’t speak out peoples’ names or
other proper nouns: they won’t be
recognised.

Also, there’s the huge issue of
pauses: if you pause for too long—
even without an “umm” or “errr”—
the software gets thrown off. And
what about sentence structure?
When does one sentence end and
the other begin? The software
needs to figure this out from your
pace—and this isn’t taken care of
during the training! Then, punc-

tuation! Try saying “then,
punctuation!”—the software

simply cannot place that
comma and that exclamation

mark where they should be!
One would proba-

bly also need to change
one’s accent—a drastic
measure, to say the
least—for commercial
speech recognition

software to get what you’re saying.
True, localised versions could be
made available, but how many?
The costs would be prohibitive.

We could go on, but we’ve
made our point: as of today, you
just can’t speak naturally into soft-
ware. And if you must, it’ll be so
slow that you’ll be better off with
a keyboard.

I’m Unique, So Are You
If you’ve read this far, you’ll have
realised that the entire problem
lies in the fact that no two people
speak the same way or pro-
nounce words the same way. It
would be quite easy to design a
system for a single person.

How does speech recognition
work? First, the phonemes need to
be recognised (phonemes are the
basic sounds, such as the “ou”
sound in “sound.” People don’t
even say the basic sounds the same
way! Then, the phonemes need to
be strung together to form words.
There’s a problem at this stage as
well: think about when you say
“meet to.” The “t” in “to” is hardly
audible, so it sounds like “me too.”
After this, the words need to be
strung together into sentences.
Here’s where the gap problem
comes in: in earlier systems where
you spoke one word at a time, this
wasn’t a problem, but in continu-
ous speech, people speak differ-
ently when it comes to pauses
between sentences.

Again, we could go into the
technicalities and explain why it’s
so difficult, but suffice it to say
that it is!

The only way out is true
personalisation, and to really
personalise the software, one
could conceivably employ sophis-
ticated neural networks, which
can learn from experience. These
networks would have to work simi-
larly to the way the human brain
understands speech, which is a
very, very complex affair. And now,
we’re again talking about the day
when we’ll have true AI (Artificial
Intelligence). But that’s the direc-
tion some researchers are moving
in. As we said, it’s in the future,
and it looks like it always will be—
at least until there’s a break-
through in AI! 

robert_smith@thinkdigit.com

Voice
recognition
is a
technology
of the
future.
Problem is,
it always has
been a
technology
of the
future!
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Robert Sovereign-Smith

Have you ever wondered
about the miracle that is
the human body? Think

about it: you go out, buy yourself
this copy of Digit, sit down to read
it, and have reached this article.
Picking up this magazine, flipping
pages, reading, understanding the
words printed on this paper, form-
ing an opinion about whether you
like this article or not… all these
actions seem to require absolutely
no effort at all. Yet, in order to be
able to accomplish this, the body
has gone through hundreds of
thousands of years of evolution,
and is made up of one of the most
complex networks (veins, arteries,
nerves, muscles, food canal, etc…)
known to mankind!

Every time you experience
something, there’s a system hard
at work that’s more complicated
than all the computers of the
world put together. Yet it just
comes to us so naturally! 

Now, think of the way you use
a computer: you have to switch it
on, wait for it to boot, then use a
mouse and keyboard to try and
get it to do what you want. There’s
complicated software to be
handled, there’s problems and
limitations of the hardware, there
are a myriad problems, but the
worst of all is that you have to
actually, physically, control input
using motor co-ordination. 

The Physicality Of It All
Now imagine if you could sit back,
relax, and just look at your
computer screen and then “think-
type” instead of having to touch-
type! What about if you could just
focus on an icon and think
“double-click” or “open” instead
of actually doing so?

Sounds unbelievable? Well,
the few lucky souls who visited
the CeBIT exhibition in Germany
know otherwise!

Called the Berlin Brain
Computer Interface, the prototype
on display had two people rigged
up to a really weird-looking head-
set with a zillion wires attached to
it, and then had them play the clas-

sic game Pong. You can see a video
of it on YouTube.com (just search
for “cebit thought”). Though it’s
not perfected yet, if you can move
your bat in pong, in time, you
should be able to do a lot more.

Your Thought Is My
Command
Now here come the interesting
bits: the beauty of thought
computing doesn’t just amount
to being able to control your
mouse with your thoughts, or
silently telling your computer to
launch Word, and then proceed-
ing to think out that letter you
were meaning to write…

Think (pun intended) about it:
almost everything has a computer
chip in it these days. From the
washing machine to the toaster to
your car, everything has a circuit
board and some sort of firmware
to control some function. It’s not
an over-imaginative mind that will
foresee this sort of headset being
made wireless—and hopefully a lot
smaller as well!

Though it will take some time
to achieve, we definitely seem to be
on the right path towards thought
controlling everything that can be
controlled. We could see little chips
being connected to our brain—
permanently, like implants—and
then be able to walk into a room
and have the lights come on auto-
matically, just by thinking, “It’s
dark in here!”

What about being able
to drive a car just by sitting
back and thinking about
the direction you want to
turn? Future wars will
perhaps have no people
actually fighting them,
just thought-controlled
machines attack-
ing each other—
may the stronger
brain win!

The possibili-
ties are endless,
and as with
every break-
through technol-
ogy, could be put
to use in either
useful or harm-
ful ways. Of

course there are always concerns,
especially when a technology inter-
faces so closely with our brains…

Controlled Thought?
Thought control is good, but
controlled thought will have
people up in arms! The fact is,
what most of us would like is a
one-way flow of information,
from our brains to the machines.
The reverse is not as pleasant.
Though there could be a myriad
of new inventions if machines
could send information directly
to our brains, something tells us
that none of us would ever
completely trust such a system.

Still, it could mean the end of
display technologies: Imagine
being able to experience a movie
or game instead of just watching
and listening to it?

For Now
We’re just happy to finally be
going to that next level of input
devices, which sorely needed a
revolution in order to make life
easier. Even if it’s just a way to ease
our pain caused by carpal tunnel
syndrome, because of excessive
mouse and keyboard usage from
cleaning up the spam from the
hundreds of e-mails we receive
each day, we’d rate thought-
controlled computing as our deep-
est desire for the decade ahead!  

robert_smith@thinkdigit.com

Why can’t computers read my mind?

Illustration Pravin Warhokar

At The Speed Of Thought
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Nimish Chandiramani

It’s a shame how even an ultra-
fast PC with a dual-core
processor and oodles of RAM

still takes ages to copy a file from a
CD to your hard disk. Or how Win-
dows XP refuses to load faster than
25 seconds. And how your
favourite game will run at 50
frames per second at the highest
setting, but will still have you twid-
dling your thumbs while you wait
for the next level to load. You’re
probably getting the drift here—
it’s all very well to make leaps and
bounds in technology, but what’s
the point if you still have a few rub-
berbands holding you back? It’s
like running to a car in the rain
without getting wet, only to find
out that the guy with the keys is
still 50 metres away.

The Fat Slug
The first thing that needs to go is
the hard disk. While data can
zoom along on your mother-
board’s system bus at speeds
approaching 10 Gbps, the SATA-II
hard disk interface ambles on at
a leisurely 300 MBps at peak per-

formance (around 150, realisti-
cally). Clearly something needs to
be done. While we pray for the
death of the hard disk and its
impending replacement by new
technologies such as carbon nan-
otubes (read about alternatives to
the hard disk in Digit March
2006), work is already being done
to do away with the hard disk
even in today’s PCs.

Well, to be honest, the idea
has been there for ages—use solid-
state storage. RAM chips are
capable of data transfer rates of 6
to 8 Gbps, and it makes more
sense to have data in there rather
than sitting on a hard disk platter.
There was just one catch—RAM is
volatile, so any data on it is erased
as soon as you stop supplying
power to it. The answer is to
supply a small battery that will
keep the data alive even when the
computer is switched off, and
voila! No more waiting for pro-
grams to load into memory—
they’ll already be there! 

At Computex 2005, Gigabyte
introduced iRAM, which is a PCI
card with DIMM slots for RAM
chips, which can be used as per-
manent storage. It fools the PC
into believing that it’s actually a
hard disk using the SATA II inter-
face. And therein lies the
problem. You see, while you’re
still gaining the advantage of
greater reliability thanks to no
moving parts, you don’t gain
speed, because the
SATA II interface will limit you to
a maximum of 300 MBps! 

A much better (read much,
much more drool-worthy) imple-
mentation is what the guys at
Atom Chip (www.atomchip.com)
have come up with—they base
their super laptops completely on
their quantum-optical RAM. The
latest SG220-2 laptop sports 2 TB
(yes, that’s Terabytes!) of quantum-

optical memory. Try to
relate that to your sit-

uation today—a 2,000 GB hard
disk? Wow! 2,000 GB of system
memory? {Faint}

Take Me Into The Light
There is only one ultimate speed—
the speed of light. We’re not
going to rest till all technology
moves at said ultimate speed,
which is why we’re so obsessed
with making fibre optics work
everywhere possible. Thanks to
fibre optic cables, it’s actually pos-
sible to have an Ethernet network
that works at 10 Gbps. But what
good can we get out of this if the
copper connections on the Eth-
ernet cards and motherboards
only support 4 or 5 Gbps? 

Enter Intel, which has been
researching the possibility of
bringing fibre optics to the moth-
erboard. Instead of the copper
tracks we have today, compo-
nents will be connected to each
other using little fibre optic
lines. This will oust copper—
which can only do 10 Gbps at its
peak—for fibre optics will take
these transfer speeds to any-
where between 30 and 60 Gbps.
And one hallowed day, fibre
optics will be used inside chips as
well—imagine over a billion tran-
sistors connected optically
without even needing a heatsink! 

The catch (for there must be
one) is that while fibre optic mate-
rials are getting cheaper, the
equipment to convert electrical
signals into optical signals and
vice versa is dauntingly expensive.
As of today, there is no way that
any of the above dreams can be
commercially viable. 

Intel to the rescue again—in
2004, they tested a new microchip,
called a modulator, which works
at 1 GHz, is made of silicon, and is
a far sight cheaper than other
modulators, which were based on
much more expensive materials
like gallium arsenide.

It’s still going to take around
10 years or so, but the super-fast
silicon-optical chip isn’t a hilar-
ious fantasy any more. 

And now the ultimate ques-
tion: What does one do with a PC
like that? 

nimish_chandiramani@thinkdigit.com

I just want a faster PC!

Breaking The Bottleneck
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Ram Mohan Rao

W e’ve talked about
human nature else-
where in this issue, and

we return to it now: how many
times have you said to someone on
the phone, “I’ll call you back! My
battery is runnin…” [Beep Beep Beep]
And then, of course, how many
times have you gone asking people
around the office, “Does anyone
have a <insert brand name here>
charger?” All this is as much a part
of our lives as our mobility.

Is There An Answer?
The answer is simple (except in
cases where you don’t have access
to a power outlet): always carry
your charger with you in the
pocket of your jeans (or in your
purse). And charge your device reli-
giously every morning—all it takes
is a half-hour each day, and it can
happen in the background while,
for example, you get ready for
work.

Still, we hanker for longer bat-
tery life! We even curse the phone
or PDA or laptop—as in “This
bloody thing keeps running out!”

Well, run out it will, with cur-
rent-gen battery technologies. So,
being pragmatic about it, we
(a) realise we won’t change our
ways, and (b) hope for all the inno-
vative companies out there to come
out with longer-lasting batteries. 

Some companies, knowing
how demanding and lazy we are,
realised there’s a zillion-dollar
market for “betteries.” It turns
out that the same technology that
can be used in hybrid cars—as in
fuel cells—can also be used for
portable devices.

The Fuel Cell
“Fuel cells for portables,” as a
phrase, was being bandied about
quite a long time ago. In 2003 or
so, we’d chanced upon a prototype
laptop-fuel cell combo. The fuel
cell looked like a little tanker
attached to the back of the laptop;
it was the same width as the
laptop. It was an ugly prototype
that no-one would use. But we

now have fuel cells for laptops and
other portables that are much
smaller than the devices they
power. 

Fuel cells are mainly different
(from the user’s perspective) from
regular batteries in that you don’t
connect them to a power outlet to
recharge them; they’re cartridges,
and you refill them by actually
pouring fuel (often methanol) into
them. That’s if the companies
decide to market them as refillable.

The Story Thus Far
At CES 2006, Panasonic showed off
a fuel cell-equipped laptop. The
company said it would provide 20
hours on a single 200 cc tank of
methanol, and the fuel would be
provided in cartridges. 

15 May 2006, Casio hopped on
the portable-fuel-cell bandwagon,
promising to offer a compact bat-
tery for laptops in 2007. The proto-
type they had was a 6.5 x 1.9 x 1.8
cm unit, and its power capacity,
translated into the size of today’s
batteries, meant a fuel cell the size
of a standard Li-ion laptop battery
would last four times as long,
according to Casio—close to Pana-
sonic’s 20 hours. Temperature is a
potential problem: 280°C is the
temperature the cell gets to during
operation! However, the cell pack-
aging means the external surface
temperature would be more like 40
degrees—certainly bearable.

We learnt that it’s Toshiba that
has the distinction of having pro-
duced the world’s smallest
methanol fuel cell. Back in Sep-
tember 2005, the company also
developed two prototypes of fuel-
cell-powered MP3 players, Flash-
based and hard disk-based
respectively. The Flash player ran
35 hours on a single 3.5 ml charge
of concentrated methanol, and the
hard disk-based player runs about
60 hours on a single 10 ml charge—
if you use it for five hours a day, it
will last 12 days!

The above list of prototypes is
in no way exhaustive: there are
many companies out there devel-
oping micro fuel cells. But what’s
nanotech doing? Well, no proto-
type gadgets yet, but nationalgeo-

graphic.com reported the fol-
lowing back in January 2005:

“Scientists have invented a
plastic solar cell that can turn the
sun’s power into electrical energy…
The plastic material uses nan-
otechnology and contains the first
solar cells able to harness the sun’s
infrared rays… Like paint, the com-
posite can be sprayed onto other
materials and used as portable elec-
tricity. A sweater coated in the
material could power a cell phone
or other wireless devices.”

That “could power” doesn’t
sound convincing enough,
somehow: besides, we haven’t
heard anything about nano-
sprayed fuel since that press
release. Perhaps 2010 is a realistic
estimate for prototypes based on
that technology.

But coming back to fuel cell-
powered gadgets, they’re very
much there, except they aren’t on
store shelves yet. However,  2007
could well be the year.

Not Everything Is Rosy
For once, we end on a negative
note: will 2007 really be the year?
“Toshiba May Bid Laptop Batteries
Goodbye: New fuel cell, coming
next year, could provide 10 hours
of power for portable PCs.” That
was what IDG News Service
reported in March of 2003. Where’s
that fuel cell?

Also, once these gadgets are
out, we’re going to complain about
(a) size; (b) having to carry bottles
of fuel; and (c) the fuel spilling into
our pockets or handbags. But that’s
just human nature! 

ram_mohan@thinkdigit.com

Will someone please give the Energizer Bunny a run for its money?
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Robert Sovereign-Smith

Thus far, portable computing
is something that’s strictly
restricted to the upper

management levels of almost every
company. Unless your job role
specifically demands that you be
connected on the move, you’re not
going to be getting that company-
provided laptop you’re hoping for. 

Let’s say you’re one of the
senior sales executives in your
company. You haven’t reached the
level in your company as yet where
you’re provided with a laptop
and/or PDA. However, it would be
nice to have access to the latest
sales figures and perhaps informa-
tion that could help you make your
sales. A presentation or two
wouldn’t hurt either. Apart from
the company not willing to spend
the extra money, you also might
not be too keen on adding another
three or four kilos of weight to your
everyday luggage.

Convergence 
This word has made a huge impact
on portable computing. Before
you knew it, cell phones, which
used to be devices you only made
and received calls on, started offer-
ing basic PDA functionality. Next
came the camera phone, which
put a phone, a PDA and a basic
digital camera all into one ultra
portable device.

Needless to say, sales figures
went through the roof—everyone
wanted the MFD of communication
devices—and we have the success of
various Nokia and Sony Ericsson
“smart phones” to prove it. 

Stagnancy
Though technology improvements
are shrinking products faster than
ever before, the size of our fingers
are limiting further shrinkage.
Yes, it’s the human anatomy and
sight limitations that are keeping
devices such as cell phones at a
very standardised size. Too small a
display and no one wants the
phone; minuscule keypads also

bring down sales. However, with
smart camera phones getting bet-
ter by the month, it’s not hard to
imagine that cell phones will soon
be as powerful as the computers of
today. When you think about it,
current-generation phones
already have faster and better
processors than the first few gen-
erations of desktop computers! 

However, we need a revolution
in technology in almost every field
before we can make true portable
computing devices.

The Baddies
LCDs: Every mobile device
depends on this technology to pro-
vide screens. However, being frag-
ile and unbendable, they’ve limit-
ed hwo small laptops, PDAs and
cell phones can get
Batteries: We’re desperately seek-
ing more battery power for all our
devices. Just a couple of hours of
charge for regular use is not good
enough for them. What we need
are batteries that can last a day.
Though there are the options of
fuel cells and other battery tech-
nologies available, it just seems
easier to find components that use
less battery power.
Input Devices: Keypads, touch
screens, foldable keyboards—
almost every innovation has been
experimented with; we’re now left
with hoping that something revo-
lutionary comes along and
changes the way we interface with
portable devices. Smaller keypads
will just not cut it!

The Desire
OK, enough complaining! What
the world needs is a device that
has the functionality of a laptop,
in a size comparable to a pock-
etable cell phone. 

LCD technologies can be
replaced by paper displays—this we
already know. However, what if we
could project the display instead of
rolling it up? Perhaps even
h o l o g r a p h i c
displays

are worth looking at, provided
they’re made to be less power-
hungry. As of now, paper displays
seem to be the answer.

So, considering that we have a
cell phone with a powerful enough
processor that can run, say, an OS
akin to Windows XP, and use Flash-
based storage as the hard drive, all
that’s left is a cool way to somehow
bundle a full-sized keyboard into
the mix, and you’d have the ideal
portable computing gadget!

Thankfully, new technologies
from companies such as iBiz
(www.ibizcorp.com), such as their
infrared/laser keyboard, which can
display a virtual keyboard in front
of you on any surface you choose,
might finally do away with the
space troubles associated with
bundling a full sized QWERTY
keyboard into a device.

If all goes well, you should be
looking at the first ultimate
portable computer in less than
five years. A guesstimate, because
the technologies that will power
one are still being developed. But
if the market is there, can the
product be far behind?  

robert_smith@thinkdigit.com

I want to own a device that fits in my pocket and is as powerful as a laptop!

Ultimate Portability
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Nimish Chandiramani

It’s a beautiful day outside, but
you don’t care. It’s a beautiful
day inside, too—the installer for

your much coveted Linux distro
approaches the hallowed 100 per
cent mark as you rub your hands
in glee. You reboot into your new
OS, and oh horror! Your Ethernet
card isn’t supported! How are you
supposed to connect to the Inter-
net? As you poke around trying to
figure out what to do, you find that
even more of your hardware turns
up as “Unknown Device.” Count-
less profanities and numerous
clumps of ripped-out hair later,
you’re back to good old Windows,
and have vowed never to go a—
wandering for another OS again.

Meeting Ground
We are, of course, no strangers to
the desire for our applications to
run on all OSes, irrespective of
which one it was written for—
Windows, Linux, Mac, even
Amiga. And to a very reasonable
extent, this is quite possible,
thanks to Compatibility Layers
such as Wine, which let you run
Windows applications on Linux.
Applications give Wine the same
instructions that they do a
Windows PC, and Wine trans-
lates those instructions to make
them understandable to the
Linux PC. Ditto Darwine, the
Wine that will let Mac users run
Windows applications. 

While everything seems all
hunky-dory on the application
front, there’s a deeper, more
painful issue to be tackled—drivers.
Emulation takes a big bite out of
system performance, and for some-
thing as critical as device drivers,
the very idea of using emulation is
horrifying. The only answer is to
write drivers specifically for the OS. 

Right.

The Hidden Truths
A device driver is a piece of soft-
ware that lets the operating sys-
tem’s kernel talk to your PC’s
hardware. The driver gives the OS
a Hardware Abstraction Layer
(HAL), which basically obviates
the need for the OS to know exact-
ly what hardware it’s running on.
All it needs to do is tell the driver
what it wants the device to do—
the rest is up to the driver. 

Things start to smell a little
fishy here—if drivers are separate
from the main OS, why are they
tied so closely to it? A printer
driver, for example, will have a
function called print, which the OS
can use every time it wants to
print something. Since all device
drivers are written in C, they
should work with anything that
calls their functions. Believe it or
not, we already live in a world
where theoretically, device drivers
need to be written only once—they
can then be used in Windows,
Linux, Unix, and any other OS. This
means that you wouldn’t need to
go hunting for Linux drivers for
your hardware—if it was supported
in one OS, it’s supported in all!

The Bitter Pill
The reason we struggle so much
for drivers is that there’s no stan-
dard way for operating systems to
talk to drivers—Windows may say
print(), but Mac may say
printme() for the same function.
Windows has the WDM (Windows
Driver Model) standard, but it’s
just designed to work for all ver-
sions of Windows. Windows driv-
ers also come bundled with a lot
of (probably unnecessary) add-
ons. No real printer driver is 25

MB—it’s the additional utilities
like ink-level monitoring et al
that add to its bulk.

Linux, on the other hand, has
no real driver standard—drivers
can even stop functioning after a
kernel update! Moreover, each
distributor might modify the
kernel a little—imagine having a
Linux driver that doesn’t even
work with all distros. Eeyugh!

Are We There Yet?
Not too long ago, we stumbled
upon a project called DriverLoader
(www.linuxiant.com) that lets you
use Windows network drivers as is
in Linux, and without emulation,
too. It builds a wrapper around
the driver that simply links the
Linux instruction to the instruc-
tion in the driver as written for
Windows. If this were to keep
developing, we’d soon have a
Linux that didn’t care about driv-
ers—“Oh, I see you have Windows
drivers for this device. Oh well,
that will do too.”

The possibility of this desire
fulfilled—to never have to be
bound to an OS—is eerily possible;
so much so, in fact, that it’s a
wonder nobody thought of it yet.
Or have they?

ReactOS (www.reactos.org) is
a project that is working on
making an open source Windows
clone. It can run Windows appli-
cations and use Windows device
drivers with few or no hang-ups.
Later versions, the team prom-
ises, will also let you use applica-
tions and drivers written for the
Linux and Unix platforms,
making it possible to even run
Macintosh applications, though
probably not out-of-the-box just
yet. Could this be the next big
thing—the OS that runs every-
thing? We itch in anticipation.

Of course, there’s a better way
out than developing a whole new
OS—a single, universal standard
for developing device drivers that
all OSes will implement and all
device manufacturers will use.
That’s on our wish-list too—right
up there with world peace.  

nimish_chandiramani@thinkdigit.com

I never want to bother with drivers or compatibility again. Ever!

UtopiOS
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Sometimes, one good
question is enough to change
our lives. For me that one

question came like a bolt from
the blue in January 1997 when I
interviewed a certain
distinguished American
professor: “Why is it that you
produce software for the rest of
the world, but very little for your
own country?” he asked. 

The software exports business
was in a gung-ho mood, fears of
the Y2K bug was driving business
to Indian companies, and the
domestic IT industry was a poor
cousin of the dollar-earning
software exports business. 

I asked the good professor to
explain what he meant.

Professor Keniston had visited
several e-government projects in
rural Madhya Pradesh, Tamil
Nadu and other places, and
tracked their progress over the
years. A social psychologist by
training, he has a keen interest in
seeing how rural India uses
computers and the Web to
promote development, political
transparency, and social justice.

“Your country is very strange.
All software is available only in
English, an alien language.”

My first reaction was, “Why
should people who speak Hindi
and other Indian languages need
computers?” To my mind,
computers were an urbanised,
westernised phenomenon, and
the idea of rural non-English-
speaking people using computers
was an alien thought. 

The interview was published,
and we kept in touch. I kept
sending Keniston news items on
language computing, and

gradually developed an interest in
this area. A few months later, I
read about Harsh Kumar, general
manager of Konkan Railways,
who had developed Indian-
language fonts that he was giving
away for free. Manu Parpia, then
president of the Manufacturers
Association of Information
Technology (MAIT), liked the idea.
Manu and Vinnie Mehta,
executive director of MAIT,
helped us set up a stall at the IT
India/Comdex 97 event in Delhi
in December 1997, where we
launched these fonts. That was an
experience that truly brought
home the need that Prof Keniston
had so astutely perceived. 

At the event, Harsh and I were
giving demos of the Indian
language fonts. Many of the
people visiting our stall wanted

to know how they could use their
own computers in Indian
languages—and they wanted the
software NOW. Over the four days
of the exhibition, we gave away
thousands of copies of the fonts.

I spent 1998-99 traipsing the
corridors of MIT and Harvard
looking for appropriate,
affordable technologies that
could be brought back to India.
Most of the professors and
students there seemed to be
using a geeky OS called Linux. Of
all the cool, fantastic, futuristic
technologies that I saw, the one
thing that really stood out as
being beneficial to India was the
collaborative model of open
source software development
that led to the development of
programs like Linux. The idea
that sophisticated software
programs can be developed by

people collaborating over the
Internet and distributed for free
was highly exciting. 

After returning to India, I
joined the newly set up IIIT-
Bangalore. The remarkable Prof S
S Sadagopan encouraged me to
continue my research on bridging
the digital divide. It was at IIIT-B
that I wrote an article titled “Why
Linux Makes Sense for India.” The
thrust there was that if the
collaborative model of open
source was leveraged to localise
Linux and other open source
software to Indian languages, it
could spark off a grassroots
revolution and truly take IT to
the masses. The upshot of this
article was that Prakash Advani,
who was setting up a company
called FreeOS, came forward to
fund this effort. This led to the

creation of IndLinux.org, a non-
profit that localised Linux to
Hindi and worked with different
language groups across India.

Looking back, working with
Linux seemed very logical
because our objective was to take
computing to the masses. The
GPL ensured that our work would
be freely available.

Today, Linux and open source
software like Open Office are
available in all major Indian
languages. Within the next five
years, we will see a profusion of
Web sites, search engines, blogs,
and social networking sites evolve
around Indian-language
computing.

Looking back, I am struck by
the irony of it all. It took an
American to open my eyes to the
need for computing in Indian
languages! Such is life. 

“Within the next five years, we will see a
profusion of activity on the Web evolve
around Indian-language computing”
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With all the hype
surrounding Web 2.0, I
want to take a step

back and ask the question: what
is Web 2.0? Is it a term we use to
describe social networking sites
like MySpace or Friendster? Does
it mean any Web application
using AJAX? Is it “just better”
than Web 1.0?

I’d like to think of it as a
movement—an evolution—in the
way users and information
interact on the Web. The Web
doesn’t progress like software
from one version number to the
next; rather, it evolves
organically over time with the
introduction of new
technologies. Those technologies,
like AJAX, help drive the Web’s
progression from static content
to dynamic applications. Those
applications—such as Google
Maps and Yahoo! MyWeb—in turn
create new ways for users to
access, share, and shape content.

Today, Web-based
applications have the power to
tie that content together and
merge it with other Web
services for convenience, ease of
use, or greater functionality.
When we started Opera eleven
years ago, we envisioned a
browser that was a perfect
window into the multimedia
Web—a world filled with rich
video, images and content. But
now, as applications have
redefined the Web, so too have
we redefined the Web browser.
Rather than being a window
into a largely unchanging world,
the browser now serves as a
launching platform for
applications. 

With Opera 9, our newest
browser, we’ve made our own
leap into Web applications by
creating Widgets. Widgets are

small Web applications with a
specific function. It might be a
simple game or a meta-search
application now, but it’s easy to
picture the day when these are
full- featured Web versions of
existing desktop applications.
It’s also easy to picture the day
when the traditional role of
the desktop operating system
is reduced.

On your computer now, your
operating system probably
launches almost all your
applications. On your computer
four years from now, your OS
will exist to control a limited set
of applications, several system
tools, and most importantly,
launch your browser. All the
applications you currently use—
word processors, games, video
editors—will be accessed directly
from that browser.

Mash-ups are one early
example of the beauty of
Web-based applications that you
will soon access from the
browser. By aggregating
information from several Web
services, these mashups offer a
new level of usability and ease
for the consumer.

Shopping for a home? You
could keep several browser tabs
open with several real estate
agencies, maps, and other tools.
Jumping back and forth could
easily and quickly become a
nightmare. But if a mashup can
bring these tools together—in
one place—that convenience
gives you an immediate value.

If they can be launched from
your browser, applications can
go wherever a browser can. For
Opera users, this improved
accessibility means the browser
can launch applications on
portable devices such as the
Nintendo DS—or on many
mobile phones available today.

Extending applications to
mobile phones fundamentally
improves how consumers
interact with the Web. Today,
Opera is collaborating with two
Norwegian partners—FAST
Search and Transfer and
Telenor—to bring location-based
Web services and applications to
mobile phones.

Imagine entering your
destination into a Web site.
Since the site knows your
location, it can tell you not only
that the nearest bus stop is 100
metres away, but also that
the bus you want arrives in
two minutes.

But these innovations won’t
happen for Opera alone because
technologies at the heart of this
Web evolution are largely based
on open standards. Opera has
been a loud and long-standing

advocate of open Web standards
because they help ensure a level
playing field for all participants.
And they make it easy for
developers to do what they do
best—drive the innovation that
shapes the Web’s continuing
evolution.

I’ve talked a little about the
future. But the present excites
me, too. Developers working
today rely on these technologies
to push the boundaries on
applications and the Web. The
first Web revolution started with
a few individuals working into
the early hours of the morning
to create sites that consumers
could use. This revolution is in
the same infant stage:
developers toiling away on their
own or in small groups to create
something that has the power to
touch millions.

This has always been our
goal at Opera from our first
days in the offices at Telenor. It
still is. 

“Four years from now, all the applications
you currently use—word processors,
games, video editors—will be accessed
directly from the browser”
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Each time I have had the
pleasure of visiting India, I
have been overwhelmed by

the creativity and talent of its
people, and the growing
acceptance of open source
software. India is a country
steeped in history and driving
towards a positive future.

Unburdened by the legacy of
closed models that are common
in other places around the world,
India has moved forward on its
own ingenuity, building on the
technology foundations of Linux
and open source software.

Open source is creating
opportunities on a global scale.
Building an environment for
unprecedented collaboration.
Generating value for the
enterprise. Allowing the ability
for companies and countries to
compete in a worldwide market.

In the open source model,
innovation has no borders. There
are no restrictions. Whether
you’re building software in
Silicon Valley or Mumbai.

It’s clear that the restrictive
nature common to proprietary
software is eroding. The cracks in
the walls are starting to show. In
India, many of those walls were
never there in the first place.

One reason is that the open
source environment is inherently
flexible. This allows greater
ability to localise content—a
critical factor in providing viable
technology to India’s citizens. It
also creates the opportunity for a
compelling desktop operating
system for India.

I am also encouraged to see
India progressively move toward
the role of open source
contributor. India is using its
wealth of knowledge to build
solutions for India, as well as
contributing towards other areas

of the world seeking similar
solutions. Open source was built
in this way.

Around the world, access to
technology means more users.
And when users have the ability
and the means to contribute—
without geographical or
structural boundaries—growth
becomes exponential.

The opportunities are real
and they are enormous. And it
begins where access is needed
most. Red Hat is proud to be a
key contributor to the One
Laptop Per Child project.
Through this work, young
people, even in the world’s
poorest and remotest areas, may
have the chance to connect and
participate in society in ways
that were once impossible.

As open source continues to

rise to prominence, it presents a
new set of challenges for the
open source community and Red
Hat as a company. And as open
source software rises, so does the
fight to keep it open. But
software is only the beginning.
We now have to challenge to
keep open other sources of
content: music, text, even ideas.
All are interrelated.

We believe a key part of our
mission as a company is to
strengthen the social fabric
through the democratisation of
content. To foster an
environment where the work we
create is free from conditions of
artificial control. Where
individuals can access global
sources of information—
bypassing the traditional
gatekeepers.

The advance of technology in
the last 10 years has given us a
gift. The gift is the opportunity
to rebuild the collaborative social
structures that have eroded in

our communities. But not to
rebuild simply what we came to
accept before, instead to build a
new social fabric. A fabric that
connects people as neighbours
who may be continents away. A
fabric that unites people with
like interests, while ignoring
artificial barriers like race,
religion, power, money. A fabric
that celebrates and nurtures
great ideas, no matter where
they come from.

The lessons we have learnt of
the power of collaboration can
now translate beyond building
software. It is time for us to take
our process and share it with the
world. To change lives through
teaching people how to build and
connect ideas in the way that we
in the open source movement
have learned to do.

As in software code, when
content is open all of us can
learn from it, build upon it, and
use it to create.

When we are free to develop
new content in an open way—
that’s when knowledge will
progress at a the kind of pace
that India has seen with building
technology infrastructure around
open source. At Red Hat, we want
to teach people how to develop
content with the intent of
sharing it.

I ask, how would the human
condition change if millions of
people around the world were
building on each others ideas.
Sharing, collaborating—without
artificial restriction. This was the
promise of the library, and now
of the Internet on a global scale.

I want to thank my friends in
India who have worked so hard
to adopt and contribute to open
source technology. The impact of
your work is recognised around
the world. 

“Software is only the beginning. We now
have to challenge to keep open other
sources of content: music, text, even ideas”
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The world has gone mobile.
Just look around. Laptops
are everywhere, Wi-Fi

hotspots are in airports, hotels,
and street corners, and over 200
million people in India own a cell
phone! The mobile computing
revolution began years ago with
laptops built upon Intel Centrino
technology and it has grown
rapidly ever since. Now get ready
for the next revolution as the
Internet gets more personal with
ubiquitous connectivity, new
form factors that blur the lines
between cell phones and laptops,
and amazing new human
interfaces.

One tenet for the future of
mobility lies in completely
ubiquitous connectivity. Not the
islands of connectivity that we
have with today’s generation of
Wi-Fi hotspots, but complete
connectivity. Whether you’re
stuck in traffic in Bangalore or
working in your village or farm,
you will always be connected to a
high-speed, high-bandwidth data
and voice network.

WiMAX promises to deliver
mobile, wireless broadband
connectivity with 1 to 5 Mbps at
ranges up to 70 km. Wi-Fi gives
coverage like a cordless phone;
WiMAX offers coverage like a cell
phone. In pursuit of making
WiMAX a true global standard,
Intel is working with legislative
and regulatory bodies worldwide
to establish 2.3-2.5, 3.5, and 5 GHz
as global frequency bands for
WiMAX. The spectral efficiency
and extended coverage
characteristics of WiMAX make it
ideal to provide significantly
lower cost-per-data-bit mobile
broadband connectivity in places
where there is no other means of
providing broadband
connectivity. We are encouraging

regulators to rapidly allocate
large blocks of spectrum in a
technology-neutral way.

As users get more connected,
opportunities present themselves
for new and exciting form factors.
Today I have incredible
functionality with my notebook
PC, but it’s just too large.
Smartphones are wonderful
communication devices, but are
severely limited in software
compatibility, are limited in
bandwidth, and offer only
compromised data services. The
future will be the best of both
without compromises. A new
category of device is emerging,
which blurs the line between
laptops and cell phones: Ultra
Mobile PCs (UMPCs). Intel and
several of its partners announced
plans for the first of these devices

earlier this year. They will be
roughly four to seven inches in
size. Despite their size, these are
complete personal computers
including wireless connectivity, a
full-fledged OS optimised for
mobility, and a breadth of
applications. Docked to an
external display and a keyboard,
these devices will feel just like
your laptop does today.

PCs have made only modest
advances in terms of their user
interface. Smartphones are even
worse; they have tiny thumb
boards or stroke and stylus
interfaces that are even more
foreign for a human.
Fundamentally, humans have
needed to adapt to computers,
not computers adapting to
humans. While speech
recognition has made progress,
its use is quite narrow and its
quality remains poor. Now,
though, we are on the verge of
having enough computing
capability to provide multi-modal

human interfaces that seamlessly
combine multi-channel, high-
quality voice with stereo vision
on the input. On the output side,
we’re likewise soon to see high-
definition sound, video, and
graphics rendering systems. The
combination will present the
most dramatic step in human
computer interfaces since the
move from DOS to Windows:
computers that can listen, see,
and provide both semantic and
contextual recognition and
learning capabilities. 

India’s GDP is projected to
grow by about 7 per cent this
year, making it a prime target of
growth for many goods and
industries. Technology is expected
to grow even faster, further
fuelling disposable income
within this populous nation.

With 54 per cent of the Indian
population below the age of 25
years, at a macroeconomic level
the technologies I’ve described
above will help drive both higher
productivity and higher growth
rates for the economy. Your
ability to “Go Mobile” plays a
critical role at many levels of the
economy from the rural to the
urban. As a nation, these
technologies are critical to
enabling the continued rise as a
global IT innovator and exporter.
In cities, these technologies will
help professionals become more
productive and help them
conduct their business in a
seamless fashion. In rural
communities, they will help
people get connected with
technology advancements,
furthering their businesses and
educational opportunities. The
future of mobile computing will
enrich all our lives and will help
further connect India to the
worldwide economy. 

“Get ready for the next revolution: there
will be new form factors and amazing
new human interfaces”
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The performance and
connectivity of PCs is
coming to the world of

consumer electronics.
Combining the convenience
and remote control of many
consumer electronics devices
with the rich content available
to PCs over the internet,
consumers can enjoy the best
of both worlds on their own
terms, from the comfort of
their living room.

Worldwide, consumers are
becoming more technically
savvy and demanding of the
technology they use in their
everyday lives. Trends clearly
show that PC and Internet
users want to share media
between their digital devices
throughout their home, on
their own terms. One study
indicates that by the end of
2007, 183 million devices will
be connected in a home
entertainment network. While
the numbers will vary from
country to country, consumers
will demand to experience
entertainment “on their own
terms.” This is the core of the
digital home vision. 

Intel’s Viiv technology, for
example, is designed to deliver
a great digital entertainment
experience in the home.
Consumers can download their
favourite movies and songs. You
can record live TV with an
optional TV tuner card and
remote. Organise and share all
your photos. Or play games
with competitors from around
the world. You can now do it all
from the comfort of your
couch—with a click of your
remote control.

At the heart of Viiv is a
suite of hardware and software
that offers new entertainment

experiences. Consumer
electronics-like features for
simplified entertainment will
make devices in the digital
home more fun and easy to
use. After initial bootup and
when enabled on the system,
consumers will have the ability
to instantly turn Viiv-enabled
PCs on and off, similar to a TV.
The PC keeps functioning even
after it’s turned “visually off”:
for example, while the PC in
the living room looks like it’s
off, it can still continue to
stream music through a digital
media adapter to the connected
bedroom stereo.

Enhancing performance and
responsiveness are the latest
processors supporting dual-core
computing, which is uniquely
suited for multitasking and

multi-user entertainment.
Intel has driven greater

cross-industry support—such as
the Digital Living Network
Alliance (DLNA)—by
collaborating on specifications
for accelerating the
development of interoperable
products, while also striving to
to make premium digital
content available, because
hardware or devices alone will
not deliver the digital home
vision. A continuing stream of
first-class digital content will
make the power of new digital
devices even more appealing.

Driving the multi-faceted
digital home vision also
requires a serious commitment
by PC and CE industry leaders
to collectively develop
guidelines and specifications
for interoperability.
Historically, these industries
have followed independent
product development paths
based on different

technological foundations.
Because their two sets of
products weren’t built on the
same technologies, they
typically don’t work together.

Recently, to help drive
greater cross-industry support,
a cross-industry group to
collaborate on specifications
for accelerating the
development of interoperable
products was formed. The
Digital Living Network Alliance
(DLNA) aims to simplify the
sharing of digital content
among networked CE devices,
mobile devices and PCs.

Leading entertainment
providers worldwide are
working with Intel to enable
countless hours of on-demand,
Internet-delivered, digital
entertainment that is easy to

access and enjoy on Viiv-based
PCs connected to a choice of
screens in the living room—or
even on the go.

The Personal Computing
and Consumer Electronics
industries are riding a massive
digital media wave, buoyed by
the rise in broadband Internet
access, escalating consumer
interest in all things digital,
and cross-industry efforts to
satiate that interest. The
launch of Viiv in early 2006
demonstrated the need to
accelerate the realisation of the
digital home vision, where
consumer electronics and
computing devices interact
transparently, and personalised
content can be delivered on any
device, anytime and anywhere.

You will soon be able to
download entertainment from
the world’s biggest online
providers. If it’s out there—
movies, music, or games—you’ll
be able to get it. Instantly. 

“Driving the digital home vision requires
a serious commitment by the PC and CE
industries to collectively develop
guidelines for interoperability”
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Mobility is the in thing now, especially since the prices of
these increasingly convergent devices are falling. We put the
cells of today under our microscope and bring you the low-
down on the best, as well as the rest
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ability to work with Word and Excel sheets and
PDA viewing aren’t up-market anymore. A mid-
range cell phone now sports all these and what’s
more, even throws in a couple of extras, making
it a true converged device.  

The Indian market is especially competitive,
and customers want all possible features on their
cell phones, while they might not be willing to
pay exhorbitant prices anymore either!     

Improved network coverage and GSM service
provider facilities coupled with the sharp
decline in the prices of mobile phones have all
gone a long way in ensuring a market that is
expanding, even as we write.

In this comprehensive cell phone shootout
we’ve reviewed 47 cell phones from all major
players. Will definite winners emerge? Will the
big names in the mobile arena reign supreme,
or will one of the minnows steal their thunder?
Read on to find out...
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Digital

Michael Browne and Kailas Shastry

Cell Phones no longer confirm to the  brick-
like form factor of yesteryear! Their shape,
features, performance as well as their bat-

tery life has improved substantially over the
years. Not only has the cell phone adapted to its
user, more and more people in India are getting
on to the ‘Go anywhere, Connected everywhere’
bandwagon. Cell phone manufacturers have also
noticed this trend and are making concerted
efforts to provide for a vast range of models to
pacify every singulare need of thier customers.

A typical urbanite wants something that goes
as well as it shows, and typical high-end-device-
like features have well and truly trickled into the
mass market. For example, a megapixel camera,
fully featured MP3 player, and FM radio along
with business features such as complete PIM,

Digital Passion l Lead Feature

Fuelling the pursuit of technology knowledge
30 days with...

Passion
Digital

Canon PowerShot S3 IS124 126
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Digital Passion l Cell Phone Test

FEATURE RICH CELLPHONES &
SMARTPHONES
The cell phones in this category ranged from
Rs 10,000 to 22,000, a very large range price-
wise, but nonetheless, comparable in terms of
features. These phones represented the high-
and upper-mid-end products that all manufac-
turers across the board provided us with. The
cell phones we received in this category were
perhaps the most diverse, in terms of looks,
functionality, and definitely, price. In all fair-
ness, it’s impossible to compare a Rs 10,000
phone with something that costs over Rs
20,000—regardless of whether they fall into the
same category or not. In order to be objective,
we’ve divided these phones into three cate-
gories, based on the assumption that India is a
very price conscious market. Moreover, each
phone has to justify its price.

Rs 10,000 to Rs 12,000
In the Feature Rich category the first mini battle
takes place between the Nokia 6600, 7360, and
Motorola E398. The Nokia 7360 is the lightest of
the three, and is part of Nokia’s L’Amour—phones
that women would want to flaunt. The phone
looks snazzy, but we were surprised that it didn’t
offer Bluetooth connectivity (wireless connec-
tivity includes IR only). 

The Motorola E398 impressed us with its
build quality—very solid! This is a no frills phone
that supports Bluetooth, as well as expandability
via a Transflash card—Transflash is advanta-

100

geous as it has a very small form factor along
with fast transfer rates.  

The last phone in this group was Nokia’s
6600, an ageing model, albeit one of Nokia’s best-
selling models of yesteryear. The 6600 shows lack
of sharpness in its display, which isn’t too notice-
able at first, but becomes more pronounced as
one compares it to some of the newer models.
Although spec-wise the screen is a 65K colour,
with a 176 x 208 resolution—identical to most
Nokia’s—the difference is definitely noticeable.
Another point against the 6600 is its keypad,

which is hard when compared to the
newer crop of cell phones. The E398
also has a keypad that lacks feedback,
something to note for SMS junkies,
who want to do a lot of typing. The
6600 does manage to hold its own
when it comes to functionality, this is
a fully functional Symbian Series 60
smartphone, and can hold its own as
far as PIM functions go. The menu
layout is more intuitive and easy to
navigate then the other two models.

As far as camera quality goes, with
VGA class cameras that offer a pixel
resolution of 640 x 480, these cameras
were never going to be anything great.
The E398 and the 6600 were the losers
here, with a slight lead in image
quality going to the newer 7360. All in
all, the image and video quality across
all the models wasn’t worth much fan-
fare, with the video playback getting
distorted and blurry at times.

The Segregation
One of the most subjective tests of them all, testing cell phones is
never easy. Specifications can be noted down, but there are just so
many impressions, so many facets of a cell phone that cannot be
numerically represented. We received 47 cell phones for testing.
These ranged from the very basic phones to the high-end PDA’s,
with prices ranging from Rs 2,500 to Rs 60,000. Now that is a very
large price band, which is impossible to compare head-to-head. 

To start off, we divided the cell phones into 5 categories, based
on price and features. First, we classified the basic and mid-end
phones into two different groups, with the basic group consisting
of phones up to Rs 5,500. The mid-end phones were those that
cost between Rs 6,000 and Rs 10,000. These categories were
considered budget categories, and the weightage was on basic
features and functionality here.

The phones that cost between Rs 10,000 and Rs 22,000 were
considered the feature-rich and multimedia cell phones, these
were awarded points for expansion, multimedia playback,
presence of a camera and its quality, as well as the functionality. In
case some phones lacked basic features, we were more severe with
our point deductions—after all, a costly phone should have all the
features of a cheaper model, and more.

The phones that fell under the Lifestyle category weren’t pitted
against each other, because of the fact that people who buy such
phones are looking to make a fashion statement, and such tastes
are very personalised. The phones that made it into this category,
did so because of their sheer flaunt value.

The Business category was made up of five phones that offered
PDA-like functionality, such as the ability to create and edit office
documents (Word, Excel, PowerPoint) and PDF files. 

The Process
We tested all the phones for their ergonomics and ease of use, if
there were any quirks—such as a hard keypad, un-intutive menu
structures, etc.—were noted down, and points were deducted. Even
finer nuances, such as the body structure, build quality, keypad
backlighting, etc., was all taken into account. The actual phones
were tested for menu layout, and ease of use of the features
present, besides the usual signal quality and integrity tests, which
were carried out simply by dialing the mobile from a landline
number, the mobile was carried around to places of weak
reception and the voice quality was judged and points awarded.
The final score was the aggregate of the max and min signal areas. 

The feature-rich category was also tested specifically for
camera quality, multimedia playback quality, screen quality, as
well as additional functions such as ability to work with office
documents. These phones were also awarded points for the
expandability they provided. The usual gamut of signal reception
tests were also carried out. 

The Lifestyle series were also put through the same
rigorous testing procedures as the others, but they weren’t
pitted against each other. Any peculiarities were however
noted, and in case of any essential functionality found lacking,
this was included in the article.

Finally the PDA/business category of phones, these were
tested for office productivity and connectivity like Wi-Fi, the
regular multimedia tests done on the feature rich phones wasn’t
carried out on this category simply because the target audience
for such phones will not be likely to go on a photo clicking
spree. However music and video playback was tested, as well as
the usual call and voice clarity tests. 

How We Tested

FIFTH ANNIVERSARY

The Sony-Ericsson K750i—Small Wonder
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Coming to multimedia playback, the 7360
loses out big time due to lack of expandability,
MP3 playback was decent however, with the 6600
and E398 offering similar music and viewing capa-
bilities. Almost all the phones in this category—
even the ones in the next price bracket— play both
MP3 and AAC files, so it’s just overall music play-
back quality we tested. As far as video playback
goes, 3GP is the format of choice of format for cells.
Why? Because the format is resource easy, is free
and small in terms of file size, therefore video
quality tests were done in 3GP format.  Nothing
much to report on the music and video front, as all
these cells are more or less similar in terms of
quality of content playback offered.

In terms of productivity, the Nokia 6600
offers the ability to view MS Word, Excel and
PowerPoint documents, ditto the 6270, the E398
misses out here. As far as editing existing office
documents go, none of these phones will allow
the user to do any writing or spreadsheet work.
Even the other Symbian cell phones have been
designed to allow reading only.

One problem with the Nokia 6600, which
deserves a mention, is its slow processor, one of
the slowest across all the categories of phones
tested. Using a large capacity memory card will
only aggravate this, and video playback can get
a little choppy. This is one cell that could use
more processing power.

Rs 12,000 to Rs 15,000
Moving up the price ladder a bit, we have a fairly
decent number of phones priced between Rs
12,000 and Rs 15,000. These phones represent
what the discerning user will actually look at.
We were also a stricter as far as music and
camera quality are concerned, simply because a
costlier phone, while not comparable to a

The Sony Ericsson W550i—Looks good, sounds better

Photographs A
m

rut Patki
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cheaper one, is supposed to do better in most, if
not all of the tests thrown at it.

Looks-wise the Philips 768 really took us by
storm, it’s small, sleek and curvy, with mock
chrome and a steel grey-silver finish that was as
appealing as water in a desert! It’s got the func-
tionality as well, with a more than decent
camera and integrated flash. The keypad layout
is good, the joystick is fluid, and the keypad
backlight is a cool blue that is functional
without being intrusive. The 768 has a good dis-
play that’s clear and crisp. If looks were all that
mattered we’d have a winner here.

The Nokia 6630, despite its pluses, has an odd
shape—the bottom of the phone widens out,
giving the base a much larger rounded foot-
print—that some love to hate, and others hate to
love! The Nokia 6260, the only clamshell model
here, featured a swivel screen, but is still nothing
special. The Sony Ericsson W550i, sported the
most unconventional look and colour, with a
bright orange and silver body, giving it a young
and trendy feel. The Nokia 6670 looks like a more
serious version of their funkier looking 7610. 

Coming to camera quality the Sony Ericsson
K750i completely ruled the roost, followed by the
Nokia 6630 and 3230 and Samsung X700. The
autofocus feature on the K750i works well, we
were able focus on the object first and then
shoot. What happens is pressing the camera
button slightly will result in a small focus
window, which automatically focuses just like a
camera. The 2.0 megapixel camera also meant
that in terms of raw pixel count, this camera was
way ahead of the other in this price range. 

The Nokia 6630 was a distant second, with its
large lens and camera rated at 1.3 megapixels. A

neat feature was the zoom of the 6630, it’s
absolutely smooth. The smoothness of the zoom
was even better than the K750i. The Nokia 3230
and Samsung X700 fought it out for the third
place, the quality of images and video being
about equal, though the edge would probably go
to the Samsung, due to its crisper screen.

As far as overall image quality goes, while
these cell phones certainly aren’t in digicam ter-
ritory yet, they are slowly getting within
striking distance. Daylight shots are definitely
good, with some very high quality images.
Engaging Night Mode, or photo shooting in dim
or dark lighting conditions is where all the cell

phones lose out, and badly. Video
shooting under these conditions is
even worse. There is no way that any
of these cell phones can be used for
after dark shooting. The K750i also
gave the best quality video shooting,
followed by the 6630. 

The Nokia 6260 gave some of the
lowest quality shots, testament to its
ageing sub-megapixel camera. A sur-
prise bad performer here was the
W550i, its 1.3 megapixel camera just
did not live up to its technical specs,
and our expectations. 

As far as screen clarity goes, the
Nokia 6630 is just great, owing to a
very classy looking set of default
icons, with a sort of shadow effect
around them, overall a very profes-
sional businesslike look! Seeing as
it’s a 65K colour screen, we couldn’t
spot any discernable difference
between this and the 262K screens.

FIFTH ANNIVERSARY
Digital Passion l Cell Phone Test

“Symbian is addictive”, said a user, very recently on a
popular forum. What is Symbian? Symbian is the

operating system used by most smartphones these days. This
replaces the typical firmware, with an actual OS, which
supports installation and removal of compatible applications,
to improve usability and productivity of the cellphone.

There are different series of operating systems for
different phones. The Symbian 60, 80 and 90 series are
open-ended platforms used exclusively by Nokia. Similar is
the Symbian UIQ platform used by Sony Ericsson, for their
high-end P series smartphones. Some bestselling examples of
Symbian devices are the Nokia 7650, 6600, 6630, 7710, N70,
and Sony Ericsson’s P800, 900 and 910 cellphones.

Symbian based smartphones could very well replace the
PDA in the near future. A typical ‘road warrior’ manager, has
to be productive in office as well as in the back seat of a
taxi. To do so he typically needs three gadgets, his laptop,
his PDA and his cell phone. While on the move, a laptop
becomes an encumbrance of sorts, and could actually hinder
productivity. The PDA typically alleviates this problem, while
losing out on the ability to stay connected. This is where the
cell phone, or rather smart cell phone scores. 

One of the major reasons why Symbian enjoys advantages
like much speedier interface and improved security over even
a PDA OS like MS Windows Mobile, is the use of the Symbian
C++ development platform as compared to the .NET
framework that Windows Mobile uses. With support for
features like multi-threading, memory protection and pre-

emptive multitasking Symbian is not only faster, but more
robust for day to day mobile needs also.

One of the reasons for insufficient penetration of Symbian
in the handheld market is the dearth of Symbian C++
programmers. The learning curve of Symbian C++ is such that
even C++ and Java professionals have to spend a lot of time
learning its ins and outs. This isn’t the case with Windows
Mobile as the .NET development environment is very
programmer friendly. Another limitation of Symbian is that
the OS was designed for use on the ARM series of processors.

One of its biggest merits is the support for third party
applications. The Symbian OS is so flexible that keeping a
series in mind applications can and have been developed for
use on Symbian phones. The best possible example is perhaps
the Nokia 6600, one of the first series 60 smartphones.
Applications developed for it range from Web browsers to
even applications that allow your cell phone to act as a
remote control for certain TVs and DVD players. In fact, more
applications were developed for Symbian OS phones than all
other OS-based cell phones combined! Symbian has another
very significant advantage—it’s very stable, more so than
Windows Mobile, and infinitely more so than firmware
phones, which are prone to errors and freezeups. 

We must also keep in mind that Symbian was designed not
for high-end PDAs but for handheld devices with limited
resources, (like smartphones), this makes Symbian the near
perfect platform for multimedia phones and smartphones.

SYMBIAN Or NOT

The Samsung X700—The best screen in
its class

JUNE 2006
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The Samsung X700 also has a very good display
with excellent clarity and crispness, maybe more
so than the 6630. Views differed about a winner,
leading to some heated arguments, followed by
more testing, until the decision was made,
they’re both good! The Sony Ericsson K750i,
W550i and Nokia 3230 all deserve a mention
here. As mentioned above, the X700 has a bril-
liant display, one sore point is it could have been
a bit larger, (one reason why it lost a couple of
points to the larger screen Nokia), which is the
same gripe with the K750i. This is one area
where scoring was very difficult, kudos to man-
ufacturers for improving the screen quality
many fold for the current generation phones.

Coming to MP3 playback quality, which is
one of the selling points of multimedia cell
phones these days, the winner is the Sony Eric-
sson W550i. This phone is part of Sony’s
‘Walkman’ series, and features stereo widening,
(a DSP effect), which greatly enhances sound
clarity and volume. Unlike some of the other
phones, the W550i can go really loud, without
distortion and we’re talking without the head-
phones! When you plug these in, its like listening
to a mini concert, they’re really so good. Nothing
else comes close! Not in this price category, or
for that matter any other. If MP3 masti is all you
really want out of your cell, (apart from the cell
phone features that is), you can blindly get the
W550i! The only pain will be, as we mentioned
the lack of expansion.

Second place goes to the K750i, which
although a tad shy on the volume, (as compared
to its musically brilliant companion above), is
high on quality and fidelity. These two Sony Eric-
sson phones were in a league of their own, as far
as music playback goes. The Nokia 6630 and 3230
make a decent showing here, with stereo play-
back, they both sound more than decent with
headphones, and clarity is good, it just ain’t got
the decibels! The Siemens SL75 along with the
6260 brought up the rear, with the Nokia 6260
sounding pathetic, not loud enough, and with
distortion even with the earplugs on. Being an
earlier model is an excuse, but look past the 6260
if MP3 playback is important to you.

Another area in which phones in this cate-
gory are supposed to deliver is storage capacity
i.e. expandability. Not much use having a great
camera and MP3 player if you cannot store more
than a few numbers of video clips right? 

The Sony Ericsson W550i and the Siemens
SL75 were the only two cellphones in this range
that didn’t come with any memory expansion.
This is a definite minus point considering the
need for storing all that multimedia content.
The W550i does have a very respectable 256 MB
onboard—which is quite a lot for a cell phone,
and more than enough for a few MP3’s and
videos. All other cell phones had expansion in
the form of memory cards, with capacities up
to 1 GB. Nokia’s latest cell phones have support
dual volt RSMMC, (or Reduced Size Multi Media
Cards), which are around half the size of an
MMC card. Sony Ericsson’s cellphones that have
expansion slots feature the Memory Stick Duo—
a Sony proprietary memory card. The Philips
768 featured a Mini SD memory slot, while the
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Scoreboard  FEATURE RICH PHONES  

Compact; 
sturdy build
Low screen & 
camera 
quality

Application 
compatibility 
VGA camera,
slow processor

Cramped 
keypad
No expansion 
slot, low-res 
cmaera 

Fast CPU, 
excellent 
keypad layout 
Bulky

Large Keypad 
Low-res 
camera, one- 
handed opera-
tion difficult 

Application 
compatibility
Very ordinary 
camera, odd 
keypad layout

Good screen,
FM support 
Bulky; slow

Nokia
6600

Candybar

Tri-band
109 x 58 x 24
122
3.5
3.5
2.75
3.25
3.5
2.75

176 x 208
65
1000
8
6
✔

✔

6
✔/MMC
64
✖

GPRS
Bluetooth, USB

640 x 480
✔/176 x 144
✖/✖

✔

✔

✖

✔/✔/✔

3 / 200

3.25
3
2.5
2
2

35.28
15.64
9.32
60.23
10,729

Nokia
7360

Candybar

Tri-band
105 x 45 x 18
92
3.5
3.25
3.75
3
3.5
3.5

128 x 160
64
1000
6
6
✔

✔

4
✖

✖

✖

GPRS, HSCSD, EDGE
IR, USB

640 x 480
✔/128 x 96
✖/✖

✔

✔

✔

✔/✔/✔

4 / 450

3.25
3.5
3.5
3.25
3

38.82
19.91
9.61
68.34
10,409

Nokia
6670

Candybar

Tri-band
108.6 x 53 x 20.9
120
3.5
4
4
2.75
3
3.25

176 x 208
65
1000
8
5
✔

✔

8
✔/RSMMC
64
✖

GPRS
Bluetooth, USB

1152 x 864
✔/176 x 144
✖/✖

✔

✔

✖

✔/✔/✔

4 / 240

3.25
3.25
3.5
3
3

36.53
19.28
9.37
65.17
12,279

Nokia
3230

Candybar

Tri-band
109 x 49 x 19
110
3.5
4
4
3
3.25
3.25

176 x 208
65
1000
8
5
✔

✔

6
✔/RSMMC
64
✖

GPRS, EDGE
IR, Bluetooth, USB
6
1280 x 960
✔/176 x 144
✖/✖

✔

✔

✔

✔/✔/✔

4 / 150

3.25
3.25
3
3
2.75

41.97
18.45
8.96
69.38
12,829

BRAND
MODEL
Features 
Design and Ergonomics
Form Factor  (Candybar,
Clamshell, etc.)
Support for Network Bands
Dimensions (mm) L x W x D
Weight (gms)
Build Quality / Fit and Finish
User Interface
Navigation
Keypad Layout
Keypad Comfort
Keypad Backlight
Basic Phone features
Display Resolution (pixels)
Display colours (K)
Address Book Capacity
No. of Lines Displayed in Message
Number of Profiles
Themes
Support for Installing New 
Applications / Games
Memory 
Phone Memory (MB)
External Memory Slot / Type
Memory Card Provided (MB)
Hot-Swappable
Internet: GPRS/HSCSD/EDGE
Connectivity: IR/Bluetooth/USB/Wi-Fi
Camera
Image Resolution
Video Capture / Resolution
Lens Protection / Mirror for
Self Portrait
Extra and Miscelleneous Features
Ability to Adjust Brightness/
Contrast
MP3 Capability
FM Radio
Voice Recorder / Voice Dialling /
Handsfree Speaker 
Talk Time / Standby Time 
Performance
Signal Reception 
Voice Clarity
Processing Speed
Quality of Captured Image
Quality of Captured Video 
Scores
Features (out of 60 )
Performance (out of 30)
Price Index (out of 10)
Overall Score
Price (Rs)

Motorola
E398

Candybar

Tri-band
108 x 46 x 21
108
3.25
2.5
2.75
3.25
2.75
3.5

176 x 220
65
1000
8
3
✔

✔

5
✔/Transflash
64
✖

GPRS
Bluetooth

640 x 480
✖

✖/✔

✔

✔

✖

✔/✔/✔

7 / 240

3
3
3
2
0

33.59
14.10
9.71
57.40
10,295

Nokia
6630

Candybar

Tri-band
101 x 60 x 21
127
4
4
3.25
4
3.75
4.5

176 x 208
65
1000
8
6
✔

✔

10
✔/RSMMC
64
✔

GPRS, HSCSD, EDGE
Bluetooth, USB

1280 x 960
✔/176 x 144
✖/✖

✔

✔

✖

✔/✔/✔

3 / 260

3.25
3.25
4
3.5
2.75

41.35
20.25
8.28
69.88
13,889

Nokia
6260

Clamshell

Tri-band
109 x 42 x 23
125
3.25
3.25
3.25
2.5
2
3

176 x 208
65
1000
8
4
✔

✔

6
✔/RSMMC
32
✖

GPRS
IR, Bluetooth, USB

640 x 480
✔/176 x 144
✖/✖

✔

✔

✔

✔/✔/✔

4 / 200

3.25
3.25
3
2
2

37.89
16.58
7.83
62.29
14,689
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FEATURE RICH PHONES  

Great looks, 
great shortcut 
keys
None in partic-
ular

Great screen 
MP3 player 
cannot play in 
background

Looks cute 
Screen lacks 
clarity

Excellent music 
quality, snazzy 
design 
Camera not 
good enough

Good camera
and music play-
back 
Small display

Decent camera,
good screen
Bulky; slow 
processor

Great display,
slick slider,
good camera
Expensive 

High-quality 
music player, 
good camera 
Cramped keypad;
expensive

JUNE 2006

Samsung
D600

Clamshell

Tri-band
96 x 46.5 x 21.5
103
3.5
4
3.75
3.5
3.25
3.5

240 x 320
262
1000
7
4
✔

✔

72
✔/MicroSD
✖

✔

GPRS, EDGE
USB, Bluetooth

1600 x 1200
✔/352 x 288
✖/✔

✔

✔

✖

✔/✖/✔

7 / 300

3.5
3.5
4
3
3

43.13
20.55
7.38
71.06
20,999

Nokia
N70

Candybar

Tri-band
108.8 x 53 x 21.8
126
4
4
4
3.25
3.75
4

176 x 208
262
1000
8
6
✔

✔

35
✔/RSMMC
64
✔

GPRS, HSCSD, EDGE
Bluetooth, USB

1600 x 1200
✔/176 x 144
✔/✖

✔

✔

✔

✔/✔/✔

3.5 / 260

3.5
3.5
3.5
3.75
3.25

46.88
21.08
7.05
75.01
21,989

Philips
768

Candybar

Tri-band
101 x 44 x 18
85
3.5
3
4.5
3
2.5
3.75

176 x 220
262
1000
6
5
✔

✔

10
✔/MiniSD
✖

✔

GPRS
IR, Bluetooth, USB

1280 x 960
✔/176 x 144
✖/✔

✔

✔

✖

✔/✔/✔

4 / 300

3.25
3.25
3
2.75
2.5

39.59
17.93
9.58
67.10
12,000

Samsung
X700

Candybar

Tri-band
108 x 44 x 19
95
3.75
3.75
3.75
3.5
3.25
✔

176 x 220
262
1000
8
4
✔

✔

35
✔/MicroSD
✖

✔

GPRS
Bluetooth, USB

1280 x 960
✔/176 x 144
✖/✔

✔

✔

✔

✔/✖/✔

7.5 / 450

3.5
3.25
4
3
3

42.89
20.21
7.82
70.92
14,699

Nokia
6681

Candybar

Tri-band
108.4 x 55.2 x 20.5
131
3.75
4
4
3.25
3.5
4.25

176 x 208
262
1000
8
6
✔

✔

8
✔/RSMMC
64
✔

GPRS
Bluetooth, USB

1280 x 960
✔/176 x 144
✔/✖

✔

✔

✖

✔/✔/✔

6 / 240

3.25
3.25
3
3
3

39.56
18.68
9.45
67.68
16,409

Sony Ericsson
W550i

Swivel

Tri-band
102 x 46 x 14
80
3.5
3
2.5
3.25
3.25
3.5

176 x 220
262
510
6
4
✔

✔

256
✖

✖

✖

GPRS
IR, USB

1280 x 960
✔/176 x 144
✔/✔

✔

✔

✔

✔/✔/✖

7 / 300

3.25
3.25
3.5
2.25
2.25

36.61
17.70
8.59
62.90
13,395

Siemens
SL75

Slider 

Tri-band
92 x 48 x 23
99
3.25
2.25
2.5
3
2.5
3

132 x 176
262
1000
9
4
✔

✔

52
✖

✖

✖

GPRS, EDGE
Bluetooth, USB

1280 x 960
✔/176 x 144
✖/✔

✔

✔

✖

✔/✔/✔

5/300

3.25
3.25
3
2.25
2.25

38.15
17.10
7.67
62.92
14,990

Sony Ericsson
K750i

Candybar

Tri-band
100 x 46 x 20.5
99
3.75
3.5
3
3.5
3.25
3.5

176 x 220
262
500
6
7
✔

✔

38
✔/MS Duo Pro
64
✔

GPRS
IR, Bluetooth, USB

1600 x 1200
✔/176 x 144
✔/✔

✔

✔

✔

✔/✔/✔

9 / 400

3.25
3.5
3.75
4
3.5

44.76
21.56
7.67
73.99
14,995

JUNE 2006
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Samsung X700 had a Micro SD slot, which is
about half the size of Mini SD. Note that these
memory standards are incompatible with each
other for the most part—except MMC and
RSMMC, for which an adapter can be used. For
exchanging data between non-alike cards, a
card reader will have to be used. 

Coming to support for document viewing,
once again all the Symbian based
Nokia phones had the option to view
MS office documents. This is a defi-
nite plus, but not necessarily a judge
for the other phones, as the Nokia’s
are classed as Smartphones, with
emphasis on the smart features, like
enhancing productivity, PDF viewing
etc, while the others are more
focused on multimedia. This doesn’t
mean that they give up on function-
ality in any way, just that the jack of
all trades principle is being put to use
by manufacturers here, it just
depends what combination of fea-
tures they are focusing on.

Coming to miscellaneous fea-
tures and quirks, there was a very
notable feature that some of the
Nokia phones had, which were
absent throughout the board. The
keypad on the Nokia 6630, 6681, N70
and N91, (not in this comparison),
models intelligently lit up when the

keypad was in use in a darkish area. This is
achieved by a light sensor placed atop the
phone that will cause the keypad to illuminate
once you operate it in dimly lit areas. Very nifty
indeed, and a small, and not very costly feature
to add! We would like to see more cell phone
manufacturers incorporating such features
that actually work! 

Rs 15,000 and Above
Looks-wise the Samsung D600 is ahead of the
other two cellphones in this category, mainly
because of it’s small footprint. The fit and
finish of the slider mechanism is also top
notch, as is the feel of the keypad, and its
layout. Generally slider phones tend to get a bit
cramped as far as the keypad layout goes, no
such problems here. Second prize goes to the
N70, with a steel chrome front and compact
looks. One sore point is the slight gap between
the chrome bezel and the rest of the body, this
becomes a bit of an eyesore after awhile, if you
happen to be choosy about fit and finish. Build
quality is however right up with the best. The
6681 is the ugly duckling of the lot, by no
means an ugly phone on its own, but the
chrome call and cancel buttons were just a
little too gaudy. 

Coming to the cameras of these phones, the
quality of the 6681 was found to be lacking on
paper—with specs, as well as in practice. The 1.3
megapixel camera just couldn’t keep up with the
cameras on the N70 and the D600, both rated at
2 megapixels. Picture quality of the N70 was
slightly better than the Samsung D600, particu-
larly when using zoom. Video shooting on the
N70 was also better.

Note that by zooming we mean a small
amount of zoom—any serious zooming distorts
the quality of the shot/video, as all the cell-
phones tested have digital zooms, which unlike
an optical zoom, reduces clarity when used. The
Samsung was a tad slow in clicking images how-
ever, ditto the Nokia 6681, though this was
more noticeable on the former. The N70 had no
such problems. 

The N70 has one camera in the front and one
in the rear. This is for video conferencing, and
the only issue here is the front camera is VGA,
and not a good one at that! It’s the rear camera
that sports the 2.0 megapixel capture resolution.
Both the 6681 and the N70 have sliders that cover
the rear cameras, and sliding them down acti-
vates the camera mode. 

One irritating point noted here—both the
Nokia sliders, although smooth to operate, actu-
ally rub against the back bezel, and after 50 to 60
times of sliding the 6681 back and forth, the
chrome trim surrounding the camera lens actu-
ally started wearing off due to this movement.
The N70 fared slightly better, but there were
scuff marks beginning to appear as well. Quite
an eyesore for someone investing as much as
these cell phones demand! 

Screen clarity is well and truly ruled by the odd
man out in the trio—the D600. This screen, (like
the X700), was crisp and ultra sharp, Samsung
really does produce top quality displays! The icons
look lifelike, and the menu layout is just so clean.

All display and no keypad makes the 7710 a confused phone. Nokia’s attempt
at a complete touch screen phone with no number keypad has most people

pleasantly surprised, while some seem to have their own reservations—the
primary reason being the said absence and its slow processor. Why are the first
of a new Nokia line always slow? First the 6600, and now the 7710.

On the bright side is the wonderful and massive 640 X 320 wide screen
display which is great for viewing videos. The
Series 90 platform used by the 7710 has several
applications written for it, and playing an MPG or
an AVI file is possible. Entertainment to go! Its
stereo loudspeaker is well... really loud! A ‘mere’
1 megapixel camera disappoints a little,
considering its price and other abilities. Video is
recorded in the standard 176 x 144 resolution. 

This is a multimedia phone in the true sense, if you ignore the lag in opening
of videos, that is. With GPRS, HSCSD and EDGE support, internet experience is
only enhanced by the large screen. With an extensive calendar and innumerable
Series 90 applications that can be further installed, the 7710 can do double duty
on your office work as well.

The stylus slots in neatly and is as easy to retrieve. The touchpad is sensitive
enough and takes in user input without fuss. Simple navigation and selection can
be done using the limited keypad too. Nokia wins again in the department of
navigation—a new user can get to the different features in no time at all. 

The Series 90’s flexibility is evident in the 7710. The number of entries in the
phonebook, message box, received and dialled call-log, all depend on the shared
memory, which pleasantly is 90MB. If you use the MMC card to store pictures
and videos, you get virtually unlimited phonebook and log entries.

The 7710 is not chic per se, but if size matters, it can be an attention
grabber. If all fails, just pump up the volume or turn on the video and you will
have a crowd around you. We tested this feature and it works! 

Large and clear display, sensitive touchpad
No keypad

Rating: 3/5

Nokia 7710 Lifestyle Phones

FIFTH ANNIVERSARY
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The Nokia N70 - Feature-rich beauty
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Text is ultra readable, just as it should be in all
phones. Dare to dream, but we wish more cell
phones shared Samsung’s prolific displays! The
6681 takes second position here, a surprise, since
we really expected the newer and more expensive
N70 to excel, but this wasn’t the case! The Nokia
N70 has a larger, but lower resolution screen than
the Samsung D600—so obviously the Samsung’s
screen looks a lot better. 

Coming to ergonomics the 6681 with its
large call buttons edges out the other two
phones, while the N70 would be preferred over
the D600 due to the former’s better button
layout. We aren’t talking about the number
keypad, rather the soft keys present on the outer
part of the phone. The navigation on the 6681 is
also the easiest to use, although this depends on
what a user is already familiar with. 

MP3 playback sounded the best on the N70,
with the Samsung D600 edging out the 6681
for second place. The N70 with headphones
really rocks; not nearly as good as Sony’s K750i,
and the W series, mind you, but definitely
better than the other Nokias. The N70 also has
a very loud speaker—around three-times louder
than the other Nokia phones we tested. Sound
quality wise the 6681 is nearly identical to the
6630, which was in a lower price bracket. The
6681 has the lowest volume levels of the three.
The Samsung was also the only one of the
threesome to have dedicated buttons for
volume control and camera, (chrome finished
buttons on the side of the phone), something to
watch out for ergonomics and usability wise.
It’s noteworthy that the media player on the
N70 is very plain-jane, earlier Nokia’s seemed a
bit better as far as layout of the player menu
and functionality goes, (including the 6630
and 6681). 

When you talk Rs 15,000 or more, expand-
ability isn’t an option, it’s understood! All these
phones featured expandability, with the two
Nokia’s supporting RSMMC dual volt specifica-
tions, while the D600 supported the ultra com-
pact Transflash. 

Siemens SL75 - The sliding beauty
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Connectivity-wise all three phones here fea-
tured Bluetooth—something that is mandatory
for cellphones in this category. Pretty much all
the cell phones across the three sub categories
had Bluetooth as a connectivity option, with
most vendors doing away with IR, Sony Ericsson
phones still feature both options however. 

Conclusion
This was the most exciting category, and we actu-
ally had to sub-divide it, because of the sheer
variety available. 

The first mini battle takes place at the
bottom of the group, (price-wise), where
the Nokia 7360 emerges winner, battling
it out with its older sibling the 6600,
(which is really showing its age now), and
the Motorola E398. Youth and beauty win
here, as the 7360 really makes a fashion
statement for itself. 

The second group sees the Sony Eric-
sson K750i emerging as winner, expand-
ability, excellent cam and MP3 playback,
compactness, this phone has it all, at 
Rs 14,995, we feel it’s a really good deal.
The Samsung X700 comes in a decent
second, with the two Nokia’s just nip-
ping at its heels.

In the top segment, price-wise, the
N70 is head and shoulders above the
competition, providing a very good
camera, clear, loud MP3 playback and all
the functionality you’re likely to need.
Samsung’s D600 takes second place, but
if you have a budget of around Rs 20,000,
we really recommend the N70, simply
because of the gamut of features it
brings to the equation. 

MID-RANGE PHONES
If your budget is important, but not the only
thing influencing your buying decision, and you
need a decent feature-set as well, this is the sec-
tion of phones you will be looking at!

With looks ranging from ‘fairly decent’ to
‘good’ you can actually think of gifting these to
a near and dear one. The price band we have
chosen is broad—from Rs 5,500 to Rs 10,000.
Here again we will spilt this category, this time
into two, below and above Rs 7,500. 

Rs 5,500 to Rs 7,000  
Phones in this segment are characterised by a
VGA camera which also shoots videos at a stan-
dard QCIF (Quarter Common Intermediate
Format) resolution of 176 x 144. All of them have
USB connectivity, for synchronising of contacts
and transferring images or video. Additional
device-to-device connectivity is in the form of
Bluetooth on the Motorola L6 and the LG C2500,
while the other phones make do with infrared.
Bluetooth offers higher speeds than infrared can,
and does not depend on line-of-sight transfers. 

Internet connectivity is via GPRS on all
phones here—the Nokia 6020 deserves special
mention for offering EDGE and HSCSD (High
Speed Circuit Switched Data). All phones have a
WAP 2.0 and xHTML compatible browser. The
browser on the C2500 was the slowest amongst
the lot, while the L6 was fast—as fast as navi-
gating through the rest of the phone.

PIM and Contact Management
All phones provide a scheduler where you can
set reminders for a particular date and time,
and you can also attach a note here. So, equal

Nokia’s answer to the ‘Walkman’ branded phones from
Sony Ericsson comes in the form of N91. Combining

some bleeding edge technologies and support for various
music formats, the N91, definitely packs the bang to take
down its opponents. 

Encased in a stainless steel body the phone feels sturdy and
solidly put together; however, keeping it spotlessly clean can be
a challenge. While the design isn’t special, this candy bar phone
does seem a little longer than most phones.

The N91 is the first phone to integrate a 4 GB hard drive and
thus has the capacity to store a significant chunk of one’s music
collection. With dedicated buttons for music playback along with
an intuitive user interface, the N91 can go toe-toe with any MP3
player in the market. Nokia has also integrated a standard
3.5 mm stereo jack into the phone, allowing most headphones to
be connected without an adapter. Support for music format
includes MP3, AAC, WMA, and MP4. The included stereo headset
provides decent quality but there is definitely room for
improvement. Transferring music is just a matter of drag and
drop as the phone is detected as a USB drive under Windows XP.

As it should be with most music phones, the music capability
is well synergised in the phone. Automatic pausing of music
when a call comes and subsequent playback on ending the call
speaks for the amount of thought put in.

The 262k colour display is brilliant; only to be spoiled by an
acceptable, but not great, resolution of 176 x 208. The keypad is
exposed by sliding down the media controls. Its keys are too

small for comfort and those with fat fingers will definitely have
problems operating the pad.

Speaking of other features this is probably the first phone
from Nokia to integrate Wi-Fi 802.11g. Other connectivity
options include Bluetooth 1.2 and USB 2.0. The phone also
supports EDGE and hence browsing
over GPRS is blazing fast.

The N91 also integrates a 2
megapixel camera capable of clicking
shots up to 1200 x 1600. It can also
record video in MPEG4, H.263 and
RealVideo8 formats. The shots taken
were good and match up to those
offered by competitors.

Priced at Rs 33,999 the Nokia
N91 is one of the most expensive
music phones around. Considering
the 4 GB hard drive, Wi-Fi
802.11g, stainless steel body and
other notable features the price
tag might seem appropriate but
for most of us, its still too
expensive.

4 GB hard drive
Cramped keypad

Rating: 3.5/5

Nokia N91 Lifestyle Phones

Siemens ME75

FIFTH ANNIVERSARY
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points to all contenders here. The Siemens C75
and the ME75; and the K300i also have a useful
notes feature. On the L6 and the C2500, this
notes feature is absent, so if you need to quick-
ly type in a note you will have to compose an
SMS and save it as a draft. 

The Siemens phones offer a whopping 1,000
phonebook entries each, with up to 20 fields!
The L6 gives you just an address and picture per
contact, while the C2500 gives six fields (apart
from name) and a picture per contact. Both, the
L6 and C2500 can hold 500 contacts.

Memory Capacity
With Internet connectivity and a camera being
standard, enough memory to store all those pic-
tures and videos is important. None of the
phones here have a memory expansion slot.
Call it cost cutting or a deliberate attempt to
differentiate between these and costlier mod-
els—you simply can’t excuse a measly 3.5 MB
shared memory on a phone (Nokia 6020) that
supports GPRS, EDGE, and HSCSD. The LG’s
C2500 comes as a pleasant surprise with a
respectable 64 MB of memory. The phone offers
MP3 functionality, and you can listen to MP3s
without even inserting the SIM card. The sound
quality is not comparable to dedicated MP3
players, but at least you have something to lis-
ten to while waiting for a friend or a bus to turn
up. The good news continues with FM recep-
tion. The Motorola L6, Siemens C75 and ME75
have a 10 MB storage capacity while the SE
K300i has slightly more room with 12 MB.

Ease of use
The menu and navigation on all these phones is
simple and straight forward enough, barring a
few quirks here and there. On the L6, for exam-
ple it will take you a while to get the hang of its
menu and navigation select key. The C2500, for
some reason had no ‘centre click’ to select, on a
keypad that looks like a 5-way keypad. This

means as you navigate to your desired
menu, you have to shift your fingers
to the left in order to press the soft-
key and make a selection. 

Once you get used to a particular
phone, you will invariably find it
comfortable to use. Thus, moving
from one phone to another takes a
while. You’ll understand what we are
saying if you have shifted from a
Nokia to a Philips or to a Siemens. So,
if ease of use is an important crite-
rion to you, give yourself some time
with a potential purchase before
drawing conclusions. If a friend has
the model that you want to buy,
borrow it for at least half a day and
toy with it.

Keypad
For SMS addicts, nothing is more
important than keypad comfort and
layout. The Motorola SLVR L6 has the
most tactile keypad by far. The C2500
has small but well spaced number
keys, but the navigation and softkeys

seem like they are jammed together. You
can quite easily press cancel when you mean
to navigate to the right! The Siemens C75
and ME75 could definitely use softer and
less noisy keys. The Nokia 6020’s rectangu-
lar keypad is easy to type on, but the joystick
should have been more responsive.

Show Worthy?
After the RAZR, Motorola’s fascination with
four lettered names continues with the
SLVR which is to be pronounced as ‘sliver’.
The SLVR L6 comes with a bright and clear
blue keypad, and its backlight adds func-
tionality as well as style. Clearly, this is a
phone meant not just to talk, but to show
off. A striking feature of the L6 is its slim-
ness, but at the cost of being longer and
broader than most. 

The LG C2500 is small and easy to hold—
even toss around! A flash of blue from the
keypad, while the phone is in standby, seems
like an attempt to grab attention. The Siemens
C75 and ME75 have a silver metallic colour,
rendering a somewhat retro and laidback
look. Nothing special about the K300i and the
6020—they’re just average-looking phones.

Rs 7,000 to Rs 10,000  
Compared to the previous segment, the
phones here are more expensive, and you will
expect more out of them. Only the Philips
Xenium 9@9e and LG S5200 have a megapixel
camera, while the others make do with the
modest 640 x 480 VGA resolution. 

Motorola SLVR L7-Sleek and easy to use

FIFTH ANNIVERSARY
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I t certainly looks more chic than a mere pebble. The phone has a unique
flip open mechanism. A mild push to the lid makes it snap open in a brisk
and sure way. A clear and pleasing blue backlight accentuated by an all-

black colour greets you as the flip opens. The screen is a crystal clear 262k
colour TFT, lending a sophisticated feel to the PEBL. A nice, easy-to-press
keypad pampers you further. Good first impressions. That’s what the phone
is about. 

On to the features though, there is nothing to rave about—5 MB of internal
memory and lack of an expansion slot to begin with. You will have to cut short
(quite literally) plans of playing videos or music. A 10 or better still, 20 MB
capacity would have been nice. Bluetooth and USB (there is no IR) connectivity,
a VGA camera and GRPS comprise the basic plumbing of the PEBL. A mini-USB
port is used for headphones, charging and USB connectivity.
Surprisingly, and unfortunately, the phone cannot be
connected as a USB storage drive, but with a 5 MB capacity, it
is not a major loss. This and the oversight on memory
though, make us wonder if the PEBL was designed in a studio
rather than an engineer’s desk.

Storing your friend’s and that friend’s friend (whom
you tried to impress with your PEBL) numbers is not
difficult thanks to the 1,000 phonebook entries capacity.
The velvety feel of the phone had some of us not liking it,
while others were neutral on it. Apart from this, the
PEBL is one of the snazziest phones we tested. Flaunters
will have a gala time with it. A debate rages in our labs
on whether the PEBL is meant to be in the hands of a
lady, or if it is meant to woo one… 

Stylish
Only 5 MB memory

Rating:  3.5/5

Motorola PEBL Lifestyle Phones
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Protection
against acci-
dental dele-
tion
Only 3 MB
memory

JUNE 2006

BRAND
MODEL
Features 
Design and Ergonomics
Form Factor  (Candybar,
Clamshell, etc.)
Support for Network Bands
Dimensions (mm) (L x W x D)
Weight (gms)
Build Quality / Fit and Finish
User Interface 
Navigation
Keypad Layout
Keypad Comfort
Keypad Backlight
Basic Phone Features
Display Resolution (pixels)
Display Colours (K)
Address Book Capacity
No. of Lines Displayed in Message
Number of Profiles
Themes
Support for Installing new 
Applications / Games
Memory 
Phone Memory (MB)
External Memory Slot / Capacity
Connectivity (IR/BT/USB/Wi-Fi)
Internet (GPRS/HSCSD/EDGE)
Camera
Image
Video Capture / Resolution
Lens Protection/Mirror for
Self-Portrait
Extra and Miscelleneous Features
Capabiltiy of Adjusting 
Brightness / Contrast
MP3 Capability
FM Radio
Voice Recorder / Voice Dialling /
Hands-free Speaker 
Talk Time / Standby Time (Claimed)
Performance
Signal Reception
Voice Clarity
Processing Speed
Quality of Captured Image
Quality of Captured Video 
Scores
Features (out of 40)
Performance (out of 45)
Price Index (out of 15)
Overall Score
Price (Rs) 

Acts as USB
drive; charges
via USB
Bundled ear-
phones a bit
uncomfortable

Sleek; good
keypad and
backlight
Poor speaker
quality

Motorola
L6

Candybar

Tri-band
113 x 49 x 10.9
86
3.5
2.75
3
3.25
3
4

128 x 160
65
500
6
3
✔

✔

10
✖

Bluetooth, USB
GPRS

640 x 480
✔/176 x 144
✖/✖

✔

✔

✖

✔/✖/✖

5.5 / 345

3
3.25
3
2
2

21.98
25.88
13.70
61.56
6,020

LG
C2500

Candybar

Dual-band
101 x 46 x 17
80
3.75
3
3
2.75
2.25
2.75

128 x 128
65
200
4
5
✔

✔

64
✖

Bluetooth, USB
GPRS

640 x 480
✔/176 x 144
✖/✖

✔

✔

✔

✔/✔/✔

2.5 / 300

3
3.25
2.75
2
2

24.20
25.43
13.33
62.96
6,190

Large
phone-book 
Joystick
unrespon-
sive

Siemens
C75

Candybar

Tri-band
103 x 44 x 17
85
3
3.25
3.5
3.25
3.5
✔

132 x 176
65
1000
9
8
✔

✔

10
✖

IR, USB
GPRS

640 x 480
✔/176 x 144
✖/✖

✔

✖

✖

✔/✖/✔

5.5 / 300

3
3.25
3.25
2
2

21.80
26.33
12.71
60.83
6,490

Nokia
6020

Candybar

Tri-band
106 x 44 x 20
90
3.25
3.25
3.25
3.25
3.25
3.25

128 x 128
65
1000
4
6
✔

✔

3.5
✖

IR, USB
GPRS, HSCSD, EDGE

640 x 480
✔/176 x 144
✖/✖

✔

✖

✖

✔/✔/✔

3 / 300

3
3.5
3.5
2.5
2

21.44
28.13
12.66
62.22
6,519

HSCSD & EDGE
connectivity
Sub-par cam-
era, low
speakerphone
volume

Good build
quality; fast
browser 
Hard keys

Sony Ericsson
K300i

Candybar

Tri-band
99 x 45.4 x 19.2
85
2.75
2.75
2.5
2.75
2.5
3

128 x 128
65
500
5
3
✔

✔

12
✖

IR, USB
GPRS

640 x 480
✔/176 x 144
✖/✔

✔

✔

✖

✔/✔/✔

7 / 300

3
3.5
3.25
2.25
2

22.14
27.34
12.14
61.62
6,795

Large phone-
book 
Sub-par build
quality; odd
colour combo

Siemens
ME75

Candybar

Tri-band
105 x 46 x 18
95
2.5
3.25
3.5
2.5
2.5
2.5

132 x 176
65
1000
9
8
✔

✔

10
✖

IR, USB
GPRS

640 x 480
✔/176 x 144
✖/✖

✔

✖

✖

✔/✖/✔

8 / 450

3
3.25
3.25
2
2

20.50
26.33
11.80
58.63
6,990

Samsung
X620

Candybar

Tri-band
106 x 45.5 x 20
71
3.5
3.5
3.75
3.25
3.25
3.5

128 x 160
65
500
6
Quiet Mode Only
✖

✔

3
✖

IR 
GPRS

640 x 480
✖

✖/✖

✔

✖

✔

✔/✖/✔

6.5 / 300

3.25
3.5
4
2.5
0

21.52
28.80
10.93
61.25
7,549
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Sleek; good
backlight
Large dimen-
sions except
for thickness

Dual display;
accidental
deletion pro-
tection
None in par-
ticular

JUNE 2006

Good fit &
finish, com-
fortable key-
pad
Poor display
quality

Samsung
X660

Clamshell

Tri-band
89.5 x 45 x 21.5
78
3.5
3.5
3.75
3.75
3.25
3.5

128 x 160
65
500
6
Quiet Mode Only
✖

✔

8
✖

IR, USB
GPRS

640 x 480
✔/176 x 144
✖/✖

✔

✖

✖

✔/✖/✔

3.5/200

3
3.5
4
2.5
2

20.80
29.03
9.59
59.42
8,599

Philips
Xenium 9@9e

Clamshell 

Tri-band
89.9 x 47 x 25.5
105
3.75
3.25
3.25
3.75
3.75
3.5

128 x 160
65
1000
6
7
✖

✔

20
✖

IR
GPRS

1280 x 1024
✖

✖/✔

✔

✖

✖

✔/✔/✔

8.5 / 800

3
3.25
3.5
3
0

22.06
27.23
9.17
58.45
9,000

LG
S5200

Vertical Slide

Tri-band
92 x 46 x 21.7
92
2.75
3
3
2.75
1.25
3.25

128 x 160
262
1000
6
4
✔

✔

64
✖

Bluetooth, USB
GPRS

1280 x 960
✔/176 x 144
✔/✔

✔

✔

✖

✔/✔/✔

2 / 200

3
3.25
3
2.75
2.75

25.52
27.23
8.26
61.00
9,990

Simple
menu lay-
out
Keypad
hard,
cramped

Motorola
L7

Candybar

Tri-band
113 x 49 x 11.5
96
4
3
3
3.5
3.5
4.25

176 x 220
262
1000
8
3
✔

✔

11
✔/128
Bluetooth, USB
GPRS

640 x 480
✔/176 x 144
✖/✖

✔

✔

✖

✔/✖/✔

6.75 / 350

3
3.5
3.5
2.5
2

26.71
28.13
8.24
63.08
10,007
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If you thought 3.5 MB on the 6020 was too
little, well, the Samsung X620 has a measly 3 MB
internal memory. Pay more for less?

The Samsung X660 is somewhat better with
8 MB, while the honours once again go
to LG—the S5200 has 64 MB and being
MP3 capable. The Philip Xenium 9@9e
has a passable 20 MB, while the L7 has 11
MB, and is the only phone in this cate-
gory with expandable memory. Its
microSD slot can support cards up to 1
GB.

The WAP 2.0 and xHTML-ready
browsers remain standard here as well.
The browsers on the X620 and X660 are
fast, as is the L7’s. The LG S5200 is slug-
gish when scrolling through Web pages.
The two Samsungs can store 500 contacts
with 10 fields, while the L7 holds 1,000
names with addresses and photo fields.

Better Keypads and Design?
The Samsung X620’s keypad makes more
noise while typing than the tones it gen-
erates. This apart, we must say the X620
is handy, and a good white backlight
makes life with the X620 easy in the
dark. The somewhat evolved version of
the X620, the X660 is a clamshell design

and has a dual-display. When its top is closed, a
smaller display shows the time and the caller
number, you can thus choose to take the call or
to ignore it: You can use the volume button to
‘reject’ a call. The keypad is more comfortable
than the X620, and with an 8 MB memory the
X660 is a better package any day. However, at an
MRP of Rs 8,599, it costs Rs 1,000 more than the
X620, which is priced at Rs 7,549. 

The Philips Xenium 9@9e costs about Rs 1,000
more than the X620, and has an uninspiring and
utilitarian look. Its dual-display works similar to
the display of the X660. Adding to the retro look
is the leather (could be faux-leather) covering its
back panel. The keypad here is one of the best in
terms of spacing; you’d have to be a bit tipsy to
press a wrong key here! For a phone in this cate-
gory, we would have liked a clearer display. The
fonts look a bit too ragged for comfort. Though
the exterior build quality creates a good first
impression, the display can be a turn-off for the
executives that this phone seems targetted at.

At the higher-end of this segment, at
Rs 10,000, sit the LG C5200 and the Motorola
L7. Now, this C5200 looks and even feels just
like the Samsung D600: A coincidence or an
inspiration? LG also offers Bluetooth; harping
it rather proudly above its display. The number
keys are a bit too small, but manageable. How-
ever, its small and cramped navigation keys
can be a problem unless you have nimble fin-
gers. The keypad could use brighter lighting to
make the lettering clearer. For the record, its
look-alike—the Samsung D600 has an excellent
backlight. The only phone to have an expand-
able memory in this segment, the Motorola L7
is similar to its cousin, the L6, except for the
memory slot. For the difference in price, we
think it fair to expect at least a higher resolu-
tion camera if nothing else. But this wish
remains just that—a wish.

Conclusion
‘Can spend just a little more, but want a lot
more’. A wish that is no doubt difficult to ful-
fill. But, with consumer reigning king, this
wish it seems, has been catered to. Style, superb
build quality, a nice keypad and an external
memory slot took the Motorola L7 to the
throne—just edging out the competition. Our
only rant is that a higher resolution camera
should have been included, instead of the VGA
camera that it ships with. 

Give or take one feature or even slightly
better ergonomics and the result for the sec-
ond place would have changed—that is the
closeness of the battle fought. The contenders
were the Nokia 6020; and the two LGs—the
C2500 and the S5200 with their impressive
internal memory of 64 MB. The 6020 and
C2500 clock high overall scores in our tables
mainly due to their competitive pricing. If you
don’t mind the higher price tag, you should
take a serious look at the LG S2500, which has
better ergonomics, a good 1.3 megapixel cam-
era and MP3 playback. However, because of the
price difference, the S2500 lost out to the LG
C2500, which is the winner of the Digit Best Buy
Silver award for this test.

Trendsetting designs have been the hallmark of many Motorola cell
phones but somehow they always fell short of critical acclaim;

due to shoddy implementation of great ideas. With the introduction
of V3 RAZR, Motorola changed all that. Despite the radical design
though, the phone did fall short in some aspects. With the V3i,
Motorola has fixed most of the shortcomings that the V3 RAZR had.

The V3i sports the same metallic body but its new aggressive
colour combination gives it splendid character. Inclusion of
Motorola’s monogram on the front accented with a blue backlight
definitely makes an impact. Measuring 96 x 50 x 12.7 mm and
weighing just 95 g, the V3i is still the slimmest clamshell phone.

The small external screen is now capable of 65K colour;
unfortunately the resolution still remains the same at 96 x 80
pixels. Buttons on the sides of the phone allow voice recording
and changing of profiles on the fly without opening the flap. 

Opening the flap leads to a big 2.5-inch, 256K colour screen capable of
delivering crisp and vibrant pictures—it also remains useable in daylight. Unlike
keypads on other phones with raised buttons, the keypad on V3i flushes with the
body. Getting used to the flat keys with short travel and blue backlight takes time,
nevertheless they are comfortable.

The camera resolution has been bumped to a megapixel. Outdoor
photographs come out better than indoors, and the video quality is good enough
for the sensor provided on the phone. You also get quad-band support, Bluetooth,
a VGA digital camera with 4x zoom, GPRS, PIM functionality, MPEG4 video
playback and Java support. The V3i has 10 MB of internal memory and it can be
further upgraded using the Transflash cards. Motorola has been generous enough
to provide a 256 MB card with the phone. The new V3i also has out of the box
support for iTunes, though the service isn’t yet launched in India!

Priced at Rs 13,045, the V3i is a head turner for sure and garners attention
wherever it goes. Targeted towards fashion conscious buyers the Motorola V3i
is definitely worth the money if one can put up with Motorola’s not so intuitive
user interface.

Slim, fashionable and practical
Average Camera

Rating: 3.5/5

Motorola V3i Lifestyle Phones

FIFTH ANNIVERSARY

LG C2500 - MP3 capability,
64 MB memory

JUNE 2006
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BUDGET PHONES
Increasingly inexpensive and convenient to
own, everyone from your friendly neighbour-
hood fruit vendor to your bus driver—seem to
be dancing to their own ring tones. The mobile
phone is empowering the common man like no
technology has done before.

This category is about phones for the mass-
es, or in a word, affordable. Amongst the
phones we tested, we classified those that fell
below the Rs 5,500 price as Budget phones.
Starting at about Rs 2,800, these humble gadg-
ets do just what a phone is supposed to do—
make and receive calls and exchange SMS. And,
they do so with no fuss or frills.

As price is the major criterion in this cate-
gory, let us break it further into three smaller
price-bands and look at each group separately,
to help simplfy your choice.

Below Rs 3,000 
In our test, the most inexpensive phones were
the Motorola C139, the LG B2050 and the Nokia
2600 priced between the Rs 2,800 to Rs 3,000
range. The C139 could definitely use a better
keypad and a more liberal spacing of keys: the
cost of an affordable phone need not be sore fin-
gers. The clarity of its tiny colour screen would
have been acceptable a couple of years ago, but
not today. A positive of this phone though, is its
impressive battery life—450 hours of claimed
standby time and 11.5 hours of talk time. Sur-

prising for a phone in its class, is that it allows
you re-arrange its menu items. Life does offer
small pleasures! 

The LG B2050 shares the woes of the C139
when it comes to keypad feedback. However, the
placement of the keys is well thought of,

reducing the chances of pressing a
wrong key. The screen is pleasant
to see, as it is with most LG phones.
The kill-joy, apart from the keypad
is the slow response while com-
posing messages. Considering that
many buyers in this segment will
be students with an SMS habit,
this something that Motorola
should look at.

In terms of  usability, the LG
phones are as friendly as their
Nokia counterparts, as their
menu system is inspired by the
latter’s. This makes the B2050 and
the B2070 (reviewed in the next
price-band) extremely easy to use,
even for a first timer. Some LG
uniqueness is maintained
though: The right-navigation
button in standby mode opens up
a shortcut to inbox, voice mail,
scheduler and alarm. Overall, the
B2050 is an impressive phone.

The Nokia 2600 gives us very
little to complain about—we couldLG B2050 - Looks cute, works without fuss



115DIGIT JUNE 2006

FIFTH ANNIVERSARY

only crib about the size of the keys
comprising its last row—evidently;
practicality has been compromised for
a more appealing look. As with most
Nokias, navigation holds no surprises or
irritants in the 2600.

The Nokia 2600 and LG
B2050 are phones that you
will not be ashamed to use in
your college or workplace.
They may not look great, but
they are certainly not cheap-
looking either—from a dis-
tance, at least.

Many of us here at Digit
found the B2050 ‘cute’,
while some just thought it
was ‘feminine’. Nothing
wrong with that, of course.
Up on closer inspection
though, it does look and
even feel very plastic,
making the Nokia 2600 look
better on the whole. 

Rs 3,000 to Rs 4,000  
Next in line were Sony Eric-
sson’s J100i and J220i, priced
at around Rs 3,800. The J100i
is as basic and barebones as
the C139, which incidentally
is a whole thousand rupees
cheaper. And that says it all
about the J100i. The J220i is the better of the two
with a clearer screen and a more forgiving
keypad. Its menu navigation is intuitive making
this a good first phone to own. The navigation
keys on the J100i and the J220i function as short-
cuts to the alarm, phonebook and to
the SMS compose box—accessing con-
tacts and sending a message is literally a
button away.

The LG B2070 is an avatar of the
B2050 with an FM radio.
Radio reception is good out-
doors but can be a concern
in a closed environment. Its
stereo headphones, which
double as a microphone,
reproduce vocals very well
but not bass.

In the sub Rs 4,000
range, the Nokia 1600 tried
a new, and unusual, keypad
design, but lost points on
ergonomics because of its—
typing an SMS is an ordeal
on this phone. On the
brighter side, its clear white
backlight and good loud-
speaker make up for the odd
keypad.

The J100i and the J220i
are dual-toned with soft
colours that blend in well
with each other, but alas,
the plastic feel remains. The
B2070 shares its look with
its cousin, the B2050.  

Rs 4,000 to Rs 5,500  
Joining the FM bandwagon is the Sony

Ericsson’s J230i at the higher end of this
budget segment. The J230i is an avatar of
the J220i, packed with an FM radio. Like

the other phones we got in
this class, the keypad of the
J230i feels a bit dead and
takes the joy away.

Wrapping up this budget
segment at the Rs 5,000 bor-
der, are the Nokia 3120 and
6030 phones. The 6030
offers a generous ten fields
per entry in its 250 contacts
capable phonebook. The
3120 gives you 256 contacts
with four fields per contact.
There is little else to distin-
guish these two phones
which are separated by
about Rs 400. The 6030 has a
65k colour screen while the
3120 has to make do with a
screen offering only 4k
colours, though the differ-
ence in clarity is not very
noticeable. On the 6030, we
were at ease with its large
softkeys, but did feel that
the number keys could have

been bigger for the SMS
junkies amongst us.

The SE J230i offered the best audio quality—
through its earphones as well as its speaker.
The good news continues with the FM recep-
tion: the J230i fares much better than the LG
B2070, both in terms of the FM audio quality

and the ability to pick up signals
indoors. On an otherwise white and

silver body, there are two careless spots
of orange vying for your attention. This
might good if you want your phone to

generate curious looks in
college, but not quite so in a
conference room. The 6030
is a typical block look
Nokia—unassuming, simple
with no make up. The most
graceful of this lot is the
3120 which can pass off as
an executive’s phone. Dual-
tones that work well, good
fit and finish—all make it a
neat looking package.

Conclusion
Barring FM radio on the
Nokia 6030, LG B2070 and
the Sony Ericsson J230i,
there were no models to go
gaga over. With hardly any
price differences and fea-
tures seperating the
phones in each price-band,
our job was not easy.
Giving a fair weightage to
the price did not mean that
the least priced phones

Nokia 2600-Value for Money

Nokia 6030 - FM radio adds value

JUNE 2006
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Scoreboard          BUDGET PHONES
JUNE 2006

Speed dialling
to SMS, fast UI
Peculiar key-
pad layout

Easy
messaging
Poor fit and fin-
ish

Light
Hard keypad

BRAND
MODEL
Features
Design and Ergonomics
Form Factor (Candybar, 
Clamshell, etc.)
Support for Network Bands
Dimensions (mm) (L x W x D)
Weight (gms)
Build Quality, Fit and Finish
User Interface
Navigation 
Keypad Layout
Keypad Comfort
keypad Backlight
Basic Phone features
Display Resolution (pixels)
Display Colours (K)
Address Book Capacity
No. of Lines Displayed in Message
Number of Profiles
Phone Memory (MB)
Support for Installing New 
Applications/Games
Connectivity: IR/Bluetooth/USB/Wi-Fi
Miscelleneous features
Adjusting Brightness/Contrast
Voice Recorder/Voice Dialling /
Hands-free Speaker 
FM Radio 
Talk Time / Standby Time (Claimed)
Performance
Signal Reception 
Voice Clarity 
Processing Speed 
Scores
Features (out of 50)
Performance (out of 30)
Price (out of 20)
Overall 
Price (Rs)

LG
B2050

Candybar

Tri-band
105 x 44 x 15.9
72
2.5
2.5
2.5
2.5
2
3.5

128 x 128
65
200
4
5
1.4
✖

NA

✔

✔/✔/✔

✖

2 / 200

3
3.25
3.25

28.53
18.9
16.72
64.15
2,990

LG
B2070

Candybar

Dual-band
104 x 43 x 15.9
73
2.5
2.5
2.5
2.5
2
3

128 x 128
65
200
4
6
1.4
✖

NA

✔

✔/✖/✔

✔

2.5 / 200

3
3.25
3.25

30.15
18.9
12.53
61.58
3,990

Motorola
C139

Candybar

Dual-band
98 x 45 x 21
85
3.25
3
3
2
2
3

96 x 64
65
100
3
2
0.5
✖

NA

✔

✖/✖/✖

✖

11.5/400

3
3.25
3.5

19.14
19.2
17.67
56.01
2,830

Nokia
1600

Candybar

Dual-band
104 x 45 x 17
85
3.25
1.25
3
1.75
3
2.75

96 x 68
65
200
3
4
4
✖

NA

✔

✖/✖/Y

✖

5.3 / 450

3.25
3.5
3

24.01
19.8
12.66
56.48
3,949

Nokia
2600

Candybar

Dual-band
107 x 46 x 20 
94
3.5
3.5
3
3.75
3.5
3.75

128 x 128
4
200
4
5
4
✖

NA

✔

✔/✔/✔

✖

3.5 / 200

3.25
3.5
3.5

28.96
20.4
17.43
66.79
2,869

Sony Ericsson
J220i

Candybar

Dual-band
102 x 44 x 18
82
2.75
3.5
3
3.75
3.25
2.5

128 x 128
65
200
3
7
0.6
✖

NA

✔

✖/✖/✖

✖

6 / 280

3.25
3.25
3.5

22.45
19.8
13.35
55.60
3,745

Sony Ericsson 
J100i

Candybar

Dual-band
100 x 44 x 18
70
2.75
3
3
2.25
3
3

96 x 64
65
250
3
4
0.5
✖

NA

✔

✖/✖/✖

✖

300 / 8

3.25
3.25
3.5

22.12
19.8
12.84
54.75
3,895

Simple menu
layout
Hard keypad,
keypad back-
light weak

Good internal
memory, good
FM reception
Sub-par build
quality

Good battery
life
Hard keypad,
sub-par dis-
play

Sturdy, good
screen, call
screening
None in partic-
ular
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PhoneCompany E-mailBrand

Contact Sheet Cellphone

iMate
LG
Motorola
Nokia 
O2
Palm
Philips
Samsung
Siemens
Sony Ericsson

Fourth Generation Mobiles Pvt.Ltd
LG Electronics india pvt ltd
Motorola India Pvt. Ltd
Nokia
Creative - e - biz.com Ltd
Palm India
Philips India Ltd
Samsung Telecommunications
Benq Mobile
Sony Ericsson

011 - 41081012
0120 - 2560900/940
0124 - 2303212
011 - 30303838
9323966815
9892049064
022 - 6691 2000
0124 - 4398005
011 - 41601707
0124 - 2560808

sales@4gnet.co.in
PPrabhakar@lgezbuy.com
NA
NA
cr_mum@yahoo.com
krishnadeep.baruah@palm.com
s.n.roy@philips.com
yuvraj.mehta@samsung.com
salesenquiryin@benq.com
dhiraj.soni@sonyericsson.com

FIFTH ANNIVERSARY

could be forgiven for bad ergonomics. After painstaking calculations,
we found the Nokia 2600 to be both inexpensive as well as easy to use,
thus being crowned the Digit Best Buy Gold in this category. It also packs
a handy expense manager feature and changeable front and back
covers.

Others who staked claim to the Gold position were the FM phones
B2070, J230i and the 6030. The B2070 is plagued by slow response, the
J230i has an ill-conceived keypad—however none of these quirks were
found on the 6030. It costs about Rs 1,400 more than the 2600, but for that
extra money you get an inbuilt FM radio, a good 65k colour screen (the
2600 has a 4k screen) and a phonebook with 250 contacts, each with 10
fields. We have no hesitation in awarding the Digit Best Buy Silver award to
the Nokia 6030.  

kailas_shastry@thinkdigit.com
michael_browne@thinkdigit.com

Elegant and
sleek
Sub-par
audio quality

Good FM quality
Poor keypad
ergonomics

JUNE 2006

Nokia
3120

Candybar

Tri-band
102 x 43 x 20
84
3.25
3.75
3
3.75
4
4

128 x 128
4
256
4
6
0.5
✔

NA

✔

✔/✖/✔

✖

6 / 410

3.25
3.5
3.5

29.90
20.4
10.14
60.44
4,929

Sony Ericsson
J230i

Candybar

Dual-band
102 x 44 x 18
84
3.25
2.25
3
2.25
2
3.25

128 x 128
65
200
5
6
0.5
✖

NA

✔

✔/✖/✔

✔

6 / 280

3.25
3.25
3

29.98
19.2
11.38
60.56
4,395

Nokia
6030

Candybar

Dual-band
104 x 44 x 18
90
3.25
3.75
3
4
3.75
3.5

128 x 128
65
250
4
6
3
✔

NA

✔

✔/✖/✔

✔

3 / 300

3.5
3.5
3.5

34.22
21
9.40
64.62
5,319

Changeable 
covers, good 
battery life
None in 
particular
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The hot new Xda Atom from O2 is a PDA phone
that packs in loads of features in an extremely

small form factor. Measuring an impressive 58 x
102 x 18.5 mm and weighing just 140 gms, the
Atom is a tad smaller than its predecessor, the
highly successful Xda II Mini. 

Encased in an elegant piano black casing,
the Atom sports a 2.7-inch screen. The fascia
sports large send and end keys, a 5-way naviga-
tion pad, and keys assigned to the Start Menu
and the MediaPlus application, along with two
tiny speakers. There are two volume keys on the
left, voice recorder and camera keys on the
right, and a power button on top. The camera
lens, the self-portrait mirror and flash are
located on the rear while the bottom is where
you will find the USB connector, the headphone
socket and the reset button. While Windows
Mobile 5.0 implements softkeys to enhance one-
handed operation, the Atom, unfortunately,
does not come with dedicated softkeys.

Powered by an Intel PXA272 processor run-
ning at 416 MHz, the Atom comes with
128 MB of ROM and 64 MB of RAM. You can add
more memory by using the mini-SD slot located
on top. The 2.7-inch touch-screen supports 262K
colours at a resolution of 240 x 320. Connectivity
options include triband, GPRS/EDGE, infrared,
Bluetooth 1.2 and WiFi 802.11b. The camera is a 2
megapixel CMOS that can capture both stills and
video. Other goodies include an FM tuner, strobe
flash and a bundled stereo wired headset. You can
even record from FM in WAV or AMR formats. The
device synchronises with a PC via a USB cable.

The Atom runs the new Windows Mobile 5.0
operating system, the most notable feature of
which, in our opinion, is persistent storage. This
means this phone will not lose any data or

installed programs when you run out of battery
power. Office applications (Word Mobile, Excel
Mobile and PowerPoint Mobile) now support
embedded images, charts and tables. Standard PIM
applications such as Calendar, Tasks and Notes are
all there. All data can be easily synchronised with

your PC. O2 has thrown in a few of their own
applications, including the O2 MediaPlus, SMS
Plus and Equalizer. MediaPlus lets you play and
view various media—radio, music, pictures and
video, from a single window. O2 SMS Plus lets
you view your text messages in an instant mes-
saging format. The O2 Connect application
informs you of system updates. The Setup
Wizard combines a number of otherwise scat-
tered settings in one place, helping you get
started in a jiffy. Apart from these, you also get
an Auto Configurator, a photo editing applica-
tion and a self-diagnostic tool. 

The glossy casing attracts fingerprints and
dust, so you may end up spending a lot of time
cleaning your phone. The 416 MHz processor is
capable of running most applications and games
with ease and lets you multitask. The new OS
still retains the nagging “Smart Minimise” fea-

ture that does not close applications even when
you tap on the close button. However, this can be
easily circumvented by using a task manager

such as SPB Pocket Plus or SmallMenu (or using the
Memory module in Settings to shut down applica-
tions manually). Phone clarity is good, even in areas
with low network coverage. You can use the speak-
erphone in a noisy environment. WiFi and Blue-
tooth also work well. 

The stylus is a bit skinny and the touch-screen
too sensitive. You can use the virtual keyboard or
handwriting recognition to input text. However,
due to the screen size, the virtual keyboard is quite
small. The screen display is vibrant, but visibility
is reduced under sunlight. The camera application
is slow to use, and does not redeem itself with

O2 Xda Atom
“Small but loaded”

Business-class Cell Phones

Nokia wanted in the flip-phone category, the love that
Samsung and Motorola seem to be wallowing in. The 7370

is an entry for the lifestyle segment. It tries to shake off the
‘rugged and utilitarian’ impressions that Nokia has, with a
swivel display that rotates 180 degrees in both directions! Alas,
it cannot do a complete 360.

A rather unusual brown is used to colour the 7370. This in
itself makes the phone stand out in the crowd of blacks and
silvers. Being a phone that is made to please, the display quality
is good with a 262K colour screen. A nice white backlit keypad
offers a clear viewing of the keys in the night and looking
graceful at the same time. 

Keeping costs low means no expandable memory—you
will have to make do with a 10 MB internal memory. Not
good enough, considering its 1.3 megapixel camera whose
high resolution photo can be as big as 400 KB each. 20 of
such images would occupy about 8 MB which is how much you
will have left after SMS, Phonebook and call logs take up

their share. 
As the display slides 180 degrees both

ways, the screen re-orients itself. A minor
irritant is that when the screen is closed, the
name ‘Nokia’ appears in reverse direction of
the display. Rather silly, we think.

A slide type phone with bold keys and
large display along with a curvy design
with soft white keypad light makes the
phone, in our opinion gender neutral. If
your decision boils down to a phone with
good build quality and off beat looks
coupled with functionality, 7370 is a
nice, fast phone for you. And, it does not
cost the earth either.

Good display quality, easy navigation
Only 10 MB internal memory

Rating: 3.5/5

The Nokia 7370 Lifestyle Phones

O2 Xda Atom - Powerhouse in
your pocket

FIFTH ANNIVERSARY
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quality either—images taken in low light turn out
to be quite noisy. Audio output from the inbuilt
speakers is decent; the wired stereo headset pro-
vides much better quality when listening to
music. The 1530mAh user-replaceable lithium-
polymer battery lasts for a decent two to three
days under standard usage.

Feature-wise, the Atom has just about every
feature one would want. Sure, you can buy a
laptop its price. But will you be able to carry it in
your pocket?

Excellent Form Factor
Average Camera

Rating: 4/5

It is difficult to classify the I-mate Jasjar as a PDA
phone: The Jasjar sits somewhere between a

PDA phone and a laptop. Considering its design
and bulk, you could classify it as a mini-Tablet PC.
Its 81 x 128 x 25 mm dimensions and whopping
285 gm weight make it difficult to be carried
around in a pocket.

Sitting on a table: you see a speaker at the top
and a 1.3 megapixel camera, the flash and the bat-
tery compartment at the bottom. The front side
has stereo speakers, buttons for camera, voice
recording, and backlight, along with an IR port
and a volume slider. The left is where you find the
SD expansion slot and the power button, while the
back sports the headphone jack, a soft reset
button, a USB connector, two capped connectors
for external antennas and the stylus silo. You also
find two phone control buttons on the hinge.
Open the device, and you are now looking at a 62-
key QWERTY keyboard and a 3.6-inch, 65,000
colour VGA display. You can now use the Jasjar the
way you would a laptop—sitting on a desk with the
screen in front and the keyboard at your fingers.
You can also swivel the screen 180 degrees and fold
it on top of the keyboard to convert the device into
a regular pocket PC. If it is switched on, the dis-
play orientation changes automatically from land-
scape to portrait and you can use the stylus on the
touch-sensitive screen. A five-way navigation con-
trol under the screen lets you browse through
menus and select options. Since the phone is 3G-
capable, a second lower quality camera is also
present to enable video telephony.

Under the hood, the Jasjar is a triband GSM
phone that also supports the 2100 MHz UMTS 3G
band. Powered by an Intel Bulverde 520MHz
processor, 128 MB ROM and 64 MB RAM, the Jasjar
runs Windows Mobile 5.0. Connectivity options
run the whole gamut—infrared, GPRS, Bluetooth
1.1, and WiFi 802.11b—EDGE is sadly lacking
though. All the wireless modules are controlled
using one application, the Wireless Manager. Stan-
dard applications include Pocket Outlook, Win-
dows Media Player, MSN Messenger, Pocket
Internet Explorer, Pocket Office and Voice Notes.
Value Added Applications include Video Tele-
phony, Smart Dialing, T9 Phone Pad, Wireless data
manager, MMS with video clip support, and PDF
Viewer. The 1.3 megapixel camera can capture
stills at 1600 x 1200 pixels (extrapolated) and at its
native resolution of 1280 x 1024 and lower. Video
capture resolutions supported are 320 x 240, 176 x
144 and 128 x 96. The full VGA screen acts as
viewfinder when the camera is switched on. Apart
from the device and the removable battery, the
box includes a wired stereo headset, USB cable,

travel charger, 2 styli, carry
pouch, application CD,
user manual, and a quick-
start guide. 

As far as performance
is concerned, you will not
find the Jasjar lacking. The
processor is zippy and han-
dles most games and appli-
cations with ease. Phone
clarity is excellent and
usable even in areas with
low network coverage. The
basic office mobility fea-
tures work well. E-mail is
great when using i-mate’s push email service—find
yourself a WiFi hotspot and you are virtually be
sitting in your office. WEP encryption security is

i-mate Jasjar
Heavy-Duty Communication

In the wake of the Apple iPod’s phenomenal success, it was but natural for Sony
to revive it’s once iconic ‘Walkman’ brand in some form or the other. The W800i

from Sony-Ericsson (SE) is the first cell phone to sport the ‘Walkman’ logo and
holds lots of promises. Except for some cosmetic differences this phone is an
exact replica of SE’s K750i phone.

The W800i is available in an orange-white combination to make appeal to the
younger generation. Weighing just 100 grams and measuring 100 x 47 x 21 mm,
the W800i is light and compact. The 1.8-inch, 262K colour screen is bright and
crystal-clear. The 176 x 220 screen renders colours vividly and is a good aide for
playing games or for browsing through photos. The joystick and the keypad on
the W800i offer good tactile feedback—SMS junkies will love it. The interface is
pretty much unchanged except for the inclusion of the Walkman media player and
a dedicated button for the same. 

The W800i comes bundled with a 2 megapixel digital camera—the same as on
the K750i, and is graced with GPRS, HSCSD and tri-band support but no EDGE. For
short-range communication Bluetooth, infrared and USB 1.1 port is offered. The
phone comes with 38 MB of internal memory, a Memory Stick Duo slot and a
bundled 512 MB card. It also features MMS and e-mail, and Java 2.0.   

While powering the device, you can choose to use it as either a phone or a
just a media player. Choosing media player increases battery life for longer media
playability. To do justice to the Walkman moniker Sony-Ericsson has significantly
improved the audio quality on the W800i, which when coupled with the bundled
Fontopia ear buds from Sony matches any standalone MP3 player on the market.
The player supports MP3 and AAC playback but lacks support for DRM protected
file such as those downloaded from iTunes or Napster.

One good thing Sony Ericsson has done is the inclusion of a standard 3.5mm
jack via the headset which allows you to connect any headphone

to the phone or connect the phone to a Hi-Fi for heart
thumping sound. As with many Walkman’s the Mega Bass
feature also shows up on this Phone and it dramatically
improves bass. The W800i in the media player mode gives a
battery life of at least 18 hours—more than enough. 

Priced at Rs 20,000 the W800i is sensibly priced. Our
verdict? If you have the money, go for it, it’s been a while
since such a good cell phone has hit the shelves.  

Excellent music playback
Gaudy colour combination

Rating: 4/5

Sony Ericsson W800i Lifestyle Phones

i-mate Jasjar - Big on size, Big on features

FIFTH ANNIVERSARY
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After Nokia’s brick-sized 9500 Communicator,
comes its smaller siblings—the 9300 and the

9300i Communicators. 9300i is the newer of the
two, major additions being the inclusion of Wi-Fi
and Bluetooth 1.2, as compared to the 9300’s Blue-
tooth 1.1. Both the 9300 and the 9300i are almost
identical and you will hardly be able to tell the
two apart if it were not for the 9300i’s dark-grey
casing, as opposed to the silver of the 9300.

Business-oriented, the Communicators
are practical devices almost to the point of
being boring.

Measuring 132 x 51 x 21 mm and tipping the
scales at 172gm, you will not have any issues car-
rying these devices in your pocket. Apart from a
small power key on the top, you will find a fairly
large and comfortable numeric keypad and
a 128 x 128 65K colour display as its fascia. It
opens to a 640 x 200 pixel transreflective dis-
play with 65K colours. Four soft keys are
placed on the right of the display. The
bottom half has the QWERTY keyboard.
Here, dedicated numerical keys and a row of
eight application buttons (including a “My
own” button that you can program) along
with the five-way joystick make working
with this device a breeze.

Powered by a processor running at 150
MHz, the 9300/9300i features 80 MB of
shared internal memory and runs Symbian
OS 7.0s on the Series 80 platform. Memory is
expandable by way of MMC cards and a
128MB card is bundled. Thankfully, you don’t
need to remove the battery to access the
memory card, though you still need to open
the back cover. This triband GSM device with
support for EGPRS and HSCSD also offers IR
and Bluetooth. The WiFi in the 9300i is the
fast 802.11g (54 Mbps) variant. Other features

your ears, which doesn’t look too smart. You
would thus want to use the bundled wired
headset or purchase a Bluetooth set, rather than
hold a brick to your face. The QWERTY keyboard
is an asset and can be used even with fairly large
fingers. You will find that it is much better to use
your thumbs for data input rather than use it
laptop-style. With the keyboard, you will hardly
need to remove the stylus since most functions
can be performed using the keys. However, the sig-
nificant weight of the device doesn’t make it too
convenient for prolonged use. The keyboard
usability is enhanced by the presence of a light
sensor that detects the amount of available light
and if required, switches on a reddish backlight
for the keys. 

Overall, the i-mate Jasjar is a capable commu-
nications device for business users who can carry
it in their executive briefcases and most impor-
tantly, can afford the price tag.

Integrated QWERTY keyboard, Dual mode GSM/WCDMA
No EDGE, Bulky, Expensive

Rating: 3.5/5

include a native e-mail client that supports POP3,
IMAP4, SMTP and Open Mobile Alliance data syn-
chronisation; with attachment viewers. The
phone also offers mobile fax, synchronisation
with Outlook, a PDF viewer, an HTML browser,
Office applications compatibility with the most
common features of Microsoft Word, PowerPoint,
and Excel, and finally speakerphone and confer-
ence call capabilities. 

With support for 40 polyphonic ringtones and
playback of common audio formats including
MP3 and AAC, it is also possible to use it as a
portable audio player. There is support for
RealVideo, MPEG4, and H.263 video. Keeping its
target audience in mind, the device does not have
a camera. A lack of vibration alert is surprising,
since users would surely want to be alerted dis-
cretely of incoming calls or messages during busi-

ness meetings. Personalisation is limited to
changing the theme and wallpaper.

Phone clarity on the 9300/9300i is
excellent and we would expect nothing
less from Nokia. Battery life too, is good.
However, the phone could do with a
speedier CPU—there is a noticeable lag
while launching applications, though
menu navigation and other operations
seem to be fine. The keyboard should actu-
ally be called a thumb-board since it is
more suited for typing short notes and e-
mails using your thumbs. The five-way joy-
stick, though comfortable on the thumb,
is a little finicky and should be improved. 

To conclude, both the 9300 and the 9300i
are practical communications devices for
business users who want a no-frills solution
on the move.

Practical business usage, WiFi 802.11g on the 9300i
No camera, No vibration alert

Rating: 3.5/5 (9300/9300i)

provided. The Jasjar’s multimedia capabilities are
also quite decent and you will find the audio
output from the stereo speakers to be adequate.
Bluetooth worked well with the Jabra BT-200 wire-
less headset. Also usable was the device’s WiFi
module. We tried the latter with an Asus WiFi
router and could connect without issues. Getting
the Jasjar to work with GPRS was also simple. The
device did not have any trouble figuring out
which connections were live, and switching back
and forth between WiFi and mobile networks was
smooth. Browsing the Web with the inbuilt IE
browser was passable. The large screen size makes
working with spreadsheets, documents and Web
pages simple. With its removable 1620mAh
Lithium Polymer battery, you can expect a period
of two days before looking for an available power
socket, unless you use it extensively.

You don’t really need to open the device to
answer a call, just press the green button on the
side and you can use the speaker provided on the
outside. This involves holding the Jasjar close to

Nokia 9300/9300i Communicator
All work and no play

Nokia 9300i - The business phone
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The Palm Treo 650, a worthy successor to the Treo 600, still retains its charm
as the best PDA-Phone device. With the Treo 650, Palm hasn’t done anything

revolutionary but made sure most of the drawbacks of its earlier product were
fixed, and has added some new features.

The design still remains the same—that’s good because the Treo 600 had the
perfect balance of size, weight and pocketability; why mess with perfection? The
metallic grey and chrome outfit lends the phone smart look and speaks clearly
to its targeted audience.

The Treo 650 is powered by a 312 MHz Intel ‘Bulverde’ Processor, which has
enough juice to put the low-resource Palm OS through its paces. The Treo’s 2.5-

inch, 65K colour screen is one of the most beautiful
displays we have seen on any phone. Its 320 x 320 res-
olution renders sharp text and icons; images are life-
like on it. 

The Treo 650 uses non-volatile memory and
doesn’t require power to retain its data, so in case
the battery runs out, the data remains safe and
intact. With just 32 MB onboard (23 MB useable)
there isn’t much you can do; however an included
SDIO slot allows the Treo’s storage capacity to be
upgraded to 2 GB; apart from accepting SDIO
capable peripherals such as GPS navigation units or
high-resolution cameras.

The inbuilt VGA camera can’t match what is avail-
able on most phones, however it clicks good photos
and is a definite improvement over the Treo 600’s
camera. It also allows video recording and subsequent
playback. Integration of Bluetooth is an added bonus
for the occasional file sharing; it also allows browsing
the internet via a Bluetooth dongle. With the Treo
650, Palm has introduced user-replaceable batteries—
a big boon especially for people on the move. Its big,
chunky battery holds enough juice to power the
Treo 650 for four days or more, on moderate usage.

The Treo bundles RealPlayer and can play MP3 in stereo, but stereo head-
phones need an optional stereo adapter. The inbuilt speaker volume is high
and the ringtones are melodious. A small switch on the top of the phone can
mute all sounds, and put the phone in vibrate mode.

As for its PDA capabilities, the Treo 650 has all the common apps provided
with standard Palm OS PDAs. Contacts, Calendar, Memo, Web browser, Versa
mail, etc., all make for a very strong application bundle and should take care of
most needs. The Documents to go application bundle makes allows one to both
view and edit MS Office files on the fly, permitting data synchronisation over
the PC—just transfer them on to the Palm Treo 650 and you are ready to go. The
Blazer Web browser is quite fast and it successfully rendered most of the sites
we visited. It also supports cookies and offers cache management. Messaging is
brilliant and SMS messages are shown in a conversational format, collating
communication with a contact as a unit—better than having multiple entries.
Bluetooth support however can improve; if you interrupt a Bluetooth transfer
the device at times hangs and requires resetting.

Usability is Treo 650’s trump card; nothing comes close to the one-handed
operation offered by the Treo 650. Though a stylus is provided, you hardly need
it. Most operations can be done using the multitude of buttons. Its QWERTY
keyboard is comfortable, once you get used to it. The keyboard is backlit by a
bright light and is clearly visible in low-light conditions.

The small stub antenna on the Treo 650 might give the phone an odd look
but it makes sure that signal reception is good. During our test the Treo pre-
sented no problems as far as reception and sound quality were concerned.

Priced at Rs 29,999, the Treo 650 is one of the best PDA-phone devices we have
reviewed so far. Though it lacks features such as Wi-Fi and a good camera, and
comes with low inbuilt memory, it makes up for it by offering the best display
screen and a purposeful application bundle.

Seamless one handed operation
No Wi-Fi, less onboard memory

Rating: 4.5/5

Palm Treo 650 - The best
one handed operation ever

Palm Treo 650
Business on the Go!
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Take a Crack 
and win 
Computer Security

by Ditter Gollmann

Published by

Rules and Regulations
Readers are requested to

send in their answers by the
15th of the month of
publication.

Employees of Jasubhai
Digital Media and their relatives
are not permitted to participate
in this contest.

Readers are encouraged to
send their replies by e-mail.
Jasubhai Digital Media will not
entertain any unsolicited
communication.

Jasubhai Digital Media is
not responsible for any damage
to your system that may be
caused while you are trying to
solve the problem.

You can create a CD that can install Windows
automatically, putting in all the details and
answering all the dialog boxes. The secret
behind the unattended nature of the whole
thing is the answer file, which tells Windows
what to do while it’s installing. The answer
file can be created using Windows Setup
Manager. 

Using this tool, you can make the answer
file so powerful that you can even tell
Windows to include or exclude individual
components, set the display resolution, and
more. Here’s how you do it.
Step 1: To begin with, insert your Windows
XP installation CD into the drive and copy
the entire contents of the CD to a folder on
your hard drive.
Step 2: Navigate to the Support > Tools
folder on the CD and double-click the
Deploy.cab file. Copy all the files to a folder
on your hard disk. 
Step 3: The crucial part begins now—
creating the answer file. To execute the
Windows Setup Manager, double-click the
Setupmgr.exe file from the contents of
Deploy.cab, which you just copied onto the
hard drive. The next step explains the option
you need to select from the first few dialog
boxes that appear.
Step 4: The first few steps of the wizard are
self-explanatory. Select the following options
from the successive dialog boxes: Create a
new answer file; Windows unattended
installation (Select the appropriate Windows
version); “Fully automated”; “No, this answer
file will be used to install from CD”; and
finally, accept the license agreement.
Step 5: Under General Settings, you can
customise the installation of Windows by
providing the default name and
organisation, display settings, time zone and
the product key. Fill in the fields using the
drop-down lists or by keying in the details. If
you don’t select an option from the drop-
down lists, the default values will be used. 
Step 6: Under Network Settings, configure
the computer name, administrator password,
networking components and workgroup. If
you are specifying the Administrator
password, make sure you check the option to

encrypt the password in the answer file. If
you have a static IP address, you can specify
the settings under the Networking
Components section. 
Step 7: : Use the Advanced Settings section
only to configure telephony, browser and
shell settings and installation folders. Under
Browser and Shell Settings, click the browser
settings button to set the home page and add
Favorites. If  you are on a network, you can
also specify the proxy settings.
Step 8: : After you’re done, click Finish and
save the answer file as “winnt.sif” when you
are prompted. Advanced users can further
tweak the answer file by referring to the
Help file called Ref.chm in the same folder
as the Setup Manager. Finally, copy the
answer file to the i386 folder in the Windows
XP installation folder you created in the
beginning.
Step 9: To burn a bootable installation disc,
you need the boot sector of the Windows XP
CD. Download it from
www.tacktech.com/pub/
microsoft/bootfiles/bootfiles.zip, and extract
the boot sector file to a folder. This file will
be used with Nero Burning ROM to create the
bootable disc. 
Step 10: : Launch Nero and select CD-ROM
(Boot) from the New Compilation dialog box.
Under the Boot tab, specify the boot sector
file you extracted. Set the emulation as “No
emulation”, and keep the boot message
blank. Most importantly, remember to set
the “Number of loaded sectors” as 4.
Step 11: : Under the Burn tab, set the write
method to disc at-once. Click the New button
to begin adding files and folders to the
compilation. Drag all the contents of the
Windows XP installation disc that you copied
to your hard drive (with the answer file in
the i386 folder) into the left pane.
Step 12: : Insert a blank CD into the optical
drive and hit the Burn button. Wait a few
minutes and there you go! Your unattended
Windows XP installation disc is ready!

We urge you to bear in mind that since
the installation is customised, you should
refrain from lending out the disc you 
just created.

THIS MONTH’S CHALLENGE

LAST MONTH’S CHALLENGE

Win!

Mohd. Arif
Room No-298, Plot -

19, Gate-5, O.C.C,
Malwani, Malad(w),
Mumbai -4000 95

LAST MONTH’S WINNER

Show us a way to delete
the Recycle Bin from the
Desktop and also remove
‘Shared Documents’ from
Windows Explorer in
Windows XP

Write in with the subject
“Take a crack”, and your
postal address, to
takeacrack@thinkdigit.com
with your solution

Automate the installation of Windows XP
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Delete the Recycle Bin from
the Desktop and remove the
Shared Documents

X
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With 12 to 24x optical
zoom, a plethora of
shooting modes and a
6-megapixel CCD, this
camera sure is drool-
worthy!

Imaging Sivalal S

Digital Passion | Geek Dreams

Canon’s PowerShot S3 IS, styled in gun-
metal grey, is the latest addition to the
PowerShot S-series, the third genera-

tion in their “super zoom” digital camera
range.

The 12x optical zoom lens can be supple-
mented with the optional lens adapter, which
allows the optical zoom to be boosted to a fan-
tastic 24x. Besides, the Optical Image Stabi-
lizer makes sure tele-photographs don’t end
up looking fuzzy.

The Canon PowerShot S3 IS has a 2-inch
LCD panel, which can be turned and twisted
in multiple directions—a great feature for
experimenting with new shot angles. What
sets the camera apart is its capability to cap-
ture video—at 30fps, VGA quality, and up to 1
GB with stereo sound—really neat for a still
camera. The camera has a dedicated movie

button, making switching between modes
convenient.  

The S3 IS comes with a plethora of shoot-
ing modes including full manual, Aperture
Priority and Shutter priority, making for com-
plete shooting flexibility. Unique features
such as Colour Accent and Colour Swap result
in fantastic effects. Apart from these, there
are also the regular predefined shooting
modes—night, snow, fireworks, and so on.

The new 6
MP CCD sensor
now supports
speeds from
ISO 80 to 800,
e n h a n c i n g
l o w - l i g h t
shooting capa-
bilities.

Canon PowerShot S3 IS

FIFTH ANNIVERSARY
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Digital Passion l 30 days with...

Sanket Naik

After we were done with our speaker set shootout of last month, the Digit Test Centre was littered with speakers from

various brands. I refrain from listening to music during office hours, but there were so many great speaker sets

around—and just because they were there, I thought of hooking up a 2.1 set to my PC. Pottering around, I chanced upon

the Creative I-Trigue 3400, which the company describes as “Premium Fidelity” and “fashionable and functional.’ They

were to grace my desk for the next 30 days.

Creative I-Trigue 3400

Digital Passion l 30 Days With...

Imaging Sivalal S Photograph Sandeep Patil

Day 1
This set comes with accessories for connecting auxiliarydevices—companies normally don’t provide these. At firstglance—and at later glances as well—what sets thesespeakers apart are the beautifully-crafted satellites, eachwith three one-inch titanium drivers. The wooden sub-woofer sports a milky-white exterior, as opposed to theorthodox black.

Day 3
Visitors to the Test Centre seemed to be turning their headsin the direction of my desk, and I assumed it was becauseof the flashy speakers. Now what use is a premium speakerset if you don’t turn up the volume? So I did,but my co-workers were more than a littleirritated. “All right, all right,” Igrumbled, and turned down the volumedown. But at this setting, the tinydrivers don’t lend depth to the sound,and the music sounds flat. Not good.

Day 4
The subwoofer is front-ported, and thisallows it to be placed close to the wall—good if your room is small. The buildquality is excellent, and the

satellites even survived a nice
four-foot fall.

Day 5
Working late has it

advantages: I merrily
cracked open the

volume knob. The set
does deliver good sound

at full volume. The bass is
overpowering at times,

though; with the highs beinggenerally predominant. Theset is lacking when it comes tothe mid-frequencies, again
because of the small drivers.

Day 8
It’s been eight days and I’m satisfied with the quality ofthe set. Not overly so, but in general, yes. Except for somecomments being passed about the colour I’d chosen: lightpink. The set comes in ten colours, but we only had thelight pink at the Test Centre! That in combination with thewhite of the subwoofer is raising many an eyebrow!

Day 14
Trance sounds great on these speakers. Sphongle andBuddha Bar is what I’ve been listening to for the past fewdays. Soft rock as well as pop need a little fiddlingaround with the equaliser to make the music sounddecent—again, not a good thing in general. Rock, on theother hand, sounds great when the volume is set to above50 per cent.

Day 18                       
Virus attack! I was forced to take a break from playingmusic off my PC. But I did have the option of connectingmy MP3 player to the speakers! The little round remotecontrol pod for the speakers has a line-in jack that makesconnecting any device convenient, and right next to theline-in jack is a headphone jack—again, very convenient.

Day 25
Quake III fever was back at the Test Centre, and we gotinto some serious fragging post work hours. In the heat ofthe moment, I fired the speakers to nearly 75 per centvolume and did-they-sound-good! I abandoned the partyand tried out the set on a couple of other games. Thesound was consistently good, but naturally, there’s onlythis much that a 2.1 set can accomplish in terms ofcreating an immersive experience.

Day 30
This is a beautiful 2.1 speaker set—but take note: thepredominant focus is on aesthetics. The sound is indeedgood, but not quite up to an audiophile’s standards.Remember that a good part of the money you’ll spend onthis set—if you do—will pay for the design!

sanket_naik@thinkdigit.com 

FIFTH ANNIVERSARY
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Jyotsna Rege

As this was an anniversary issue, we
decided to include two sites in this
space—one that takes your desktop

to the Web, and one that could get a
neuron or two fired up.

www.goowy.com
When we heard about Goowy.com, we
didn’t expect to take the site seriously.
Honestly, with a name like Goowy,
what can you expect? Our first glimpse
revealed it was some sort of e-
mail and Web storage site. As it
turns out, Goowy is a site that has
IM, mail, file storage, games, per-
sonal organisers and more rolled
into one—making up what they
call a “webtop.”

This Flash-based site is rather
original in concept. Goowy
explains that their purpose is to
offer a “fresh desktop-like experi-
ence on the Web.” We tried a guest
account, and what we got was a
sort of a desktop, with a toolbar at
the bottom. The “webtop” has sev-
eral functions neatly arranged. There’s
Goowy mail (but imagine an
address@goowy.com—how uncool is
that?), IM, a page to manage contacts,
and a calendar. The IM has four service
providers—AOL, Yahoo, MSN and ICQ;
you can access two or more messen-
gers simultaneously. You also get

storage space for your data. And there
are the “Minis”—where you have
weather reports, news, and videos,
besides Flash games.

Goowy.com is impressive primarily
for the desktop-on-the-Web feel. It’s
novel—you have to log in just once to
access all the features instead of log-
ging in individually for, say, blogging,
IM, and so on.

The design is impeccable—it actu-
ally does feel like a desktop, with
reminders sliding up as in Outlook,
tooltips for the icons at the bottom,

nice colours, and more. Functionality-
wise, it’s good, really: you get most of
your everyday stuff under one banner.
Last we checked, this up-and-coming
site offered 1 GB of file storage, 2 GB of
mail, and a forum had been added.
Take a look!

http://mathworld.
wolfram.com
A mathematics resource, here’s a
maths encyclopaedia that would be an
enthusiast’s answer to fevered prayers
for comprehensive information on any
subject under mathematics. Not only
does the site have a huge repository of
formulas, theorems and explanations,
you can also contribute your own facts
and definitions.

The site is “intended for students,
educators, math enthusiasts, and
researchers,” and is easy enough to
navigate. The sheer amount of content

Maths, Minis, And More
will amaze you: you need to exercise
some patience before you get a hang of
digging out the information you need.

On the left of the main page is an
index that lists the main categories.
Clicking on these takes you into sub-
categories, and so on. There is, of
course, a search window on the main
page. Reading up “About Math world”—
a link under Destinations—helps under-
stand the site a little better. Then
there’s “Math news for you” to read up
on what’s new on the mathematics
front, besides checking out recent con-

tributions to the site.
To simplify the explanation

for a term or expression, the site
makes effective use of an inter-
linked framework of descriptions.
If, for example, you were to look
up quadratic equations, going to
Algebra > Algebraic equations >
Quadratic equations takes you to
the required expression. But
here’s the tricky bit: the page
defines a quadratic equation as a
“second-order, polynomial equa-
tion in a single variation x”! If you
scraped up quadratic equations

from memory and don’t have a clue as
to what a polynomial equation is, you
can begin by clicking on the hyperlink.
The linked page then goes on to
describe the quadratic formula, the
development of the quadratic equation
through history, and so on. You’ll even-
tually find what you’re looking for, but
you do need to have your basic maths
in place—which again, the site helps
you with.

Mathworld is helpful at all levels—
whether you’re in school and need to
understand all about the Fourier series
or whether you just need 
to quickly solve a probability problem
(and have even forgotten what proba-
bility is all about). The only hitch is
there really is a lot of information—
you’ll need to get the hang of clicking
in the right places to get to what you’re
looking for. 

jyotsna_rege@thinkdigit.com

Goowy
explains
that their
purpose is
to offer a
“fresh
desktop-
like
experience
on the
Web” 

For anything maths-related, just head to MathWorld

This isn’t a desktop—it’s what Goowy calls a webtop
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I’ve been
fascinated by the
graphics tablet
that the designers
use here. Even as I
watched them
sketching and
drawing, I
wondered if their
ease arose from
constant use of the
instrument or if
the gadget was just
plain easy to use.
Did it feel very
different from
sketching using a
pencil?

At the designers’ corner, Pradeep, one of our
designers, showed me how to use the Graphire
graphics tablet. It looked like a high-tech slate; I spent
some time doodling on the PC. After a five-minute
exercise with the tool, I realised that using it would
be much tougher for someone not accomplished
with a pencil. You don’t have to be really good at
drawing, but a deft hand is a definite requirement. 

For my drawing, I chose an action figure—an object
that, I discovered, was challenging enough. Working
on a tablet makes things easy—a wrong stroke can
just be undone! Besides, for symmetry, I could always
invert an image to create an exact match. Satisfied
with what I had sketched, I tried my hand at
colouring it.

Colouring an image on the screen is much, much
easier than with pencil and paper. I can create a
layer for my original sketch and colour on the layer,
akin to placing a tracing sheet on paper and then
colouring the tracing sheet. And I found that I
could create as many layers as I wanted. Cool!

I found that I was done a lot faster with the
graphics tablet, and because I could undo, I had a
much more professional looking drawing. The
colouring, thanks to my experimentation with
layers, was really good too.

My efforts with a pencil... My masterpiece using the graphics tablet

1

2

3

4

Good old sketching is fun, but if you want to save on
time and need a record of all you sketch, draw and

colour, the tech way is the only way. A graphics tablet is
easy to use, and if you’re adept at Photoshop, the PC is
really neat. But the use of the tablet assumes a

reasonably deft hand. Although you can conceivably
scan an image into Photoshop and then work on it, it’s
not entirely feasible. For ease, its technology. For
practice and developing your art, it’s definitely pencil
and paper.

OLD
WAY

TECH
WAY

Fun Quotient: 3/5
Total Time Taken: 1 .5 + 1.5 = 3 Hours

Fun Quotient: 4/5
Total Time Taken: 1 hour 45 mins

And 

The

Winner

Is...

Jyotsna Rege (jyotsna_rege@thinkdigit.com)

I finally finished the second piece too. The whole
cause cost me more time than I expected to spend,
courtesy my rather average drawing skills, but my
efforts have a proud place on the Digit pin-up board,
not to mention on our backup server!

Etching A Sketch

It’s an unwritten law that if a hand-sketched image is
to be scanned, it better be worthy of veneration! My
initial attempts at drawing drew sniggers from
colleagues. I should not have been surprised—it’s been
ages since I wrote with a pen. The memory of a pencil
is even further off. Although I knew the rudiments of
drawing, it had been too long ago. So I decided to do
myself a favour…

Working with colour was next. I couldn’t colour the
earlier image—it was replete with pencil shading. I
made another drawing, and used pastels for the
colour. I had to be careful because every wrong stroke
required a bit of covering up.

A three-hour, four-day summer course promised
improvement in my sketching and drawing skills. At
the end of my sessions, I did find my “art” markedly
improved. I put in a lot of hard work, and then,
soon enough, I was ready to scan it! The
imperfections seemed more obvious on the screen,
but anyway…

FIFTH ANNIVERSARY



A monster of a graphics card

This GPU is the latest from NVIDIA. It’s based on
NVIDIA’s newest and fastest 7900GTX chipset. It

features the same 24-pixel pipeline architecture of the
7800GTX series, but with a lower transistor count,
meaning significantly lower heat dissipation. The low
transistor count also means NVIDIA could up the
clock speed, which they haven’t missed out on.

The Leadtek PX7900GTX features a 650 MHz core
and 512 MB of GDDR3 memory @ 1600 MHz. Add to
that full Direct X SM 3.0 compliance and HDR
support, and you have a monster of a card on
your hands! And the card does look
monstrous, thanks in part to the huge heat
sink, which has cooling pipes dissipating
heat away from that supercharged core. One
serious accomplishment here is the temperatures,
which were well in check—easily within limits for a card of
this calibre. The memory is also actively cooled via the heat
sink, which is integrated with a large-diameter slow fan.
Noise levels are tolerable.

Apart from the driver CD and free software, the card
comes bundles with a full version of Serious Sam 2, a new
game, which should give this card an easy workout. Also
bundled are the composite cables, and the DVI to D-Sub
adapter; the card comes with two DVI-I connectors, so if your
monitor has only D-Sub, you will need to use this.

Performance-wise, this board is no slouch! 3D Mark 2005
put up scores in excess of 11000—an all-time high among all
the cards we’ve tested! We started up DOOM 3 and were
greeted with a straight 100+ fps score. To make things
interesting we cranked up the resolution while enabling full
AF and AA, and even at these settings the card didn’t miss a

beat—
shattering
all previous
records. 

A true fire-breather, the
Leadtek PX 7900GTX costs a
whopping Rs 35,000. Premium
products don’t come cheap, now, do they!
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Rating

Company Top Notch Infotronix (I) Pvt Ltd

Price Rs 35,000

Phone 044-26616201/202

E-mail zebronics@zebronics.net

Web site www.leadtek.com

Rating

Your data vault on-the-go

Kingston’s PRIVACY series of USB Flash drives has
always stirred users’ fancies. The drive we

received for testing offered a very decent 2 GB. It’s
great in terms of design, build quality, and
aesthetic appeal.

Once inserted into a USB port the drive gets
detected, but you can’t access data just yet.
Instead, the Kingston software will autorun; the
software is on the drive’s system area, which
cannot be formatted. The purpose of the software

is password protection: only after the
correct password has been
entered will the drive become
accessible. If the password is
incorrect, the drive will not
show up in Windows. The
password can only be reset by
formattting the drive!

Data transfer rate is better
than the other drives we’ve tested. The
DataTraveller ELITE PRIVACY is perfect for
moving large amounts of data to and fro,
but Rs 8,500 is a little expensive.

Just a good camera

The DSC-512X PLUS camera may not look extraordinary,
but it has a 7-megapixel CCD with 3x optical zoom. The

display is a 2-inch colour TFT LCD. There’s no viewfinder, so
shooting in bright sunlight is somewhat difficult. Inbuilt
memory is only 32 MB but thankfully, an SD/MMC card slot
is provided. The camera supports the PictBridge interface.

The photos we clicked were crisp, and the colour vivid.
Video shooting is supported. The inbuilt flash is good
enough even for pitch-dark conditions.

Tech-Com has also provided
four games with the
camera, and the
software
package
includes Ulead
Photo Explorer
8 SE. The
bottom-line—a
decent buy!

Company A A Infoways

Price Rs 8,500

Phone 011-26442261 

E-mail info@infoways.com

Web site www.kingston.com

Tech-Com DSC-512X PLUS

Company Shree Sagarmatha Dist Pvt Ltd

Price Rs 7,990

Phone 011-26428541

E-mail contact@techcomindia.com

Web site www.techcomindia.com

Leadtek Winfast PX7900GTX

Kingston DataTraveller ELITE PRIVACY

Rating

Photograph A
m

rut Patki

Photograph A
m

rut Patki
Ph

ot
og

ra
ph

 S
an

de
ep

 P
at

il



133JUNE 2006 DIGIT

Storage, movies, music and more!

Vantec’s AVOX-100 Jukebox is a nifty 2.5-inch hard drive
enclosure: you need to add the hard disk. It can play

movies and music and display photographs on a TV set, and
also acts as a standalone backup device—you can copy files
directly from other USB devices such as thumb drives and
digital cameras without the need for a PC. 

The case is powered by a power adapter; it can also run on
standard AA batteries using the provided battery adapter. The
device can work like any other external USB storage device (as
in plug and play). A little switch lets you toggle between three
modes: storage, TV, and USB host.

When connected to a TV, files can be accessed via an easy
interface. In our test, the device easily played DivX and MP3
files. A slideshow of photographs worked great. Data backup 
from other USB devices works without a hitch.

For its versatility, we think the Vantec AVOX-100 is worth the 
Rs 5,000 price tag.

Razor-thin

It’s a Sony, and it’s powered by a Mobile Intel Core Duo
processor running at 1.8 GHz. Other specs read 512 MB

DDR2 RAM @ 533 MHz, an 80 GB hard drive, and a
DVD-RW. The 13.3-inch wide-screen display supports
1280 x 800, and is one of the slimmest displays we’ve
seen on any laptop we’ve ever tested! Image quality is
crisp, colours are vivid, and the large viewing angles
mean great visibility.

A new concept called the Hybrid Graphics System
means you can change from Stamina mode—where an
Intel GMA 950 graphics processor is used for low-power
computing—to Speed mode, where an NVIDIA GeForce
7400 Go allows for high-powered gaming (at the expense
of greater battery consumption).

Other features such as a Web camera integrated into
the display, a memory card reader supporting almost
every type of card, and Wi-Fi connectivity round up the
features list. Rs 1,24,990 is, we think, a good price point
for this notebook.

Digitise those cards!

For the busy marketing executive, the sudden availability of
business card readers is a welcome development.

PENPOWER’s WorldCard Color is one such device that offers a
no-frills approach to digitising business / visiting cards. It’s
bundled with seemingly intelligent software that recognises
details from cards—company and person’s name, address, phone
number, e-mail ID and Web site. Scanning and extracting these
details takes about 10 seconds per card.

The device installed without a hitch when we tested it on
Windows XP. The software is intuitive, and
bundles along features such as a Mail To
the e-mail ID that was read, Go To the
Web site, a powerful search
feature, alphabetical sorting,
and even the capability
to read from an
image file! With
a resolution
of 600 dpi, it
can even be
used a regular
scanner
for small
(A6)
documents
such as ID
cards, driver’s
licenses and
so forth.

Rating

PENPOWER WorldCard Color

Sony VGN-SZ18GP/C

Rating

Company Access

Price Rs 8,450

Phone 022-23840789

E-mail cshah@bom8.vsnl.net.in

Web site www.penpower.us

Vantec AVOX-100 Jukebox

Company Sony India Pvt Ltd

Price Rs 1,24,990

Phone 022-28313333

E-mail sonyindia.care@ap.sony.com

Web site www.sony.com                      

Rating

Company Apical Impex Pvt Ltd

Price Rs 5,390

Phone 9821349177

E-mail tejas@apical.in

Web site www.vantecusa.com
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Photograph Sandeep Patil

Photograph Jiten Gandhi
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My friend had just assembled a
computer, and realising he hadn’t
bought any software, he called me to

ask if he could “borrow” my installer CDs! Now,
I’m known for my strong views against piracy,
and I decided to make him my first lecture
victim for the summer! Determined to make
him realise the importance of buying the orig-
inal software, I headed for his place.

My friend’s not a cheat—he’s just
misguided because of all the piracy that takes
place around here. Even system assemblers
load pirated OSes and software when they
provide you with a machine. Had he not
decided to buy his machine in parts and assem-
ble it himself (he had always wanted to do so),
he would have got a machine with an OS and
the most popular paid software—MS
Office, Tally, Norton SystemWorks,
and the likes—all pirated, all at no
extra cost. The phrase “but every-
one does it” is no justification for
committing a crime, and my
friend understood. But though he
agreed to pay for the OS, he was
quite confused about how to go
about buying it. I decided to use
my regular slot in Digit to tell all of
you what I told my friend.

The OS
Windows XP is the unanimous
choice, but not many know
that there are various
flavours available. There’s
the Professional Edition,
Home Edition and Media
Center Edition. Home users
should not consider
Windows XP Home cripple-
ware, as popular belief goes,
because all that the Home Edition
does not have is some advanced tweak-
ing tools and lack of support for IIS.
Most home users will never notice
these differences, and can pay less to
obtain your legal copy!

XP Professional is the most
powerful flavour of the lot, but
there are complications when
buying it. For example, if you’re
buying the OS for just a single
computer, you can opt for the Box
Pack, which contains the installer
CD, the Manual and the End User

License. The box contains a serial key that can
be used only on one computer, and you will
need to preserve the license to prove the
authenticity of your copy. Now, if you have 15
computers or more in a SoHo setup, it would be
stupid (and expensive) to buy 15 box licenses.
So, you have the option of buying the Paper
License. This means you get only one box and
one serial, but can use that to install XP Profes-

sional on all your computers. The advan-
tage is that you cut down on

paperwork and costs, and all your
computers have a single serial.

Those of you who want to buy a
copy of Windows Server 2003 will
need to remember that apart from
the cost of a Server 2003 license, you
also need to pay for a Client Access
License (CAL). This is the license for
the users who will connect to and use
the server. Server 2003 comes with
licenses for five to 10 users, and if
you have more, you will need to buy
the CAL for more users.

Open Source
Those of you who are averse to
paying anything at all should
seriously consider shifting to
Linux. The beauty of this is that
whether you need it for desktop
or server use, you will never pay
a penny—of course, you’ll have to
learn about Linux and pretty

much start from scratch!
When it comes to office suites,

most of us Indians use pirated
versions of MS Office. If you want to
stay out of trouble without coughing
up—and MS Office comes with a
hefty price tag—you can always give
OpenOffice.org a try; it’s an excel-
lent replacement for MS Office! 

Agent 001

Please Go Paid!
Using pirated software only because “everybody
else does” is all but an excuse. Here’s how to go
about buying legal software—flavours of
Windows XP and more

Illustration Pradip Ingale

Want more of Agent 001? Turn over to read his
answers to your buying questions

Software

Windows XP Home 
Windows XP Professional
Windows 2003 Server 
Client user licenses for 2003 Server 
MS Office 2003 Standard
MS Office 2003 Professional
Adobe Photoshop CS2
Adobe Illustrator CS2
Adobe Creative Suite 2 Standard 
Adobe Creative Suite 2 Professional 
Adobe Acrobat 7.0 
Macromedia Director 10
Macromedia Flash 8
Macromedia Studio 8
Norton Anti-Virus 2006 (Single user)
Norton Corporate Edition (10-user pack)
McAfee 10.0 (Single user)
McAfee AVSS (10-user pack)

Price (Rs) 
(Box/Paper License)
3,500 (OEM)
9,500 / 6,270
32,200 / 24,140
1,165
13,100 / 12,390
16,100 / 15,330
35,570 / 32,500
27,440 / 26,660
48,250 / 45,000
64,260 / 60,000
15,300 / 14,200
58,450 / 56,600
19,700 / 19,000
49,130 / 47,100
1,600
6,500
1,350
8,600
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Boost My Brain
I have a Pentium 4 3.0 GHz on an 865 GV moth-
erboard with 256 MB of RAM. I want to upgrade

the memory to 512 MB or higher. On opening my PC,
I found that I have two 128 MB modules. My question
is, what should I be looking at before buying the
memory modules? What frequency modules will I
require for my motherboard, and what will be the
approximate price?

Hari Raj K

Motherboards based on the Intel 865
chipset support dual-channel memory

capability, and that’s the reason you have those
two 128 MB memory modules. For your mother-
board, therefore, I’d suggest you opt for two 256
MB modules instead of one 512 MB module, so as
to take advantage of dual-channel mode. These
boards support DDR 400 MHz modules, so while
buying, you will have to specifically ask for DDR
400 MHz. The approximate price of 256 MB DDR
400 MHz memory modules is around Rs 1,000.
Opt for modules from brands such as Kingston,
Transcend or Hynix.

The Brand Matters
I have a budget of around Rs 1,100 and want to
buy a pen drive. What is the maximum capacity

that I can get within my budget, and what brand
should I opt for?

Ashad Ullah 

I think you need to be a little careful
when buying a pen drive. The market is

full of spurious drives that cost a third of what
good, branded stuff costs. I suggest you buy a
drive from a branded player such as Kingston or
Transcend. For Rs 1,100, you will get a 512 MB
branded drive.

Not Quite Music To My Ears
I bought an MSI MEGA 533 MP3 player, but I’m
not satisfied with the bundled earphones—they

are too tinny. Please recommend good earphones!
Tanmoy Mallivk

You’re right—most MP3 players are
bundled with bad earphones. I would

suggest you buy original Sony earphones for your
player: visit Planet-M or any other good music
store. Sony has some quality earphones called
Fontopia, and you can get them from shops sell-
ing foreign goods—or you can import them from
the US via your friends. There’s quite a range in
the Fontopia series, and prices range from $15 to
$49 (Rs 700 to 2,300).

A Burning Question
I have an Intel Pentium 4 3.6 GHz processor on
an Intel 915GV/GL motherboard with 256 MB of

RAM. I have a CD-ROM drive I would like to upgrade
to a DVD-Writer. What brand?

Via e-mail

I recommend either a Lite-On or a Sony
DVD-Writer for your system. The Lite-On

SHOW-1693S is the model you should be looking

for. If you’re unable to locate a Lite-On dealer in
your area, opt for the Sony DRU-810—it’s compa-
rable to the Lite-On in all respects, and is widely
available.  

On An Equal Note
I want to buy a laptop primarily for home use.
I will be using it of for photo editing, converting

songs, surfing, and word processing. I have two
models in mind—the HP Pavilion DV1615TS (1.7 GHz,
2 MB cache, 400 FSB) and DV1624TN (1.66, 2 MB
cache and 667 FSB). The other specs are pretty much
the same—80 GB HDD, 14-inch WXGA and so on.
Which model should I opt for? Do you know of any
better models? Rs 50 to 60K is what I’m looking at. 

Madhabi Roy

Any current-gen laptop with sufficient
processing power will be good enough

for your needs. Of the two HP models I would
suggest the DV1624TN, because it has the latest
Intel Core solo processor and the supporting
945 chipset. The other model is based on the
older Sonoma platform—nothing wrong with it,
but it is an older platform. As far as other
vendors are concerned, you can look at IBM
(now Lenovo), Toshiba and Fujitsu. And regard-
ing after-sales service, HP and IBM have the
upper hand.

Power For My Tower
I want to buy a UPS. I have a typical PC setup
with a CRT monitor; can you help me select the

right one, and also tell me about the important
aspects of a UPS?

Karthik S

Apart from backup power, a UPS should
also provide voltage regulation. This is

an area not many brands are good at. I person-
ally have been using APC’s BackUPS ES for two
years now and haven’t come across any prob-
lems; moreover, it also has automatic voltage
regulation. It costs about Rs 2,500.

Obsolescence Alert
I need some advice on graphics cards. I have a
budget of around Rs 16K. I can't decide between

the GF6800XT 256MB, GF6800XT 512MB and the
GF7600GT 256MB. My card should last me a good
two years at least. What do you suggest?

I was also wondering if it’s better to opt for an
integrated solution now and buy a card later, when
dx10 is supposed to be out with Vista. Finally, which
is a better combo—the AMD X2 3800+ with DDR400
RAM or a Pentium D940 with DDR II 667 MHz RAM?

Anirudh

I’d say the GF6800 series is already
outdated to a certain extent. You can

very well go for a GF7600GT card—these are the
latest, and are fast enough to run most games.
I don’t think it will last two years, though! If you
can delay your purchase by a couple of months,
get a GF7800-based card.

Of the two processor-RAM combos you’ve
mentioned, I’d recommend the AMD X2 3800+
for performance. 

Want a tech product, but
don’t know how to go
about buying it? E-mail
agent001@thinkdigit.com
with your complete 
contact details, and he
might answer them here!
Please note that
Agent001 only answers
purchase-related
questions in this space.

Ask Away!

Ask Agent 001
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THE REGISTRY
The HKEYs
Demystified

The Windows registry is
organised in the following
way.

HKEY_CLASSES_ROOT:
Holds all file types and their
associations

HKEY_CURRENT_USER:
Holds the settings for the user
that’s currently logged in

HKEY_LOCAL_MACHINE:
Holds your computer’s
configuration information—
both hardware and software

HKEY_USERS:
Holds the settings of all user
accounts on your PC

Kill Apps Faster—I
If you’re the impatient

type and can’t be troubled
with the wait while
Windows shuts down errant
applications, there are two
ways out for you—either
make Windows shut down
hung processes
automatically, or reduce the
time that Windows waits for
before killing it. 

To shut down
applications automatically,
open the registry editor
(Start > Run, type “regedit”
and press [Enter]), and
navigate to
HKEY_CURRENT_USER\Cont
rol Panel\Desktop. In the
right hand pane, double-click
“AutoEndTasks” and change
the Value Data to 1 to enable
automatic app kills. To
disable the feature, change
the Value Data back to “0”. 

Note: Keep in mind that
if you want to apply this
tweak—Windows might end
up killing critical services
before they have time to
recover themselves,
increasing the possibility of
a system crash.

Kill Apps Faster—II
The second option is to

reduce the time Windows
waits for before showing you
the “End Program” dialog box.
Follow the instructions above
to get to
HKEY_CURRENT_USER\Contr
ol Panel\Desktop and double-
click on “HungAppTimeout”
and change the value data to
the time (in milliseconds)
you’re willing to wait for an

unresponsive application. If
you find applications that
take too long to close when
Windows is shutting down,
you can also set the time that
Windows will wait for before
killing it. You’ll find this
value under
“WaitToKillAppTimeout” in
the same pane. 

Kill Apps Faster—III
If you want to change

the time that Windows waits
before killing a system

service when shutting down,
navigate to
HKEY_LOCAL_MACHINE\SYS
TEM\CurrentControlSet\Con
trol and double-click on
“WaitToKillServiceTimeout”
and enter a more acceptable
value than the default 20000
milliseconds. 

Save Your Tweaks
If you’re a compulsive

registry tweaker and like to
switch between different
settings often (like showing

and hiding the
Administrator as above), you
can save yourself some time
and considerable
inconvenience by using this
simple method. Navigate to
the key whose value you’re
changing. Go to File > Export
and choose a save location
and name for the exported
registry file (extension: .reg).
Open this file in Notepad.
You will see “Windows
Registry Editor Version 5.00”
at the top, followed by the
path to the key you just
exported
(“[HKEY_CURRENT_USER\Sof
tware\Microsoft\Windows\
CurrentVersion\Run]” for
example). Leave these two
lines alone, and delete
everything but the value you
want to keep. For example,
in the “Kill Apps Faster—III”
tip, all you need would be
the “WaitToKillService
Timeout” key—the rest can
be removed. Save as many
copies as needed with
different values for the key.
For example, we saved one
file called showadmin.reg
with “Administrator” as 1,
and another called
hideadmin.reg with the
value as 0. To change the
settings, just double-click
these .reg files. No more
running into Regedit all the
time!

Now that you’ve saved
tweaks in different files, you
can also share them with
friends! Just make sure that
they’re not too application
or user-specific. The safest
option would be to share
tweaks that apply to
Windows directly. 

A Background Image
For Explorer Toolbars 

To display a background
bitmap for Windows
Explorer toolbars, navigate
to HKEY_CURRENT_USER
\Software\Microsoft\Intern
et Explorer\Toolbar and
create a new String value by
right-clicking in the right
hand pane and selecting
New > String. Call it
“BackBitmapShell”. Double-
click on it and enter the
path of the image you want
to use as a background. The
image must be in the .bmp
format.

Illustrations Harsho Mohan Chattoraj
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Change Processor
Performance Settings

Note: This tweak only applies
to laptops using Intel
SpeedStep or AMD PowerNow!
Processor performance
management. 

To change the way
Windows XP’s inbuilt
processor management
works, navigate to
HKEY_LOCAL_MACHINE\SYS
TEM\CurrentControlSet\Serv
ices\P3\Parameters and in
the right-hand pane select
New > DWORD and call it
HackFlags. Enter the
following values for the
corresponding effect: 

0 = disable native XP
support 

1 = use the settings
inherited from Intel’s
software 

5 = the system can
support all processor modes
even when running on
battery.

Stop Paging The Core
Windows System

On systems with at least 1
GB of RAM, you can
configure the Windows core
system to run completely out
of memory. Keep in mind
though, this will limit the
performance of other
applications and may even
cause problems with
applications like Adobe
Photoshop, which depends
on the Windows swap file
directly. Navigate to
HKEY_LOCAL_MACHINE\SYS
TEM\CurrentControlSet\Co
ntrol\Session
Manager\Memory
Management and create a
new DWORD, calling it
DisablePagingExecutive. Set
the value data to 1 to disable
system paging, and 0 to
return to its default setting.

Optimise Windows For
Larger L2 Caches

By default, Windows XP is
optimised for processors
which have 256 KB of L2
cache memory. However, if
your processor has more
(verify this with your
vendor), you should modify
its settings to make better
use of it. Navigate to
HKEY_LOCAL_MACHINE\SYS
TEM\CurrentControlSet\Co
ntrol\Session

Manager\Memory
Management and in the
right-hand pane create a
new DWORD value and call
it “SecondLevelDataCache”.
In the value data, enter the
number for how much L2
cache memory your
processor has (make sure you
select the Decimal radio
button when you do so). The
changes will take effect once
you restart windows. 

Put My Computer
Back On Top

Do you prefer the old
Windows 98 desktop layout
where My Computer was at
the top rather than My
Documents? Navigate to
HKEY_CLASSES_ROOT\CLSI
D\{450D8FBA-AD25-11D0-
98A8-0800361B1103} and
double-click on
“SortOrderIndex”. To choose
which icon goes at the top,
use the following values:

48 (hexadecimal): My
Documents

54 (hexadecimal): My
Computer

If the setting doesn’t
work immediately, right-
click on the desktop >
Arrange Icons By > Type.
Though you can achieve the
same thing just by dragging

the icons into whatever
order you want, this tip will
help you keep it that way
even if you choose to
automatically sort the icons
by any parameter—Name,
Type, Size, etc.

Change The Colour Of
Encrypted Files

When you encrypt a file in
Windows XP, its filename
begins to display in a bluish
green colour. To change this
colour, navigate to
HKEY_CURRENT_USER\Soft
ware\Microsoft\Windows\C
urrentVersion\Explorer. If
it doesn’t already exist,
create a new Binary value
called “AltEncryptionColor”.
To change the colour, edit
the value data for this
binary value. The colour will
be represented by RR GG BB
00, where RR is a number
that denotes the value of

Add Rename and/or Delete to special folders
You can add a Rename or Delete command or both to the right-click menu for

special folders like My Computer, My Documents and so on if you know the GUID
(Globally Unique ID) for that folder. Just navigate to
HKEY_CLASSES_ROOT\CLSID\{GUID}\ShellFolder and add or modify a Binary Attributes
value (New > Binary value) to change the setting. In place of {GUID}, use one of these: 

Description Globally Unique Identifier (GUID)
Administrative Tools {D20EA4E1-3957-11d2-A40B-0C5020524153}
Briefcase {85BBD92O-42A0-1O69-A2E4-08002B30309D}
Control Panel {21EC2O2O-3AEA-1O69-A2DD-08002b30309d}
Fonts {D20EA4E1-3957-11d2-A40B-0C5020524152}
History {FF393560-C2A7-11CF-BFF4-444553540000}
Inbox {00020D75-0000-0000-C000-000000000046}
Microsoft Network {00028B00-0000-0000-C000-000000000046}
My Computer {20D04FE0-3AEA-1069-A2D8-08002B30309D}
My Documents {450D8FBA-AD25-11D0-98A8-0800361B1103}
My Network Places {208D2C60-3AEA-1069-A2D7-08002B30309D}
Network Computers {1f4de370-d627-11d1-ba4f-00a0c91eedba}
Network Connections {7007ACC7-3202-11D1-AAD2-00805FC1270E}
Printers and Faxes {2227A280-3AEA-1069-A2DE-08002B30309D}
Programs Folder {7BE9D83C-A729-4D97-B5A7-1B7313C39E0A}
Recycle Bin {645FF040-5081-101B-9F08-00AA002F954E}
Scanners and Cameras {E211B736-43FD-11D1-9EFB-0000F8757FCD}
Scheduled Tasks {D6277990-4C6A-11CF-8D87-00AA0060F5BF}
Start Menu Folder {48e7caab-b918-4e58-a94d-505519c795dc}
Temporary Internet Files {7BD29E00-76C1-11CF-9DD0-00A0C9034933}
Web Folders {BDEADF00-C265-11d0-BCED-00A0C90AB50F}

Enter these settings in the Attributes
value to add the new context menu items:
These will appear under the File Menu in
Explorer:
50 01 00 20—Rename only
60 01 00 20—Delete only
70 01 00 20—Rename and Delete

These will appear under the Edit Menu in
Explorer:
41 01 00 20—Copy only
42 01 00 20—Cut only
43 01 00 20—Copy and Cut 
44 01 00 20—Paste only
45 01 00 20—Copy and Paste 
46 01 00 20—Cut and Copy 
47 01 00 20—Cut, Copy and Paste

Bring My Computer to its rightful
location
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Red in the colour, BB the
value of blue and GG the
value of Green. 

Send Outlook XP To
The System Tray

Jealous of lucky Outlook 2003
users who get to hide Outlook
in the system tray? Fear not.
Navigate to
HKEY_CURRENT_USER\Softw
are\Microsoft\Office\10.0\O
utlook\Preferences and in
the right-hand pane, select
New > DWORD and call it
“MinToTray”. Set the value
data to 1, reboot, and Outlook
will now sit in the system tray
when you minimise it. You
won’t get anything from
right-clicking on the tray
icon, though. To reset this to
its prior condition, either
delete “MinToTray” or set its
value to 0. 

Show Me The Admin!
When you install

Windows XP, it creates a
system administrator account
(called, by some strange
coincidence, Administrator),
which will be visible on the
login screen only till you

create a new user account,
after which it is hidden from
you. To add the
Administrator back to the
login screen, open the
Registry Editor and go to
HKEY_LOCAL_
MACHINE\SOFTWARE\Micro
soft\Windows
NT\CurrentVersion\
Winlogon\SpecialAccounts\
UserList. Double-click on
Administrator if it’s there
and change the Value Data to
1. If you don’t see it, create it
by right-clicking in the pane
and selecting New > DWORD.
Name it Administrator and
then change the Value data
to 1. The next time you start
your system, you should see
the Administrator in the
logon screen as well. 

Set Programs to Run
on Startup Only Once

You’ve probably encountered
RunOnce if you’ve ever
diagnosed your system for
startup programs. Programs
entered in the RunOnce key
will, as the name suggests,
run just once before being
removed from startup. To add
a program to the RunOnce
category, navigate to
HKEY_CURRENT_USER\
Software\Microsoft\Window
s\CurrentVersion\RunOnce.
Right-click and select New >
String value. The name of the
value should be the name of
the program you want to run,
and the Value Data should be
the path of that program.

Start Command
Prompt From

Directories
When you start the Windows
Command Prompt, (Start >
Run, type “cmd” and press
[Enter]), it starts in your user
directory. This registry tweak
will let you start command
prompt in any directory that
you choose. Navigate to
HKEY_CLASSES_ROOT\Directo

ry\shell. Right-click on the
“shell” key and select New >
Key. Call it Prompt. On the
right pane for the Prompt Key,
change the default value data
to “Start Command Prompt
Here” (without the quotes).
Now, under the Prompt Key,
create another key called
Command. In the default
value here, enter “cmd.exe /k
cd %1” (again, without the
quotes). You should now be
able to right-click on any
folder and start the command
prompt from there. 

Increase the USB
Polling Interval

Windows constantly checks
(polls) USB ports for
connected devices. If you
don’t have any USB devices

connected, you can increase
the poll interval to save on
resources and power. Laptops
especially will be able to
enter the power-saving mode
faster. Navigate to
HKEY_LOCAL_MACHINE\Sys
tem\CurrentControlSet\Co
ntrol\Class\{36FC9E60-
C465-11CF-8056-
444553540000}\0000, right-
click in the right hand pane
and choose New > DWORD.
Call it “IdleEnable” and set
the value data to 1. This will
enable USB idling and will
increase the polling interval.

Disable the Windows
Key

If you don’t want to use the
special Windows key, you
can disable it in the registry.
Navigate to
HKEY_LOCAL_MACHINE\SYS
TEM\CurrentControlSet\Co
ntrol\Keyboard Layout. If it
doesn’t exist, create a new
Binary value (Right-Click >
New > Binary Value) and call
it Scancode Map. Double-
click on the value and enter
this value data:
00 00 00 00 00 00 00 00 03
00 00 00 00 00 5B E0 00 00
5C E0 00 00 00 00
Restart Windows for this to
take effect.

Disable Windows CD
Burning 

To disable Windows’ default
CD burning function, use
this tweak. Navigate to
HKEY_CURRENT_USER\Soft
ware\Microsoft\Windows\C
urrentVersion\Policies\Expl
orer (or the same key in
HKEY_LOCAL_MACHINE if
you want this to apply to all
users) and create a new
DWORD by right-clicking in
the right-hand pane and
selecting New > DWORD.
Call it “NoCDBurning” and
set its value data to 1 to
disable CD burning. To
enable it again, just change
the value data back to 0 or
delete the DWORD
altogether. 

Bring Windows to
Front à la X-Windows

In X-based operating systems
like Unix and GNU/Linux, you
have the option of being able
to bring windows to the
foreground by just hovering
the mouse cursor over them.
Here’s how you can do it for
Windows XP too. Navigate to
HKEY_CURRENT_USER\Contr
ol Panel\Desktop. You will
find a binary value called
“UserPreferencesMask”. This
is different for different
people, so this part is a little

Revealing the hidden Admnistrator

The settings for the “Start Command Prompt Here” feature

The menu item in action
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Virtual private networks, or VPNs
as they are known, are private

networks routed through public
networks such as the Internet. For
example, if your company has a
branch office, then instead of using
leased lines to connect to it, you can
opt for a VPN.

The immediate advantage is a
reduction in cost. While there are
many VPN solutions available, we will
here take a look at Hamachi, a small,
minimum configuration VPN utility
with NAT-to-NAT traversal capability.
NAT-to-NAT capability means two
computers on different domains can
be connected for direct mmunication.

So what’s in it for you? If you are
on, say, ISP A, and the other office or
your friend is on ISP B, transferring
files or sharing directories won’t be
possible, since your domains are
different. Hamachi, however, lets you
achieve just this.

Download And Install
You need to get the Hamachi
client, and all you have to do

is head to www.hamachi.cc—it’s a
650 KB file. Once it’s downloaded,
install it in the appropriate
directory. While installing, you will
be prompted to install hardware.
Don’t panic—just click Next and
everything will be OK!

Start The Wizard
Once the setup is done, on
the last screen, check the box

“Launch Hamachi” and then click
Finish. As soon as the Hamachi client
launches, a first-time setup wizard
also pops up along with the client.

Create An Account
To switch on the client, you
need to click on the power

button that has the standard power
symbol we see on most devices. Once
on, the client will connect to some
backend servers and then assign you
a private Hamachi network address.
The assigned IP is unique to your
machine, and it will be used for
connecting to various other
computers on the Hamachi network.

Before connecting to the server,
the client will prompt for an
account name. Just select any name
you like—it need not be unique—and
then click Create. 

Obtaining The IP
When the client is offline,
the IP is generally denoted as

0.0.0.0; as soon as it connects to the
backend server, it will change to
something like 5.38.x.x. Once the
unique IP appears, you’re all set to
host a small Hamachi network.
Alternatively, you can join a different
network. Let’s look at both scenarios.

Hosting A Network
To create your own network,
click on the little Network

button indicated by three dots and
connecting lines. In the menu, select
“Create new network”. In the next
dialog box, you need to enter two
things—first a name for your
network, and secondly, a password to

prevent unauthorised connections.
Once you key in both, click

Create. The network will be created,
and will be displayed in the client
with the name you specified earlier.
Now any friend who wants to
connect to your client just has to
type in the name of your network
and provide the password.

Joining A Network
To join a network, you again
click on the network button

and select Join Existing Network. In
the following dialog box, type in the
name of the network you want to
join and the correct password, then
click Join. Once the connection is
established, you will see all the
other computers connected to the
same network. 

The Business Of Accounts
Once the connection is
established, you can access

shares on other connected machines
and they can access yours. But before
that, you will need to make an
administrator account on Windows XP
for your friend. Go to Control Panel >
User Accounts and select “Create a
new account”. Give an appropriate
name to the account. In the next
dialog box, select the type of account
as Computer Administrator and then
click Create Account. Once the
account is created, click on it and
assign it a password so as to prevent
unauthorised access.  

Accessing Stuff
Once you’ve
created a user

account for your friend,
you can browse his
shares simply by right-
clicking on your friend’s
name in the Hamachi
client and selecting
Browse. An alternative
way to do this would
be to go to Run and
type in your friend’s
Hamachi network
address followed by the share name,
for example, \\x.x.x.xx\music.  Make
sure the shared folder doesn’t have
write access—just to avoid network
worms and virus infections.

You’ve just set up a VPN! 
sanket_naik@thinkdigit.com

Set Up A Virtual Private Network
It isn’t as difficult as you probably thought—courtesy a VPN utility called Hamachi

Ignore this warning window and just continue

Joining an existing network

It’s easy to
browse the
network once
it’s set up

Select the appropriate Network Name
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tricky. What we need to do is add
Hexadecimal 41 to the first Hexadecimal
number in the value. For example, the
“UserPreferencesMask” value in our test
PC had the value “90 12 01 80”. Start
Calculator and select View > Scientific.
Select the Hex radio button in the top
row and add 41 to the first two numbers
(in our case, 90 + 41, which gave us a
result of D1). Now edit the
“UserPreferencesMask” value data and
replace the first two digits with the result
you just got (ours now reads D1 12 05 80). 

The next step is to create a new
DWORD called “ActiveWindow
Tracking” (if it isn’t already there) and
set its value data to 1. Next, create (or
edit) the “ActiveWndTrkTimeout”
DWORD. When entering its value data,
choose Decimal and type in how many
milliseconds you want to wait before
switching windows. Now restart
Windows and voila!

End The Beeping
Do random Windows events cause

your PC speaker to beep in that annoying
manner? Shut it up permanently.
Navigate to HKEY_CURRENT_USER\
Control Panel\Sound and double-click
the “Beep” value. Change the value data
to “No”, and you won’t hear a
peep…er…beep again.

Enable Your Network
Adaptor’s Onboard

Processor
If your network card has an
onboard processor (you can
find this out from the
vendor’s Web site), it can take
off the load of network
processing from your CPU.
Navigate to
HKEY_LOCAL_MACHINE\
SYSTEM\CurrentControlSet\
Services\Tcpip\Parameters
and create a new DWORD
called “DisableTaskOffload”.
Set its value to 0 to enable
offloading network
processing onto the network
card. Restart Windows for this
to take effect.

Change Outlook XP’s
Restricted Files

Outlook blocks attachments with the
following extensions by default:
ade, adp, asx, bas, bat, chm, cmd, com,
cpl, crt, exe, hlp, hta, inf, ins, isp, js, jse,
lnk, mda, mdb, mde, mdz, msc, msi, msp,
mst, pcd, pif, prf, reg, scf, scr, sct, shb,
shs, url, vb, vbe, vbs, wsc, wsf and wsh

However, if you want to allow any of
the above file types, navigate to
HKEY_CURRENT_USER\Software\Micro
soft\Office\10.0\Outlook\Security and
create a new string value called
“Level1Remove”. In the value data, enter
the extensions that you want to allow,
separated by a semicolon. For example,
“exe;bat;pif” and so on. Do remember
that these file types are often used to
spread malicious code, so be careful
when using this trick. 

Optimise Your Hard Disk When
Your PC Is Idle

This tweak will make Windows
rearrange data on your hard disk when
the PC is idle, so that applications will
run faster. Navigate to
HKEY_LOCAL_MACHINE\SOFTWARE\
Microsoft\Windows\CurrentVersion\
OptimalLayout and create a new
DWORD called EnableAutoLayout (if it
isn’t already there). Set the value data
to 1 and restart your PC. When you
leave your PC idle now, Windows will
optimise your hard disk.

Copy NTFS Permissions
If you copy files from one NTFS

drive to another, it loses its permissions,
inheriting the default permissions of the
new drive. To make Windows preserve the
current permissions, navigate to
HKEY_CURRENT_USER\SOFTWARE\Micr
osoft\Windows\CurrentVersion\Policies
\Explorer and create a new DWORD
called “ForceCopyAclwithFile”. Set the

value to 1 to preserve the original
permissions. 

Set Disk Defragmenter Options
The Windows XP disk

defragmenter doesn’t really allow you
much in the way of customising the
defragmentation. To set a
defragmentation method, navigate to
HKEY_CURRENT_USER\Software\Micr
osoft\Windows\CurrentVersion\Appl
ets\Defrag\Settings and create a new
key called Method under Settings. In
the Method key, edit the (Default)
string and set it to any of these options:
FULL - Defragment files, space and
optimise programs. 
FULLNOAPPLOG - Defragment files and
space. 
FILES - Defragment files only. 
SPACE - Defragment space only.

To decide whether to run scandisk
before starting the defragmenter, create
a key called “scandisk” under Settings
and set “(Default)” to TRUE or FALSE. 

Disable Shut Down
If you don’t want anyone to shut

down your PC, you can disable the
command altogether. Navigate to

HKEY_CURRENT_USER\Software\Micros
oft\Windows\CurrentVersion\Policies\
Explorer. In the right-hand pane, right-
click and select New > DWORD Value and
call it “NoClose”. Set its value to 1 to
disable shutting down the PC.

Re-initialise the registry without
rebooting

If you don’t want to restart or log off to
make a registry tweak work, try this
instead:
Use [Ctrl] + [Shift] + [Esc] to bring up the
Task Manager. Under the Processes tab,
select “explorer.exe” and click on End
Task. Note: This will kill any Explorer
windows you have open. Explorer.exe will
restart automatically because Windows
can’t run without it, an your new
registry settings will now be loaded. 

Enabling Active Window Tracking

Joining an existing network

Where did Shut Down go?
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Shooting In RAW
Format
If your camera has a RAW
capture mode, it’s a good idea
to try it out. Here are some
things you need to know.

What is RAW?
RAW is not really a

single file format at all. Every
camera manufacturer has its
own native file format; all
these formats are collectively
referred to as RAW. For
example, Canon RAW files use
the .crw and .cr2 extensions,
and Nikon cameras use the
.nef extension. They are all
unique as well proprietary—
the files in these various
formats are incompatible.

But no matter what
flavour of RAW you use, the
basic idea is the same. RAW
files are uncompressed,
perfect representations of
what the camera’s image
sensor captures when you
press the shutter release.
RAW images are totally
unprocessed. Contrast this
with JPEG photos, where the
camera performs tasks such
as white balance adjustment,
colour correction, and image
sharpening.

Most importantly, RAW
files preserve all the colours

originally captured by the
camera, usually 12 bits per
pixel. When a picture is saved
as a JPEG, the camera reduces
the total number of colours
to 8 bits per pixel. The higher
colour fidelity of RAW makes
for better photos, especially if
you do a lot of editing on
your images.

Disadvantages Of RAW
There are a couple of

disadvantages to working
with RAW, however. First and
foremost is the time it takes
to save each image on your
camera. Most modern
cameras can save even large

JPEG images more or less as
fast as you can shoot them.
But RAW images are another
story. On a typical 6-
megapixel camera, for
instance, each RAW image
takes about 40 seconds to get
saved to the memory card.

File size is another
consideration. Top-quality
JPEG images could typically
be just above 2 MB each, but
their RAW counterparts are
about 4 to 5 MB. If you have a
smaller memory card, this is
something to consider.

Fortunately, there’s
nothing particularly unusual
about moving RAW files from
the camera to the PC. Use
whatever technique you
prefer. But after the pictures
are on your computer, RAW is
a different story.

RAW-Compatible
Software

In the past, most image
editors didn’t understand
the RAW format, and it was
also difficult to view, edit,
and organise RAW photos.
But thankfully, that’s
changed. No matter what
popular commercial photo
editor you use, you’ll get
RAW support if you upgrade
to the newest version.

However, Windows XP
doesn’t understand RAW files.
In your folders, RAW images
appear as nondescript icons
instead of thumbnail
previews. And if you double-
click on a RAW file, it won’t
open the Picture and Fax
Viewer to display the image.

There is, however, a

solution: Microsoft’s free
RAW Image Thumbnailer and
Viewer. This PowerToy lets
you preview, see thumbnails,
and print RAW images as if
they were any other file
format that Windows
understands. It also gives you
the ability to see RAW images
on the desktop without
special RAW image
management software.
Download the PowerToy for
XP from www.microsoft.com/
windowsxp/downloads/powe
rtoys/xppowertoys.mspx.

Depending upon what
image editor you use to edit
RAW files, your experience
will vary. Most programs
allow you to make some
initial adjustments to your
RAW photo before loading it
onto the editing canvas—more
on this later.

Should You Use RAW?
If you need to spend

money to experiment with
RAW, think twice. JPEG, used
with low compression, gives
results that are surprisingly
similar to RAW. RAW’s real
benefit comes in by making it
easier to get high-quality
results when you edit your
photos on the PC. If you rarely
spend much time editing your
photos, using RAW may be
more trouble than it’s worth.

RAW Gives Richer
Pictures

With a RAW file, the process
of applying the required
algorithms is given to your
computer rather than to your
camera. This means the
conversion process can take
advantage of the more
powerful processor in your
computer as opposed to the
processor in your camera.
And, because your computer’s
more powerful processor is
being used, camera
manufacturers have the
option of using more powerful
algorithms to process your
photograph than could be
used in the camera. This can
have the effect of giving you
richer, sharper pictures.

Pre-Edit In RAW
A great reason for

shooting in RAW is the ability
to make exposure, white

DIGITAL CAMERAS

If you shoot in the RAW format, you will find myriad options by which
you can edit your photographs
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If you use Web mail services such as
GMail, Yahoo!, Hotmail, etc., you

don’t need to read further. But do read
on if you use Outlook 2003 which, with
its plethora of features, is without a
doubt the best e-mail client out there!

Regular use of e-mail clients
coupled with the daily chaos of a
workplace can easily result in your
Inbox becoming ridiculously cluttered.
Here are some tips on how to set up
and organise your mailbox, and make
the most out of MS Outlook 2003.

Group Similar Messages
In Outlook 2003, all messages
are delivered to the Inbox. By

creating separate folders, you can
arrange the mails properly. Create
folders according to teams, projects,
and departments—or categorise them
in any way that makes sense to you. 

Go to the All Mail folder, right-click
on Inbox and then select New Folder.
Single-click the new folder and then
rename it as you like. Now, if you want
to create more sub-folders under this
new folder, repeat the above process.

Sort E-Mails By
You can specify how Outlook
sorts incoming mails. They can

be sorted by Date, From, To, Size, Flag,
Importance, Subject and Conversation. 

To set the default view, go to the
View menu, select Arrange By, and
choose the option that suits you best.

Every time Outlook starts, it will sort
the new mails according to whatever
settings you chose.

Virtual Folders
While sorting does help in
quick retrieval of mails, one

still needs to search for them. Outlook
2003 allows creation of virtual folders
for search. By default, Outlook has
three search folders—for Large mails,
Follow up, and Unread mails. You can
go about making as many search
folders as you like. Creating virtual
folders helps keep together mails that
pertain to a particular project,
meeting, and so on.

To make new search folders, right-
click on Search Folders in the All Mail
Folders window, and then select New
Search Folder. In the following dialog
box, you can select from the
predefined search criteria, or you can
define custom search criteria.  

Keep Junk At Bay
Outlook provides an inbuilt
Junk filter that diverts

unsolicited mails to a separate folder.
You can create a White List of senders
who will never be blocked, and also
mark as junk the few mails that slip
through the junk filter. 

To turn on the Junk filter, Go to
Tools > Options > Preferences. Under E-

mail, click on Junk E-mail. In the next
dialog box, specify the level of junk e-
mail protection—there are four options:
No Automatic Filtering, Low, High, and
Safe List Only. If you get loads of spam,
you might want to set the filter to
High—but remember to regularly check
the junk folder for mails that have
wrongly been marked as junk!

Smart Rules 
Mailbox rules are a smart way
of automating manual work.

For example, you can use them to
move specific mails to separate folders,
mark meetings, auto-delete mails from
specific people, etc. Mail rules will save
you lot of time and are an effective way
of organising your mailbox. 

To set rules, go to Tools > Rules and
Alerts. In the Rules And Alerts window,
go to the E-mail Rules tab. Click on
New Rule, which opens the Rule
Wizard. Outlook already has some
predefined templates: you can start
defining rules using them, or start
with a blank rule.

sanket_naik@thinkdigit.com  

Organising Your Mail 
Outlook is a wonderful e-mail client. Here’s how to get it to keep your mails organised

Creating new mail folders

The junk filter settings in Outlook 2003

Set up filters so mails go where they should

Creating “virtual” folders

Sort e-mails by any criteria you choose
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balance and other edits to
your photo before you even
create the photo. Photo
editing applications such as
Photoshop handle most
exposure and white balance
editing on JPEG, TIFF and
Photoshop files by removing
data from the photo. To test
this out, launch a photo in
Photoshop, and open the
Levels panel (Image >
Adjustments > Levels) where
you’ll see a histogram for your
photo. At the bottom of the
histogram will be three
diamond-shaped sliders. Move
in the left and right sliders
toward the centre. In most
photos, this will have the
effect of increasing the
contrast of your photo. Click
OK, and your levels changes
will be accepted. Then reopen
the Levels panel, and you’ll
most likely see the histogram
with open vertical lines. These
lines indicate missing
information or data that has
been removed from the photo
in order to achieve the effect
you saw on your monitor.

With a RAW photo, you
can make these levels and
other adjustments before you
use the conversion algorithms.
In Photoshop CS, this is done
when you double-click on a
RAW photo. Photoshop will
present you with a panel with
various exposure, white
balance, contrast, saturation,
shadow and other adjustment
options in addition to a very
large thumbnail of your
photo. You can play with these
adjustments and Photoshop
will adjust the thumbnail
photo to give you a very good
representation of what the
final photo will look like if
you accept these settings.
When you click OK, your
editing adjustments are made
to the algorithms that convert
your RAW data to reflect the
changes you want to make in
the photo.

The most important thing
to remember here is that your
adjustments are being applied
while your photo is being
created. This means that no
data is lost, and your photo
will have all the tonal
characteristics that are
possible with that file.
Because no data is lost when

you adjust a RAW file, this
gives you the ability to make
exposure changes to your
photo that are as wide as two
f-stops or more. This is the
reason many commercial
photographers shoot in RAW.

Lenses For Digital
Cameras
If you’re planning to buy a
lens for your digicam, how
do you distinguish between
the different kinds of lenses?
Wide-angle or telephoto?
What focal length and what
speed? There are several
questions you need to answer
for yourself. Here’s a brief
primer.

Choosing The Focal
Length

Focal length is probably the
most important factor to be
considered when choosing a
lens: it determines the field-
of-view of the photos you
will be able to take with
your camera.

The two main types of
focal length are telephoto
and wide-angle, and while
telephoto lenses have a
narrow field-of-view and are
best suited for close-up shots
and portraits, wide-angle
lenses have a wider field-of-
view which is perfect for
indoor photography and
landscapes.

Keep in mind that the
performance of lenses differs
from camera to camera.

Fast And Slow
When you hear about

fast and slow lenses, people
are referring to a lens’
maximum aperture, which is
the maximum amount of
light that a lens can let in. A
simple rule of thumb is that a
fast lens lets in a lot of light,
while a slow lens lets in less
light, which defines how your
photos will look.

Maximum apertures are
measured in f-stop numbers,
which are actually a ratio of
the size of the lens aperture
and focal length. The smaller
the f-stop number, the more
light is let in. An increment
in the f-stop number doubles
the amount of light let in, so
f-1.4 lets more light than f-2.0.

This may seem confusing
at first; the easiest way to
make sense of it is to
remember that fast lenses are
best suited towards successful
photography in darker
lighting conditions, and slow
lenses are targeted towards
photography in brighter
conditions. 

Zoom Lenses
Unlike a fixed-focal-

length lens, a zoom lens often
gives you the diversity of a
range of focal lengths all
rolled into a single adjustable
lens. This can be great if you
often have to switch between
various lenses for different
shots, but it is important to
remember that not all zoom
lenses have a constant
maximum aperture, and those
that do are often larger and
more expensive.

The maximum aperture
can be reduced as you zoom in
using a lens with a variable
maximum aperture, but this

may not be as important to
some as the reduced cost and
size of such lenses.

Add-on Lenses
Add-on or accessory

lenses are targeted at compact
digital cameras, and allow you
to significantly lengthen or
reduce the camera’s inbuilt
focal length while at the same
time being able to automate
camera functions including f-
stop settings and focusing.
These lenses can be excellent
low-cost add-ons to your
digital camera, with telephoto
add-on lenses being able to
increase focal lengths by up to
300 per cent, and wide-angle
versions allowing for
reduction in focal lengths of
up to 30 per cent.

A fish-eye lens is an
extreme wide-angle lens that
has an angle of view
exceeding 100 degrees—
sometimes more than 180
degrees—and which renders a
scene as highly distorted. 

Above: A photograph that’s clicked normally
Below: The same scene shot using a fish-eye lens
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Viruses 
And 

Anti-Viruses
Here’s all you need to know about evil code and

the software that keeps you safe from it

Viruses 
And 

Anti-Viruses
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the on-access scanner encounters
a file whose activity it identifies
as virus-like (such as a file trying
to dial a certain number or
trying to e-mail something from
your PC), it informs you or takes
some kind of action (depending
on how you’ve configured it).

Since they always run in the
background and constantly
access files, on-access scanners
invariably slow down your
system, at least to some extent
and depending on your system
specs. Most on-access scanners
allow you to disable on-access
scanning temporarily. If, for
example, you need to run a
resource-hungry application
such as a 3D game, you might
want to disable on-access scan-
ning, provided you’re not con-
nected to the Internet and are
not accessing files from remov-
able media.

You should never install two
on-access scanners on your
machine because each of them is
likely to detect the other as a
virus, and this can even cause
your system to crash.

On-Demand Scanners
These scan files or folders at the
user’s request. All anti-viruses
are on-demand scanners; some
are both on-access as well as on-
demand. On-demand scanners
are useful when you want to scan
a file or folder where you want to
make sure there isn’t a virus. For
example, if you’re burning a CD
and giving it to a friend, it’s a
good idea to scan it first.

You may install as many on-
demand scanners as you wish.
Having more than one can be a
good thing—two anti-viruses can
detect more viruses! You should,
however, remember to run on-
demand scanners separately. Also,
take care before you run an on-
demand scanner that an on-access
scanner is not already running.

What Is Heuristic 
Scanning?
All anti-virus software depend on
virus definition files which con-
tain virus “signatures” to iden-
tify a virus. This is traditional
scanning and here, the anti-virus
looks through files and searches
for strings that resemble the sig-
nature of a known virus. But
newer viruses are always being
unleashed, and their signatures
obviously won’t exist in the data-
base. What does the anti-virus do
in that case? It falls back on its
heuristic scanning capabilities.

The heuristic scan capability
of an anti-virus is its ability to
detect an undefined virus from
its suspicious activities. It works
on the principle that viruses
usually use certain methods of
infecting other files, and if an
application is found to be using
such methods—or exhibiting
such typical behaviour—it is
detected as a virus.

A file can also be wrongly
detected to be a virus. This hap-
pens more often when the
heuristic “sensitivity” is kept
high. You need to decide the
course of action in such a case
by taking a look at the file-
name. There’s a trade-off here:
if you keep the sensitivity high,
you’re safer, but you’ll get more
false alarms.

What Is A firewall?
All Internet communication
takes place by exchange of indi-
vidual packets of data. Each
packet is transmitted by a
source machine towards a desti-
nation machine. When the
latter receives the packet, it
sends an acknowledgement
packet to the source machine
that the packet has reached it.
For the receiving computer to
know who sent it the acknowl-
edgement packet, it must also
contain the IP address and port
number of the source machine.

Jayesh Limaye

W
hen it comes to
security, all of us are
paranoid, and with
good reason. With

millions of ways to exploit our
computers or data, and hundreds
of thousands of people trying to
do so, can you blame us? But how
many of us are really careful, or
even know what to do when the
bits hit the fan? This workshop
will help you do just that...

Am I Infected?
So how do you know if your com-
puter is infected with a virus?
Here are some indications:

It runs considerably slower
than usual
It frequently stops
responding
It crashes and restarts
Applications don’t properly 
One or more disks are inac-
cessible
You see distorted windows
and dialog boxes
Files get deleted for no
reason
You get strange error mes-
sages
You see strange behaviour in

your e-mail program

What Are The Kinds Of
Virus Scanners?
Anti-virus software are of two
types—those that can be invoked
when needed, and those that are
always active in the background.

On-Access Scanners
Also known as Memory Resident
Scanners, these run in the back-
ground when the PC is running.
The function of an on-access
scanner is to monitor all activity
on your machine such as files
being read or accessed, down-
loads, receiving, sending or
reading e-mail, and so on.

Digital Tools l Workshop
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A firewall inspects each and
every packet that arrives at your
computer before it is seen by any
other software running on your
system. Similarly, it also inspects
every packet being sent from
your computer—before it is sent.
It can “filter” arriving packets
based upon any combination of
the originating machine’s IP
address and port and the destina-
tion machine’s IP address and
port. As an example, if your com-
puter is a Web server, remote
computers can connect to your
computer using the port 80,
which is for http. The firewall
will inspect every incoming
packet and allow connections
only via port 80 and deny connec-
tions on all other ports.

Thus, even if a Trojan horse
gets installed on the computer
and opens a listening port, the
Trojan scanner at the other end
will not be able to communicate
with the Trojan horse since all
the attempts to contact it will be
blocked by the firewall.

Some Important Rules
For Security 

Update Windows before
installing new security soft-
ware. Install the latest patches
and service packs for your ver-
sion of Windows, using
Microsoft’s Windows Update
Web site.
To avoid conflict, do not use
two firewalls at the same
time. Before installing a new
firewall, completely uninstall
the first. The Windows fire-
wall offers only basic protec-
tion, and it is recommended

that you install a third-party
firewall—disable the Win-
dows firewall before you do
so, of course.
After installing any security
software, immediately check
for updates at the vendor’s
Web site.
Do not install Windows and
then get online to download
anti-virus software or defini-
tions. Before you get online
even for the first time, you
should have installed an anti-
virus with updated defini-
tions off a CD.
Use an online testing service
such as Microsoft’s Windows
Live Safety Center at
http://safety.live.com/ or
Kaspersky’s Free Online Virus
Scanner at http://www.
kaspersky.com/virusscanner
if you can’t afford or procure
anti-virus software. During
an online virus scan, an
ActiveX component is down-
loaded to your computer,
which does the actual scan-
ning. You need to stay online
for the length of the scan.

What Are The Types Of
Viruses?

Virus
A piece of code that is loaded
onto your computer without
your knowledge and that can
run against your will. Most
viruses can replicate them-
selves. All computer viruses are
manmade. A simple virus that
can make a copy of itself over
and over again is relatively easy
to produce, and even such a

simple virus is dangerous
because it will quickly use all
available memory and bring the
system to a halt. More dan-
gerous viruses are capable of
transmitting themselves across
networks and bypassing secu-
rity systems.

Boot Sector Virus
A virus that infects the boot
sector of a disk. An attempt to
boot from a disk infected with a
boot sector virus will cause the
virus to become active in
memory. Every time you boot
your system from that point on,
the virus will be active in
memory. The boot sector is a
sector at the beginning of a disk
that identifies the disk’s archi-
tecture. For startup disks,
bootable CDs and bootable hard
disks, the boot sector also con-
tains a program that loads the
operating system.

Macro Virus
These are small programs
written in the macro language
of an application, which can
normally only spread within
files of that application.

In order to infect you, they
need the corresponding applica-
tions to be activated and at least
one of the infected macros
should have been executed.

What Should I Do When A
Virus Is Detected?
When a virus is found, you have
the option to disinfect the file,
and if this fails, you can delete
the file. If the file refuses to
delete, or if the infected file is
important, you can opt to back
it up safely to the “virus chest,”
or “quarantine” it, so it can’t
cause any further infection and
also so that it may be repaired
in the future when a solution
becomes available for that par-
ticular infection. 

jayesh_limaye@thinkdigit.com

Virus removal tools are free executables designed to eliminate specific viruses.
Using a virus removal tool does not require you to install any anti-virus soft-
ware. Examples of free virus removal tools are the Stinger remover from
McAfee at http://vil.nai.com/vil/stinger, a host of tools from Symantec at
www.symantec.com/avcenter/tools.list.html and from BitDefender at
www.bitdefender.com/site/Download/browseFreeRemovalTool.

Why Are Virus Removal Tools Needed?



Calibrate That CRT
Here’s how to get your CRT to display the best picture it’s capable of
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2. The next window will give you a
brief intro. Click as directed
onscreen. You are taken to a
window that shows you exactly
what the next test will accom-
plish, what you should look out
for, and what problems you may
face, along with possible solu-
tions. Read the page carefully.
3. The first test is all about
getting the Brightness and
Contrast settings right. Follow the
instructions on-screen. It’s a good
idea to jot down what you have to
do, because you might have to
refer back to the process
explained in the previous page,
which can get a bit irritating!
4. The next step ensures that the
lightest and darkest shades of
white and grey are properly repro-
duced and faithfully represented
by what you see. As with step 3,
read carefully and then tune!
5. Ensuring the monitor’s black-
ness level is perfect (or close to
that) is the next part of the cali-
bration process. This test shows
you a number of blocks on the
screen with varying shades of
grey. You need to tune your bright-
ness settings so as to ensure that

the maximum number of blocks
appear dark grey while ensuring
the background remains black. 
6. The next tweak is the well
known ANSI greyscale pattern
test. This is to ensure that the
extremes of the greyscale are
properly reproduced. Two boxes
are shown, with colours ranging
from Black represented by 0, to
White, represented by 100. You
need to adjust the
brightness/contrast settings so
that the two middle boxes—5 and
95—are distinct from the others.
7. The next step deals with
setting a black level and playing
around with the whiteness level.
This step actually has two
screens, (the left half of the
screen will remain constant
displaying two dark grey strips.
The first screen will, (on the right-
hand side), have four varying
levels of grey, ranging from dark
grey to white; the second screen
will have a full-intensity white bar
that takes up half the screen. You
need to adjust the monitor bright-
ness until you can just see both
the vertical strips, (ones on the
left). The background should
remain black. The White bar
should not appear distorted, and
the dark (vertical) strips should
look identical on both the
greyscale and the white pages.
8. The test in this step involves
ensuring that the brightest image
detail remains as sharp as possi-
ble. As all high-intensity beams
tend to defocus, leading to what is
called the “Bloom” effect (the halo

Michael Browne

T
he choice of most home
users, 90 per cent of
gamers, and movie buffs is
still the bulky old CRT.

CRTs need to be set up prop-
erly. It’s time to calibrate it when
you have a dark- looking image on
your screen, or if you feel your
CRT isn’t displaying colours as
well as it should.

We jump into the fray and
help you setup your display!

The Software
We will use DisplayMate to cali-
brate our test CRT. This software is
precise, and gives you a step-by-
step explanation window, which
explains what the next display
window will achieve by means of
tuning, and what you need to
watch out for. This help window
alternates with the actual calibra-
tion pane, where you can tune the
settings. It is available for down-
load at www.displaymate.com.
The registered download with the
manual costs $69 (Rs 3,300).

The Procedure
1. Install Display Mate. We ran the
program with the “Novice”
option disabled. After running
Display Mate, the startup screen
should look as below. Click on the
“Set Up Display” button. We have
refrained from explaining in
depth what exactly each step
does, as there is a very intuitive
help window, so you will not have
any problems.

The DisplayMate main window

Checking colour gradation levels

Get as many dark grey boxes as
possible when calibrating Logarithmic greyscale test fine-tuning

For
application
s like
Games and
Movies,
the CRT
still
represents
the best
Visual
Quality you
can get
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effect that generally surrounds
white and light-coloured pixels in
a scene). This test tries to minimise
this. The relative sharpness of the
grey and white patterns should be
studied. Look for the size of the
dots inside the “O”s, and the gaps
between the lines. You can fiddle
with the contrast setting to
achieve something of a compro-
mise, since the Bloom effect
cannot be completely done away
with; causing it to disappear
completely will result in the
display becoming too dark.

9. Now you’re presented with a
screen consisting of a set of black
strips separated by white lines,
and white strips separated by
black lines. The Contrast control
has to be adjusted here.
Increasing it will result in the
white strips gradually encroach-
ing on the black lines. This loss in
sharpness occurs because as the
beam current is increased, the
width also increases. You will
have to settle for a look that feels

right to you, because anomalies
are present at all contrast levels;
it is just what is noticeable and
what’s not.
10. Colour contrast is what we
check in this test. Black and
coloured text is placed on dark-
grey, grey and white backgrounds.
Basically, the black text should
have sharp edges on all back-
grounds and appear uniformly
black. The coloured text should
not have any bright or dark ridges
around it.

Your display is now calibrated.
Note that calibration doesn’t
follow a formula; it’s simply what
looks best to you. Then there’s
colour temperature to be consid-
ered; each colour temperature
relates to the type of lighting
where the monitor is being used,
but on average, 6500 K is arguably
the ideal colour temperature to
select. A higher colour tempera-
ture (measured in Kelvin or K)
causes a bluish tinge, while a
lower value causes a reddish tinge.
Though we’ve said 6500 is ideal,
you’ll need to experiment.

Your graphics card settings
also affect what you view. Ideally,
set your graphics card to its
default settings, and turn off
special effects such as dynamic
colour and high-contrast settings.
But a few points are in order:
1. Experiment with the settings. If
you actually want an artificially
bright screen, go ahead!
2. Some monitors are too dark
even after proper calibration, in
which case you might want to
pump up the brightness and/or
contrast on your graphics card
through the software.
3. Some movies may be too dark
for you, in which case you’ll need
to use the software.
4. If you want a special look—say
an overly red or a cool blue
look—you can also tweak the
gamma settings of your graph-
ics card. 

michael_browne@thinkdigit.com

CRT technology has been around for a long
while now. With the coming of LCDs, our good
old bulky boys have been referred to as “eye
strainers,” and despite the amount of radiation
they emit, not to mention their inherently higher
power-consuming capabilities (not a good thing),
they are still around! There are three distinct
reasons for this.

First, an LCD simply cannot match the sheer
image quality, contrast and sharpness that a CRT
can provide. Watching a movie on a CRT gives
you a much richer viewing experience that an
LCD can, and we’re talking about a normal CRT
as compared to even a relatively high-end LCD.
This is largely due to the fact that CRT
technology has gone through numerous
refinements over the years, whereas LCDs are
still sort of a “work in progress,” with
refinements still being made as regards
features, production process, etc.

A serious shortcoming with all LCDs is
noticeable by any gamer—their response time.
Unlike a CRT, which has a virtually negligible
response time—the time gap between the on and
off of an individual pixel—LCDs have much larger
response times, resulting in the ghosting effect

one sees when gaming (or even watching
movies) on them. 

Flat panels also have much lower contrast
ratios (the ratio or difference between the
lightest and darkest areas of a screen) than
CRTs. For example, a man sitting near a
campfire at night: a CRT will easily capture the
finer nuances, while an LCD will have problems,
especially with depicting the areas around the
campfire edges, where light meet darkness. 

Besides these technical flaws that LCDs
haven’t ironed out as yet, there remains the
price issue. LCDs cost nearly three times more
than a CRT of the same size. While a 19-inch CRT
may cost you around Rs 12,000, a decent LCD of
the same size would set you back by around Rs
25,000 if not more! This is because while
manufacturing LCDs, there is a high product
discard rate—close to 40 per cent (this figure is
constantly on the decline) of all LCDs made fail
the testing standards, and the products that are
cleared for sale have to bear the production
costs of the rejected pieces.

In short—if you want movies and games,
make some room on that table—a good ol’ CRT is
still the way to go!

Advantages of a CRT Monitor

The Lines and Dots test

Fine-tuning the contrast levels

Rohini
Note



Online Over The Air
If your laptop has Wi-Fi, here's how to connect
it to a hotspot
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signal range is divided into a
number of smaller bands or
"channels," similar to TV chan-
nels. Thus, all Wi-Fi devices on a
particular network must use the
same channel.

1. Before proceeding further,
you need to find out the SSID,
Channel, Mode and WEP key of
the Wi-Fi network you’re plan-
ning to connect to. Some Wi-Fi
locations do not require a WEP
key. The above information can
be accessed from the Wi-Fi
network provider’s Web site, or
when you purchase the access
rights to the Wi-Fi network. A
list of Wi-Fi hotspots in India is
available at the following sites:

www.wi-fihotspotlist.com/
browse/intl/2000044/

www.jiwire.com/browse-
hotspot-india-in.htm

www.wi-fihotspotsdirectory
.com/Wi-Fi-Hotspots-In-India-
100.html

You can find contact details
here to be able to access
hotspots.

2. You should make sure you
have a firewall and a good anti-
virus program installed. This is
necessary to protect your data.

3. We assume that your
laptop came with the Wi-Fi card
drivers installed. If it did not
come with drivers for the Wi-Fi
card, you may need to go to the
manufacturer’s Web site and
download the appropriate driv-
ers according to the model
number of your Wi-Fi card or
your laptop. Power on the laptop
and after Windows is up and

running, look for the Wi-Fi
network icon in the System Tray.

4. Click on the Wi-Fi network
icon, and a window showing
the connection strength and
session duration will appear.
Click on the Properties button
in this window.

5. The Wireless Network
Connection Properties window
showing the name and type of
network card installed will show
up. Click on the Wireless
Networks tab in this window.

6. In the Wireless Network
Connection Properties window,
you will be able to view the avail-
able Wi-Fi networks in your area.

Jayesh Limaye

A
lmost all laptops these
days come equipped
with Wi-Fi connectivity.
And places such as

airports have Wi-Fi hotspots
where you can connect your
laptop to go online. But not
everyone knows how to set up
Wi-Fi on a laptop! Here, we
explain the process of setting up
your laptop to be able to connect
to a Wi-Fi hotspot.

We assume you have
Windows XP Professional
installed on your laptop, and
that your laptop has inbuilt Wi-
Fi. If your laptop does not have
Wi-Fi capability, you can always
purchase a PCMCIA Wi-Fi card
and make it Wi-Fi capable
(PCMCIA slots are fairly
common in laptops). Some Wi-Fi
cards can set themselves up
automatically to detect and
connect to a wireless network,
but we will see how to manually
set up a Wi-Fi card to connect to
a wireless network.

You’ll need to know a few
terms, and we explain here:

SSID is an acronym for
Service Set Identifier. The SSID
is a sequence of up to 32 letters
or numbers that is the ID, or
name, of a wireless local area
network.

WEP is short for Wired
Equivalency Privacy. It is a secu-
rity protocol for Wi-Fi networks.

Wi-Fi Channel: The Wi-Fi

The Wireless Network Connection Status

Information about the wireless adapter

Intel’s Core Duo mobile technology is
the successor to Centrino. The key
components of a Core Duo laptop are
an Intel Core Duo Processor, Mobile
Intel 945 Express chipset and an
Intel PRO/Wireless 3945ABG network
connection. The benefits of Intel Core
Duo technology are excellent

performance due to the dual-core
processor, higher battery life due to
low power consuming components, a
smaller form factor, and expanded
wireless connectivity due to the
newer Wi-Fi adapter, which supports
a higher throughput under adverse
conditions.

Core Duo
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Click in the SSID of the network
that you wish to connect to and
click on Configure button to
enter the WEP key. 

7. If you do not see any
networks listed in Preferred or
Available networks, you will have
to manually add the SSID. To do
this, click Add and enter the SSID
and WEP key, if necessary. Click
OK, and you should be able to see
the network you just added, in

the Available Networks box. If
you see the correct SSID in the
Available Networks box, you’re
required to click on Configure in
order to enter the WEP key, if
that is required.

8. In the next window that
appears, enter the SSID. If a
network key is required, click on
‘Data Encryption (WEP enabled)’
and then enter the Network Key
you’ve been provided with. If you

enter the key incorrectly, a pop-
up message will appear stating
‘Incorrect WEP key’, and you will
have to re-enter the key. While
you do this, make sure that the
Caps Lock and Num Lock are off
all the while. Click OK to close
this window. Click OK again to
return to the Desktop.

9. Now, click on Start and go to
Connect To. You will see some
choices pop up. Click on Wireless
Network Connection, and your
Wi-Fi connection will be ready to
work. You can also access this by
clicking on Start and opening the

Control Panel. Open Network
Connections and double-click on
Wireless Network Connection.

Sometimes, the connection
may not work. If this happens,
disable your firewall and try to
connect. If you can connect with
the firewall disabled, you need to
change the firewall program
settings to allow it to connect to
the network. If the firewall is not
the problem, you’ll need to check
the SSID and WEP key you
entered. Both these are case-sensi-
tive. These are the problems that
you are more likely to encounter.
If you’re still facing difficulties
connecting, contact the Wi-Fi
hotspot provider’s helpdesk. 
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Li-ion batteries prefer partial discharges rather
than full discharges. Frequent full discharges
must therefore be avoided. Charge the battery as
often as you can.

Typically, a Li-ion battery lasts for around
two to three years, or around 300 to 500 charge
and discharge cycles, whichever comes first. Over
a period of time, the internal resistance of the
battery increases due to oxidation. Eventually, the
resistance level reaches a point where the battery
can no longer deliver the stored energy, although
the battery may still have ample charge. Although
this cannot be avoided, the rate at which the
battery ages can be slowed down.

Avoid exposing the batteries to high
temperatures (higher than those prescribed on
the battery pack). This is the case when the
laptop is always run on the mains with the
battery inside. The laptop’s temperature rises,
and the battery will not last for more than 12 to
18 months. If you use the laptop primarily in your

office, you would use the mains to power the
laptop. You can charge the battery and then
remove it to store it in a cool place, and continue
working. Be sure to periodically charge the
batteries, though.

Avoid purchasing spare Lithium-ion batteries
for later use, and look at the manufacturing date
while purchasing a battery. If you already have a
spare battery, charge it to 40 per cent charge and
store it in a cool place.

Windows XP also has Power Management
features that you can put to good use to
lengthen the life of the laptop’s battery. Go to
the Control Panel and open up Power Options.
Under the Power Schemes tab, select the
Portable/Laptop scheme. You can tweak this
scheme by setting the ‘Turn off monitor,’ ‘Turn
off hard disks’ and ‘System Standby’ times to
different, lower values. For example, there’s no
reason to keep hard disks running for longer
than five minutes of inactivity.

Prolong The Life Of Lithium-Based Batteries Start working on the wireless network

Available wireless networks Enter the WEP key for your SSID



Think Out Of The Box
Turn your spare hard disk to an
external storage device, and learn how
to look after your disks
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Connect the IDE and power
cable of the converter to the
hard disk and secure the hard
disk on the chassis by mounting
it (if it is a case type, rather than
open type). Plug in the USB cable
to the USB port (USB 2.0 if you
want the best read / write speed).
Under Windows 2000 or
Windows XP, the drive will be
recognised as a mass storage
device, just like a thumb drive. If
in case the drive is not detected,
unplug and plug it again. If
prompted to, restart the PC.

To prevent chances of data
loss, do not disconnect the hard
disk while data is being written
to it. For greater safety, ‘stop’
the device from the system tray
before unplugging it. 

There is more to an IDE to
USB converter than making an
external hard disk. If your
laptop’s CD ROM Drive is not
working and you need to install a
software from a CD urgently, you
can plug in a CD-ROM drive just
like a hard disk! Windows may
need to restart after seeing a ‘non
hard disk USB device’. The best
part of this setup is the price—an
IDE to USB converter with casing
will cost you just about Rs 500. A
worthy investment for the func-
tionality it provides!

If your PC has a USB 1.1 only
interface, you can still connect
your hard disk to it, but the read
/ write speed will be very slow.

Hard Disk Maintenance
We have learnt in our Physics
classes that anything that moves,
causes friction and hence wear
and tear. The hard disk is one
component that is in constant
motion, with its spindle spin-
ning at 7,200 rpm! This is why we
keep talking about hard disk
maintenance and cooling—here
we will summarise the most
important steps that you can
take to ensure that the old faith-
ful—your hard disk serves you for
a long time!

Disk Defragmenter And
Error Checking
The most basic of disk mainte-
nance tasks still hold good. Just
as a messy room makes it diffi-
cult for you to find things when
want, the hard disk has to do
more work to fetch data if it is
scattered all across the disk.
This is why you need to keep
your disk defragmented. Go to
Start > Programs > Accessories
> System Tools > Disk
Defragmenter; or right click on
the partition (or drive) you wish
to defragment and click on
Properties and then Tools >
Defragment. 

Scandisk performs a write
test on every cluster and reports
an error if there is any. One
must remember that disk errors
cannot be cured by scandisk,
but only identified and marked
such that the affected areas are
not used to store files. If scan-
disk shows bad sectors, its time
to buy a new drive!

Windows XP calls the Scan-
disk operation ‘Error Check-

Kailas Shastry

I
n this age of upgrades, lets
say you have just acquired a
250+ GB hard disk and your
poor old 20, 40 or 80 GB hard

disk is packed and put into your
cabinet. It is time now to dig it
out and convert it into an exter-
nal hard drive with minimal
investment. You no longer need
to convince your friend to open
up his cabinet so you can hook
up your hard disk to this
machine to copy songs—just plug
it into the USB port and it will get
recognised as a mass storage
device!

What you need
Your old (a new one is also
fine!) hard disk.
An IDE to USB converter.
IDE to USB converters are

available for the standard 3.5-inch
desktop internal drive as well as
the 2.5-inch laptop drives. When
you are shopping for the
converter, be sure to ask for a 3.5-
inch form factor converter. The
converter has an IDE and molex
power cable that connects to the
hard disk and a USB cable to
connect to the USB port. There is
an internal circuitry that converts
the IDE interface to the USB inter-
face. The power supply for the
hard disk is drawn from a power
adaptor bundled with the kit

The insides of an IDE to USB converter 

CCeennttrree  AAnn  OObbjjeecctt
If your BIOS supports booting from
USB, you can even run an operating
system from your just assembled
external hard disk.

Bet You Didn’t Know
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ing’, it can be accessed by right-
clicking on the desired drive (or
partition), Properties > Tools >
Error Checking. Windows 98
users can run scandisk by boot-
ing into DOS prompt and typing
“scandisk <Drive>:” where
<Drive> is the drive letter you
want to scan. This is more reli-
able than running scandisk
from Windows.

Using S.M.A.R.T. 
Some hard disks have a monitor-
ing and error reporting technol-
ogy called S.M.A.R.T. (Self
Monitoring Analysis and
Reporting Technology) that issues
a warning during boot-up if
certain things are found to be
‘wrong’ in the hard disk. This is
not always reliable, but another
step in ensuring that you know
when things go wrong. This can
be enabled in the BIOS in General
or Advanced BIOS settings.

Using A Cooling Fan
Heat is the primary cause of elec-
tronic component failure.
Keeping a device cool goes a long
way in extending its life. If your
computer is in a hot environ-
ment, running applications that
use the disk continuously (such as
video editing), you can attach a
fan to the hard disk. In our test,
placing an ordinary case cooling
fan such that it blows air onto the
hard disk made noticeable differ-
ence in the amount of heat that
the hard disk reported. 

Secure Mounting
If you sense vibrations emanat-
ing from the hard disk, just
tighten all the screws that are
used to fasten it to the chassis
(cabinet) in the hard disk bay.
Vibrations, though small, can
have adverse effects on moving
parts through a phenomenon
called resonance. Generally two
screws on either side are used

to hold the hard disk in place. If
necessary, use more screws.

If you are using two or more
hard disks, don’t simply pile up
one above the other—stack
them in alternate bays, leaving
space for air flow.

Handle With Care
Internal hard disks are less
rugged than their external
counterparts and need special
care while transporting. Put the
hard disk in an anti static cover
to prevent static electricity from
affecting it. Next, to shock proof
it, cover it with bubble wrap (if
you don’t find bubble wrap, you
can use cotton cloth, but not
synthetic material). Also, make
sure you don’t drop it!

When you are attaching an
IDE cable, ensure that the
connector and pins are well
aligned and none of the pins on
the hard disk are bent. If you see
a bent pin, gently straighten it
with the help of a flat screw
driver or get someone who
knows his stuff to do it. Forcing
the connector the wrong way or
onto bent pins will only create
more problems—if a pin gets
broken, you will have to take it
to a repair shop to fix the broken
pin, if at all it can be done. 

Backup
The tips we have given you here
will reduce the chances of
premature failure of your hard
disk. However, you cannot
neglect the probability of failure
due to factors beyond your
control. A power surge, for exam-
ple can destroy the hard disk
along with other components.
While money can buy you a new
hard disk, the same cannot be
said about the data that the hard
disk contains, especially in a
work environment. There is only
one definite solution to this risk
- backup frequently! 

kailas_shastry@thinkdigit.com

All of us have, at some time or the
other, emptied the Recycle Bin only
to realise that some important files
got deleted.

There's a way out: you can
recover your “deleted” files using
data recovery software, provided,
of course, that the space the
deleted file occupied hasn't been

taken over by any other file.
One way to ensure this is to use

the data recovery software immedi-
ately after you do the deletion.

Drive Rescue is one such soft-
ware—it's powerful and free. You
can download it from:
www.woundedmoon.org/win32/dri
verescue19d.html.

Data Recovery

Do not open any files when
the defragmenter is running, else
the process will start all over
again!
" Turn off anti-virus programs
during defragmenting as
background scanning may come
in way of the defragmenter.

Defragmenter works best
with more free space at hand for
temporary storage. If you have
less than 15 per cent free space,
the Defragmenter will warn you.
You can clear temporary internet
files or move data temporarily to
other partitions to free up some
space.

If you are using Windows 98
or 98SE, and find the defrag-
menter restarting all the time
and eventually giving up, you can
use the defragmenter from
Windows ME. Download it from
http://www.the-old-sea-
dog.net/defrag/w9x-medefrag.zip

Tips For Defragmenting

Rohini
Note



Digitise!
Whether at home or in the office, you might want to use your MFD to OCR
your documents

Photograph Jiten Gandhi
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Offices are
increasingly
digitising
their paper
documents.
OCR
software is
the tool that
enables this
process, and
the MFD
makes it
convenient

copy using an MFD.
The OCR software we’ll be

using is SimpleOCR—because it’s
free! SimpleOCR has many of the
features of paid software—a
1,20,000-word dictionary, error
correction, format and image
retention, plain text extraction,
batch and zone OCR, and more. It
is a 9.3 MB download, available
from www.charactell.com/
scanstore/InstSocr.exe.

To convert a scanned docu-
ment to PDF, you need a PDF
converter. You can use CutePDF
Writer, formerly known as
CutePDF Printer. CutePDF Writer
installs itself as a printer subsys-
tem and can be used to output a
PDF file as easily as printing to a
printer. This way, any Windows
application that can print will be
able to output PDF files. CutePDF,
too, is free, and is available from
www.cutepdf.com/download/
CuteWriter.exe. In addition to
this, you may also want to install
CutePDF Writer Companion,
available from www.cutepdf.
com/download/CuteComp.exe.
This requires a PS-to-PDF
converter such as GhostScript,
available from www.cutepdf.
com/download/converter.exe.

How To Go About It
1. Install all the above software.
Place your document on the
flatbed glass of the MFD. Launch
SimpleOCR. 

2. You will be prompted to

choose the type of document you
want to read. The options are
Machine Print and Hand Writing.
When you choose Machine Print
recognition, you can only scan
and OCR documents that are
printed, whereas when you choose
Hand Writing recognition, you
can even scan and OCR handwrit-
ten documents—the precision of a

different and more powerful OCR
engine is used in this case. While
the Machine Print recognition
engine is free, the Hand Writing
recognition engine can be evalu-
ated for 14 days (it costs $60, or
Rs 2,700). Choose the type of docu-
ment and proceed.

3. In the next screen, you can
choose the language. SimpleOCR
recognises four languages,
including US English and UK
English. Choose between these
and click Select.

4. You need to select the
appropriate scanner for the soft-
ware to use. Click on File, then
on Select Scanner. A window
will appear where you can see
the list of scanners on your

Jayesh Limaye

M
FDs combine a printer,
scanner, and in many
cases a fax machine.
The printer-scanner

combo gives an MFD the added
functionality of a copier.

Laser MFDs are faster than
their inkjet counterparts. Their
cost of operation is also lower
and so, even though they are
priced considerably higher, they
are preferred by the small and
medium business segment.

Offices are increasingly digi-
tising their paper documents.
OCR (Optical Character Recogni-
tion) software is the tool that
enables this process, and the MFD
makes it convenient. OCR soft-
ware, in conjunction with the
scanner, recognises characters in
the scanned image of the hard
copy and converts it to a docu-
ment format that a word proces-
sor can recognise. This document
can then be edited if necessary.

It is sometimes necessary to
convert the document to PDF,
because this file format is plat-
form-independent and does not
require any fonts to be
installed—a PDF looks the same
on any computer that can read
the format. PDF is therefore
ideal for exchange and distribu-
tion of electronic documents.
We shall see how to create a DOC
file as well as a PDF from a hard

The SimpleOCR welcome screen

Choose the type of document to scan

Send faxes directly from your computer’s
modem without having to print the document
and feed it manually into the fax machine.
Scan photos and e-mail them directly by just
pressing a button (on models that support the
scan-to-email feature).
Use a second function while another function
is being performed; this depends on the MFD
model.
Scan multiple documents in batch-processing

mode, and also OCR them.
Save received faxes on your computer and
print only the required ones.
Use it as a copier without the need to connect
to a PC by just pressing the Copy button.

And,
(Automatic fax/phone switch) If you have a
single line for phone calls and faxing, some
MFDs will switch to the fax function when
there’s an incoming fax.

Using A Laser MFD You Can…
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system. Choose the correct one
and click OK.

5. To scan the document, click
the Add Page button. Here you
can also set the scanner options
by clicking Scanner Options. You
can set various settings such as
Colors, Resolution, and Paper
size. Select your settings and click
OK. Click OK again.

6. The document will now be
scanned, and it will appear in the
window. To begin the OCR
process, click “Convert to text.”

7. You can now click Accept to
accept a word if it is correctly

recognised, or you may correct it.
You can also click Decide Later to,
well, decide about a word later, or
Keep As Image if an image was
misinterpreted as text.

8. Go to File > Save as and save
the file as a TXT or DOC file. If you
wish to save only the text, you
should choose TXT, whereas if you
wish to also save the formatting
and images in the original docu-
ment, you should choose the DOC
file format. You can also save it as
an image by clicking as File > Save
Image As. You can save it as a TIFF
image, but doing so defeats the
purpose of the OCR software!

Finally, close SimpleOCR.
We’ve now converted the hard

copy to the electronic format;
let’s now convert the electronic
document to PDF.

1. Using your word processor
application, open the document
you just scanned and created .

2. Go to File > Print, and select
CutePDF Writer from the list of
printers. You can change the
paper size, orientation, and so on

to what you want. You can also
change CutePDF Writer options
according to your preferences.
Click OK.

3. Click Print. The CutePDF
Writer Companion will launch;
here, click Save to save the docu-
ment as a PDF.

4. Remember that you can also
insert or delete pages, edit docu-
ment properties, combine PDFs,
and so on before creating the PDF. 

While SimpleOCR can get
most of the job done, it is still not
as powerful and accurate as some
of the better and more powerful
OCR applications available. Partic-
ularly problematic areas are the
retention of formatting, recogni-
tion of images as such, and stray
marks on the paper throwing the
software off. 

But then, it’s free!
jayesh_limaye@thinkdigit.com

Most MFDs come with a fax feature. They can send as well as receive faxes
without the need for a PC. The number of pages that an MFD can store
depends on the fax memory. Some MFDs can provide a detailed report about
the number of faxes sent and received, as well as the numbers to which they
are sent to and received from. This is useful for system administrators.

The “junk fax barrier” feature in some MFDs lets you specify certain fax
numbers that you think are likely to send junk faxes. Faxes from these
numbers are then blocked. Then there is the Broadcast feature, which lets you
send faxes to a number of recipients at once.

The Delayed fax or Scheduled fax feature lets you prepare a fax to be sent
at a later time.

The Fax Features Of An MFD

Choose the scanner settings

Select CutePDF as the printer device

The CutePDF Writer Companion

Convert the scanned document to text

Select the appropriate scanner



Printing 
Over The Wires

Set up your laser printer so it can be
used by multiple computers

Printing 
Over The Wires

Photograph Jiten Gandhi
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Network
Printers
are on an
average
costlier
than other
laser
printers as
they are
targeted at
the
corporate
segment

using the menu on your printer.
Network printers come with LCD
screens, which can be used to
configure all aspects of the
printer. Navigate to the main
menu. Note that your printer
needs paper in the In tray before
you can use the menu.

2. Get into the Network
menu using the arrow keys, and
select Yes in the Network
Configuration option. Go to “Get
Network Address” and select
Manual. You will be using the
directional keys a lot now.

3. You will get a blank
screen, where you assign a
unique IP address to the printer.
Your IP address should look
something like 128.128.135.28—
this number is an example. Note
that this is a Static IP—an IP
that, once assigned, will not
change unless manually
changed.

4. The next step involves
entering an SM (Subnet Mask)
number, which will be some-
thing like 255.255.0.0. There are
some advanced options as well—
mostly Yes and No options—but
there’s no need to configure
anything.

5. Now install the drivers on
one PC on the network. Note
that since the printer is not
shared through one PC, you will
have to individually install the
drivers on each PC that needs
access to the printer. 

6. The drivers, when
installed, will give you a
Toolbox/Setup window, where
you have to assign a printer port
to the printer, as in the next
step. Note that the software will
search the network for all print-
ers by that manufacturer: for
example, HP printing software
will only search for HP laser
printers on the network, andlist
them.

7. Once the printer has been
located, it’s simply a matter of
assigning the printer a port on

your machine, which can be
done using the drivers.

In the rare event that your
network printer doesn’t have an
LCD display—meaning you can’t
set it up from the printer
controls itself—the software kit
accompanying it will definitely
have the necessary tools to
assign an IP to the printer.

As far as operating system
dependency goes, users of
Windows 98/98SE will need to
install LPR (Line Printer Remote),
which is an optional install
component available on the
Windows CD, but which doesn’t
install by default. LPR is a spool
command and not a printer
command; it simply spools files
to a location for print.

Under Windows 2000 and all
its flavours, the TCP/IP configu-
ration under Network
Components will have to be
installed. Windows XP installs
these options by default, so your
task is simplified.

Using Telnet
A network printer can also be
configured using the “telnet”
command. If you do not know
your printer’s IP address, set it to
the factory defaults. All network
laser printers have a small
button that resets everything to

its default values. This button is
typically located on the rear of
the printer, and may sit inside a
recess to prevent accidental
setting of the switch.

Michael Browne

M
any homes and small
offices have made the
transition from
inkjet to laser

because of the costs of consum-
ables involved with inkjets. Laser
printers are more versatile and
are faster. Add to that the fact
that a toner cartridge can output
some 5,000 (if not more) pages of
text, and the laser printer makes
one sweet buy if your printing
needs are heavy.

If you have more than one PC
at home, or if you have a small
office with just one printer, you
can easily configure it to be used
by multiple systems. We get
down to assist you setting up
your laser printer on a network.

Network And 
Non-Network Printers
As far as networking and printers
go, there are two types of laser
printers—network-enabled print-
ers, and non-network printers.
Almost all the printers manufac-
tured in the last two years are
network-enabled, meaning they
can be directly plugged into a
TCP/IP network. These printers
can be assigned an IP address,
and any machine accessing them
on a network can print to them.
Network-enabled printers are
more expensive, but are worth it
considering that no print server
is required; the configuration is
much easier. An ordinary laser
printer (meaning non-network)
needs a print server to be
installed, with the printer being
assigned a virtual port. Here are
the steps involved.

Steps for a Network
Printer
1. Connect your printer to the
LAN (RJ45) cable. Power it on.
Now there are two ways to set up
a network printer. The first is by

A typical telnet window

Workshop
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In the Start Menu, select run
and type in “telnet <default IP
value>”, where <default IP value>
represents the factory, default IP
address you’ve reverted
the printer to by using the
Reset switch. 

You will be presented with a

telnet window.
Here you can
change the IP
address to
whatever value
you wish to
assign. The SM
can also be set
here. 

Also notice
that most of
the options
( i n c l u d i n g
setting an IP)
will have an
Enable and
Disable option.
Setting any of
the options to
Disable will
mean that the
option itself is
disabled, so

disabling the IP means you won’t
be able to assign one.

Steps For A Non-
Network Printer
If you have a laser printer that
isn’t network-ready, that is, if it
doesn’t have a LAN jack, you will

need to set up a print server. This
is a device that has a LAN jack on
one side, and connectivity
options to one or more printers
on the other side. Typically, print
servers will have a combination
of parallel and USB ports—
usually not more than three
ports. This “print server” is not to
be mistaken with a PC working
as a print server.

1. Set up the print server,
hook it up to the LAN, and
connect it to the laser printer,
either through the parallel or
the USB port.

2. Next, you need to install
the print server software on any
one PC on the network. This is
the software that will find the
print server. Once again, in the
case of a large network, all the
print servers from the manufac-
turer bundling the software will
be listed, and you will have to
select the one you want to config-
ure.

3. Now you assign an IP and
then an SM to the print
server, similar to the case of the
network printer.

4. The next step will be to
assign a virtual port to the
printer connected to the print
server. Virtual ports are basically
multiple ports that share one
physical port: the physical path
to each of the printers connected
to the spooler is the same. This is
because a print server can
connect to multiple printers, but
it has only one IP address. It
therefore can share this IP with
multiple printers using virtual
ports. Each printer will get a
virtual port and therefore a
virtual IP.

5. Next, a port on the
computer has to be assigned to
the print server (and not the
printer, since it doesn’t have a
physical IP).

Your laser printer is ready to
be used over the network! 

michael_browne@thinkdigit.com

Laser printers were earlier the prerogative of
corporates and small businesses. A drastic fall
in prices has made them affordable to SoHo
and home users as well. The major advantages
of a laser printer are low running costs, suit-
ability for volume printing, and the fact that
they are much faster than inkjets.

In case of heavy usage, make sure you invest
in a printer that has a separate toner cartridge
and drum: this reduces long-term running costs.

Your laser printer generates a lot of heat,
especially when used non-stop for extended
periods of time. Make sure to place it away
from obstructions, preferably near an AC vent,
so as to enable proper heat dissipation, which
will increase longevity.

Laser printers consume much more power
than inkjets; make sure the printer is in
standby mode when it’s not being used.

For mass printing, if quality is not an issue, use
draft mode, since this uses a saves a lot of toner.

In the case of printing brochures and other
media where higher quality is required, try to
print in 300 dpi or 600 dpi mode. This will
result in higher-quality prints. In the case of
high-quality printing (as on photo quality
paper), a 1200 dpi mode is also available
on some laser printers, which will consume
the most toner but also produce the best-
looking results.

If you’re suffering from smudged prints,
worry not. It’s usually a matter of cleaning the
roller, which tends to pick up some residue
toner on the outside. Clean this off with a
clean cloth or paper, and remember to dispose
of the cloth or paper carefully. Also be careful
not to come in physical contact with the toner
compound—it is toxic.

Usage Tips

The TCP/IP window

Setting the IP using Telnet



Get More From Your 
LCD Monitor
LCD monitors are becoming more
affordable, and almost everyone
wants one. Here are a few things
you should know before going out
and buying one

Photograph Jiten Gandhi
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nent or S-video ports. Get a suit-
able cable and connect it from
the video out of the DVD / VCD
player to the video in of the LCD
monitor. Keep the monitor
powered on with its power cable
just as you normally would. If
your monitor as well as the
player supports S-video, it is
better to use it rather than
composite input for better

picture clarity.
LCD monitors can offer hours

of flicker free viewing that will
make your eyes heave a sigh of
relief. So far so good. But most
LCD monitors are not suitable
for viewing fast paced videos
such as formula 1 racing or most
music videos today. Thankfully,
many manufacturers are making
efforts to bring LCDs closer to
CRTs in terms of viewing experi-
ence. Already there are LCD
monitors with on-off time as low
as 6 ms which is good enough for
most movies. 

INNOVATIONS!
3D On Your LCD Monitor

Making a device do more than
just what it was originally
intended for brings out some
amazing innovations. One such
innovation is a plastic strip that
can be clipped onto LCD moni-
tors to render 3D viewing experi-
ence. A 3D kit for laptops and
LCD monitors includes a strip of
plastic that has special optical
properties and software, which
creates perspective views that
makes normal 2D images appear
as 3D. 

The plastic strip that is used
consists of small polarised
prisms that diverts light from
alternate pixels in opposite
directions. For example, all even
pixels would be diverted to the
left eye and odd pixels to the
right. This gives a feeling of
being surrounded by the object
from the sides, rather than
simply viewing it straight on.
The software that is bundled
with the kit creates certain
number of perspectives (viewing
angles) horizontally and verti-
cally. Accordingly the add-on
plastic sheet will contain polar-
ized areas such that each
perspective is rendered in a
slightly different angle. 

Thus if we have 8 horizontal
and 4 vertical views on a standard
1024 X 768 resolution, a 3D of 128
X 192 (1024/8 and 768/4) resolu-
tion. The software generates
display such that every 8th hori-
zontal pixel is same and similarly
every 4th vertical pixel is same. 

These 3D kits are not yet
available commonly in India, but
it is only a matter of time before
you can pick one up from your
neighborhood store. 

Manufacturers like Sharp are
making LCDs with inbuilt 3D
capability. Another innovation is
that of the switching viewing
angle developed by Sharp. There
is an on/off control by which you
can narrow or broaden the view-
ing angle.  

Kailas Shastry

T
he bulkiest, most power
hungry component of
your computer, the moni-
tor, has undergone a

change of many sorts with the
coming of the LCD versions.
While the LCD technology is not
new in itself (remember the LCD
display on watches?), it was not
perfected enough for monitors
until quite recently. LCD monitors
are very thin in comparison to
their older cousins, the CRTs.
They consume just about one
third the power and offer a flicker
free viewing experience. This
makes them ideal for office use
where energy conservation, space
and of course reducing employee
fatigue is a prime concern.

Video On Your Monitor
If you have just bought an LCD
monitor for your home that has a
composite or S-video input, here
is how you can get to watch
movies from your DVD player on
it. DVD players provide an output
through the composite, compo-

By turning on ClearType in Windows XP, you can make your text look smoother
and more pleasing to the eye. This is more noticeable with LCD monitors than
with CRTs. To enable ClearType, just right-click on the Desktop, choose
Properties > Advanced > Effects, and check "Use the following method to
smooth edges…". In the drop-down menu, choose "ClearType." For more fine
tuning, download the Microsoft ClearType PowerToy from
www.microsoft.com/windowsxp/downloads/powertoys/xppowertoys.mspx.
This application shows you a bunch of screens, and you select which one
appears best—thus ensuring you're seeing what you want to see! 

Using ClearType Fonts In Windows XP

S-Video connector

A composite video connector
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Caring For Your 
LCD Monitor

LCD screens are delicate in
comparison with the CRTs. Hence
you need to be more careful in
cleaning them. When wiping
dust off, use a dry cloth first and
then, if need be, wet a cloth,
squeeze out excess water then
use it. Do not press too hard on
the screen as you may create
‘stuck pixels’. Alcohol and
Ammonia based cleaning agents
are a strict no-no. Many monitors
contain an anti glare coating
which can easily get damaged
when washing agents are applied
on them.

LCDs use proprietary power
supply. In case of the adaptor not
functioning use the manufac-
turer recommended spare. If
that is not available use only
those adaptors which meet the
voltage requirement exactly and
a current ratings that is at least
equal to rating of the original.

If you ever come across a
stuck pixel (a dot whose colour
does not change), try and gently
rub on the spot where the pixel
is stuck. Do not apply too much
force as you will risk damaging
adjacent pixels. If a couple of
tries don’t work, then just let go!
Note that while stuck pixels may
be corrected, dead pixels cannot
be revived. A dead pixel appears
black always while a stuck pixel
stays on with a single colour.

A Buying Guide
In spite of the nice aesthetics,
fatigue free viewing and power
saving, LCD monitors have
certain drawbacks and you must
look out for specifications
pertaining to the drawbacks
before making an investment.
They don’t come cheap after all. 

Response Time
This is the time taken by the
monitor to change the colour
and / or brightness of a pixel. It is
measured in milliseconds and
the values generally are 10, 12,
16 ms. Some LCD monitors offer
a very quick response of 8 and
even 6 ms. The lower this value
is, the better the LCD is for view-
ing fast moving graphics such as
games or action movies. With
some entry level LCDs that offer
a dismal 25ms response time, a
ghosting effect becomes very
noticeable. So look for LCDs with
a response time of 10ms or lower.

Viewing Angle
Unlike CRTs, which can be
viewed from pretty much any
angle, images on LCDs will
appear dull and even colour
distorted when viewed from
beyond a certain angle. Their
best quality appears when
viewed head on (perpendicular
to the monitor). As you move
sideways the display appears
more and more distorted.

Viewing angle is the maximum
angle at which you can see the
display with no noticible change
in quality. Obviously, the greater
this angle, the better the LCD is!

Native Resolution
LCDs have to be run at their
native resolution which is the
number of pixels that make up
the display. Usually using a reso-
lution that is lesser or greater
will result in distorted display.
Make sure that the native resolu-
tion of the LCD is something you
are comfortable with.

Go for Goodies!
Speakers—Some CRT models of
the bygone era (ok, say 8 years
ago) tried bundling speakers in
the monitor box. But not many
of these 2-in-1 models were
made owing to mutual interfer-
ence between the speakers
magnets and the high voltage,
electromagnetic radiation of the
monitor itself. With the coming
of the LCD monitors there is no
problem of interference, mean-
ing it is much easier for manu-
facturers to bundle in speakers
inside the monitor cabinet.
These speakers don’t need any
extra power supply as they draw
their power from the monitor’s
main DC supply. 

USB Hub—How often do you
have to try positions of yoga to
hook up a digicam to the USB
port at the back panel of your
cabinet? If you are buying a LCD
monitor, spend a little more and
get one which has a USB hub. The
monitor will have one cable that
connects to the USB port on the
back panel. On the monitor itself
you will find USB ports (usually
4) to which you can connect USB
devices. You not only get more
USB ports, but also the ease of
connecting the cables right at
your desk. 

kailas_shastry@thinkdigit.com

Ambient lighting can make or mar the LCD
experience. The best image quality on LCD
monitors is attained under dim lighting. This is
not practical if the room is being used by
others; in such a case, it is best to have the
lights to the side of the monitor. Bulbs meant
for TV viewing are the best to use here—such
bulbs have a reflective coating at the bottom
so that there’s no directed light, but the room
appears well-illuminated. The downside is the
higher power consumption of these bulbs, as
they are tungsten based. In place of the bulbs,

you can use low-wattage CFL tubes, which can
give you nearly as good lighting.

Lights behind the monitor (this applies even
to CRTs) are to be avoided—they can distract
your vision. They can also cause eye strain and
mental fatigue, since you unconsciously try to
avoid the more intense bulb or tube and concen-
trate on the monitor.

In the same way, lights behind you are also
a strict no-no. They get reflected on your screen
and not only spoil the viewing experience, but
also cause eye strain.

Room Lighting



Portable music players
have given us the free-
dom to be entertained on
the go. Here’s how you
can make the right choice

MP3 PlayersMP3 Players

Photograph Jiten Gandhi
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artist name. If your ripping soft-
ware does not have the option,
spend a couple of minutes in
renaming the MP3s manually. 

Let’s briefly take a look at a
batch renaming software called
CKRename. It gives you a variety

of options, like prefixing, suffix-
ing, selective renaming etc.
Download it from www.music-
sucks.com/CKSoft/CKRename/

When you open CKRename
you will see a Windows Explorer
like interface to the left. Navi-
gate to the folder whose files you
wish to rename. You can change
the filenames and extension,
introduce numbering for the
selected files. Files such as
track001.mp3 can be changed to
“artist—song name 001.mp3”.
You can later on rename them to
“artist-song name.mp3” if you
want to. You will be saved the
trouble of typing in the artist’s
name for every song.

Size vs Quality
In a really nice world, we will
choose the best quality for our
songs while ripping, in an ideal
world we will just save them in
the gigantic wave formats. But
when we have to only so much
space and a lot of songs—we will
have to compress them. This
holds good not only for MP3
players but any storage media,
including hard disks. Most play-
ers support playback of MP3s
compressed with 32 to 320 kbps.
A higher bit rate provides better
sound but occupies more space.
For pure voice tracks, the basic

32 Kbps is enough to retain clar-
ity. For music files however,
compressing to 32 Kbps is crimi-
nal! You need 128 Kbps to retain
the varied music elements. This
will give you a file size of 1 MB
per minute approximately. The

‘quality’ will also depend
on the efficiencies of the
ripping (encoding) soft-
ware as well as the player
itself. When both of these
are good, you might ~
just~ be able to get away
with 96 kbps. We recom-
mend 128 Kbps as a mini-
mum however. 

Let us now take a look at
ripping CDs using a well known
free software called Audiograb-
ber. Download it from
h t t p : / / a u d i o g r a b b e r . c o m -
us.net/download.html.

Also download the LAME
MP3 encoder from the same
location and paste the
lame_enc.dll in the directory
where audiograbber is installed. 

When Audiograbber is
opened, click on the button that
says MP3 and choose the
LameEnc DLL encoder. Set the
quality settings to ‘Joint Stereo’
and ‘High’. Now by moving the
slider, choose the bit rate you
want. For an MP3 player, you can
start with 192 Kbps and go

Kailas Shastry

A
lmost every gadget avail-
able today can be used
with little or no calibra-
tion. But getting your

hands dirty with details and
feature sets is what separates the
boys from the geeks. An MP3
player is no exception. Of course
you can simply drag and drop or
use a syncing software to transfer
your songs. But there are optimi-
sations that you can try out to
make music listening a more
pleasurable experience.

Sort So You Can Search
Most players display files accord-
ing to the filename—you will
have files called track001.mp3 if
that’s how your ripping software
names them. On Winamp or
Windows Media Player, this is
not a problem as they identify
ID3 tags (bearing artist and
album information) and not to
mention, the easy navigation.
Your MP3 player, even if it recog-
nizes ID3 tags, will display the
artist and title, but the sorting
may not always be according to
the tag. It gets irritating if you
are looking for one particular
song amongst a 100. A simple
solution is to name the tracks
with something more descrip-
tive than an uninformative
track001! 

While ripping from your CDs,
set the preferences in your
ripping software to name the
files starting with a word that
describes them, like the album or

Batch renaming in CKRename

Setting ID3 tags in Audiograbber

Setting the bitrate
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downwards till 96 Kbps and
check the sound quality at every
stage. As there is not single rule
to choose a particular settings,
use your discretion here.
However, unless you are
crunched for space, do not go
below 96 Kbps for music files.
Speech only files can be encoded
at as low a bit rate of 32 Kbps.

Some ripping and editing soft-
ware allow you to set a Variable Bit
Rate (VBR). This essentially means
that the parts of the track which
contain less detail are compressed

more (meaning lesser bit rate) and
the portions that contain more
sound elements are compressed
less (higher bit rate). The concept
is no doubt an optimisation, but it
places an overhead on the decod-
ing logic. Some low-end MP3 play-
ers maybe sluggish while
decoding VBR and your sound
quality may actually suffer. If you
are unsure of how your player
responds to VBR, just choose a
constant bit rate as we have
explained above.

Clearer FM Radio
Do you remember the stand
alone radio sets or two-in-ones
which had long aerials for radio
reception? Our MP3 players have
only a miniature ferrite rod to
act as an antenna, or in some
cases, they depend on the head-
phone multitask as antenna. Due
to this antenna issue alone, FM
reception loses clarity when used
indoors or while traveling. This
can be solved by wrapping a wire
around your MP3 player. While
this may mar the aesthetic
beauty, you will get clearer recep-
tion indoors. If you on the move,
keep the player in a pocket such
that it touches your body which
itself can act as an antenna!

Better (h)earphones
Just as a chain is as strong as its
weakest link, the MP3 player can
only be as good as its acces-
sories, which in many cases are
the earphones. The unassuming
earphones pack complex tech-
nologies to deliver the best
sound to you. A good pair of
earphones can easily cost half as
much as your MP3 player itself.
Unfortunately, due to cost
cutting, the earphones that we
see on most entry and even 
on some mid-segment players
are just mediocre and simply
ruin the sound experience. 
Buy a good pair of headphones
or earphones and plug it into
your player. 

Bear in mind two factors
while choosing an earphone—
the impedance and the maxi-
mum power rating of the
earphone. The impedance must
of the earphone must be equal to
the impedance of the player—
measured in ? (ohms) most
earphones have a rating of 8? The
maximum power handling abil-
ity, measured in mille Watts
must be greater than or equal to
that of the player. 

kailas_shastry@thinkdigit.com

There are three types of storage available for
MP3 players - flash memory, micro hard drive
and hard drive.

Of these flash memory is most commonly
used in low end and mid range MP3 players.
Capacities usually range from 128MB to 1GB.
Some players like that iPod nano have hit the
4GB mark for flash based MP3 players. Unlike
hard drive based devices, MP3 players are not
mechanical devices, meaning, they do not
contain any moving parts. This makes them an
ideal choice for people who are on the move or
for those who want to listen to music while
working out in the gym. A hard drive based
player may skip some parts of the song when it
is subjected to movement, like when carried
while jogging. Flash memory has a definite

number of read / write cycles which is less than
that of a good quality hard drive. 

Hard disks offer much higher storage space
than flash memory, upwards of 20GB. A good
quality hard disk will outlast flash memory in
the number of read / write cycles that can be
performed. On the down side, hard disks are
heavier, consume more power and are prone to
errors when subjected to movement.

Micro hard disks, as the name suggests are
a smaller version of the hard disk. They
combine the reliability of hard disks with a
relatively light weight and capacity that is
higher than flash memory. Owing to the small
size, design and fabrication is more expensive
than hard drives, resulting in a relatively
higher cost per GB.

Storage Media in MP3 Players

Wrap a wire around for better FM reception indoors

The storage capacity often
becomes a constraint especially if
don’t have the time to transfer fresh
songs to the player. The mantra
here is simple—bigger the better.
1 GB is better than 512 MB is better
than 256 MB.. you get the picture.

Headphone Comfort: Every ear is
different and this makes it difficult
to make earphones that are
comfortable for everyone. If you are
investing in a good earphone,
comfort is an important factor.

If you plan to use the player as a
USB drive to carry data around, the
data transfer speed is important.
Opt for a player with USB 2.0
connectivity.

Buying tips



DVDs To DVD!
Take a compressed backup of your DVD movies and burn several
movies on to one DVD

DVDs To DVD!

Photograph Jiten Gandhi
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15-day trialware ($19.99, or Rs
950, for the registered version),
and the download is 16.4 MB.

4. LAME ACM MP3 audio
codec: This MP3 codec is required
for compressing and encoding
audio to a bitrate of 128 kbps,
which is good enough for most
purposes. Windows comes with
an MP3 codec, but this doesn’t
allow encoding to a bitrate higher
than 56 kbps, which is way too
low. You can download the LAME
ACM MP3 codec from www.free-
codecs.com/download/LAME_AC
M_Codec.htm. Just 214 KB. 

5. VirtualDUB: A video
capture/processing utility for 32-
bit Windows. Freeware. It is very
fast, and is used to create DivX
videos. The latest version is
1.6.14, and can be downloaded
from www.virtualdub.org. It’s
about a 1 MB download.

Armed with this arsenal of
tools, let’s rip those DVDs!

A) Insert your DVD into the
drive and launch DVD Decrypter.
DVD Decrypter will detect the
DVD, and its file contents will be
displayed in the right pane. Now
go to File > Browse and select the
destination for the ripped VOB
files. Keep in mind that the desti-
nation must have enough free
space to store the contents of the
entire DVD.

After choosing the destina-
tion, click on File > Decrypt to
start the decryption process. DVD
Decrypter removes the Macrovi-
sion protection (which is a type
of copy protection in video DVDs)
by default, and you can set it to
remove the region code as well by
going to Tools > IFO > Region
Patch > Region Free. These are
necessary for the next step. After
the DVD ripping process is
completed, close DVD Decrypter.

B) Next, launch DVD2AVI. Go
to File > Open. Make sure the
correct track number in the
Audio menu is selected. You need
to find the correct track number—

most DVDs have multiple audio
tracks in different languages. This
can be checked by selecting one
track at a time and playing it. Also
click on the Audio menu and navi-
gate to “48 > 44.1 KHz”, and select
Off. Go to Help > SIMD Technol-
ogy and select all the optimisa-
tions supported by your processor.
Now go to File > Save as AVI. 

Decide on a file name and
choose a location with enough
free space. You will now be
prompted to choose a video
compressor. Choose “DivX 6.2.1”
from the drop-down menu
where you can select the video
compressor.

Under the Certification
Profiles, you can choose an
appropriate preset profile such
as High Definition, Home
Theatre, Portable, Handheld, and

Jayesh Limaye

M
uch as we’d like them
to be, movie DVDs still
aren’t cheap. If you
have a lot of them

lying around, you probably value
them dearly, and are worried
about them getting scratched.
Then there’s the issue of friends
borrowing them and not return-
ing them! In general, it’s a good
idea to back up your DVDs. And
no, just trying to copy the VOB
files to your hard disk won’t do it!

Here we tell you how to back
up a DVD movie and convert it to
the popular DivX formats—you
can then burn them back onto
DVD. And yes, it’s legal—just as
for CDs, it’s legal to have one
backup of a DVD. Once you create
backups, with the movies in DivX
format, you can cram three or
even four of them onto a DVD!
There’s a whole bunch of soft-
ware required to do this, but
after you’ve done it for one
movie, it will become routine. So
here’s the list:

1. DVD Decrypter: This is a
very fast and free DVD ripping
software. It can rip multi-angle
DVDs. Find it at www.mrbass.
o r g / d v d r i p / S e t u p D V D D e -
crypter_3.5.4.0.exe. The current
version is 3.5.4.0, and it’s a 0.86
MB download.

2. DVD2AVI: You use this soft-
ware to convert the ripped and
decrypted VOB files to the AVI
file format. DVD2AVI v1.77.4 is
freeware, and is available at
www.afterdawn.com/software/v
ideo_software/dvd_rippers/dvd
2avi.cfm. The download is a tiny
0.16 MB.

3. DivX Create: This has a soft-
ware codec that allows you to
compress videos while maintain-
ing almost the same quality as
that of the original video. The
latest version of is 6.2, and is
available at www.divx.com. It is

The DVD Decrypter main window

Choose the appropriate bit rate for
your movie
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Unconstrained. When you choose
one of the above profiles, it is
virtually guaranteed that the
encoded DivX file will be playable
on any standalone DivX-certified
player. Click on Settings. You can
select a bitrate of your choice. A
higher bitrate means a larger file
size and better quality, while a
lower bitrate means a smaller file
size and lower image quality.

In the Codec tab, you can set
the Encoding mode. The default
setting is a good trade-off
between quality and compres-
sion, but if you wish to control
the file size, you can state your
own mode such as High Perfor-
mance, Better Quality, etc. Click
on OK and then on Save to start
the video demultiplexing

process. This will take some time
depending on the speed of your
computer. At the end of this
process, you’ll have an AVI file
and a WAV file.

C) We now get to the creation
of the DivX file—putting together
the video (AVI) and audio (WAV)
files that were created in the
previous step. Launch Virtual-
Dub. Under File > Open, browse
to the folder where the AVI and
the WAV files are stored. Select
the AVI file and click Open. 

D) Click on the Audio menu
and click “Full Processing Mode”.
Click again on the Audio menu
and select “WAV Audio”. You will
be prompted to open a WAV file.
Select the WAV file you created
earlier and click Open. Click on
the Audio menu and then on
Compression. Select “MPEG
Layer-3” from the left pane and
then select “128 kBit/s, 48,000
Hz, Stereo” in the right pane.
Click OK.

E) Select Interleaving from the
Audio menu. Then, select the “ms”
radio button and input “500” into
the “Interleave audio every” dialog
box. Click OK. Again, in the Audio
menu, select Volume. Check the
box and move the slider to 200 per
cent. Click OK.

F) From the Video menu,
select Direct Stream Copy.

G) Go to File > Save as. Enter a
file name of your choice at a
location of your choice, and click
OK. This, again, will take some
time, but not as much as the
video encoding using DVD2AVI.
After the process is complete,
you’ll have a DivX backup of your
DVD movie.

H) All that’s left now is to burn
the DivX backup to CD or DVD
using your DVD-Writer. Like we
mentioned, you can make back-
ups of several movies and cram
them all into one DVD. How many
depends, of course, on the quality
settings you chose during the
backup process. Remember,
though, that distributing the DVD
you create to friends is illegal! 

jayesh_limaye@thinkdigit.com

SimpleDivX is, as the name suggests, a really
simple, free software to convert DVD movies to
formats such as DivX. In this case, too, you need
to first decrypt the DVD to your hard drive. The
step-by-step, tabbed approach makes it easy for a
novice to understand. It is highly customisable -
for example, you can even set the location of the
directory where the temporary files are stored.
“DivX” in the name of the software is misleading -
it can convert to MPEG-4 formats of any kind,
such as XviD. This is one software worth trying!

SimpleDivX

Choose the encoding mode in DivX Select audio compression format

Set Interleave audio every 500 ms in
Virtual Dub

Set the Volume to 200% in VirtualDub



Hook ’em 
Up Right
Right after getting your speakers and even before you try
listening to them, spend a half hour setting them up right!
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Almost all motherboards today
come with either 6-channel or
even 8-channel audio onboard.
With technologies such as Intel’s
High Definition—codenamed
Azalia—a high definition, 8-chan-
nel audio architecture becoming
more mainstream, the need to
invest in a discrete multi-channel
sound card is decreasing. We will
use an onboard 5.1 solution for
the purpose of setting up the
speakers. Those with discrete
sound cards can follow much the
same procedure. So here’s how to
get the best sound from your
speaker set:

1. First, ensure that your sound
drivers are installed properly and
up-to-date. Not only will these seri-
ously hinder audio playback, they
are notorious system resource
hogs as well. Updated drivers
ensure that bugs are ironed out.

2. Speaker wire plugs are
generally colour-coded, and some
manufacturers also mark the
speakers as “front left,” “rear
right,” and so on, which further
simplifies the installation process.
Most 5.1 speakers have the satel-
lites connecting to either the
subwoofer or an external box or
decoder. Terminals are either of
the wire clamp or plug types.

3. The front satellites are
ideally placed a minimum of five
feet apart. More powerful speakers
can be placed further apart,
barring space constraints. The
satellites should be placed so that
they fire in the audiences’ direc-
tion. Similarly, the rear speakers

are placed behind the listener, and
in general should form a rough
box formation with the front
speakers. The centre speaker,
which handles most of the vocals
in a DVD movie, is ideally placed
atop the monitor, directly in front
of the user. 

Face the speakers towards you:
if not, loss in clarity will result,
since mid and high frequency
sounds are direction-specific. The
subwoofer can be placed anywhere
in front of you, since low
frequency sounds are not direc-
tional. Place the sub away from
obstructions so it can fire properly,
and try to maintain adequate
ventilation around it. If you have
an underpowered sub, place it
near a wall to boost the bass.

4. If the speakers’ connect
plugs are colour-coded, attach the
corresponding wires to the satel-
lites. Some speakers come with
wired satellites, making this step
unnecessary. Move on and attach
the other end of the wires to the
rear of the subwoofer or decoder
box, as the case may be. There
should typically be six connectors
at the back, with front, left and
right, centre, etc. marked. It’s
good practice to coil up and tie the
wires if they’re too long, rather
than let them hang around, as
they tend to get knotted up,
particularly at the point of
connection with the sub/amp. 

5. Now you need to connect
the speakers to the sound card or
motherboard. Sound card/
onboard outputs are usually
colour-coded. Light green is for
the front two channels, black typi-
cally denotes the rear speakers,
while the centre and subwoofer
are represented by an orange-
coloured connector. If there’s no
colour coding, your sound drivers
can help—use the troubleshooting
feature.

6. You should have “5.1” sound
selected in the speaker settings,
which you can access via the

Michael Browne

S
o you got a new set of 5.1
speakers. Great—way to go!
Your next step would proba-
bly be to grab a bag of

popcorn and settle down in front
of your home entertainment
system! Slide in that DVD and sit
back. But what’s this? DVD not
sounding the way it should?
Gunshots fired from behind being
played by the front speakers? The
ensuing irritation could make you
want to tear out your hair, or
maybe throw out your speakers, or
both!

What you need is only to prop-
erly set up those sound boxes, and
you’ll be surprised at the mere
minutes it takes to actually get it
right. We throw in a helping hand,
as usual, and believe it—you will
hear the difference!

Why Six Channels?
A 5.1 speaker set is, of course, a six-
channel system, that is, it is capa-
ble of reproducing six channels of
sound, one of which is dedicated
to bass (the subwoofer). 

DVD audio, movies and
gaming are the two areas where
5.1 speakers are in heavy demand.
These are also the only two areas
that fully utilise multi-channel
audio, since music and movies
from non-DVD sources are typi-
cally stereophonic. True 5.1 sound
is positional sound, “positional”
relative to the seated audience:
DVD soundtracks are natively 6-
channel, so positional sound is
inbuilt. This means that gunfire
behind and to your left will sound
from exactly that channel—
provided you’ve placed your speak-
ers correctly, that is. With
upmixing—adding virtual chan-
nels to a stereo source—the result
is never good enough to compare
with a true surround sound
source.
Setting Them Up Typical Subwoofer back panel

A 6 channel
speaker
setup is a
must for an
immersive
DVD movie
experience
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control panel or the sound card
drivers. All sound cards come with
a setup Wizard or calibration
Wizard—click on it. Here, too,
select “5.1”: some software will
intelligently detect the speaker
connects and show 5.1. These utili-
ties usually play sounds from each
speaker while indicating which
speaker is playing by highlighting
them on the screen. This is to
ensure that the channels are right.
If the speakers are playing when
they should, breathe a sigh of
relief—you’re nearly through!

If a sound channel has got
mixed up, you may have either

connected the speakers to the
back of the woofer/amp incor-
rectly, or the outputs at the sound
card end have been plugged in
wrong. The most common prob-
lem is of left and right or front
and rear being inverted; simply
swap the connectors. If the cables
and the sound card sockets aren’t
colour coded, and if there’s no
sound from, for example, the
centre speaker, you can use trial
and error to get it right.

7. Another important tweak is
the subwoofer crossover. In your
sound card drivers, this will be
shown as a slider bar. Generally, if

set at a value like 120 Hz (typically,
the crossover allows a range from
0 to 200 Hz), it means that any
sound intercepted by the decoder
unit below 120 Hz will be redi-
rected to the woofer unit. The typi-
cal crossover frequency should be
between 80 Hz and 120 Hz;
anything higher than this can be
handled by the mid range
(squawker) drivers. Experiment
and see what sounds best for you.
The best sound may even vary
from song to song, but there
generally is an optimal setting.

8. Slip a DVD movie into your
drive. Start her up! You now need
to calibrate the volume of the
speakers. A good way to start is to
set the overall (or “master”)
volume to between 50 and 75 per
cent, while playing around with
the individual speaker volumes.
The woofer volume should be kept
at about 60 per cent; this is a
comfortable volume that doesn’t
distort, and at the same time,
doesn’t intrude on the other
sounds. Usually, the centre
speaker is a bit more powerful
than the other satellites, so it can
be set at a slightly higher volume
level than them without distor-
tion. The centre speaker should, as
a rule always be more powerful,
because this is the channel that
produces the vocals in a 5.1 movie. 

9. Sit back on your settee, grab
the popcorn (which you dropped
in frustration earlier), and chill
out! 

michael_browne@thinkdigit.com

LFE: An acronym for “Low Frequency Effects”.
The very term “sub” in the term “subwoofer”,
means meaning sound below 50 Hz. A sub is
typically capable of producing sound in the
range of 35 Hz to 100 Hz. Some subs can go
higher, though this is not really needed. A sub
that can go lower than 35 Hz is good indeed, and
the lower a sub can go, the more ideal it is for
producing deep rumbles. Subs that go really low
are also costlier.
Drivers: The driver is what produces the
sound from your speakers. It consists of the
enclosure (typically metal), a permanent
magnet, and the diaphragm (often of paper).
Speaker drivers are of three types,
distinguished largely on the frequency
spectrum they are built to reproduce.
Tweeters are the smallest of the speaker
drivers and can produce the highest-frequency
sounds, like the tinkling of breaking glass. A
good-quality tweeter can reproduce sounds up
to 25,000 Hz. Squawkers are the mid-range

drivers. They are typically 3- to 5-inch drivers
with the ability to produce a wide spectrum of
sound between the sub and the tweeters.

The subwoofer is the low-frequency sound
producer, and is responsible for all the thuds
and thumps. They are capable of playing
sounds below 150 Hz. A sub also has the
biggest driver, sizes range from 6.5 inches to
12 inches in diameter.
SNR: The Signal to Noise Ratio is a very
important consideration for audiophiles and the
discerning user. Very simply put, every sound
channel carries, along with the actual audio
content, a certain amount of “signal
interference” or stray noise. This causes
distortion in sound, and it is particularly
noticeable at higher volumes, mainly because of
the unit design imperfections. SNR is measured
as a ratio. A typical good value for a speaker is
85 dB, with some higher end 5.1 sets having an
SNR as high as 110dB. Speakers with an SNR of
below 65 dB should be avoided at all costs!

Jargon Buster

Final Subwoofer assembly The soundcard all hooked up

Changing the Speaker Options in your
soundcard panel



Cinema At Home
If you’re thinking of buying a Media Center PC, you should also
invest in Digital Media Convertor to minimise the disk space used
when capturing video

Photograph Jiten Gandhi
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WMA, and WAV formats, and also
batch-convert them.

Before you proceed, you must
make sure your system meets the
minimum system requirements.
For a Windows XP Media Center
PC, you need to download and
install an MPEG-2 encoder such as
the freeware from www.desk-
share.com/download/mpeg2deco
der.exe. For Windows XP Home
and Professional, you require
Service Pack 2, Windows Media
Player 9, DirectX 9c and the above
MPEG-2 decoder. Let’s get started!

1. Launch the program. Go to
File > Add Files, or click on the
toolbar button labelled Add Files.

2. Browse to the folder where
the files you want to convert are
stored. Select one or more files
you’d like to convert.

3. Select the “Convert to”
format and click Open.

At this point, the Digital
Media Converter will start
adding the files one by one, and
will display an error message if it
is not able to add any of the files,
and will also display the reason
for it not being able to add the
file. This converter is intelligent:
instead of just displaying the
error, it will also instruct you
about what you may need to
install in order to be able to
convert the file.

4. If you need to remove a file
from the list, just select that file
and click Delete in the Edit menu.

5. You may wish to change the
conversion settings before you
convert the files to your
preferred format. To choose the
format of the converted file, go
to Tools > Settings. Select a
format from the “Convert To”
box. Click on the Properties tab
to change the settings of the
selected “Convert To” format.
Click OK.

6. To configure an automatic
shutdown after batch conver-
sion, go to Tools > Settings, and
check the “Shut down the
computer after conversion”
option. Click OK.

7. You can disable hardware
acceleration—this will result in

s m o o t h e r
conversion, as
fewer system
resources are
used. To disable
hardware accel-
eration, click
on Tools >
Settings, check
the box next to
‘Disable Hard-
ware Accelera-
tion during
conversion’ and
click on OK.

Jayesh Limaye

W
indows XP Media
Center PCs are
already gracing the
shelves of PC stores

all over India. It is finally being
realised that the Windows XP
Media Center PC, which
comprises the OS along with the
compatible hardware, is the ulti-
mate convergence of personal
computing and entertainment.
The ability to capture live TV or to
be able to view TV the at your own
pace, so to speak, makes it an
attractive replacement for the TV
as well as the regular PC.

Windows XP Media Center
PCs use a new format known as
DVR-MS (which derives its name
from Digital Video Recorder).
Video of this type is encoded in
the MPEG-2 format. DVR-MS files
can also be copy-protected by
the author, thus allowing them
to be run only on the Media
Center PC that was used to
record the content.

The DVR-MS file format
captures live telecasts at excellent
quality levels, but there is a draw-
back. The size of the captured file
is huge. A two-hour capture at the
best quality settings would take
up a whopping 5.5 GB of hard disk
space! And DVR-MS files cannot be
easily edited. This is why you
might want to convert files from
this format into a format such as
WMV, which not only occupies
only a fraction of the space for
almost the same quality, but can
also be edited.

Thankfully, there is software
known as Digital Media Converter
from www.deskshare.com which
does this job for you. Not only is it
capable of converting unpro-
tected DVR-MS files to the WMV
format, it can also convert them
to the VCD, DVD, AVI (DivX, MS
MPEG4, uncompressed, etc),
MPEG-1, MPEG-2 (PAL, NTSC), MOV, Add video files to Digital Media Converter

Disable Hardware Acceleration during
conversion
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8. If you selected AVI as the
conversion format, you can select
from amongst the Best Quality,
Best Compression or Most
Compatible presets. In addition,
you can also choose the video
dimension, frame rate, video and
audio compression codecs. 

9. In a similar way, if you
selected MPEG as the format,

you can configure the proper-
ties. You can choose from
amongst a myriad of MPEG-1
and MPEG-2 formats here such
as VCD, SVCD, DVD, etc. You can
also choose the aspect ratio,
bitrate and frame rate. There are

options such as these for each
format that you can choose,
such as QuickTime.

10. To convert to the WMV
format, point to the Tools menu
and click on Settings. From the
“Convert To” box, select WMV—
For Desktop Viewing for Video,
or WMA—For Desktop Viewing
for audio. Select the Properties
tab. From the Profile box, select
a profile you feel is appropriate.
From the list of available
bitrates, select the ones you
want to include in the conver-
sion. When more than one
bitrate is selected, the converted
video is an MBR (Multiple bit
rate) video. Click OK.

11. You can apply effects to
the videos you convert. Select

the file to which you wish to
apply a video effect. On the Tools
menu, click Video Effects. Spec-
ify the effects that you want to
apply in the Effect Settings
window. Click OK.

12. The Brightness can be
used to change the brightness
level of the video. Up to a 200 per
cent adjustment in brightness is
available.

13. The Contrast allows you to
adjust the contrast of the video
to up to 200 per cent, allowing
you to define the difference
between the dark and light areas
in case they do not appear in the
video as they should.

14. The Gamma slider lets you
adjust the gamma of the video by
up to 200 per cent.

15. Videos can also be manip-
ulated before they are
converted. The Gray Scale effect
transforms all the colours in the
image into shades of grey, in
effect converting colour videos
to black and white.

16. “Flip Horizontally” turns
the image ~upside down~. This
can be useful in cases such as
when the videos have been
converted from the YUV colour
space to the RGB colour space,
which can sometimes result in
the converted video turning
upside down.

17. “Mirror Image” produces a
mirror image of the video. This is
also called the “Flip Vertically”
effect, because it flips it about the
vertical axis.

18. “Invert Colors” trans-
forms the colours in the video to
their negatives.

Digital Media Converter v2.65
is available from www.desk-
share.com, and the download is
about 9.4 MB. It is shareware and
can be converted to the full
version for $39.95 (Rs 1,900). It can
be picked up easily even if you are
a novice. Start emptying out your
hard drive!

jayesh_limaye@thinkdigit.com

EPG, or Electronic Programming Guide,
has just been launched by Microsoft in
India. This will allow users of Windows
XP Media Center Edition PCs easy
access to program schedules for over
80 cable TV channels available in India.

An EPG is an on-screen
interactive guide to TV programs that
lets the user navigate, select, search
for and record TV shows. Until now,
this was only available in areas such
as Europe and the US.

The EPG has a list of all the
programs on your cable channels, and
it will be integrated into all Windows XP

Media Center PCs from now on. Due to
its interactive nature, you can look for
your favourite shows just by typing in
keywords such as the name of the
program or movie, actor, time, day and
date. You can also view the program
start time, duration, censorship
classification and genre. The EPG
combined with the DVR (Digital Video
Recording) capabilities of Windows XP
Media Center transforms your PC into a
PVR (Personal Video Recorder),
allowing you to schedule recordings.
The great thing is that this does not
need a subscription—it’s free!

India’s First-Ever EPG

Select the AVI file codec as required

Change the Effects Settings
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The Elder Scrolls 3 a.k.a. Mor-
rowind will always be
remembered for its stun-

ning visuals, excellent first person
perspective (somewhat rare for
the RPG genre), and it’s hours of
completely open-ended gameplay.
That game was released in 2002. 

It’s been four long years, and
Bethesda Software had a tough
task ahead of them: making a
game as visually splendid for
today’s computers as Morrowind
was for PCs back then, at the same
time ret-aining the award-winning
gameplay. After all, gamers every-
where were waiting anxiously for
the next game in the series. Would
the sequel deliver?

Enter The Elder Scrolls 4: Obliv-
ion, which was finally released in
March of this year.

The Graphics
Put simply, Oblivion is the best-look-
ing RPG to date, and cannot be
compared to anything in the
genre, eye-candy wise. We’d go as
far as to say that visually, Oblivion is
to RPG what F.E.A.R was to FPS. This
game has the ability to bring even
X1900XT and 7900GTX cards down
to the vicinity of their knees. Par-
allax Mapping, Shader Model 3.0,
complex and soft shadows, Bloom
and HDR effects, Oblivion has it all! 

One look at the amount of
detail in a single scene will be
enough to convince you; the com-
plex movements of grass and
foliage, water effects, volumetric
and particle effects like smoke,
fire effects-all very appealing. The
unfortunate thing is that the
game is very resource hungry, and

needs a real powerhouse rig to
play it at 1024 x 768 with all the
eye-candy turned on. And believe
me when I say this: you won’t
want to play Oblivion without all
the effects cranked up and with AF
and AA disabled, because this
game is meant to played with all its
bells and whistles.

Another problem with Oblivion
(although there are third-party
patches to fix it) is the LOD draw
detail—it’s simply horrible. You’ll
frequently see people suddenly
appearing in front of you as you
move close to their location. Simi-
larly, a tree will appear, then its
leaves will appear as you get closer,
and finally, visual effects will be
apparent upon getting closer. This

is because the game tries to com-
pensate for slower cards by ren-
dering such textures on demand.
The problem is that it does this
even on the most powerful systems
with the latest graphics cards—
very irritating.

Gameplay—Awesome As
Always!
Oblivion delivers big on this front.
You start off in prison, and are
freed to partake on a quest for the
emperor, who also gets killed early
in the game. Now armed with a
relic and the knowledge that the
gates of Oblivion have been opened,
pouring forth a wave of nasty crea-
tures into the world of Tamriel,
you set forth on what should be

A treat for the eyes My journey ends here, yours begins...

From Morrowind to Oblivion A long journey

Digital Leisure l Touched by Tech

Technology Beyond Work
Leisure
Digital

222198 The God
Of Gaming

Booth Babes194 Lara’s in Good
Hands now

Choose to play as one of many characters The game looks gorgeous!
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the stuff legends speak of! Char-
acter cus-tomisation is good, and
there are many classes to choose
from. Once again, you cannot
increase stats like in a regular
RPG, but only by actually per-
forming actions that utilise those
stats repeatedly—thereby improv-
ing them over time. For example,
as a fighter, if you use a lot of
swords in a melee, your blade skill
will keep on increasing the more
baddies you slash up. Also, the
more you block attacks, the more
your block skill will improve. This
is a unique experience and actu-
ally works quite well in the game.
Combat—whether melee, or
ranged or magical—works well,
and the spell effects are particu-
larly spectacular. Even the in-game
physics is superb—you can actual-
ly shoot an arrow at an unsus-
pecting enemy and watch his body
being plucked by the impact,
turned around and thrown in a
heap: very realistic. It’s so pleasur-
able to see one of your flame spells
incinerating someone while he
runs around in panic! Oblivion’s
combat system rewards you every
time you score a hit by actually
making you feel like it. Likewise,
when you’re getting thrashed, you
vision will blur and sway with the
impact—thereby throwing off your
aim. 

The open-endedness of this
game is sheer genius; there’s no
hurry to complete quests. In fact,
you can take as long as you like,
exploring the world around you—
the fields, the sprawling meadows,
the underground caverns, the

towns, and the like. If you’re in a
hurry, though, you can rush
around and complete quests. Then
there are guilds to join, bounties
to collect, people to interact with,
weapons to maintain—all vying for
some of your time. Oblivion also
allows you to buy a horse to speed
up your excursions, and you can
gallop off to quests, instead of plod-
ding along! All in all, while Obliv-
ion plays slowly for the first hour
or so, once you get a few complet-
ed quests under your belt and a
couple of level-ups.

What gets slightly repetitive,
though, is the constant need to
travel around from quest to quest,
although you can use the map
travel system that instantly tele-
ports you to your destination. The
actual time spent simply moving
around exploring does tend to add
up though, and you find yourself
actually waiting for some action.
We’re not sure whether the wait-
ing is bad, or if the anticipation it
creates is good—you decide!

My Verdict
Oblivion is an excellent game if
you’re a fan of the genre—and per-
haps even if you aren’t. Definitely
one of the most anticipated games
of 2006, it has delivered with
aplomb: I was completely hooked.
The only caveat is that Oblivion
requires CPU and rendering power,
and makes no bones about this. A
lot of the gameplay is in its visual
element, and if you have a more-
than-decent rig, this game is an
absolute must-have. ■ 

michael_browne@thinkdigit.com

The Imperial City walkway

Giddy up!

Rating: 8/10 Price: Rs 2,999
Developer: Bethesda Game Studios
Publisher: 2K Games
Web site: www.bethsoft.com
Distributor: e-XPRESS Interactive
Minimum System Requirments:
512 MB system RAM, 2 GHz P4 or
equivalent, 4.6 GB HDD space,
DirectX 9.0c (included), 128 MB
Direct3D Compatible video card
and DirectX 9.0 compatible driver,
DirectX 8.1 compatible sound card

I shoot, I score



A
fter the terrifying
downturn that Lara
Croft’s career took
post-Tomb Raider 3
(some would even

say 2), it hardly seemed likely
that the lady would rise from the
grave that developer Core Stu-
dios had been so diligently dig-
ging for her. Now in the
seemingly able hands of new
developers Crystal Dynamics (the
guys behind the Legacy of Kain
series), the Tomb Raider fran-
chise has been revamped and
reintroduced to the masses.

To Thine Own Self Be
True

The heart of any Tomb Raider
game lies in exploring large envi-
ronments, solving puzzles,
leaping wantonly from ledge to
rope to who-knows-what and a
little shooting up of the bad
guys. And, of course, watching
Lara Croft carry out aforemen-
tioned activities. Lara’s latest
adventure will take her from the
jungles of South America to the

icy corners of the Himalayas and
the streets of England, among
other locations, on a quest to
find out the truth about King
Arthur’s Excalibur, an ex-col-
league who didn’t really die and
what really caused her mother’s
death. She’s not alone, though,
and will constantly find herself
in the middle of skirmishes with
the enemy.

The game’s environments—
open spaces and dungeons
alike—are mind-bogglingly large
at times, and nearly always
breathtaking. We often left Lara
hanging on to a cliff while we
took a look-see at the entire set
before proceeding. You will also
encounter puzzles ranging in dif-
ficulty and complexity from the
simple push-this-do-that type to
the insanely elaborate push-this-
pull-that-shimmy-down-wall-
DON’T-DIE-shoot-this-and-then-s
wiiiiing kind—you get the drift. 

Throughout the game, you’ll
also be treated to some interac-
tive cutscenes—press the arrows
that the game tells you to in
time. Miss a cue, and Lara will

Lara s in
Good

Hands now
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meet a very painful end.
The Goods

In addition to her signature dual pis-
tols, Lara can also pick up weapons
that enemies leave behind. She also
has a new Personal Light Source (PLS),
which, while a good substitute to her
older flare, is quite useless given the
well lit scenes—the only time I used it
was when the on-screen tutorial told
me to. She also has a new magnetic
grapple, which adds to the Indy Jones
part of her character, letting her
latch on to metal objects and swing.
This very entertaining addition is
tragically under-used, though.
Another interesting but useless addi-
tion is the PDA which gives you a gist
of your mission and what’s hap-
pened so far.

The controls are quite fluid and
quick leaps and moves (quite essen-
tial sometimes) can be made with
minimal hair-pulling—you can even
execute combinations of moves with
tremendous ease. They do fall flat on
their face in some of the boss fights—

most notably one where you have to
holster the guns and whip out the
grapple in quick succession. 

Combat action is a little disap-
pointing. While enemies gather round
aplenty and keep you quite busy, it’s
still insultingly easy. It’s a tad hard to
digest that even fifteen bullets from a
high-powered machine gun fail to
deplete half of Lara’s health.

Pretty as a picture

In the display settings, you will find
an option called “Next Generation
Content”, which when turned on
kicks up the levels of detail beyond
the capabilities of most graphics
cards. Our 6600 was reduced to a
proud 3 fps thanks to the ultra high-
resolution textures and water effects.
On higher end cards like the GeForce
7 series, turning this on is definitely
worth it—the game looks incredible.

That’s not to say that the game
doesn’t look good without the next
generation content—it’s still quite
impressive. Most noteworthy is the

attention to detail in texturing.
When Lara comes out of an
encounter with water, her skin is
actually shiny wet and her clothes
take on a slightly darker shade. She
also progressively “dries” as time
goes on.

Finally, Lara. Crystal Dynamics
have given her a complete makeover,
basing her new avatar on British
model Karima Adebibe. She’s prettier,
curvier and is generally a more pow-
erful stimulant for the hormones
than ever before. She’s also brilliantly
voice-acted by actress Keely Hawes.

Endnote

For a game that generously spreads
itself over 7.5 GB of hard disk space,
TRL is horribly short. Even if you
waste your time looking for all the
secrets to unlock new concept art
and costumes for Lara, you can’t help
finishing the game in a day. Overall
though, the smooth gameplay, gor-
geous settings and of course, Lara,
make this game worth a go ■

Rating: 8/10
Minimum System Requirements: Pentium 3 1.0Ghz or Athlon XP

Equivalent, 256MB RAM, 64MB 3D Accelerated Card with T&L
Developer: Crystal Dynamics
Publisher: Eidos Interactive

Distributor: Milestone Interactive
Contact: sales@milestoneinteractive.com
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T
he PSP version of the hugely popular Wipeout series,

Wipeout Pure is all about racing your hover-ship on a

narrow, futuristic racetrack without blowing up. It’s a

lot tougher than it sounds—you will invariably find yourself

bonking your ship coming out of a corner, and to make

matters worse, your racing opponents are constantly firing

weird and wonderful weapons at you (and vice versa). 

The description doesn’t sound like much, but the

execution of the concept is where this game stands out.

Firstly, for a game that will be played on the PSP’s small

screen, the game looks beautiful—no doubt the best looking

of the four reviewed here. Track design is brilliant and

delivers the very futuristic feel it’s meant to. The hover-ships

are based on two basic designs, but look good nonetheless.

Controlling your craft is quite difficult initially, till you

realise that the key is to use the analogue stick in

conjunction with the L and R buttons. 

There’s also a Zone mode in the game, which puts you

alone on a track, progressively increasing your speed—the

goal is to last as long as possible without becoming one with

the wall. Surviving long will unlock new tracks for the zone.

Surprisingly, I found that the Zone mode was more exciting

than the single race—especially beyond zone 20.

Wipeout Pure is a really good title to own, though

nothing groundbreaking in terms of its adrenaline-

pumping value. It is, no doubt, a gorgeous looking title and

sounds really good even on the PSP’s speakers—so you know

it’s going to sound excellent on a respectable pair of

headphones too. The review copy we got kept crashing the

PSP, but we’re being optimistic and hoping that commercial

copies aren’t that nasty. ■

If there’s any game genre that gaming console

controllers are beautifully suited for, it’s sports!

Playing World Tour Soccer on the PSP is a treat;

this from someone who couldn’t really care less

about sports games. World Tour Soccer offers you

the option to play quick matches, exhibition

matches, cup competitions and multiplayer

matches. There’s also the challenge mode—seven

matches for you to beat and showcase some smart

moves and stunts—classy steals will be rewarded,

and sloppy passing will earn you negative scores.

Honestly, if there were more challenge matches, the

game could have stood on their shoulders alone—

coupled with the amazing soundtrack, it’s no doubt

the most appealing part of the game. 

Controlling your players is straightforward and

intuitive for the most part. Special moves and

sprints are easily executed and don’t really require

you to read the help—the controls are exactly what

they should be. Friendly AI is not as smart as you

would hope for, but with you on their side they

seem to survive well enough. 

There are plenty of unlockables here, and as you

progress through the game, you will unlock new

stadiums, clubs and challenges. If you’re the kind

that loves unlocking bonuses, this should be heaven

for you. ■
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All Games Distributed

by Milestone Interactive

e-mail: sales@milestoneinteractive.com

Price: Rs 2,999

nimish_chandiramani@thinkdigit.com

P
ursuit Force is a cheeky nod to the campy

action movies of the 80s—you’re a cop in

Capital City and it’s your job to keep the

streets clean. A crazy combination of racer and

action generously dabbed with some third-person-

shooter elements here and there, this is one title

that will keep you entertained all the time.

In your numerous pursuits of vile gangs, you will

jump from vehicle to vehicle, shooting at gang

members from mid-air, landing on their cars’ hoods

and subsequently ousting them from their vehicles.

There will also be times when you will find yourself

on a helicopter, armed with a trusty machine gun to

blow up errant cars. 

The game is mission based, and you will face off

against one of six gangs each time. Each gang has

their own special style and story—the Warlords are

ex-army renegades, the Vixens are stuntwomen-

turned-criminals and so on. Each mission starts

racer-style on a track, with you in your cruiser and

your chief barking orders at you. As you approach

the bad guys, you will engage in a gun battle with

them, either finishing them off from your car itself

or by climbing onto theirs. This aspect of the game

is the most fun—there’s nothing like delivering

justice when in transit from one car to another. The

controls also work beautifully and though it sounds

difficult, this leaping from here to there is really

easy to do. The missions do get quite punishing,

though—even the first novice missions aren’t as easy

as one would think. 

The game is full of many subtle, self-mocking

hilarious moments—old hostages crying “I don’t

want to die a virgin!” and the like. If you’re the type

that takes long journeys in public transport, keep

this one handy ■

F
1 Grand Prix puts you in the official cars, on

the official tracks and in the official shoes of

the drivers of the Formula One Championship.

The game has been made with undoubted finesse—

the graphics and sound are amazing, as is the

soundtrack. You can also import songs from your

own music collection to play while you race! You can

choose to play random quick races, an entire F1

championship, or enter the Scenario Mode where

you’re presented with different scenarios with

varying difficulty—from something as easy as “reach

15th place by the first split” to “win the race in the

rain without changing to rain tyres”. 

The cars’ realistic controls can get quite

frustrating at times—simulations and the PSP don’t

really mix well. Thankfully, you can turn on the

brake assist for a more arcade-ish feel. If you’re

expecting a game with all-out adrenaline, you might

be disappointed with this one, though. The only way

to tell how fast you’re going is the speedometer—

beyond 100 kmph, everything just looks the same;

it’s just that your car suddenly seems to be a little

more touchy with the steering. For a game with such

a tried-and-tested formula and so stylishly made,

this title doesn’t really light our fire ■
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The week-long E3—the
world’s largest video
game convention—

happened in May this year at
the Los Angeles Convention
Center. It wasn’t just games
being played: there was an
art exhibit called Into the
Pixel, now in its third year,
which showcased video
game art—and which made
people ask the question, “Are
video games art?”

Into the Pixel was an
exhibit that showcased 16
works of video game art
chosen from amongst 150
submissions worldwide. The

panel of judges included
people from the interactive,
fine art and contemporary
art worlds.

“Call it life influencing
art, or games influencing
art, or games influencing
life, or art influencing
games. Or better yet, why
not just call it art?” said
Salatino, a former curator of
graphic arts at the Getty
Research Institute in L.A.

So, well, are video games
art? In what many consider
the definitive essay on the
topic, Henry Jenkins, head of
the comparative media

studies program at MIT,
wrote that games are indeed
art. He titled his essay Games,
the New Lively Art, in
reference to Gilbert Seldes’
1924 book The Seven Lively
Arts, which lists jazz, films,
musicals and comic strips,
amongst others, as some of
America’s greatest
contributions to art. (Umm…
comic strips are art?)

It’s an idle question,
really, and the best response
probably came from Louis
Marchesano, one of the
jurors of Into the Pixel and an
art historian whose expertise
is 17th- and 18th-century art.
“Are video games art? I’m
not going to answer that

This month’s winner is Tarun Brari.
Please mail us your address, Tarun!

HHooww  hhee  ddiidd  iitt::
Object bar 1.2 
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iTunes remote widget, weather
widget, calender and digital clock
Any suitable Macintosh wallpaper 

Participate in this contest
and win 
Introducing Maya 7
3D for Beginners
by Dariush Derakhshani
Published by

Too Much Of A Good Thing
There's a trend on in the US of banning laptops in
class. In the news now is Paul Engelking of the
University of Oregon, who found his students gambling
online while they were supposed to be diligently
working on an assignment!

My Desktop

The AMD PIC

Whatever
Happened To... 

In 2004, AMD debuted the
Personal Internet

Communicator—the PIC. The
idea was to create a simple,
affordable solution for the
masses, which had all the
necessary goodies to
connect to the Internet. It
would sell in developing
nations such as India, Brazil,
Mexico, and others of the
league. Sound familiar? Like
so many other devices that
promised to bring computing
to the masses, the PIC seems
to have taken the long walk
into oblivion. And with so
much going for it, too.
It runs on a 333-400MHz
AMD Geode GX processor,
has 128 MB of RAM, a 10 GB
hard disk, a LAN interface
and four USB ports. Connect
a keyboard, monitor, mouse
and a modem or LAN
connection to it, and the Web
is yours! Of course, you have
to get past what a silly
device this is first.
For one thing, it runs
Windows CE—whoever heard
of licensed software on an
affordable device? Still, the
claim is that Windows CE is
only $3 out of its not entirely
affordable price of $249 (just
over Rs 10,000, including a
keyboard, mouse and CRT
monitor). Then there’s the
fact that you can’t install
new software. The BIOS
prevents you from installing
Linux, too! And the final
push—visit AMD’s site to look
up where you can buy this
product in India, and
surprise, surprise: for a
product launched for nations
like India, this one isn’t even
available on the site!

A God-Fearing Virus!
An absolutely crazy Trojan now spreading over P2P deletes
smut! Erazer-A scours the “share” folder the P2P application
is using—for AVI, MPEG, WMV, GIF, and other potentially
dirty files. It then erases the porn, warez, and music in
those folders! Now that's a virus parents would approve of!

Send your desktop with description of how you made
it to mmyyddeesskkttoopp@@tthhiinnkkddiiggiitt..ccoomm with the subject 
““MMyy  DDeesskkttoopp””, and tell us your postal address, too.

IF ELEPHANT DUNG CAN BE…

Pixel Paintings
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question. I don’t know. But,
frankly, I don’t care,” said
Marchesano, who is not a
gamer. “You can’t look at
these pieces and not be
moved by them,
intrigued by them.”

Take a look at the
pictures on the
previous page, which
are quite like what
was exhibited at Into
The Pixel. We think
they’re stunning. In any
case, remember we live
in a world where
elephant dung smeared
on walls and garbage
cans overflowing
with garbage are
considered art!

THE WAR AGAINST
PIRATES

Sniff Out
The DVDs!

We gave it away in
the headline above,
but otherwise,

you’d never guess what
Hollywood’s latest weapon is
in its war against movie

piracy. It’s
Labrador Retrievers. Yes,
authorities in the UK are
using Labs to sniff out
counterfeit DVDs.

Looks like the Motion

Picture Association of
America (MPAA) didn’t know
how much money they were
losing to piracy. Because the
Association said two black
Labradors had been trained
by British customs to do the
DVD-sniffing job just a few
days after a leaked report
revealed that $6.1 billion (Rs
29,000 crore) had been lost
to piracy in 2005. The
Association did not
comment on where they got
the idea from.

The two dogs, named
Lucky and Flo, have their
work cut out at FedEx’s
British hub at Stansted
Airport near London. They
can identify DVDs located in
envelopes, boxes, or almost
any packaging. Naturally,
they can also sniff out discs
concealed amongst other
goods. “This is the first time
dogs have been used

anywhere in the world to
search for counterfeit
DVDs and the results
were amazing,” said
Raymond Leinster,

director general of the
Federation Against

Copyright Theft.
Now it beats us how

dogs can sniff out DVDs.
We didn’t even know
DVDs had a smell! Besides,
what about CDs? Mr
Leinster has qualified his
statement very precisely:
“first time dogs have been
used... to search for
counterfeit DVDs.” So
does he mean they’ve
been used to search for

counterfeit CDs before?
Or bootlegged VHS tapes,

perhaps?
OK, let’s assume DVDs

smell different from CDs.
Next is the question of how
the dogs know the DVDs are
counterfeit. As far as we know,
copies of DVDs are legal,

Atari founder Nolan Bushnell
is widely
considered
the father of
the video
gaming
industry.
Bushnell was
into games

right from his childhood; he
played in chess tournaments
in college and loved puzzles
and problems. He was one of
the many computer science
students of the 1960s who
played the famous Spacewar!
game on a DEC mainframe. 

While he was learning
basic computer graphics at
university, he also worked as
manager of an amusement
park. During this period, he
also created a game named
Computer Space. The game
didn’t take off because the
gameplay was too complex. 

It was in 1972 that
Bushnell went on to establish
the company named Atari. In
the first year of his
entrepreneurial career, he
invented a coin-operated
video game, Pong, which was
a big hit in the gaming
console market. Pong—
essentially a console game
based on ping-pong—was
simple; the ball would go
back and forth between two
pads that moved up and
down, controlled by players
using control knobs. At this
time, coin-based video games
were in vogue, and PC games
were almost non-existent.

Atari soon introduced the
Atari 2600 Video Console
System, which revolutionised
the home video game market
and started a new era in
game consoles. While at
Atari, Bushnell invented 20
games. He sold the company
in 1976 to Warner
Communications, and in the
following year opened Chuck
E Cheese’s pizza restaurant,
which offered both fast food
and electronic games. To
date, Bushnell has founded
18 companies, one of them a
home robotics company.

People Who
Changed

Computing

Nolan Bushnell

The God Of Gaming

Piracy Is Going
Legal!

This month’s 
winner is 
Dr S P Singh
Patiala
drspaulsingh@yahoo.
co.in

Participate in this
Digipick contest and 
win 
Visual Basic
Database
Programming

by Roger Jennings
Published by

WIN!
Send in your entry and you could win an exciting gift just by sharing
an amusing picture with a tech angle to it. The picture should have
been shot by you, and should not have been published anywhere
earlier. E-mail your picture with the subject “DigiPick” and your
postal address oonn  oorr  bbeeffoorree  tthhee  1155tthh ooff  tthhiiss  mmoonntthh  to
digipick@thinkdigit.com. One prize-winning picture will be
published each month.
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provided you don’t share
them, and they’re for your
personal backup purposes.
So do backup and pirated
DVDs smell different, too?

Another pressing
question is, why broadcast
the news that sniffer dogs
are being used? DVD pirates
will now probably coat their
wares in pepper to throw the
dogs off. So now if your next
off-the-street DVD smells of
pepper, you know it’s been
through Stansted Airport!

LEGAL P2P USE

BitTorrent To
Deliver
Movies

Warner Bros will use
BitTorrent’s
technology to

deliver movie downloads, the
studio’s home entertainment
division announced mid-May.
Early May, it was alleged that
Apple will use the same
system to power its
upcoming movie download
service. Warner will soon
make available for download,
via BitTorrent, around 200
titles. The content will be
available for computer
playback only, and will,
naturally, be DRM-protected.
The DRM technology the
service in use will have to

work alongside the
BitTorrent system, which
splits content into numerous
chunks to accelerate delivery.
See How BitTorrent Works,
Digit April 2006.

BitTorrent co-founder
Ashwin Navin said the
company is in talks with
other studios, but there was
no word on how much the
downloads will cost.

In November 2005,
BitTorrent had struck a
deal with the MPAA to
remove links to pirated
movie files from its search
engine. Was that just to
look good? What’s the
point of one search engine
removing links when there
are a hundred others that
will provide the same
links?

We’re not attempting an
analysis of this move on
BitTorrent’s part, but
there’s potential for a
comical situation here. If
BitTorrent’s main site will
have a music purchase
section and also the free
torrent search bar, we could
soon be seeing two large
buttons on BitTorrent.com’s
main page:

1. “I’m a regular P2Per.
Get on with it—take me to
the free movies!”

2. “I’m a God-fearing,
law-abiding citizen. Take me
to your credit card
processing system so I can
pay for the movies!”

MARS AND VENUS

Gender
Differences
Online@Work

Folks always find surveys
that reveal gender
differences interesting,

hence the following:
Websense, a Web security
and Web filtering
productivity software
company, recently conducted
the 2006 Web@Work
Employee survey. Some of
the findings are predictable;
some are interesting.

First, men are more
likely than women to engage
in personal Web surfing at
work. Now that’s probably
because women are in
general more law-abiding
and God-fearing than men,
but it’s just a thought—
please don’t write in to tell
us otherwise!

As far as the types of
sites they visit while at the
workplace is concerned,
there’s a significant
difference. Men are 2.3 times
more likely to visit sports
sites. They’re twice as likely
to visit investment or stock
purchasing sites (naturally,
MCPs would say: women
don’t know how to invest).
But here’s a surprise: men
are 2.5 times more likely
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Computers
Through The
Ages
Not much hair on your chin?
Do people poke fun at you for
never having braved the
times of Windows 3.1? Here’s
how to show them that even
though you haven’t been
there or done that, you still
know more.
The Baby: On June 21, 1948,
the University of Manchester
made its first successful run of
a computer program on the
Small Scale Experimental
Machine, affectionately called
the Baby. It was the first
machine that had the same
basic set-up as the modern
computer and could store both
data and programs in memory. 
The IBM 604: This was an
electron-tube based computer
that could read and process
punch-cards. Its 2x2x1 m
frame and a petite 640 kilo
weight made it the first
commercially available
miniature electronic
calculator. It ran at 50 KHz
and was built out of 1600
vacuum triodes.
The ENIAC: Following the
success of The Baby and its
successor, the Mark I,
researchers developed the
ENIAC—the Electrical
Numerical Integrator and
Computer, which shattered the
2000-tube barrier with its
18,000 vacuum tubes in its
1800 square-foot cabinet. It
could add, multiply and
calculate square roots, though
some claim its real agenda
was to take over the world.
The Altair: In 1975, Popular
Electronics magazine began
selling the Altair as a kit.
Based on the revolutionary
Intel 8080A microprocessor,
this monster could be picked
up for $397 and required
dedicated geek-time to be
assembled and finally used. It
had 256 bytes of memory, and
was programmed in 0s and 1s
by flipping switches on its
front panel. 

So the next time anyone
mocks at you for not knowing
computers, shoot a few
classics at them. 

OK, we’re patting ourselves on the back,
but three cheers to the Digit team’s

spirit! We battled two of our worst enemies
to have this bonanza issue out. First, the
Friday load-shedding; we’ve also been
working weekends as well, and no sir, no
AC on weekends! Then, of course, the
deadlines—which of course no one met, but
the universe unfolds as it should, and
things worked out all fine. Except for Ed
Deepak’s hair having greyed a bit.

Its been raining trips to Singapore:
Michael made a mid-month trip for a
training program, and the end of the
month saw Nimish follow suit for a
training program on Vista. They brought
back cigarettes for Raaabo and Ram. One
pack each. (“Just because I went to
Singapore doesn’t mean I
had money!”)

Raaabo, Nimish
and Prakash sported

the deprived-of-the-comfort-of-my-home
look while they battled slow Net speeds
and late nights to prepare our dual-layer
DVD. We arrived at work one morning to
find them sprawled senseless under their
tables. We had to use an intravenous
caffeine drip to wake Raaabo up.

Anup has taken a sabbatical to study
for a while, whereas Jyotsna is moving on
for good. What had us all in splits was the
quick entry and quickest ever exit of an
indecisive wannabe Digit-ian, a certain 
Mr Singh. A Thursday morning saw him
striding into office and taking up his
appointed seat; Friday afternoon saw him
gone without a word to anyone! Was it the
no-AC-on-Friday thing that scared him off?

And finally, as we turn five, we’re
already wondering what the next

five and more years will see.
Digit on paper displays
perhaps?

FIVE is a nice number... FIFTH ANNIVERSARY
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than women to visit blogs!
Why? A possible explanation
is the following: women are
slow to catch on. (Please
direct all hate mail to
readersletters@thinkdigit.com
with the subject line “ALL
MEN ARE MCPs” in caps.) In
the early days of the Net,
Web surfers were all men—
well, more than 90 per cent,
as we remember it. When
there was talk about Web
sites, women would go, “Oh,
you’re talking about the
Internets! Yes, I’ve heard of
those! They’re special
computers!” (Hate mail to
the address above, please)
And now, in the relatively
early days of blogs, women
are catching on more slowly.

Back to the survey: it
found that 16 per cent of
men had visited a porn
site while at work; 8 per
cent of women had done
so. Now on the one hand,
it’s a no-brainer—porn is
primarily targeted at men
anyway. But eight per cent
of women view porn while
at work? What is the
world coming to? Where
have values gone?

More fun findings:
women tend to vist travel-
related sites more than men
do. Of course—isn’t your wife
always clamouring for that
next vacation? Then, women
who encounter spyware are
more likely than men to
complain—they are more than
twice as likely as men to call
their help desk or IT
department if their
computer got infected with
spyware! Talk about damsels
in distress!

Then, men use IMs at
work more than women do,
which comes as a surprise.
(Women are more chatty.)
Men are also more likely to
listen to MP3s on their work
PCs. (This is something
we’ve seen first-hand right
here at Digit, and we just
don’t know why!)

Finally, men are also
more likely than women to
have heard of the term
“phishing.” Ostensibly,
therefore, women get
phished on a more regular
basis, but that’s just a wild
guess. Still, just to be on the
safe side, don’t give out your
bank details to your wife!

It’s getting to be a sort of record here. Every time we pick a
site for this space, we feel there can’t be another more tear-

provoking. Orlyowl.com had us whipping out our
handkerchiefs.

An Internet meme that became popular mid-2003, O-RLY
is a well-known-on-the-Web term for “Oh Really.” Used to
convey sarcasm on Net forums, it appeared along with the

image of a snowy owl, thus
bestowing cult status upon the
bird.

The site, clearly designed to be
a spoof of the original owl, claims
it is “The home of the infamous O
RLY! owl. This site hopes to
catalogue all of the spin-offs from
the original.” A set of links on the
left largely contain only two sets of

images—pictures of real owls and pictures of the original
Snowy owl, coupled with images of popular American icons—
actors and shows included.

If you do spend a few minutes at the site, the image of the
snowy owl will have been imprinted upon your optical cortex.
Owl, owl, OWL! The aim of the site seems to be to get you to
upload your own version of owl—there’s a helpful “blank owl
template.” What actually made us gasp is the number of
images that have actually been uploaded by visitors—no less
than four thousand!

A spoof’s a fine idea if it can actually make you laugh, but
clicking on a couple of images (of owls, of course!) is all it
takes to end your curiosity. Yawns guaranteed!

Even if you absolutely love Owls, would we recommend
that you take a look at the site? NT-RLY…

whatweretheythinking.com

Lorelle
http://snipurl.com/blogjun1
(http://lorelle.wordpress.com/2006/05/02/blogs-that-
stand-out/)
Blogs That Stand Out 
What is it about a blog that makes it stand out from
the blogging crowd for you? Is it the pretty? The
interesting web page design that makes it enjoyable to
look at as well as read? 

Is it the content, the words, the ideas, the point of
view that captures your attention and keeps you
returning for more? Do you have to agree with their
opinion or perspective or do you make return visits
because they are the opposite of your point of view? Or
because you find it entertaining? …

Mark Cuban
http://snipurl.com/blogjun2
(www.blogmaverick.com/entry/1234000500073690/)
Blog Vs Traditional media 
A blog is media. It’s a platform to communicate that
can reach anyone within reach of an Internet
connection.  I’ve been writing this blog for more than 2
years and that time has allowed me to recognize the
difference between a blog and traditional media and
why the two will never successfully meet.

In traditional media, you are first defined by your
medium. There is some constraint to the physical or
digital definition of the medium the content is
delivered on or by, that for the most part determines
how you are perceived.

Seth Godin
http://snipurl.com/blogjun3
(http://sethgodin.typepad.com/seths_blog/2006/05/the
_problem_wit.html)
The problem with mobile
Why hasn’t the whole cell phone industry exploded?

I don’t mean the “use a portable phone to call
people” market. That market is doing great, because
everyone knows how to use a phone and a cell phone is
just a better solution to that problem for a lot of uses.

I mean the entire “data in my pocket” or
“fundamentally different kind of interaction” business.
For years, everyone has been talking about the coming
goldmine in mobile.

ClickRich
http://snipurl.com/blogjun4
(http://clickrich.blogspot.com/2006/05/best-long-term-
storage-format.html)
Best long-term storage format?
Ok, so let’s take everything we read in the papers at
face value and, between the celeb worshipping and
reality TV, assume we take some time out to plan for
the demise of humanity. Think of a disastrous event
which wipes out, say, 99% of the human population on
earth. Now think about you being one of those ‘lucky’
enough to come out blinking into the light. Let’s say you
reinstate the basic needs of warmth, food, shelter etc.
Now, what would be the best way to access the
thousands of years of civilisation’s knowledge to start to
develop society and technology as fast as possible?

Does blogging
provide an advantage
over traditional
media? What makes a
blog stand apart?
With our hard disks
and what not, what’s
the best way to
prevent data from
vanishing into the
void in the case of an
apocalypse? Some
serious musings.

www.orlyowl.com

Two hoots for the O-RLY owl site

FIFTH ANNIVERSARY

Escape



Glad To Be Reaching You
I’m a student from a small town in Uttar
Pradesh. I’m not rich, so I couldn’t
purchase Digit earlier—but now I save my
pocket money, and have been reading
Digit since June 2005.

There’s no real computer
infrastructure in my area, and no
broadband—so I either have to travel to
Lucknow or make do with BSNL’s 30 Kbps
at my place. I give credit to Digit for my
being able to solve computer-related
problems amongst my circle of friends.

There is a lack of books on 3D game
design and programming here. Since it’s
becoming a great career option, it would
be great if you could provide some
material on it. Anyway, I just want to
thank you for your good work. The Fast
Track is great and is worth it. 

Abhishek Dwivedi
Uttar Pradesh

Dear Abhishek, 
Thanks for giving us credit—we work hard, and
are delighted when we receive feedback like
yours. Upcoming issues of Fast Track might very
well cover areas such as 3D design. In addition,
we’re trying to include more articles in the
magazine on career options—and the areas
you’ve mentioned will likely be featured.

—Associate Editor

The Unrepentant Pirate!
I am regular reader of Digit. I want to
know why PC games cost so much! Here
in my college, I conducted a poll how
many boys buy original game CDs. Of
462 boys who play games, 454 buy
pirated copies. We can get games for Rs
25 to

Rs 150 whereas an original game costs
more like Rs 1,000 to Rs 3,000 or more.

Most game buyers are from middle
class families. It’s not possible for us to
buy such expensive games. I’m happy
with pirated games, and till now I have
not faced any problems while playing
them. Instead of spending so much on
games, I’d rather use the money to
upgrade my PC or buy a new mobile! We
are gadget freaks, and I don’t think the
companies can fight piracy. Yes, they can
fight if they sell their games for as low as
Rs 25. We are Indians and want sasta,
sundar and tikau…

Baskey
Bhubaneshwar

Dear Baskey,
We have reasons for being proud to be Indian,
and wanting sasta, sundar and tikau is not one of
them. There’s a lot I’d like to tell you, but I’ll
keep this response short.

First off, you’ve said that only eight out of
462 buy original games—and you seem to have
been encouraged by this fact. Just because
everyone does it doesn’t make it right: you’re
doing something wrong. “Everyone” throws
garbage onto the street: does that make it
right? If “every policeman” collected hafta;
would that make it right?

Second, game companies spend money
developing their games. If you don’t pay, they
stand to lose money. Think about a scenario
where everyone bought only pirated
versions—how would the companies survive,
improve, innovate?

As for fighting piracy, there’s a trend
towards gaming companies using uncrackable
protection for their discs. CDs can be easily
replicated these days, but this won’t be the
case a couple of years from now—you’ll have
to pay up! We suggest you start practising...

To sum it up, please refrain from promoting
piracy, and prepare yourself for the time when
games will no longer be “free”!

— Associate Editor

Good Mag, Great Service
Digit has always been the best! I’d heard
about the magazine earlier, but only
now have I seen what a good magazine it
is. You’ve helped me get a very good PC.

I purchased the December 2005
issue and the DVD was faulty. I wasn’t
able to mail you earlier, complained
only in March. I had no hope that I
would get a new one. But thanks to
your great customer service, I got the
disc replaced immediately! Thanks for
keeping my trust!

Here’s a suggestion—how about
including a Tips & Tricks corner
dedicated to Linux in every issue?

Sachin
Via E-mail

Dear Sachin,
We do try to keep our readers satisfied—thanks
for writing in about this incident! Regarding
Linux, unfortunately, there simply aren’t enough
Digit readers who are Linux users to warrant
Linux Tips & Tricks in every issue. Just take a
look at the Q&A section of any of our issues, and
you’ll see what I mean—most of our readers use
Windows. Of course, this might change over the
next couple of years.

—Associate Editor

Pack In The Bytes!
I’m a great fan of your magazine. I was
reading Digit in the past, I’m reading Digit
in the present, and I will be reading it in
the future too! Your articles are
informative and broaden our knowledge.
Tips & Tricks and the game cheats on the
CDs and DVDs are helpful for students
like us. The brilliant presentation of the
Fast Track books has solved many of my
problems. The software, games and other
information available on the CDs and
DVDs are superb! I would like to suggest
that you increase the number of software
on the CDs and DVDs, and give us articles
and Tips & Tricks relating to the software
available on the discs. If possible, please
publish a Fast Track on graphic design or
Web page designing in the coming issues.

Riwaj Acharya 
Via E-mail

Dear Riwaj,
We can’t really increase the number of
software we provide on our discs. We have a
certain amount of space, and we try as hard as
we can to include only the best software.
Besides, it’s not the number of software that
counts, but the quality!

We choose topics for our Fast Track series
based on what is feasible and what readers
want. Several readers, including you, have
mentioned graphic and Web design, and we are
indeed contemplating the idea.

—Associate Editor

Games All The Way
My life is incomplete without computers,
and without you my knowledge about
computers is incomplete. I started reading
your magazine when I was in class II. It’s
been a long journey. It is due to you that I
was the best at computers in the entire
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school, and till now, you’re making me
more rocking! I still miss your magazine
Computer Gaming World very much. Your
Fast Track series is stupendous—I can’t
find any other word to describe it. The
gaming title was very good, but a bit
disappointing on the game reviews.

If you could just send me some
information about computer games such
as what developments changed the face
of gaming, in which year, how one game
is different from the other, a tree
showing the release of different games in
the years up until now and their
corresponding year of release, I would be
very grateful.

Avinash Singh 
Via E-mail

Dear Avinash,
You can find a lot of the information you’re
looking for at SKOAR.com—SKOAR! is a gamer’s
magazine and our sister publication. Other sites
that can be helpful are Gamershell.com,
Gamespy.com and 3dgamers.com.

— Associate Editor

We Made A Boo-Boo
I had sent in the solution of the April
2006 crossword after having struggled
with it. I was therefore very curious to see
who the winner was. But there was no
winner declared! I could have consoled
myself if you had declared at least one
winner. It is very negligent on your part
to not acknowledge the correct solutions
sent; I had sent you two mails hoping
they wouldn’t bounce. As a regular
subscriber and reader of your magazine, I
would like to know why you commit such
silly mistakes? Please send me an
appropriate reply!

Krishna
Via E-mail

Dear Krishna,
This was indeed a slip-up. The incorrect file
inadvertently went to our printers, and the name
of the April crossword winner never got printed
in our issue of last month. We’re very sorry for
the frustration you’ve had to go through. Last
month’s crossword winner was Chitra Bharathi.

— Associate Editor

To Case Or Not To Case
I subscribed to Digit in February 2006. I
received my issues as well as the digicam
gift, but I found my magazine copy torn
in two. I did not complain because the
CDs were all right, but I request you to
please send them with protection. If

Inbox

Write to the Editor
E-mail: editor@thinkdigit.com

Snail Mail: The Editor, Digit, D-222/2, Om Sagar Building, MIDC, TTC Industrial
Estate, Nerul, 
Navi Mumbai 400 706

Digit will publish the best letters on these pages. Letters may be edited for clarity.
YYoouu  mmuusstt  iinncclluuddee  yyoouurr  ccoommpplleettee  aaddddrreessss  iinn  aallll  ccoommmmuunniiccaattiioonn..  

For subscription queries, call the help desk at 
022-27629191/9200, fax 022-27629224, or 
send an e-mail to help@jasubhai.com

possible, send the CDs in plastic cases.
Also, you told us in February about

a lucky draw called Fulltoo Dhamaal—
what happened to that? I also read a
reader’s request regarding a calendar. I
was really impressed by the idea. Some
of my friends have subscribed to
competing magazines, but I’ve never
let Digit down! Please consider my
request.

Rahul Ktiyar
Jaipur

Dear Rahul,
We’re always open to readers’ suggestions.
The problem is sometimes that they are
not practical; sometimes it’s about costs,
and so on.

With regards to discs in plastic cases,
couriers do not allow containers in our
packaging. A plastic case would therefore
force us to pay the courier extra, which in
turn would raise the price of a subscriber’s
issue. We want to offer Digit at the lowest
possible price, and the majority of the
subscribers we’ve polled want a lower price
rather than features such as a plastic case. So
here, it’s a cost issue. Please bear with us,
and keep your suggestions coming—and yes,
thank you for your continued patronage!

— Associate Editor

Mind Readers?
This is my fourth letter to Digit. I have
one question: how do you guys get the
software and games that we gamers
think of asking you to provide? I was
thinking of downloading Tomb Raider
Legends and Adobe Photoshop, and
since I’m on dial-up... Then I saw the
May issue, I was so excited I was
jumping with joy seeing the game list
and developer software list! Without
Digit I wouldn’t have been able to host
my own Web site. I earn Rs 6,000 to Rs
7,000 from my site, and you get all the
credit! Please include the Onimusha
demo and the upcoming Devil May Cry
and Residential Evil 4 when released. 

M Avinash
Rajahmundry, 

Andhra Pradesh

Dear Avinash,
It’s just our job to bring our readers tech
knowledge and fun, and if someone really
benefits, we’re happy—thanks for writing in!

We will try and include the demos you’ve
mentioned as soon as possible.

— Associate Editor

It’s MY Digit!
Perhaps you'll find me a unique
kind of reader of your magazine
- I'm jealous of all Digit readers! It
is a precious part of my life, and I
deal with it like one would with the
things one loves most. Though I'm not
a subscriber, I try not to miss an issue.
I mention that I get my copy wrapped
in a newspaper or in a black bag so
that nobody gets to know that I buy
Digit! I hardly tell anybody that I read
your magazine. I keep my collection of
CD/DVDs in a secret place. And, of
course, I feel very jealous when I find
others in my vicinity also reading Digit!

All the credit goes to a friend
who, some four years ago, told me
about your magazine. With my first
copy itself, I was impressed, and now
I think my friend was a fool to have
told me about the treasure that is
called Digit! I haven't even told him
in all these years that I've started
buying Digit!

Let me tell you that your great
magazine keeps me overflowing with
the latest tech knowledge.

I feel proud to be the most tech-
savvy among my friends and
relatives. I recently assembled a
rocking AMD 64 rig for myself—solely
on the basis of ideas in Digit. And
right now, it helps me tweak my PC
to the limits.

Finally, thanks a million for
building my career as a student of
BCA, by providing a magazine which I
think should exist only for me.

Sarfraz Ali
Aligarh

Dear Sarfraz,
Your mail is one of the most intriguing ones
we've received in a long time! It’s heartening
to know that we actually have such an
impact on peoples’ lives. 

We think we're doing our bit to spread
the IT word around the country—the
computer starts off as a casual interest,
develops into a serious hobby, and so on—
eventually, careers are built upon the
exposure one has had as a youngster. We're
glad to be a part of this.

We also think you should share your
knowledge, and spread the word among your
friends. Digit will always be special to you no
matter how many people read it!

— Associate Editor
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People And Events That Grabbed Headlines—For Better Or For Worse

Tom Cruise
doesn’t own
TomCruise.com.

The owner happens
to be the world’s
most famous
cybersquatter, Jeff
Burgar. Cruise has
taken Burgar to a
domain name
arbitrator so as to get “his”
domain back.

Burgar knows at least some
of the loopholes. He’s won
against Kevin Spacey for
exactly the same kind of thing,
and also against Bruce
Springsteen. He lost against
Pierce Brosnan, Celine Dion,
and Michael Crichton. It
sounds a little like a game...

While the legal
proceedings are on,
fans can head to the
sad-sounding
tomcruisefan.com.
Actually, the
legalities are
fascinating: since this
site already has a fan
site up, do they have a

right to TomCruise.com? Anway,
here’s a word of advice: register
your name dot com today to
avoid having to confront the
Burgars of the world—just in
case you become a celebrity
some day. It’s a bit late in the
day, though, for Rajeshes and
Deepaks, but the Tathagathas
and the Chittaswarups of the
world have it easy.
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Ever wonder how many
women there are at
gaming conferences?

There are quite a few, and

they don’t play the games:
they’re referred to as the
“booth babes.” Essentially,
they’re under-dressed women
who entice the geeks to come
and play their game.

Last year, the babe thing at
E3—the world’s largest annual
video game conference, held
in Los Angeles—went over the
top, it’s reported. Girls were
ambling about in bikinis. The
industry decided to tone it
down this year, ostensibly to
make the game industry seem
a bit more family-friendly. But
then, sex games are taking off,
and what can we expect at
next year’s E3?

What’s more interesting is
that there’s actually a site for
them—e3girls.com! Naturally,
it’s image-heavy.

Looking at the site, you
get the feeling that men really
love the booth babes. There’s a
picture archive of the women
at E3 booths for all the years
that the conference happened.
You get the feeling that
they’re as much of an
attraction as the games!

From the site: “The best
collection of E3 booth babes!!
Upload and share your E3 babe
pictures... we all know: you
didn’t only play the games!”
Then, “Do you have e3 girl
photos, if you attended the
conferences you probably do.”

So how does this reflect on
the role of Woman in society?

For any quiries regarding the Digit Patron programme, e-mail us at digitpatron@jasubhai.com

That’s My Name! 

Red Hot Chili Peppers
released their new album
Stadium Arcadium on 9 May.

Naturally, it was on P2P
networks, and fans were
downloading it. Not good for
RHCP. So they resorted to
begging, pleading, and
emotional blackmail (“Please
don’t download the album! Give
us your money instead!”). It really
did involve emotion: Flea, the
bassist, told fans in a letter
posted on the Web site of the Red

Hot Chili Peppers Fan Club that
it would “break his heart” if they
downloaded the new album!

Fans should, Flea said,
appeal to their consciences
before deciding whether to
download the album or buy it.
There’s no news on how many
folks appealed to their
consciences before double-
clicking the album icon in their
P2P clients. It’s sad, really.

Or is it a sham to boost
album sales just a little bit?

ALondon cabbie has
probably been reading
Digit—each month, we tell

folks how to bluff their way
through various things tech,
and this man did exactly that!

The cabbie was mistaken for
IT expert Guy Kewney, in the
following fashion: he was
holding a badge for Kewney at
the BBC studio reception. A
producer called out for “Guy
Kewney,” and the cabbie was
ushered on to a studio set.

Now, instead of doing the
square thing by telling people
he was not actually Kewney, he
decided to field the planned
interview, which was about a

court battle between Apple
iTunes and Apple Corps!

Even as the real Mr Kewney
watched the interview in
disbelief, the cabbie answered
several questions, possibly
including a few gems and some
generic answers—as in “I’m
very surprised to see this
verdict... because I was not
expecting that.” 

His interviewer did catch on
after some such answers, but it
goes to show that bluffing one’s
way through IT isn’t all that
difficult! Get some news titbits
from here and there, develop a
know-it-all attitude, and rattle
off buzzwords!

He Bluffed His Way Through

“Booth Babes”

Pretty Please... 

Look—they’re even wearing “booth babe” T-shirts!




